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Disclaimer 
Information in this document is subject to change without notice and does not represent a 
commitment on the part of Software Bisque.  The software and/or databases described in 
this document are furnished under a license agreement or nondisclosure agreement.  They 
may be used or copied only in accordance with the terms of the agreement 
(www.bisque.com/eula).  It is against the law to copy the software on any medium except 
as specifically allowed in the license or nondisclosure agreement.  The purchaser may 
make one copy of the software for backup purposes.  No part of this manual and/or 
databases may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including (but not limited to) photocopying, recording, or information 
storage and retrieval systems, for any purpose other than the purchaser’s personal use, 
without the express written permission of Software Bisque. 
 
Charts created with TheSkyX are for personal use only.  They may not be published in 
any form without express written permission of Software Bisque, Inc. 
 
TheSkyX includes routines from Astronomical Algorithms Software, © 1991 by Jeffrey 
Sax, and option to the book Astronomical Algorithms by Jean Meeus copyright © 1991 
by Willmann-Bell. ISBN 0-943376-35-2.  Non-exclusive use has been specifically 
granted, in writing, by Willmann-Bell, for use in TheSkyX.  Serial Number U11A445.  
Photographs in the AAO folder of TheSkyX’s media are copyright Anglo-Australian 
Observatory (AAT images) and/or ROE/AATB (UK Schmidt Telescope images) and are 
reproduced with permission.  Photographs from the Anglo Australian Observatory 
telescopes are by David Malin. 
 
The photograph of the Milky Way is licensed from Digital Sky LLC. 
 
TheSkyX™ copyright 2010 Software Bisque, Inc.  All rights reserved. 
 
TheSkyX Serious Astronomer Edition is a trademark of Software Bisque, Inc. 
 
Winter Star Party panorama photographs courtesy Art Mullis. 
 
Selected “in-place” photos are copyright Robert Gendler and are reproduced with 
permission. 
 
Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and 
other countries. 
 
All other product names are trademarks of their respective owners and are used solely for 
identification. 
 
Portions of this document were written by Andre Bormanis and Woodrow W. Grizzle III. 
 
Revised: May 2010 
 

 

http://www.bisque.com/eula�
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Welcome to TheSkyX 
Many of you have never seen the sky.  Not really.  If you live in a city or suburb, a pale 
blue or grey dome looms overhead while the Sun is up, and a darkish brown curtain 
hangs down at night, with maybe a few sparks of light poking through here and there if 
the clouds haven’t gathered and the glare from buildings and cars and billboards isn’t 
overwhelming.  The Sun and the Moon are unmistakable of course, but the spattering of 
stars you glimpse are probably strangers to you.  Some of them might even be planets – 
for most people, it’s hard to tell the difference. 
 
All of this is about to change.  You have in your hands an extraordinary tool for revealing 
not just new worlds, but the entire universe.  The night sky is an incredible wonderland of 
diverse and spectacular objects and phenomena.  Some of these breathtaking sights are 
created by tiny particles that ply the fringes of our atmosphere.  Others are immense, 
ancient structures, incomprehensibly far away. 
 
TheSkyX Professional Edition or TheSkyX Serious Astronomer Edition will bring all of 
these amazing marvels and more to your desktop.  It will help you learn the fundamentals 
of astronomy, the most ancient science, and teach you how to recognize just about 
everything in the real sky.  Whether you’re looking up from the streets of a light-polluted 
city, or taking in the view from a remote, pitch-black mountaintop, or controlling your 
distant observatory from Internet, TheSkyX will help you understand what you see and 
find what you’re looking for. 
 
You’ll also enjoy experiences that are only possible through the magic of simulation and 
virtual-reality programming.  Faster-than-light flights through the solar system, out-of-
this-world views of the Earth and Moon, and the orbital tracks of hundreds of satellites 
are just some of the animations built into TheSkyX.  Trips through space and time that 
were once possible only in the imagination will be vividly brought to life on your 
computer screen. 
 
TheSkyX has something to offer everyone, from the absolute beginner to the most 
knowledgeable amateur astronomer.  This User Guide will help you navigate the basic 
features and tools our unique program has to offer. 
 
The sky is waiting for you.  Let’s get started! 

Getting Started 

TheSkyX Professional Edition and Serious Astronomer Edition (hereafter referred to 
simply as TheSkyX) are available for either Mac or Windows operating systems. 
Operating system specific versions are sold separately, so please make sure you have the 
right product for your computer before proceeding. 
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Throughout this document, TheSkyX Professional Edition-specific features are 
accompanied by the Professional Edition graphic below. 
 

 

Updating Your Computer’s Video Driver 

If you use Windows, Software Bisque strongly recommends updating your computer’s 
video display driver before installing and opening TheSkyX.  TheSkyX takes advantage of 
software called OpenGL to show 2D and 3D planets, animations, and photos at video-
quality frame rates.  To enjoy TheSkyX’s entire feature set, and for the best overall 
performance, make sure that your computer has OpenGL version 1.5 or later installed.   
 
A utility application called TheSkyX Compatibility Test can be run on your computer to 
determine the OpenGL version.  This app can be downloaded from TheSkyX 
Compatibility Test page on the Software Bisque web site. 
 
When you open TheSkyX Compatibility Test, and your computer is not running OpenGL 
1.5 or later, the following window appears: 
 

 
Figure 1: TheSkyX Compatibility Test window that appears when OpenGL version 1.5 or later is not 

present. 

 

http://www.bisque.com/sc/pages/TheSkyX-Compatibility-Page.aspx�
http://www.bisque.com/sc/pages/TheSkyX-Compatibility-Page.aspx�
http://www.bisque.com/�
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Installing Mac Video Drivers  

The latest version of OpenGL is included with the OS X software updates.  Click the 
Apple icon, then click the Software Update command to make sure your Mac is up to 
date.  That’s it. 

Windows 7, Windows Vista and Window XP Video Drivers 

For all 32- and 64-bit editions of Windows, the latest version of OpenGL is distributed as 
part of your computer’s video driver (the video driver is software that communicates with 
the video display hardware).   
 
In order to obtain the latest version of OpenGL, you must install the latest video driver 
directly from the original equipment manufacturer (OEM) of your computer's video 
display adaptor.   
 
Video driver software is updated very frequently, so chances are you don't have the latest 
driver installed on your computer right now.   

To Properly Update the Windows Video Driver and OpenGL 

To properly update the Windows video driver and OpenGL, first determine the make and 
model of your computer’s video display adaptor.  Both are listed in the Windows Device 
Manager (see Windows Help for details about accessing the Device Manager from XP, 
Vista and Windows 7).   
 

• Do not use Windows Update to try to obtain latest video drivers.  Windows 
Update installs video drivers from Microsoft, not from the hardware 
manufacturer. 

• In general, do not use the video driver that is supplied by Microsoft Windows as 
it often does not include the latest version of OpenGL or the latest video driver for 
your video hardware.   

 
Next, visit the Downloads page of the video driver manufacturer:  

• AMD (ATI) 
• Intel  
• NVIDIA 
• S3 Graphics   

 
From there, download and install the latest video driver according to the video display 
hardware manufacturer’s instructions. 
 
After installing the latest Windows video driver, you’re ready to install and run TheSkyX.  

Running TheSkyX without OpenGL 

TheSkyX can be run on a computer that does not have, or cannot support OpenGL 1.5 or 
later.  For example, video driver software that supports OpenGL 1.5 or later for older 
video hardware simply may not exist.  Or, some remote control applications, such as 

http://support.amd.com/us/gpudownload/Pages/index.aspx�
http://www.nvidia.com/Download/index.aspx�
http://www.nvidia.com/Download/index.aspx�
http://www.s3graphics.com/en/drivers/index.aspx�
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Windows XP Pro’s Remote Desktop, cannot run applications that use OpenGL graphics 
acceleration. 
 
When TheSkyX is launched for the first time, it determines if a suitable version of 
OpenGL is installed, then configures the display mode accordingly.  To manually 
configure TheSkyX to run without OpenGL, click the Preferences command from the 
Tools menu (Windows) or the Apple menu (Mac) to show the Preferences dialog.  Select 
the No OpenGL option from the OpenGL Detection Mode list and then click Close.  
Restart TheSkyX for this setting to take effect. 
 
The following features will not be available when the No OpenGL option is selected. 

• Photographic panorama horizons (page 151). 
• Solar and Lunar Eclipse Viewer (page 117)  
• Satellites From Above Earth (page 121) 
• 3D Stars (page 101) 
• 3D Solar System (page 115) 
• Planets rendered using 2D ellipses instead of 3D-like photographs. 

Minimum System Requirements 

Please review the minimum system requirements before installing TheSkyX on your 
computer. 

Mac 

TheSkyX Serious Astronomer Edition for Mac can run on any Mac desktop or laptop 
computer with OS X 10.4.8 or later with a 1.25 GHz or faster G4 PowerPC processor, or 
a 2 GHz or faster Core Duo processor.  You also need at least 512 MB RAM, 64 MB 
video RAM, and 1.3 GB of free disk space, a mouse or other pointing device and a DVD 
ROM drive. 
 
 
TheSkyX Professional Edition for Mac has the identical minimum requirements, except 
that a total of 2.5 GB of free disk space is required. 

Windows 

TheSkyX for Windows can run on any desktop or laptop computer running Windows 7, 
Vista or XP with a 1.5 GHz or faster Intel Pentium 4, Pentium M, Pentium D, or AMD 
K-8 (Athlon) or better processor.  You also need at least 512 MB RAM, 64 MB video 
RAM, and 1.3 GB of free disk space, a mouse or other pointing device and a DVD ROM 
drive. 
 
 
TheSkyX Professional Edition for Windows has the same minimum requirements, except 
that a total of 2.5 GB of free disk space is required. 
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Installing TheSkyX 

Macintosh 

Like all Macintosh software, TheSkyX is easy to install.  Insert the DVD in the DVD-
ROM drive.  TheSkyX icon appears on your desktop once the media is recognized.  
Double click it.  TheSkyX install icon should now appear.  Double click that icon and 
follow the prompts.  You’ll be asked for the all the usual stuff. 
 
If you’re curious about exactly what files are installed to your Mac, turn on the Installer 
application’s logging feature.  From the Installer menu, click the Install Log (L) 
command on the Window menu then click the Show All Logs command in the pop-up 
menu on the Install Log window.  You might want to print the Installer log for future 
reference by clicking the Print button. 
 
To launch TheSkyX, click Go > Applications from Finder (U), then double-click on 
TheSkyX (Serious Astronomer Edition or Professional Edition) icon. 

Windows 7 or Windows Vista 

To install TheSkyX under Windows 7 or Windows Vista: 
1. Log on as an administrator.  TheSkyX requires administrative privileges to 

be installed under these operating systems. 
2. Insert the DVD-ROM in the DVD-ROM drive.  
3. Click Start > Computer. 
4. On the Computer window, select the removable storage device that holds 

TheSkyX media, and then click the AutoPlay button (it’s located in the tool 
bar near the top of this window). 

5. On the AutoPlay window, click Run Readme.  
6. After carefully reading the instructions in the ReadMe file, click the Click 

Here to Begin Installation link.  Follow the on-screen instructions to 
complete the installation. 

Windows XP 

To install TheSkyX under Windows XP: 
1. Log on as an administrator.  TheSkyX requires administrative privileges to 

be installed under XP. 
2. Insert the DVD-ROM in the DVD-ROM drive and wait for the ReadMe 

file to appear in a browser window. If XP’s AutoRun is not active, then 
click Start > My Computer, right-click on the removable storage device 
that holds TheSkyX media and then click Open. Next, double-click the file 
named ReadMe on TheSkyX media to proceed. 

3. After carefully reading the instructions in the ReadMe file, click the Click 
Here to Begin Installation link.  Follow the on-screen instructions to 
complete the installation. 

 
You can bypass the ReadMe and just run setup.exe on the distribution media to begin the 
installation process. 
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Minimum Free Drive Space on Windows 

The Microsoft Windows Installer must cache files in the during installation, therefore, the 
drive that holds the Windows operating system must have approximately three times the 
amount of free disk space as the product's installer requires.  
 
This means, for example, when installing the 2.5 GB TheSkyX Professional Edition, the 
drive where the Windows operating system is installed should have at least 7.5 GB of 
free disc space.  Otherwise, an “out of disk space” error can occur (even if the destination 
drive has ample free space). 
 
This is limitation of Microsoft Windows Installer. 
 
To open TheSkyX, click Start > All Programs > Software Bisque > TheSkyX Serious 
Astronomer Edition > TheSkyX Serious Astronomer Edition. 

Removing TheSkyX 

If you wish to remove or uninstall TheSkyX from your computer please follow the 
procedure outlined below. 

Macintosh 

1. From Finder, click Go > Applications to open the Applications folder.  
2. Drop TheSkyX Professional Edition or TheSkyX Serious Astronomer 

Edition application to the trash. Note that you must empty the trash before 
re-installing.  The files you create with TheSkyX are saved to the 
Application Support folder.  See “Application Support Files” on page 19 
for details. 

Windows 

1. Log on as an administrator.  
2. Click Start > Control Panel > Uninstall a Program (or double-click the 

Add/Remove Programs from XP). 
3. Select TheSkyX Professional Edition or TheSkyX Serious Astronomer 

Edition from the list of installed programs, and click the Uninstall button 
(or click the Remove button under Windows XP).  

Name and Serial Number Registration 

The first time TheSkyX is launched, you’ll be prompted to enter your name and serial 
number. 
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Figure 2: The Serial Number dialog. 

If you purchased TheSkyX from the Software Bisque store, your serial number has 
already been registered, and is included as part of your web order information.  To access 
your registered serial number from your Software Bisque account, sign in to 
www.bisque.com, then click your Sign In name on the upper right side of the page.  On 
your account profile page, click the Subscriptions link on the left side of the page (below 
your account’s avatar).   
 
If you did not purchase the product directly from Software Bisque, your serial number is 
located on the outside of the media case.  We urge you to register your software at 
www.bisque.com/register.  After you register your serial number, you will be able to 
download the full product installer and latest update. 
 
We also recommend that you keep a copy of your serial number for your permanent 
records.  Your registered serial number serves as one form of proof of purchase for future 
updates, and you’ll need it if you ever have to reinstall TheSkyX. 

Small Computer Screens 

When TheSkyX is opened on a Netbook computer or a laptop with a small screen, it 
automatically configures settings to maximize screen real estate.   
 

http://www.bisque.com/�
http://www.bisque.com/register�
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Figure 3: TheSkyX’s window optimized for a 1024 x 600 Netbook computer. 

The following reminder will be displayed. 
 

 
Figure 4: Small Screen Settings Reminder. 

Turn on the Don’t Show this Dialog Again checkbox to prevent this window from 
appearing in the future. 
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Application Support Files 

When TheSkyX is launched for the first time, it creates a folder named TheSkyX 
Professional Edition or TheSkyX Serious Astronomer Edition.  This folder is used to store 
TheSkyX’s settings, such as location, time, field of view, etc., as well as tours, movies, 
exported databases, TPoint Add On settings files, and other TheSkyX-related files that 
you create and save. 

Mac 

TheSkyX’s application support files and folders are located in the Library/Application 
Support/Software Bisque folder in your home directory.   
 
Note that TheSkyX’s support files and folders will remain in your home folder until they 
are sent to the trash.  In other words, if you ever remove TheSkyX from your Mac (page 
16), you will want to remove these files and folders, too. 

Windows 

Application support files and folders are located in the Software Bisque folder of your 
Documents (Windows 7 and Windows Vista) or My Documents folder. 
 
Note that TheSkyX’s support files and folders will remain in your Documents folder until 
they are deleted.  TheSkyX’s uninstaller (page 16) will not delete files or folders in your 
Documents folder.   
 
We’ll discuss customizing TheSkyX for your geographic location in a moment… 

About This Documentation 

The purpose of the User Guide is to familiarize you with the basic organization and 
structure of our program, and to introduce those of you who are new to the subject of 
astronomy to some of its most important terms and concepts.  We also hope the Guide 
will stimulate you to become more interested in astronomy and space science, and excited 
to start learning about the extraordinary universe we live in. 
 
We urge you join the Software Bisque support community at www.bisque.com/support.  
If you have questions, our support staff, and other knowledgeable astronomers, are there 
to help.  

Having a Look Around 
The star chart display is the heart and soul of TheSkyX.  We call it the Sky Chart, to 
distinguish it from the real thing.  To the left of the Sky Chart you’ll find a series of 
stacked windows with vertical tabs to access the most commonly used commands and 
options.  You can show or hide stacked windows from the Display menu. 
 

http://www.bisque.com/support�
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Figure 5: TheSkyX’s default screen showing the Sky Chart in Daylight mode, with stacked tool 

windows on the left and toolbars on the top. 

 
Figure 6: The toolbars (click and drag the checkered “gripper” on the left side of each toolbar to 

move it). 

When TheSkyX is first launched, it attempts to automatically set your location using the 
web; the date and time are read from your computer’s clock.   
 
You’ll also notice that if you are using TheSkyX during daytime, the sky it displays is 
blue (just like the actual sky).  In a moment we’ll describe how to change that to a night 
view even during the day.   
 
To help you get started and more easily identify commands, the toolbar buttons are 
configured with large icons and text description.   
 
The software authors understand that showing both a graphic and text consumes valuable 
real estate on notebooks, smaller computer screens, or when operating TheSkyX from a 
remote computer.  To reduce the size of the toolbar buttons, click the Preferences 
command from the Tools menu (TheSkyX menu on the Mac), then click the Toolbars 
icon.  In the Appearance pop-up, select Icon Only; in the Size pop-up, select Small and 
then click Close.  See “Customizing Toolbars” on page 130 for more information. 
 
Right now, let’s make sure that the program is set to display the Sky Chart from your 
location. 

Entering Your Location 

Home is where you hang your hat, and also where most of you probably view the sky.  
The first time TheSkyX is launched, your computer’s IP address is used to place your 
location on Earth, typically within a few miles, which is “close enough” for most 
astronomy work. 
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If you know the precise longitude of your location, you can enter it, or choose the name 
of the city you live in, or the one closest to you, from the list in the Location window. 
 

1. Highlight the Input item in the main menu.   
2. Select the first command, Location. 

 

 
Figure 7: Location window, List of Locations tab. 

A window appears displaying options for setting your location.  From the List of 
Locations tab, if you live in the U.S., double-click on United States.  A list of the major 
cities within your country appears.  You can choose your city, or the one closest to where 
you live, by double-clicking on it.   

The Location on Earth used by TheSkyX (My Location) 

The My Location table shows your location on Earth as defined by its longitude, latitude, 
time zone, elevation and Daylight Saving Option.  

Location Description (Description) 

The location Description is for reference purposes only.  Double-click the description to 
change it. 

Time Zone Offset (Time Zone) 

The time zone of a location on Earth is the difference between Universal Time (UT) and 
local time, in hours. For most locations, this equals your longitude divided by 15 degrees. 
Regional variations can cause the time zone to differ by plus or minus one hour. 
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Daylight Saving Option (DSO) 

TheSkyX can be configured to automatically “spring forward” when Daylight Saving 
Time begins, then “fall back” when it ends. Select the DSO for your region.  
 
See Appendix A: International Daylight Saving Time to see the starting and ending dates 
for each option. 

Location Database (List of Locations) 

TheSkyX includes a large database of pre-defined locations that can be used to get you 
“close enough” to your home location.  
 
When a location is highlighted in the list, the Selected Location table shows the details 
for this location. 
 
Select a location from the list, then click the Set As My Location button, or double-click 
on the location name to use it as your location.  
 
Click the Remove button to remove the selected location. 
 
Your location settings are saved when you click the Close button, and will be used the 
next time TheSkyX is started. 

Custom Location 

Alternatively, you can enter your latitude and longitude or U.S. zip code from the Custom 
tab. 
 

 
Figure 8: The Custom location tab (Input > Location). 
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Location from Zip Code (From Zip Code button) 

Residents of the U.S. can enter a zip code to retrieve their location information.  

Location from Computer’s Internet Protocol (From IP button) 

If your computer is connected to the Internet, you can obtain reasonably accurate location 
data using your computer’s IP address.   

Adding Custom Locations to TheSkyX’s Location List (Add to Location Database 
button) 

After manually entering your location details, click this button to permanently save them 
in TheSkyX’s Locations List. 

Using Google™ Maps (To Google Map button) 

Compare your coordinates to a Google map to make sure they’re accurate. Or, use the 
Google map to refine your location. Clicking the To Google Map button launches a 
browser and shows this location on a Google Map. 
 
To refine the coordinates, adjust the map accordingly, right-click (+left-click on the 
Mac) on the map, or click the Satellite button to show the satellite photo of your 
observatory, for example, then click the Directions To command to show the precise 
latitude and longitude, in decimal format, of this point in the Driving Directions.  
 
Highlight the latitude (the first coordinate that is shown), then select the Copy command 
from the Edit menu. From TheSkyX, right-click (+left-click on the Mac) and select the 
Paste command. Repeat this procedure for longitude.  
 
When you’re done, click the To Google Map button again to make sure the values you 
entered are correct.  The coordinates of pointer on the map that appears should match 
your observing site. 

Earth Map 

Yet another way to find home is to use the Location window’s Earth Map tab. 
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Figure 9: The Earth Map tab (Input > Location). 

The default view shows a map of the entire Earth. Use the Zoom slider to change the 
magnification, and the scroll bars to center the correct region. Click the Show Cities 
option to reveal TheSkyX’s Location list. The Show Boundaries option shows you the 
approximate country and U.S. state boundaries. 

The Basics 
What follows is an introductory section, which describes the basic functions of TheSkyX, 
and will help you to quickly get started exploring the marvels of the sky.  Included in this 
section are instructions for zoom, scroll, and pan controls, as well as display options, 
returning to home position, and moving/adjusting the toolbars and “dockable” windows.  

Zoom Control 

There are a number of ways to zoom in and out in the Sky Chart.  You can use the zoom 
in/zoom out buttons on the toolbar, the zoom box, or by using Orientation menu controls. 

Zoom Buttons 

To zoom in on objects in the Sky Chart, simply click the zoom in button in the toolbar.  
This will reduce your field of view, and increase the angular size of the scene (called the 
field of view or field width). 
 
To zoom out, simply click the toolbar’s zoom out button.  This will increase the Sky 
Chart’s field of view, giving you a wider field of view. 
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Zoom Menu Controls 

Alternatively, you can zoom in or out using menu commands.  Under the Orientation 
menu, you will find controls to zoom in and out. 

Sky Chart Zoom Tool 

On the left side of the Sky Chart window, you will find a red zoom tool.  This tool makes 
it easy to zoom in and out with a simple click and drag.  Just click the zoom tool’s slider 
bar, and by dragging it up or down, you will zoom either in (up) or out (down).  Or, click 
the +/– symbols to zoom out or in. 
 

 
Figure 10: The Sky Chart’s zoom tool. 

Zooming with Scroll Wheel Mouse 

If you are using a mouse with a scroll wheel feature, you can zoom in or out by simply 
rolling the wheel forward for zoom in, and backward for zooming out.  This feature is 
great for quick, convenient zooming. 

Zoom Box 

Using the zoom box is another easy way to zoom in on objects in TheSkyX.  Choose a 
portion of the Sky Chart into which you would like to zoom.  Hold down the SHIFT key 
(the cursor changes to the pointing finger) while clicking in one corner of the chosen 
portion, and drag the mouse to the opposite corner.  Release the mouse button, and the 
box’s caption says, “Click inside to zoom, outside to cancel.”   
 
Notice that the box’s diagonal dimensions appear above it in degrees, minutes and 
seconds of arc.  Click anywhere inside the box to zoom in, filling the Sky Chart’s field of 
view with the dimensions of the zoom box. 
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Figure 11: A zoom box on the Sky Chart (SHIFT+drag). 

Returning to Naked-Eye View 

Regardless of how you zoom, you can always return to the naked-eye field of view by 
either zooming out manually, or by selecting Orientation > Zoom To > Naked Eye 100°. 

Scrolling and Panning Control 

Scrolling or panning the Sky Chart’s “camera” will allow you to look at the universe in 
any desired direction, giving you that perfect view. 

Toolbar Controls 

The toolbar features four easy to use buttons for camera scrolling/panning.  By locating 
and clicking any of the four blue arrow buttons, you can move to camera to look up, 
down, left, or right.  Also, to look specifically in the four cardinal directions or at the 
zenith (straight up), locate and click the “look” buttons (Look North, for example).  
Clicking any of these buttons will orient the Sky Chart in the corresponding direction.  
 

 
Figure 12: The cardinal direction and move buttons. 

Clicking and Dragging 

Alternatively, you can adjust the field of view by left-clicking your mouse anywhere in 
the Sky Chart and dragging the view.    
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Chart Navigation 

The navigate command lets you explore the digital sky through a celestial sphere map 
(showing the constellations and their boundaries), by entering specific coordinates, or by 
selecting a specific position angle. 

Using the Navigate Command 

To access the Navigate command, select Orientation > Navigate.  Three tabs at the top of 
the window indicate the navigator choices: Celestial Sphere, Sky Chart Center, and 
R otation. 

Celestial Sphere 

This tool lets you select a region of the sky from a model of the Celestial Sphere, in 
Mercator projection, and with celestial north at the top.  The brightest stars (in correct 
colors) and the constellation borders appear in this map. 
 
If the chart looks too small at first, simply click and drag the window’s lower right corner 
to resize it.  After you close the window or quit the application, TheSkyX will remember 
the window size and position each time you open it. 
 
As you mouse over the map, notice that both the equatorial and altitude-azimuth 
coordinates of your pointer’s current position appear at the bottom of the window.  The 
constellation associated with your pointer’s position also appears. 
 
Click on any location to center it on the Sky Chart.   
 
By default, TheSkyX attempts to pin the local horizon near the bottom of the screen.  If 
the “clicked on” position happens to be below the horizon, the Sky Chart moves to the 
closest visible point.  Turn on the Allow Sky Chart to be Scrolled Below the Horizon 
option on the Horizon tab on the Display > Horizon & Atmosphere Options window to 
allow regions below the local horizon to be accessible. 
 
To see more of the map, click and drag at any point to scroll.  Because it represents a 
sphere, the map is a continuous loop. 
 
You can remove the horizon picture altogether by deselecting the Show H orizon 
checkbox.  Click Close to return to the Sky Chart.  You will notice that you can now 
scroll below the horizon either manually or with the Celestial Sphere navigator. 
 
When finished with the Navigate window, click Close to return to the Sky Chart. 

Sky Chart Center 

Select the Sky Chart Center tab to enter specific coordinates in either equatorial 
(RA/Dec) or horizon coordinate (Az/Alt) systems. 
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To enter coordinates, click on the desired field and directly enter the values into it.  For 
convenience, you can simply enter three numbers separated by spaces.  For example, 
enter 10, 30, 29 into the R A field to specify right ascension of 10h 30m 29s. 
 
Because equatorial coordinate systems are based upon the orientation of Earth’s axis, 
their accuracy diminishes over time due to, among other factors, precession.  For that 
reason, many publications reference equatorial coordinates at a specific point in time 
known as an equinox.  If you are using RA/Dec coordinates, it is important to choose the 
correct equinox (either 2000.0 or 1950.0).  The 1950.0 equinox setting can be useful, as 
many older publications list equatorial coordinates according to the 1950.0 equinox. 
 
Click Center on R A/Dec (for equatorial coordinates) or Center on Az/Alt (for horizon 
coordinates) to center the Sky Chart on the selected coordinates. 
 
Click the Get Sky Chart Center Coordinates button to display the current coordinates of 
the Sky Chart’s center in the above coordinate fields. 
 
For your reference, example input for each of the coordinate systems appears near the 
bottom of the window. 
 
Click Close to return to the Sky Chart. 
 
See “Slewing to a Specific Coordinate” on page 216 for details about slewing a telescope 
using the Navigate commands. 

Rotation 

The Sky Chart can be rotated to position angle you wish.  This parameter is called a 
position angle, and it helps to match the Sky Chart to the real sky and to any paper charts 
you may use while observing or planning an observation session. 
 
Click the R otation tab to view and adjust the Sky Chart’s position angle.  You will 
immediately see a graduated circle with a brown indicator showing the Sky Chart’s 
current position angle.  Click and drag this indicator to adjust the position angle to 
whatever you wish in real-time. 
 
Near the bottom of the window, you will see the Sky Chart’s current position angle.  You 
can also enter a specific position angle into the field at the bottom of the window (to 
hundredths of a degree of accuracy).  Use the up and down arrows here for an easy way 
to adjust the position angle in whole-degree increments.  For example, if you enter 
42.78°, clicking the up arrow once will increase the value to 43.78°. 
 
Once you have entered a position angle, click Set to update the Sky Chart. 
 
Click Close to return to the Sky Chart. 
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Note:   T he horizon disappears when you adjust the position angle.  Changing the 
position angle is equivalent to changing the direction of “ down”  in relation to the 
horizon, so the horizon as a reference becomes irrelevant.  TheSkyX removes it to avoid 
confusion. 

Mirror Image 

Refractors and catadioptric telescopes used with star diagonals produce mirror images of 
the sky because they have an odd number of image reflections.  Selecting Display > 
Show Mirror I mage flips the Sky Chart to “reflect” the view through a refractor or 
catadioptric telescope with star diagonal. 

Display Chart Elements 

In addition to the huge database of celestial objects in TheSkyX, a number of other useful 
elements, such as coordinate system lines, constellation boundaries, and other reference 
lines, are all available to you.  Each can be toggled on or off with ease.   

Chart Element Buttons 

On the toolbar, you will find a number of buttons assigned to control chart elements 
(Constellation Figures, the Ecliptic, etc.).  To toggle a given chart element on or off, 
simply click the appropriate button.  For instance, if you want to turn on the constellation 
figures, locate and click the Show Constellation Figures button on the toolbar: the 
constellation figures appear in the Sky Chart.  Also, note that the button is now a darker 
gray than the rest of the toolbar.  This change indicates that the constellation figures are 
turned on.  To hide them, click the button again.  The button color will lighten and the 
constellation figures will fade from view.  There are several other chart element buttons 
on the toolbar.  Try them all to get a feel for how they work. 

Chart Elements Window 

A complete list of chart elements is available by selecting Chart Elements from the 
sidebar of the stacked tool windows, which is located on the left side of the screen when 
you first open TheSkyX. 
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Figure 13: The Chart Elements window (Display menu). 

If Chart Elements does not appear in your stacked tool window, or if you removed it, 
you can always access it again by selecting Chart Elements from the Display menu. 

Locating a Chart Element by Name (Locate by Name) 

If you know the name of the Chart Element you’re after, there’s a quick way to find it in 
the list.  For example, suppose you want to turn on the line that represents the galactic 
equator.  Typing the letter “g” into the Locate by Name text input shows a list of all of 
the elements that begin with this letter in the pop-up menu.  Selecting Galactic Equator 
expands the Reference Lines and Photos node to reveal this option.  Press the TAB key to 
place the “focus” on this checkbox.   
 
From here, you can turn the checkbox on or off, or, click the Edit Attributes button to 
configure this element’s upper and lower magnitude limits, angular size limits and other 
display properties, such as the font size, line styles, fill colors and symbol.  See 
“Customizing Chart Elements” on page 136 for more information. 
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Customizable Interface 

One of the great features of TheSkyX is its customizable interface.  All toolbars and 
“dockable” windows are movable and adjustable, giving you great flexibility in using 
TheSkyX to best suit your needs. 

Positioning Toolbars 

When you first open TheSkyX, you will notice rows of toolbars on the top of the screen, a 
stacked tool window on the left, and the Sky Chart on the right.   
 
When looking at the toolbars, notice that at the far left of each, you will see a textured 
area (or “gripper bar”).   
 

 
Figure 14: The textured region on the left side of toolbar windows can be used to position the toolbar. 

Clicking and dragging on this area will allow you to move that toolbar to almost any new 
desired location on the screen.  As you drag the toolbar, you will notice that portions of 
the screen move to allow you to drop the toolbar into position.  If you drop a toolbar in 
one of these positions, it will “snap” into place.  (You may also drop the toolbar over the 
Sky Chart in any location, without snapping.)  Feel free to experiment with this feature to 
get a feel for how the toolbars can be moved, as you can always move the toolbar back to 
its default position later.  Be sure to look over each toolbar, and you will see that they are 
divided into sections, each of which can be moved.  Note that the textured section 
denotes the beginning of a new toolbar section. 

Moving Dockable Windows 

To the lower left of the screen, you will find a set of tool windows that are stacked 
together.  A sidebar allows you to choose which window you want to see.  All of the 
windows stacked together on the left side of the screen can be moved and/or made into a 
new stack.  Notice that when you select a stacked window on the sidebar, its name also 
appears at the top of the window along with a window resize button and a close window 
button.  By clicking the window resize button, you release that particular window from 
the stack.  Now you are free to move the window to any location that you like by clicking 
and dragging it.  Alternately, you can dock the window on the left or right side of the 
window by dragging it and releasing it in any area that readjusts as the window is drug 
over.  For instance, try clicking Labels in the stacked tool window.  Now click the 
window resize button in the top right of that window.  The window will now undock 
from the stack.  Click and drag the window to the far right side of the screen.  You will 
notice that the Sky Chart will move slightly to the left, and a dark gray area will appear, 
indicating that you may “dock” this window here.  Release the mouse button, and you 
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have docked the window.  If you would like to move another window, simply repeat the 
previous steps. 
 

 
Figure 15: The stacked tool windows, including Tours, Find, Date and Time, Photos, Labels and 

Telescope and Observing List. 

Stacking and “Dockable” Windows 

Windows can be stacked by dropping a window on top of docked windows.  When the 
docked window turns a dark gray, drop the window you are moving to stack them.   

Closing and Reopening a Docked Window 

If you ever wish to remove a window from view completely, simply select it from the 
stacked tool window sidebar, and click the close window button.   
 
If you want to view a window again, simply select it from the Display menu. 
 
The following windows can be stacked on the left or right side of the main window, or, 
by dragging the window’s title (caption), positioned anywhere on your computer’s 
monitor. 
 

• Chart Elements 
• Chart Status 
• Date and Time 
• Find 
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• Labels 
• Observing List 
• Photos 
• Telescope 
• Tours  
• Telescope-specific command windows 

Full Screen 

The Sky Chart can fill your entire screen.  For Full Screen Mode, select Display > F ull 
Screen.  Select the command once more to return to normal mode. 

Heading Home 

The universe is a big place, and when you are ready to go home, it is nice to know that 
TheSkyX can get you there in only two clicks (that’s one click faster than it takes with a 
pair of famous red shoes).  When you are ready to return to your default space and time, 
simply click Look South, followed by Computer Clock, both in the toolbar.  This action 
will adjust the Sky Chart’s view to the south, and at the current time designated by your 
computer’s internal clock.  Welcome back! 

Restoring Default Sky Chart Settings 

Or, select the New command from the File menu whenever you want to restore 
TheSkyX’s chart settings to their default values.   
 
This will show the daytime sky (Display > Show Daylight), set the date and time to the 
computer’s clock and (turn on the Computer Clock button on the Date and Time 
window, Input menu), shows the default objects labels, object types, reference lines, 
object magnitude and size limits; just like when TheSkyX was first launched. 

Saving & Retrieving Your Sky Chart 

Your Sky Chart settings can be saved and opened at any time by creating special 
TheSkyX files with the extension .skyx. 

Saving Your Sky Chart 

You can save your current Sky Chart, along with all of its settings, at any time by 
selecting F ile > Save.  TheSkyX saves the Sky Chart in .skyx files, which are a handy way 
to save data you wish to quickly recall later, such as when you journey to your favorite 
hilltop. 
 
Choosing F ile > Save As allows you to save another .skyx file without overwriting the 
current one. 
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Opening An Existing File 

To open an existing Sky Chart, select F ile > Open.  You will then be able to search your 
hard disk for existing .skyx files. 

Help Options 
As you continue to use TheSkyX and read through this User Guide, keep in mind that we 
have included the complete User Guides for both TheSkyX and the TPoint Add On, as 
well as an XML-based help guide and all are accessible from TheSkyX’ s H elp menu.  
Even the most seasoned observer sometimes needs a little help, and with all the features 
packed into TheSkyX, it is handy to always have a reference guide at your fingertips. 

Help Search 

You can easily search through TheSkyX’ s many commands by entering search terms into 
the Help menu’s search field.  For more detailed help, continue reading for more help 
options. 

TheSkyX Help - Assistant 

TheSkyX includes a slick, XML-based help guide called Assistant, which is designed to 
help you to get the most out of TheSkyX, no matter how you plan to use it.  Whether you 
use TheSkyX to plan for meteor showers, or you want to use the most advanced telescope 
controls, TheSkyX Assistant is there for you, regardless of your user experience. 

TheSkyX User Guide 

This user guide is available, in its entirety, at any time from the Help menu.  Simply 
select H elp > T heSkyX User Guide to access it. 

TPoint User Guide 

TPoint is an advanced telescope pointing analysis system, which allows you to analyze 
the errors inherent in your particular telescope system to drastically improve its pointing 
performance.  Both TheSkyX Serious Astronomer E dition and TheSkyX Professional 
E dition come with a trial version of TPoint, which can be activated the first time you use 
the add on, after which time, you will have to purchase a license separately.  TPoint can 
be accessed from the T ools menu. 
 
Like all aspects of an imaging system, there is a significant learning curve with TPoint.  
Fortunately, TheSkyX makes using TPoint smooth, and you should be able to complete a 
mapping run on the first night and start analyzing your system right away.  There is a 
comprehensive user guide for TPoint available by selecting H elp > T Point User Guide. 
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Finding and Identifying Celestial Objects 
TheSkyX’s astronomical databases can be quickly searched to locate any one of millions 
of available objects, either by clicking on the object on the Sky Chart (called 
“identifying”) or through the Find command from the Edit menu.  

Identifying Objects 

The Sky Chart is linked to TheSkyX’s astronomical databases.  Clicking on an object (or 
locating it with the Find command on the Edit menu) identifies the object and displays 
the Object Information Report with a wealth of information… 
 

• the object’s common name and/or its catalog designation  
• the graphical symbol used to represent this object on the Sky Chart 
• cross references to other catalogs (Name 2-Name 10) 
• the object’s type (variable star, irregular galaxy, and so on) 
• the constellation in which the object lies 
• the object’s magnitude 
• a star’s Bayer (Greek-letter) brightness designation 
• the Dreyer description of the object, in plain English 
• the object’s distance from Earth, in light years and AU (where known) 
• catalog-specific information (such as min/max magnitude of variable stars, 

spectral class, parallax, proper motion, position error, distance from the Solar 
System) 

• the object’s equatorial (RA-Dec) coordinates, for both the date specified in the 
Site Information dialog and Equinox 2000.0  

• the object’s horizon (Az-Alt) coordinates at the time displayed in the Status Bar 
when the object was clicked on (or found using Find) 

• the object’s rise time, transit time and set time for the site location the object’s 
angular dimensions 

• the angular separation from the last object identified 
• the object’s position angle (the angle between the line connecting the object and 

the last-identified object, and the line connecting the last identified object and the 
North or South Celestial Pole) 

• Other object-specific information… 
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Figure 16: Find window (Edit menu). 

The object you clicked on (or located using the Find command), and up to ten “nearby” 
objects (or objects with names that closely match this object), are listed in the Related 
Search Results box.  This eliminates any need to click exactly on the object, and makes it 
easy to study groups of objects without having to click on each one.  If you click in an 
area without any nearby objects, the Mouse Click Position is the only entry.  
 

 
Figure 17: The text color indicates the object's visibility (green means the object is currently above 

horizon; black text means it is below horizon). 

The object’s symbol (a yellow star in Figure 16) is displayed next to the object’s name.  
When the object’s name is displayed with green text, the object is above the horizon.  
Black text means the object is currently below the horizon. 
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Identifying Galaxies, Nebulas, and Open Clusters 

At wide fields of view, galaxies, nebulas and open clusters are displayed as their standard 
symbols. At higher magnifications, the symbols are replaced with circles or ellipses that 
represent the shape and dimensions of the object. Within these extended objects, there is 
no marked point on which to click. If the object is displayed as a circle, you can click 
anywhere within the circle. For objects displayed as ellipses, click within the circular 
region defined by the ellipse’s minor axis, as shown in the drawing below.  

 

 
Figure 18: Click inside the shaded circle to identify this extended object (galaxy). 

The Andromeda galaxy (M31) is one example of an extended object.  You need to click 
on a point towards the center of M31 – without too many nearby stars – to identify it.  
Click on the central region of stars to identify them.  
 

 
Figure 19: Object-specific buttons on the Find window. 

Centering Objects on the Sky Chart (Center button) 

The Center button repositions the Sky Chart with the identified object at the center.   

Framing Objects (Frame button) 

The Frame button repositions the Sky Chart with the identified object at the center and 
adjusts the field of view to show extended objects. 
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The default field of view for point sources (or cataloged objects that do not have size 
information) is 10 arcminutes.  To use a different framed field width, change the Default 
Frame Size when Object Size is Unknown value on the Non-stellar Object Options 
dialog from the Display menu. 

Showing Photographs and Hertzsprung-Russell (HR) Diagrams (Show Photo+ 
button) 

If the identified object has a photograph (not all objects have photographs), the Show 
Photo+ button shows it in the Photo Viewer window. 
 

 
Figure 20: Photo Viewer window showing M31. 

If the identified object is a star in the Hipparcos/Tycho catalog, a Hertzsprung-Russell 
(HR) diagram is displayed.  The cross hairs show the position of the star on the diagram. 
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Figure 21: HR Diagram for a Hipparco-Tycho star. 

Slew the Telescope (Slew button) 

When a telescope connection is established, click the Slew button to command the 
telescope to slew to this object. 
 
Aborting Telescope Slews (Abort button) 
If you change your mind after clicking the Slew To, click the Abort button to cancel or 
terminate the slew.  This button is available only while the telescope is slewing. 

Copy Object Information Report to Clipboard (Copy Text button) 

To copy all the information in the Object Information Report to the Clipboard, click the 
Copy button.  Or, right-click (+click on the Mac) on the report and click the Copy Text 
command in the pop-up menu. 
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Figure 22: Right-clicking (+click on the Mac) over the Object Information Report to show a 

context pop-up menu. 

To copy the contents of a single field, move the mouse cursor over it, right-click the 
mouse (+click on the Mac) and then click the Copy ‘<Field Name>’, where ‘<Field 
Name>’ is the name of the information field beneath the mouse cursor. 
 
Other pop-up menu commands allow copying just the equatorial coordinates (J2000.0 or 
current), or toggling the number formatting between sexagesimal and decimal format. 
 

Adding Objects to an Observing List (Add to List button) 

TheSkyX can create an observing list of the objects.  To add this object to the Observing 
List, click the Add to List button.  See “Observing Lists” on page 172. 

Locking On a Solar System Object (Lock On button) 

If the identified object is a planet, moon or other solar system object, click the Lock On 
button to pin this object to the center of the Sky Chart.   
 
As a reminder, the text Locked on <Solar System Object> appears in the lower right 
corner of the Sky Chart.  Left-click and drag the screen to break the lock.  
 
Objects outside the solar system cannot be locked on. 
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Finding Objects 

You don’t have to locate an object in the Sky Chart to get information about it.  The Find 
command in the Edit menu can locate every object in TheSkyX’s databases.  
 
You can also access it by pressing F, or by clicking the Find button in the Edit toolbar. 
Selecting the Find command displays the Find window, which provides several ways to 
locate any object. 

Finding by Name 

One way to find an object is to enter its name (Aldebaran, Bear Paw) in the Search For 
text input. You can enter the names of comets, minor planets, and auxiliary objects that 
appear in any active Sky Database.  
 
For example, to find the Orion Nebula, type Orion Nebula  
and click the Find button. The Object Information report shows details about the Orion 
Nebula. If the Orion Nebula is within the current field of view, it’s marked with a bull’s 
eye.  
 
You can also search for a star by manually entering its Bayer (Greek-letter) magnitude 
designation, followed by the constellation’s three-letter abbreviation. For example, to 
find the third-brightest star in Orion, type Gamma Ori. Clicking the Find button locates 
that star, Bellatrix. 
 
Great Nebula in Orion   
Gamma Ori  

If You’re Not Sure of the Right Spelling… 

Star names are Greek, Arabic, or Latin. You don’t have to know the correct spelling. The 
Find command shows you matching names. 
 

 
Figure 23: A list of matching names appears as you type. 

 
For example, if you enter ‘Or” the Search For text input shows objects that start with 
these letters. 

The Milky Way and the Magellanic Clouds 

The Milky Way (our galaxy) is displayed as a photograph or draw as a polygon that can 
cover a significant portion of the Sky Chart. Keeping track of its boundaries in all cases 
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would consume too many resources. It was therefore decided not to identify the Milky 
Way when you click inside it. At narrow fields of view, the Milky Way’s boundaries are 
not usually visible and the polygon forms a solid background color. This is potentially 
confusing (”Is that the Milky Way or a nebula?”), so the Milky Way is not displayed at 
fields of view below 20°. 
 
The Magellanic Clouds (the two smaller galaxies “attending” our galaxy) are large, 
complex objects.  The Small Magellanic Cloud is shown as a filled ellipse and is easy to 
spot in the Sky Chart – it’s located at a right ascension of about 1h, not far from the south 
celestial pole.   Type the text ‘Small Magellanic Cloud’ in the Search For text input and 
then click the Find button to locate it. 
 
By default, the Large Magellanic Cloud is not shown as a specific object.  To display the 
region in which it’s located, search for Large Magellanic Cloud.  To have TheSkyX draw 
a polygon that represents this region, select the Large Magellanic Cloud Sky Database in 
the Database Manager window from the Input menu. 

Entering Catalog Numbers with the Mouse 

Because it can be difficult to type keyboard keys in the dark, TheSkyX includes a method 
for entering catalog numbers with the mouse.  
 
On the Advanced Find tab, click the numbers (and the decimal point) on the right to 
enter numerical keys. Clicking Space enters a space. Clicking Back deletes the last 
(rightmost) character in the edit box, regardless of the current location of the text cursor.  
 

Advanced Searches 

Finding by Object Type 

Objects are categorized by type in the Find by Name or Catalog Number list on the 
Advanced tab of the Find window.  
 
A simple way to find any object is to first determine its type (is the object a star, galaxy, 
cluster or other?).  Next, determine what catalog you want to search and then select the 
name of the object from the catalog list. The table below lists each category in the Find 
tree list. 
 

Object Type  Catalog/Cross Reference Description 
Asterisms  Lists the names of many common asterisms. 

 
 

Constellations   Lists the names of the 88 constellations. 
 

Non-stellar 
Objects 

  Lists databases of non-stellar objects. 
 

Caldwell Caldwell Catalog objects. 
 

Common Names Names of common non-stellar objects. 
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Herschel Herschel 400 catalog. 
IC Index Catalog. 
Lorenzin Tomm Lorenzin Catalog. 
Messier Messier Catalog. 
NGC New General Catalogue. 
PGC Principal Catalog of Galaxies.  
PGC cross reference Cross references to the Principal Catalog of Galaxies. 
PLN Planetary Nebulae. 
SAC* Saguaro Astronomy Club Deep Space Object catalog. 

Sky Databases 
(SDBs) 

Additional (non-core) databases  Sky Databases that are loaded from the Sky Database 
Manager command in the Input menu. 

 
Solar System   Objects within our solar system. 

 
Meteor Shower Radiants 
 

Locations of meteor showers. 

Moon Earth’s Moon. 
 

Planets (alphabetical) Earth  
Jupiter 

Mars 
Mercury 
Neptune 

Saturn 
Uranus 
Venus 

 
Satellites Man-made satellites that have been imported from the 

Satellites window on the Input menu. 
 

Small Solar System Bodies Objects that are classified as Small Solar System 
Bodies by the IAU. 

 
Asteroids (Large Database): Names of asteroids that 
have been imported from the Large Database tab on 

the Small Solar System Bodies windows (Input menu). 
 

Asteroids (Small Database): Names of asteroids that 
have been imported from the Small Database tab on 

the Small Solar System Bodies windows (Input menu). 
 

 Comets: Names of comets selected in the Comet tab 
on the Small Solar System Objects dialog (Input 

menu). 
 

Dwarf Planets Pluto 
 

Sun The Sun. 
 

Stellar Objects    Lists databases of stars. 
 

Bayer Bayer catalog designations. 
Common name Common star names. 
DM Bonner Durchmusterung number. 
Flamsteed Flamsteed designations. 
GCVS General Catalog of Variable Stars. 
GSC Guide Star Catalog. 
HD Henry Draper Number. 
NSV Catalog of Variable Stars. 
SAO Smithsonian Astrophysical Observatory. 
Struve Struve Catalog stars. 
WDS Washington Double Star catalog. 
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SAC Cross References 

The Saguaro Astronomy Club Database contains cross references to the astronomical 
catalogs in the table below. 
 
Catalog Name SAC Cross Reference 
Third Cambridge Catalog of Radio Wave Sources 3C  
George Abell (planetary nebulae and galaxy clusters)  Abell 
Aitken Double Star catalog ADS 
Arp-Madore (globular clusters)  AM          
(open clusters)  Antalova    
Apriamasvili (planetary nebulae)  Ap          
Halton Arp (interacting galaxies)  Arp         
Barkhatova (open clusters)  Bark        
Barnard (dark nebulae)  B           
(open clusters)  Basel       
Bonner Durchmusterung (stars)  BD          
Berkeley (open clusters)  Berk        
Bernes (dark nebulae)  Be          
Biurakan (open clusters)  Biur        
(open clusters)  Blanco      
(open clusters)  Bochum      
Cederblad (bright nebulae)  Ced         
Catalog of Galaxies and Clusters of Galaxies CGCG        
Collinder (open clusters)  Cr          
(open clusters)  Czernik     
David Dunlap Observatory (dwarf galaxies)  DDO         
Dolidze (open clusters)  Do          
Dolidze-Dzimselejsvili (open clusters)  DoDz        
Dunlap (Southern objects of all types)  Dun         
European Southern Observatory (Southern objects)  ESO         
Feinstein (open clusters)  Fein        
(open clusters)  Frolov      
(bright nebulae)  Gum         
William Herschel (globular clusters)  H           
(open clusters)  Haffner     
(open clusters)  Harvard     
Havermeyer and Moffat (open clusters)  Hav-Moffat  
Henize (planetary nebulae)  He          
(open clusters)  Hogg        
Holmberg (galaxies)  Ho          
Haute Provence (globular clusters)  HP          
Humason (planetary nebulae)  Hu          
1st and 2nd Index Catalogs to the NGC (All types of objects except dark nebulae)  IC          
Iskudarian (open clusters)  Isk         
Jonckheere (planetary nebulae)  J           
Kohoutek (planetary nebulae)  K           
Father Lucian Kemble (asterisms)  Kemble      
(open clusters)  King        
Krasnogorskaja (planetary nebulae)  Kr          
Lacaille (globular clusters)  Lac         
(open clusters) )  Loden       
Lynds (bright nebula) )  LBN         
Lynds (dark nebulae)  LDN         
Northern Proper Motion, 1st part, Galaxies NPM1G       
(open clusters)  Lynga       
Messier (all types of objects except dark nebula)  M 
Morphological Catalog of Galaxies MCG         
Merrill (plantary nebulae)  Me          
Markarian (open clusters and galaxies)  Mrk         
Melotte (open clusters)  Mel         
Minkowski (planetary nebulae)  M1 thru M4  
New galaxies in the Revised Shapley-Ames Catalog New         
New General Catalogue of Nebulae & Clusters of Stars. (All types of objects except 
dark nebulae) NGC         

http://www.saguaroastro.org/content/db/SAC_DeepSky_Ver80.zip�
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Palomar (globular clusters)  Pal         
Peimbert and Costero (planetary nebulae)  PC          
(open clusters)  Pismis      
Perek & Kohoutek (planetary nebulae)  PK          
Rodgers, Campbell, & Whiteoak (bright nebulae)  RCW         
(open clusters)  Roslund     
Ruprecht (open clusters)  Ru          
Sandqvist (dark nebulae)  Sa          
(open clusters)  Sher        
Sharpless (bright nebulae)  Sh          
Sandqvist & Lindroos (dark nebulae)  SL          
Shapley & Lindsay (clusters in LMC)  SL          
Stephenson (open clusters)  Steph       
(open clusters)  Stock       
Terzan (globular clusters)  Ter         
(open clusters)  Tombaugh    
Tonantzintla (globular clusters)  Ton         
Trumpler (open clusters)  Tr          
Catalog of selected Non-UGC galaxies UA          
Uppsala General Catalog (galaxies)  UGC 
United Kingdom Schmidt (globular clusters)  UKS  
(open clusters)  Upgren 
Vorontsov-Velyaminov (interacting galaxies)  VV 
van den Bergh (open clusters, bright nebulae)  vdB  
van den Bergh & Herbst (bright nebulae)  vdBH 
van den Bergh-Hagen (open clusters)  vdB-Ha 
Vyssotsky (planetary nebulae)  Vy  
(open clusters) Waterloo  
Double Star (Messier 40)  Winnecke 
Zwicky (galaxies)  ZWG 
 
To locate objects in the SAC, in the Search For text input on the Find window, enter 
SAC SAC <Cross Reference> <Catalog Number> and then click the Find button. 
 
For example, entering the text SAC Cr 33 locates an open cluster from the Collinder 
catalog. 

Finding by Catalog Designation 

Another way to find an object is to enter its catalog designation.  Leading zeroes are not 
required; the search routine automatically adds them.  Typing just the catalog 
abbreviation (with no number) lists the first 10 items in the catalog. 
 
The Tycho catalog’s designers indexed it with the corresponding GSC numbers. We have 
therefore not included it as a searchable catalog.  

Searching Other Catalogs 

Other catalog designations can be used to find objects. The table below lists the available 
catalogs and their prefixes, along with the number of galaxies in the catalog (Count) and 
an example of the correct format. Catalog numbers requiring leading zeroes are noted in 
the Comments. 
 
In some cases, the name of the catalog is not known. These entries are marked with a 
dash (–). 
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Catalog 
 

Prefix Count Example Comments 
 

— 1SZ 26 1SZ 39 Numbering is not 
contiguous. 

— 2SZ 32 2SZ 4  
Zwicky1 1ZW 238 1ZW 1  
Zwicky2 2ZW 199 2ZW 1  
Zwicky3 3ZW 158 3ZW 1  
Zwicky4 4ZW 203 4ZW 1  
Zwicky5 5ZW 531 5ZW 1  
Zwicky6 6ZW 238 6ZW 1  
Zwicky7 7ZW 1145 7ZW 1  
Zwicky8 8ZW 645 8ZW 1  
Arakelian Catalog of Galaxies ARAK 595 ARAK 38  
— ARP 560 ARP 70  
Catalog of Galaxies and Clusters of 
Galaxies 

CGCG 29809 CGCG 502-64  

David Dunlap Observatory Catalog 
of Galaxies 

DDO 242 DDO 11  

– ESO 16239 ESO 152-5  
Fairall Catalog of Galaxies  FAIR  1185  FAIR 700  
Infrared Astronomical Survey IRAS  9347  IRAS 01293-2548 5-digit prefix must be 

padded with zeros. 
Karachentseva Catalog 
of Galaxies  

KARA  183  KARA 4  

Kazaryan UV Galaxies  
 

KAZ  581  KAZ 9  

Kiso UV Galaxies  KUG  5455 KUG 0001+311  4-digit prefix must be 
padded with zeros. 

– 
 

LGS  5  LGS 4  

Second Byurakay Survey  SBS  259  SBS 1209+550  
Tololo Galaxies  
 

TOL  111  TOL 29  

Uppsala General Catalog 
of Galaxies  
 

UGC  13073  UGC 8100  

University of Michigan 
Catalog of Galaxies  
 

UM  652  UM 533  

– 
 

VV  1161  VV 222  

Virgo Cluster Catalog 
of Galaxies  

VCC  2097  VCC 3  

Weinberger Catalog 
of Galaxies  
 

WEIN  207  WEIN 1  
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More Find Examples 

The following tables show a variety of useful search queries for the Locate By Name text 
box. 
 
Stars  Type of query  
Polaris  Common star name.  
SAO 308  Smithsonian Astrophysical Observatory star. 
GSC 4628:237  Guide Star Catalog number. 
HIP 11767  Hipparcos identifier.  
PPM 431  Positions and Proper Motions (PPM) number.  
HD 8890  Henry Draper number.  
B+88 8  Bonner Durchmusterung catalog.  
C-34 12784  Cordoba Durchmusterung catalog. 
P-42 7856  Cape Durchmusterung catalog. 

  
Flamsteed/Bayer (use constellation 
abbreviation)  

Type of query 

ALPHA UMI  (Alpha Ursae Minoris)  
25 PSI 1 ORI  25 Psi 1 Orionis  
  
Non-stellar Objects Type of query 
Great Nebula in Andromeda Common non-stellar object name. 
M31 M31 Messier 
NGC 224 NGC (New General Catalog) 
IC 434 Index Catalog 
PGC 18508 Principal Galaxies Catalog 
GCVS GK ORI General Catalog of Variable Stars 
NSV New Suspected Variable catalog 
PLN 194+2.1 Planetary Nebula 
  
Solar System Objects  Type of query 
Saturn  Finds Saturn  
Wild 4  Finds the comet named "Wild 4"  
Ceres  Finds small database asteroid named "1 Ceres"  
MPL 835 OLIVIA  "MPL" prefix finds that asteroid (or minor planet) named "835 Olivia" from 

the large asteroid database.  
  
Uranometria Star Charts  Result 
URA 36  Centers on Uranometria star chart number 36  
URA 36+  Centers on Uranometria star chart number 36 and sets Uranometria-like 

chart attributes.  
 
Satellites  Result  
SAT COSMOS 100  Searches for the satellite named "Cosmos 100".  
 
Miscellaneous Objects  Result  
Zenith Moves to 90 degrees altitude.  
AAVSO A  Sets field width to AAVSO type A (accepts a-g).  
12.3, 13.4  Moves to RA 12.3 and Dec 13.4  
Z2.5  Zooms to 2.5 degree field of view.  
Z2.5m  Zooms to 2.5 minute field of view.  
Z200s  Zooms to 200 arcsecond field of view.  
SCALE 2.5  Sets the screen scale to 2.5 arcseconds/pixel. 
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Labeling Objects 

 
Figure 24: Common star, Bayer and Flamsteed designation labels near the Pleiades Nebula (M45). 

 
The first time TheSkyX runs, the common names for the planets are shown.   To show the 
names of other objects, select the Labels command from the Display menu to turn on the 
Labels window or click the Labels tab to make it visible. 
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Figure 25: The Labels window (Display > Labels command). 

The Labels window allows you to show or hide the names of the following common 
objects. 
 

• Asterisms 
• Asteroids (Name, Magnitude and Number)  
• Comets 
• Common Star Names 
• Bayer Designation 
• Flamsteed Designation 
• Common Non-stellar Object Names 
• Constellations 
• Cardinal Directions 
• Messier Objects 
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• Meteor Shower Radiants 
• Planets, Dwarf Planets, Moons and the Sun 
• Artificial Satellites (Name, Range and Latitude/Longitude Position)  

 
Turn on the checkbox next to the desired common label to show it.  Turn off the 
checkbox to hide the label. 
 
The astronomical catalogs used by TheSkyX also contain catalog-specific information that 
might be useful to show on the sky chart.  Detailed labels can also be shown for star and 
non-stellar catalogs and custom Sky Databases (SDBs). 
 
For example, if you’re working with double stars, you can show a detailed label that 
contains the magnitude and angular separation between star systems in Washington 
Catalog of Double stars by expanding WDS in Stellar Objects section under Detailed 
Labels.   
 
Or, if you’re researching galaxies in the New General Catalogue (NGC), you might want 
to show a detailed label that includes blue magnitude and equatorial coordinates 
(Detailed Labels > Non-stellar Objects > NGC Identifier group).    
 
Important Note:  Detailed labels are shown on the Sky Chart at 60° fields of view and 
smaller. 

Showing Labels (Show Labels) 

This checkbox shows or hides the check marked labels.  

Finding a Specific Label (Locate a Label by Name) 

Use this text input to quickly locate (and turn on or off) a particular common name or 
detailed label in the labels tree.  For example, to turn on satellite labels, type “s”; the 
labels that begin with this letter appear in the pop-up menu.  Select Satellites to expand 
the labels list and show the Satellites checkbox.  Pressing the TAB key highlights the 
checkbox. 

Turning Labels Off (Turn Off All Labels) 

Press this button to turn off the Show Labels checkbox and turn off every checkbox in the 
labels list. 

Label Density (Number of Labels on Chart) 

Adjust this slider to change the total number of labels that will appear on the Sky Chart. 

Anti-aliased Labels (Enable Smooth Moving Labels)  

The font used to display labels can be “anti-aliased” that the motion of the label (as the 
chart is updated, or, particularly during time skip animations or viewing tours) is smooth.  
When this option is turned off, you might notice a slight “jerky motion” of fonts during 
animations. 
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Tours 
Before we investigate the various menu and “button” commands arranged across the top 
of the screen, let’s explore some of the tours that have been created to help you 
appreciate several of the most common yet fascinating things you can see in the sky. 
 
Notice the series of tabs running vertically on the right side of the main.  Select the tab 
labeled Tours.  If this window is not visible, click the Tours command from the Display 
menu to show it.  A list of available tours is displayed: 
 

• Analemma 
• Angular size of Mars 
• Coordinates - Equatorial 
• Coordinates - Horizon 
• Mercury evening visibility 
• Mercury morning visibility 
• Moon cycle - size and phase 
• Motion of Barnard’s Star 
• 24-Hour Motion of Saturn’s Moons 
• Rotation and Phase of Mercury 2008 
• Rotation and Phase of Venus 2008 
• Saturn from Earth Over 10 Years 
• Venus and Mercury Paths 
• What Was That? (Iridium Flare Example)  
• Winter Constellations 

 
Go ahead and take one of the tours.  Highlight one that sounds interesting, then click the 
Start button. Or, click the Run All button to watch them consecutively. 

Creating Tours 

 
TheSkyX Professional Edition provides a powerful interface that can be used create tours 
that simulate astronomical events, highlight  interesting objects, or demonstrate 
astronomical concepts.   
 
A tour is based on a timeline that can be as long or as short as you want.  Any number of 
waypoints can added to the timeline at which you can “show something” (for example, 
turn on the constellation lines) or “do something” (for example, perform a 100-year time 
skip simulation) by executing a macro command.  One, or any number macro commands 
can be executed at each waypoint, providing a virtually unlimited set of tools to create 
educational demonstrations.  Tours can be saved later in QuickTime movie format. 
 
To get started, let’s look at one of the supplied tours.  
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1. Highlight the Winter Constellations tour on the Tours window.  Click the Tours 
command from the Display menu to show this window if necessary.  This 
displays the Tour Information tab. 

 

 
Figure 26: Tour Information tab on the Create Tour dialog. 

2. Enter the title of the tour in the Title on Sky Chart text input.  The title appears on 
the bottom of the Sky Chart while the tour is running. 

3. Enter a Tour Description as plain text or native HTML.  This description appears 
on the Tours window when the tour name is highlighted. 

4. To play a sound at the beginning of the tour, click the Choose button and select 
the file.  Turn on the Loop Continuously checkbox to play the tour repeatedly. 

5. Click the Timeline tab.  
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Figure 27: The Timeline tab. 

The green line on the timeline graphic indicates the length of the tour, in seconds.  
A red arrow on the top of the timeline represents the position of a waypoint.   
 
The Winter Constellations tour is 30 seconds long.  Click the + button to expand 
the timeline, or the – button to shorten it.  This tour also includes ten different 
waypoints (indicated by a red pointer on the top of the timeline).  Each waypoint 
represents a point of transition in the tour.   
 
Dragging the gray tour time pointer (positioned at 0 seconds in Figure 27) lets 
you advance to a specific point in time in the tour.  Defining a new waypoint is 
easy, just drag the tour time pointer to the desired time and then click the Add 
Waypoint button.  When the tour time pointer is positioned beneath a waypoint, 
the button text Reset Waypoint appears instead.  
 

6. Drag the time pointer to 0 seconds or click the Rewind button to go to the 
beginning of the tour.  The Macro Commands at Waypoint text input now shows 
the four macros that will be run when the tour begins: 

 
Macro Explanation 
SetConstlLine( "*", 0 ); 

 
Show or hide constellation lines. 
 
• Argument 1 is either constellation’s 

abbreviation in quotation marks (“Ori”), 
or an asterisk in quotes “*” to indicate 
all constellation lines. 

• Argument 2 defines how to show the 
constellation lines.  A 1 means to turn on 
the constellation(s), a 0 turns them off. 
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SetConstlBoundary( "*", 0 ); Show or hide constellation boundary lines. 

 
• Argument 1 is either constellation’s 

abbreviation in quotation marks (“Ori”), 
or an asterisk in quotes “*” to indicate 
all constellation boundary lines. 

• Argument 2 defines how to show the 
constellation lines.  A 1 means to turn on 
the constellation boundary lines on, a 0 
turns them off. 

 
SetConstlLabel( "*", 0 ); Show or hide constellation labels. 

 
• Argument 1 is either constellation’s 

abbreviation in quotation marks (“Ori”), 
or an asterisk in quotes “*” to indicate 
all constellation lines. 

• Argument 2 defines how to show the 
constellation labels.  A 1 means to turn 
on the constellation label(s) on, a 0 turns 
them off. 

 
SetConstlDrawing( "*", 0 ); 
 

Show or hide constellation drawings. 
 
• Argument 1 is either constellation’s 

abbreviation in quotation marks (“Ori”), 
or an asterisk in quotes “*” to indicate 
all constellation lines. 

• Argument 2 defines how to show the 
constellation labels.  A 1 means to turn 
on the constellation drawing(s) on, a 0 
turns them off. 

 
 
See “Appendix D: Macro Commands” on page 277 for a complete list of 
available macro commands. 
 

7. Drag the time pointer under each red arrow to reveal the macro commands for that 
waypoint.   

8. Click the Rewind button, then the Start button to watch the entire tour. 

Adjust Timeline Pop-up Menu 

Use the commands in the Adjust Timeline pop-up menu to add or remove time from the 
tour. 
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• Scale Time to Pointer adjusts the length of the tour based on the current position 
of the time slider. 

• Remove Before Pointer resets the start of the tour to the current position of the 
time slider and removes all waypoints before this position. 

• Remove After Pointer resets the end of the tour to the current position of the time 
slider and removes all waypoints after this position. 

• Mirror creates a mirror image of the timeline and waypoints. 

Clear Button 

Click this button to remove all text from the Macro Commands at Waypoint text input. 

Record 

When the Record checkbox is turned on, the macro commands necessary to perform a 
action are displayed as you perform them.  For example, clicking Display > Horizon & 
Atmosphere Options and turning off the Show Horizon checkbox shows: 
 
SetVisible(“Horizon”, 0); 
 
Note that you can access any of TheSkyX’s celestial object types in macro arguments by 
name.  For example, instead of “Horizon” as argument 1, you can turn the meridian line 
on or off by using the text “Meridian” as the first argument instead.  See “Customizing 
Chart Elements” on page 136 and the Chart Elements window for the complete list of 
permitted object type names. 

New Tour 

Click this button to start a new tour.  

Start  

Begins the tour from the current time slider position. 

Rewind 

Resets the time slider to the beginning of the tour. 

Create Movies 

Once your tour is complete, you can create a QuickTime™ movie from the Create Movie 
tab.  Windows users will have to install QuickTime (available free from Apple’s web 
site) to use this feature. 
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Figure 28: Create Movie tab. 

Movie File Name 

Displays the file name of the movie that will be created.  Click the Save As button to 
specify a different file name. 

Save As Button 

Click this button to enter the name of the movie. 

Options 

The resolution and frame rate of the movie is configurable to your audience. 

Movie Size (Pixels) 

Select the resolution of movie from the Movie Size list.   
• 320x240 (iPod Classic) 
• 640x480 (Desktop) 
• 480x272 (PSP) Sony PlayStation Portable™ format 
• 480x320 (iPhone/iPod Touch) 
• 800x600 

Frames Per Second 

Select the number of frames, or frequency to capture the Sky Chart when creating the 
movie.  The higher the frames per second, the better the quality at the expense of a larger 
movie file. 
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High Quality  

Turn this radio button on to configure high quality QuickTime movie settings. 

Create Movie 

Click this button to create the movie.  The length of time it takes create the movie 
depends on the length of the tour, the resolution and frame rate settings, as well as the 
speed of your computer. 

Photos from the Deep Sky 
Since the middle of the 19th century astronomers have been taking pictures of the sky.  In 
recent years, digital imaging sensors have replaced film to capture even more remarkable 
views of the Moon and planets, as well as star clusters, nebulas, and galaxies.  Relatively 
modest amateur telescopes, equipped with digital cameras, can capture images that rival 
the best photographs taken by professional observatories just a couple of decades ago. 
 
TheSkyX has a veritable art gallery’s worth of fantastic space images you can look at 
anytime.  Browsing these images will give you a taste of the extraordinarily diverse 
number of objects that populate the night sky. 

Viewing Astronomical Photos 

In the stacked windows, you’ll see a tab called Photos.  Select it.  (Select the Photos 
command from the Display menu to show this window if necessary.) 
 
In the dialog that opens, you’ll see two items, Photo Groups, and NGC/IC Digitized Sky 
Survey Photos.  NGC/IC stands for New General Catalogue/Index Catalog.  These are 
two of the most popular catalogs astronomers use to keep track of the huge number of 
celestial objects they’ve been studying over the centuries.   
 
As you scroll through the list of objects, a small picture of each will be displayed below 
the list.  Click the Show in Photo Viewer option to view them in a separate window. 

Placing Photos 

 
TheSkyX Professional Edition’s Place Photo command lets you create and manage 
individual or groups of photographs and provides tools to precisely position each 
photograph on the Sky Chart.  In short, there’s everything you need to show off your “in-
place” photos. 
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Figure 29: Sky Chart showing in-place photo of the Great Nebula in Orion (M42). 

The Bevis constellation drawings are one example of one Photo Overlay Group that is 
included with TheSkyX. The Deep Sky Overlays is another. 

Creating a Photo Group 

To create a photo group from your collection, start by copying all the photos to a single 
folder on your computer.  Note that TheSkyX can show GIF, JPG, TIFF and PNG file 
formats.  The PNG format works well since it can have a transparency layer and is 
compressed. 
 
We’ll use the Messier Overlay photos as a “collection” to demonstrate how to create a 
photo group.  On the Mac, TheSkyX’s resources are stored inside the application bundle, 
so these photos are not readily accessible or visible from Finder.  If you are familiar with 
accessing files in an application bundle, you’ll find the files in this example in the 
Resources/Common/Photos/SDBs/Messier Overlays folder.  If you’d like to follow along, 
you can make a copy of these files in a folder on your desktop.  On Windows, these files 
are located, by default, in the following folder: 
 
C:\Program Files\Software Bisque\TheSkyX <Edition Name Here>\ Resources/Common/Photos/SDBs/Messier 
Overlays 
 
Where <Edition Name Here> is either TheSkyX Serious Astronomer Edition or TheSkyX 
Professional Edition. 
 

1. To avoid confusion, first turn off the existing Messier Overlays Photo Group by 
clicking the Database Manager command from the Input menu, and turning off 
the checkbox next to Messier Overlays in the Photo Databases node under Sky 
Databases, then click Close. 
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2. Select the Place Photo command from the Input menu to show the Place Photo 
window. 

 

 
Figure 30: Photo Group tab on the Place Photo window (Input menu). 

3. On the Photo Group tab, click the Choose Folder button and navigate to the 
folder that holds your collection of photos then click the Choose button. 

4. Your photos appear in the Photo List.  The name of the photo group text file, 
which stores the photo group information, is listed in the Editing Photo Overlay 
File text input box. 

5. To overlay and place a single photo in the list on the Sky Chart, highlight its 
name.  A preview of the photo appears on the Photo Group tab.   

6. Click the Place Photo tab.  The selected photo is centered on the Sky Chart.  
From here, you need to adjust the Sky Chart’s center coordinates, field width and 
rotation to align the photo. 

 

 
Figure 31: Edit Place Placement tab on the Place Photo window. 
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7. The Edit Photo Placement tab has tools to move left, right, up, down, zoom in, 
out and rotate the Sky Chart so that the photo can be aligned with the Sky Chart.  
Click the Edit Photo Placement button to begin this process.  The Show Digitized 
Sky Survey Photos checkbox allows you to show these photos as another frame of 
reference to help align your photo.  Once you are satisfied with the position of the 
photo, click the Save Placement Changes button to save it.  Click the Cancel Edit 
button to abort the process and not save changes.  

8. Repeat steps 5-7 for each photo in the Photo List. 

Placement Information 

Click on the Placement Information tab to show the equinox 2000.0 RA/Dec coordinates 
of the photo, as well as the photo’s Scale, in arcseconds/pixel and Position Angle, in 
degrees. 

Managing Photo Databases 

Click the Database Manager command on the Input menu to show the Database 
Manger window.  Next, expand the Photo Databases branch of the Sky Databases node 
in the Databases tree to show the available photo overlays. 
 

 
Figure 32: Photo Databases in the Database Manager. 

Viewing Photos from the Digitized Sky Survey 

 
TheSkyX Professional Edition can overlay photos from the Digitized Sky Survey (DSS) 
on the Sky Chart (see Figure 94) or retrieve the equivalent FITS image for any position 
on the celestial sphere and for any field of view up to 2° x 2°.  This “all-sky photographic 
reference” can be extremely useful when searching for new objects such as supernovas or 
asteroids. 
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Overlaying Digitized Sky Survey Photos on the Sky Chart 

1. Adjust the Sky Chart to the desired position and field of view.  For example, 
frame the spiral galaxy M81 by selecting the Find command from the Edit menu, 
entering M81 in the Search For text input, and then clicking the Frame button.  
You should now see the color photo of M81 on the Sky Chart.   

2. For convenience, select the Celestial Sphere command from the Orientation 
menu.  This command fixes the equatorial center of the Sky Chart to the center of 
the window with the north celestial pole “up” on the screen.   

3. Select the Digitized Sky Survey command from the Tools menu. 
 

 
Figure 33: Setup tab of the Digitized Sky Survey window. 

4. From the Setup tab, select the Web option (internet connection required).  If you 
own the TheSkyX Pro Database Add On (page 266), select the Disc Drive, Folder 
or Volume option, click the Choose button to specify the location of the Digitized 
Sky Survey data, then select the Palomar Sky Survey (10x) option. 

5. Click the Create Photo tab. 
6. Click the Fill Sky Chart button.  The photo is retrieved from the selected source. 
7. Click the Show Photo in Front of Chart Elements option to show the photo on 

top of everything else on the Sky Chart. 

Creating a FITS File of a Digitized Sky Survey Photo 

1. Follow steps 1-5 above. 
2. Click the Create button.  The FITS file is retrieved from the selected source and 

displayed in the FITS Viewer window. 
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Figure 34: M81 in the FITS Viewer window. 

 

Viewing FITS Photos 

 
TheSkyX Professional Edition uses the High Energy Astrophysics Science Archive 
Research Center’s (HEASARC) CFITSIO software library to manage FITS files.  It is the 
“standard” library that handles the all complexities of different FITS file formats so that 
your FITS (provided it adheres to the FITS standard) will be opened and displayed 
correctly. 

Opening a FITS  

1. Click the Open FITS command from the Tools menu. 
2. Navigate to the location of the FITS file, select it and then click Open.   
3. The FITS photo is now displayed on the FITS Viewer window. 

 

FITS Viewer Window 

The FITS Viewer window contains basic image manipulation commands and shows a 
table with the FITS header information.  Software Bisque plans to implement a more 
robust feature set in future versions.  

Photo Pop-Up Menu 

The following commands are available from the Photo pop-up menu. 
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Open 

Opens a FITS and displays it on the FITS Viewer window.  Note that the FITS file must 
use the extension FIT or FTS to be recognized as a FITS on the Mac. 

Save 

Saves the FITS file using its current file name. 

Save As 

Saves the FITS file using the file name you specify. 

Print 

Prints the FITS file to the default printer. 

File Information 

This command shows the FITS Information tab that displays a table containing the FITS 
header information.  Search the web for the Flexible Image Transport System 
specification for details about FITS headers and keywords. 
 

 
Figure 35: The FITS Header Information tab on the FITS Viewer window. 
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Zoom In/Zoom Out 

These commands can be used to change the scale of the displayed photo by zooming in or 
out. 

Fit To Window 

This is the default photo option that scales the photo to match the size of the FITS 
Viewer window. 

Clear  

Click this command to close the FITS image. 

To Image Link 

Select this command to copy the displayed photo to the Image Link window.  See 
“Image Link and Automated Astrometry” on page 185 for details. 

Close  

Click this command to close the FITS Viewer window. 
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Your Sky Tonight 
This section is intended to help you explore the night sky from your location on any date, 
at any time.  You’ll be able to answer the question: “When I head outside tonight at, say, 
9 p.m., what am I going to be able to see?”  You’ll also learn how to plan ahead for 
special events, like meteor showers and lunar eclipses. 
 
For a given location, what you can see in the sky on any given night depends on the date 
and time.  The stars that are visible at 9 p.m. on a December night are very different from 
the ones you would see at 9 p.m. in June, for example.  And the Moon and planets follow 
their own unique celestial paths – their positions, and their brightness, vary from month 
to month and year to year. 

Observing Lists 

TheSkyX includes a command that will display a select list of objects that will be visible 
in your night sky on the current date.  You can set the parameters of this list to choose the 
kinds of objects you’re most interested in seeing. 
 
To generate a What’s Up Observing List: 
 

1. Go to the Tools menu. 
2. Select the Manage Observing List command. 
3. Click the What’s Up Setup tab. 
4. Select the Viewing Time for the list. 
5. Select the Optical Aid that you will be using. 
6. Click the What’s Up? button. 
7. Click the Close button. 

 
Clicking the What’s Up? button creates and shows the list of objects that are visible from 
your location in tonight’s sky on the Observing List window.  When you highlight an 
item, observing notes are displayed.   
 
Some of these objects, and the data displayed with them, may be unfamiliar to you.  
We’ll be describing most of the information in the What’s Up? command in more detail 
on page 172. 

Field of View Indicators 

A Field of View Indicator  (FOVI) is an on-screen element that represents the field of 
view that is rendered by an eyepiece, CCD sensor, camera body and optical tube, or a 
Telrad™ finder, binoculars or other optical system.  As you zoom in or out in the Sky 
Chart, the FOVIs shrink or grow in proportion to the field of view.  The utility to this 
feature is endless, particularly helpful during observing sessions and with telescope 
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control.  Easy, quick identification of celestial objects can be made when you view the 
Sky Chart as if you were looking through the eyepiece: no guesswork required! 

Choosing Your Telescope and Eyepieces 

Select the Field of View Indicators from the Display menu to open the Field of View 
Indicators dialog.   
 

 
Figure 36: Field of View Indicators dialog. 

 
To the left, you will see the equipment database list, including selections for Telescopes, 
Eyepieces, and Detectors.  To select a telescope, expand the Telescopes portion of the 
tree.  You will see a large selection of telescope makers.  Expanding a telescope maker’s 
menu will produce a list of telescope models by that manufacturer.  Choose your 
telescope from the list.  Once you have selected your telescope, click the green arrow 
button found in the middle of the window.  You will then see the telescope listed on the 
My Equipment list to the right of the window. 
 
Now, choose your eyepiece and/or detector from the appropriate menu from the left side 
Equipment Database.   
 
Once you have chosen your telescope, eyepieces, and detectors, click the Create my 
FOVIs button.  You will then be taken to the My FOVIs tab, where each FOVI will 
appear in a list with a checkbox to toggle each FOVI on or off.   
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Figure 37: My FOVIs tab. 

Selecting a FOVI and clicking the Edit button will show the Add/Edit Equipment dialog 
where you can edit each element and aspect of the telescope and eyepiece or detector 
combination (page 69). 
 
Clicking the Quick Add button also opens the Add/Edit Equipment dialog, in which you 
can add a FOVI with characteristics of your choosing.  Just input the desired Shape, 
Reference Frame, and Width and Height in arcminutes, and you’ve added a brand new 
FOVI of custom dimension. 
 
Clicking Remove will remove a FOVI from the list.  Clicking Center will center the 
FOVI on the screen. 
 
Checking the Preview checkbox will reveal a preview of each selected FOVI in the Sky 
Chart.  When the Preview checkbox is turned on, the currently selected FOVI is centered 
on the Sky Chart.  This lets you quickly determine which optical system is best for your 
needs.   
 
Note that if you turn on both the Preview checkbox and the checkbox next to a FOVI, 
two identical FOVIs will appear on the Sky Chart (the “preview” FOVI and the actual 
FOVI).  To avoid confusion, make sure to turn off the Preview checkbox before closing 
this window. 
 
Note:  Remember that FOVIs represent the view through your telescope, and will not 
appear on the Sky Chart if the chart’s field of view is set to 100° (naked eye) or more.  To 
see the indicators, you must zoom to a smaller field of view. 
 
The My FOVI tab shows the following information for each field of view indicator. 

Description 

The FOVI description is the combination of the telescope and the eyepiece or detector 
description.  To change a description, highlight the FOVI in the list and click the Edit 
button. 
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Size  

The size column shows the angular dimensions of the FOVI, in arcminutes.   

Scale/Magnification 

For telescope and camera FOVIs, the scale or image scale, in arcseconds per pixel is 
displayed.  The optical system’s magnification is displayed when the FOVI consists of a 
telescope and eyepiece. 

Type 

The Type column shows either Eyepiece for eyepiece plus telescope combinations, or 
CCD for a camera plus telescope FOVI. 
 

Reference Frame 

This column shows the frame of reference to use when displaying the FOVI.  See “FOVI 
Frame of Reference (Reference Frame List)” on page 70 for details about reference frame 
options. 

Showing Telrad Finders 

Telrad™ finder FOVIs are shown at all fields of view (but may not be completely visible 
at small fields) and can be added to the Sky Chart using the My Chart Elements 
command on the Input menu. 

To Add one or more Telrad Finder FOVIs to the Sky Chart: 
1. Click Input > My Chart Elements.  
2. On the Manage tab, click the Add Telrad button.  
3. Under Command+Click (Mac) or Ctrl+Click (Windows), select Cursor Position 

in the Snap To pop-up menu.  
4. Position the mouse cursor over the Sky Chart, press and hold the  key on the 

Mac or the CTRL key on Windows, then click the left mouse button.  A new 
Telrad finder is drawn at the current cursor position.  
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Figure 38: Sky Chart showing multiple Telrad finders. 

To position a Telrad finder at a specific coordinate: 
1. From the Manage tab on the My Chart Elements window, highlight the Telrad 

you want to move in the My Chart Element list by clicking on it or click on the 
center of the Telrad Finder on the Sky Chart.  A selected Telrad finder appears as 
My Chart Element # in the Object Information Report on the Find window. 

2. Click the Edit button (or double-click on the element) to show the Add/Edit Chart 
Element window. 

3. To enter equatorial coordinates, click the Equatorial radio button then enter the 
right ascension (RA) in hours, minutes and seconds and declination (Dec) in 
degrees, minutes and seconds.  

 
To enter horizon coordinates, click the Horizon radio button then enter the azimuth 
(Azm) in hours, minutes and seconds and altitude (Alt) in degrees, minutes and seconds. 
 
To Drag and Move a Telrad Finder: 
 

1. From the Manage tab on the My Chart Elements window, select the Telrad you 
want to move in the My Chart Element list, or click on the center of the Telrad 
Finder on the Sky Chart.  A selected Telrad finder appears as My Chart Element 
# in the Object Information Report on the Find window. 

2. Click and drag the small red rectangle in the center of the Telrad finder to move 
it. 

3. Release the mouse when the Telrad is positioned where you want it. 

Adding or Editing Field of View Indicator Properties 

Clicking the Edit button or the Quick Add button on the My FOVIs tab (Field of View 
Indicators dialog) shows the Add/Edit Equipment dialog.  This window lets you define 
up to twenty different FOVI elements.  
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Figure 39: The Add/Edit Equipment dialog (clicking the Edit button). 

Field of View Indicator Description (Description) 

Enter a description for your detector, such as Super CCD with 10 Detectors. 

Element Number List 

Up to 20 separate FOVI elements can be defined for each FOVI.  For example, if your 
camera has a built-in autoguider, then the FOVI will have two different elements, one for 
the imaging detector and one for the autoguider. 

Element Description (Description) 

Enter a text description for the element, such as “ST-237 guider mounted to my guide 
scope”. 

Shape 

Specify the shape of the element. An element can be:  
• Circular (or elliptical) 
• Rectangular 
• Marker (a small cross offset from the main FOVI) 

Position Angle 

Enter the position angle, measured counterclockwise from North, of the FOVI element. 

FOVI Frame of Reference (Reference Frame List) 

Select the frame of reference for the detector or detector/telescope combination. 
• Screen: The FOVI will remain fixed at on the computer screen. 
• Equatorial: The FOVI will remain fixed at a specific equatorial coordinate. 
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• Telescope: The FOVI will be included as part of the telescope cross hairs at 
smaller fields of view. 

• Telescope Mask: Use this option to simulate the view through a telescope with 
this field of view indicator.   

 

 
Figure 40: Sky Chart showing a telescope mask FOVI. 

Size, X/Y 

Enter the physical size of the detector, in mm. 

Offset, X/Y 

Enter the offset of the element from the Element Number 1, in mm. 

Pixels, X/Y 

For CCD cameras, enter the number of pixels in each axis. This value is used to compute 
the scale of images acquired with the camera, in arcseconds/pixel. 

East/West offset 

Specify the number of arcminutes to shift the center of the FOVI to the East or West.  A 
number greater than zero shifts the FOVI West, a negative number shifts it East. 

North/South Offset 

Specify the number of arcminutes to shift the center of the FOVI to the North or South.  
A number greater than zero shifts the FOVI South, a negative number shifts it North. 
 
Clicking the Quick Add button shows slightly different options. 
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Figure 41: The Add/Edit Equipment dialog (clicking the Quick Add button). 

Enter the FOVI’s Description, Shape and Reference Frame (described above) and the 
Width and Height, in arcminutes.  

FOVIs and the Sky Chart 

FOVIs that are displayed on the Sky Chart are configurable and customizable. They can 
be:  

• Clicked and dragged to any part of the screen 
• Copied and “pinned” to a specific equatorial (RA/Dec) coordinate 
• Rotated to any angle 
• Used as the telescope cross hairs 
• Used to create a telescope mask 

How to Position a FOVI on the Sky Chart 

1. Select the FOVI on the Sky Chart by clicking on it, or click on the center 
marker (if the FOVI has a visible center marker). Two small reddish squares, 
and the position angle, appear when the FOVI is selected.  The center square 
can be dragged to move the FOVI; drag the outer square to change the 
position angle. 
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Figure 42: Clicking on a FOVI shows the position angle, and rectangles to position and orient it.  

How to Use a FOVI as the Telescope Cross Hair 

1. Click the Field of View Indicators command from the Display menu. 
2. Click on the My FOVIs tab. 
3. Highlight the FOVI that you want use as the telescope cross hair. 
4. Click the Edit button. 
5. On the Add/Edit Equipment dialog, select Telescope from the Reference Frame 

list. 
6. Click OK. 

 
When the Sky Chart’s field of view is small enough to resolve the FOVI, and the 
telescope is connected, the telescope’s cross hair will include the FOVI, too. 

Object Paths 

Sometimes the best way to say something is with a picture.  This is certainly true with a 
complex concept like planetary motion.  Tracing out motion paths of solar system objects 
is the perfect way to demonstrate their motion and to plan for upcoming observation 
sessions.  TheSkyX allows you to do so with ease and flexibility. 
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Generating An Object Path 

Selecting the Object Paths command from the Tools menu will bring up the Object Paths 
dialog.  In it, you will see a list of solar system objects, along with various drop-down 
menus and buttons that control the various object path functions.  On the left, you will see 
a list of solar system objects: the eight classical planets, plus Pluto, the Sun, Moon, 
comets, and asteroids.  On the right, you will see information pertaining to the path that 
TheSkyX is currently set to create, including the number of items selected, the chosen 
time increment, the count of time increments, and the path style. 
 
To get our feet wet, let’s try out the object path tool on an observer’s favorite, the planet 
Mars. 
 
Note: This process works the same way with any object.  If Mars is not in your sky right 
now, you can always choose another object, or adjust your Sky Chart to the next time 
Mars is visible. 
 

1. Choose Object Paths from the Tools menu. 
2. From the Select Solar System Object list, select Mars. 
3. Looking over to the right side of the window, you will now see that Items 

Selected now says 1. 
4. By default, TheSkyX sets the time increment to 1 day, which is changeable by 

using the pop-up  menu.  Let’s leave it at 1 day for now.   
5. The Count is set at 30 by default, which means that the system will calculate a 

path for 30 of the chosen time increments.  In this case it is 30 days. 
6. The Path Style may be changed from a connected line to a dotted line, each 

with various point styles.  Experimenting with this feature will allow you to 
best decide which option is right for you. 

7. Then, click the Create Path button, and a new path appears in the Sky Chart, 
revealing the path taken by Mars starting with the current system time and 
ending in the next 30 days. 

 
In this example, the generated path shows the position of Mars in the sky each day at the 
same time.  So, if the clock is set at 12:00 a.m. when you generate the path, it will show 
the position of Mars each day at 12:00 a.m. 
 
 
Clicking the Show button in the Object Paths window will zoom in and center the path in 
the Sky Chart. 
 
What if you would like to see the path that an object takes through the sky during a single 
day?  TheSkyX makes that easy, as well.  Using Mars as our example again, following 
these easy steps will lead you to success. 
 

1. Select Object Paths from the Tools menu. 
2. Choose Mars from the Select Solar System Objects list. 
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3. Ensuring that the Create Paths button is highlighted on the right, change the 
time increment to 1 hour. 

4. Change the frequency to 24 by either typing it into the field or by using the 
field’s arrow  buttons. 

5. Select the path style that is best for you. 
6. Click Create Path. 

 
You will now see a path on the Sky Chart reflecting Mars’ motion through the sky over 
the next 24 hours. 
 
Remember, clicking the Show button in the Object Paths window will zoom in and 
center the path in the Sky Chart. 
 
Once you get the hang of the example path, try out several different paths, changing the 
variables to achieve different effects. 

Updating Object Paths 

Should you wish to update object paths based upon new time and date settings, simply 
click the Update All button. 

Clearing Object Path Data 

If you would like to clear paths from the Sky Chart, click Clear All Paths. 

Create Paths Options 

TheSkyX allows you to create object paths with a great amount of flexibility.  The 
following is a detailed explanation of each option under the Create Paths menu. 

Items selected 

This area denotes how many objects are selected for which paths will be drawn.  You 
may select as many objects as you wish from the list on the left. 

Time increment 

Here, you can select the desired time increment from minutes, hours, 12-hour increments, 
days, and 30-day increments. 

Count 

Using this function lets you choose how many time increments you want to include in the 
object path.  Selecting 1 hour as the time increment and 24 as the count generates a path 
that is 24 hours in length, or about one Earth day. 

Path style 

Using the drop-down menu, the path style can be changed so that is drawn as a smooth 
connected line, a dotted line with points at each position, a dotted line with a graphical 
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representation of the object at each position, or a continuous line with either dots or 
graphic objects at each position. 

Animating an Object Path 

If you would like to animate the path as the object moves, simply turn on the Animate 
Path checkbox.  

Path Labels 

TheSkyX affixes labels to paths so that you can reference an object’s position at any given 
time along the path.   
 
To see the label data, or to adjust how labels are generated, click the Path Labels button 
near the top right side of the Object Paths window.  You will see a number of options, 
such as the position of the label, label frequency, and options for the label data (day, 
month, date, etc.).  Let’s change the label parameters in our Mars example to show us the 
date and time of several points along Mars’ path. 
 

1. Click the Path Labels button in the Object Paths window. 
2. The label position is set at top, and the frequency at 6, by default, so let’s just 

leave those as they are for now. 
3. In the Label Options drop-down menu, select Date and time. 
4. Click the Update button. 

 
You will now notice that the path labels in the Sky Chart now show the date and time of 
six points along the generated path.  If you want to change the label details again, simply 
follow the previous steps, substituting the new parameters under the Path Labels section. 

Label List 

In the Path Labels section, you will notice a label list under the label parameters.  
TheSkyX allows you to view and change any label along your generated path.  Scrolling 
in this list will reveal the label and the date and time of each incremental point along the 
generated path.  (In our example above, we generated a path 30 days in length, so the 
label list contains data for 30 days.)  You can change any label to anything you like by 
double clicking on a label cell and entering text.  Clicking Update will update your path 
and show the new labels. 

Path Labels Options 

TheSkyX affixes labels to object paths based upon default parameters or those selected by 
the user.  Understanding these will help you to get the most out of TheSkyX’s object paths 
function. 

Position 

A label’s position can be changed here.  You can elect Top, Bottom, Left, or Right. 
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Frequency 

This function adjusts the frequency at which labels appear on the object path.  The 
frequency can be changed by directly entering a number into the field, or by using its 
arrow buttons. 

Label option 

Here, you can change the data content of labels.  Labels can display date, time, date and 
time, day and month, or day only.  Additionally, labels can be turned off completely by 
selecting None. 

Label list 

This list shows all labels on a given object path and lists the labels as well as the date and 
time of each point along the path. 
 
You can change the content of any label by double-clicking in a label’s cell and entering 
text. 

The Calendar 

Mankind has been using calendars of one kind or another to mark the passage of time for 
thousands of years.  TheSkyX’s Calendar charts the phases of the Moon, sunrise and 
sunset, and viewing opportunities for a special kind of satellite event called an Iridium 
flare, on a monthly basis.  You can display and print a calendar for a single month or the 
entire year. 
 

 
Figure 43: The Calendar window (Tools menu > Calendar command). 
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Copy Calendar to Clipboard (Copy button) 

The current month’s calendar can be exported by copying it to the Clipboard using the 
Copy button, and then pasted into other applications that accept graphics (in Portable 
Network Graphics or PNG format). 
 
Please include the Software Bisque copyright if you publish a calendar on the web or in a 
monthly astronomy bulletin. 

Create a Calendar as a PDF (Create PDF button) 

Calendars created as Portable Document Format (PDF) documents can be emailed and 
viewed, or printed using free software on Windows, or freely with the Preview 
application on the Mac. 
 
PDF calendars, by default, are saved to the directory named: 
 

Software Bisque/TheSkyX <Edition Name Here>/Exported Data  
 
In your home folder (the one with the house icon in Finder on the Mac or the current 
user’s My Documents folder on Windows). 

Print Calendars (Print button) 

Clicking the Print button sends the calendar to your printer.  Make sure that your printer 
is turned on and ready to go before doing so. 

Show Sun or Moon Rise and Set Times (Sunrise/set, Moonrise/set checkboxes) 

Turn on the Sunrise/set or Moonrise/set checkbox to show the local sunrise (moonrise) 
and sunset (moonset) times for each day on the calendar.  

Show Times of Iridium Flares (Iridium Flares checkbox) 

In order to show the predicted times for flares in the calendar, TheSkyX must first 
generate an Iridium Flare Report.  To do so, click the Iridium Flares command on the 
Tools menu, specify the desired search parameters, then click the Find Flares button to 
generate a report of upcoming flares.  
 
After an Iridium Flare report is generated, turning on the Iridium Flares checkbox on the 
Calendar window shows the magnitude, time, direction and altitude of each flare in the 
Iridium Flare report. 

Show Yearly Moon Phase Calendar (Show Full Year checkbox) 

Turn on the Show Full Year checkbox to view the phases of the Moon for the current 
year. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

79 

 
Figure 44: Phases of the Moon for one year. 

Future and Past Calendars (Previous/Next Month/Year buttons) 

When the Show Full Year checkbox is off, click the Next or Previous Month button to 
view a future or past month’s calendar. 
 
If you select the Date & Time tab, a small calendar for the current month will be 
displayed.  Here’s a very interesting feature: if you click on any date in the calendar, the 
Sky Chart automatically shifts to show you what the sky will look like on that date, for 
the current time.  Notice also that the four major phases of the Moon are displayed in the 
calendar. 
 
For a more detailed calendar, go to the Tools item in the Main Menu.  Scroll down to 
Calendar and select it.  A larger, printable calendar is displayed.  Note that you can select 
various kinds of information to be included in the calendar by checking the appropriate 
boxes on the right-hand side of the window. 

Exploring the Sky Chart 
In this section of the User Guide we’ll focus on how to adjust and navigate the Sky Chart.  
The best way to learn our program is simply to use it.  Feel free to play around with the 
various buttons and menu commands you see in the tool bars.  TheSkyX won’t break, and 
it won’t bite you. 

Changing the Date and Time   

The clock built into your computer is constantly tracking the date and time.  TheSkyX 
reads this and displays whatever is above your horizon right now, but it can also show 
you the sky for different times of day or night.   
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By default, TheSkyX starts up using the computer’s clock to show time advancing at 1× 
(real time) with the Go Forward button pressed (meaning time is advancing how you’d 
expect). 
 
From the Input menu, select the Date and Time command to show the Date and Time 
window (Figure 44).   
 

 
Figure 45: The Date and Time window (Input > Date and Time command). 

Entering the Date and Time (Date & Time Control) 

Use TheSkyX’s Date & Time control that is located near the top of the Date and Time 
window to enter any date, after January 1, 4,712 BC and before December 31, 10,000 
AD. 

 
Figure 46: The Date & Time control on the Date and Time window and on the Date & Time Toolbar 

(Display > Date & Time Toolbar). 

Do to so, click the mouse on the date or time element you wish to change, then type the 
desired value for: 

• hours 
• minutes 
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• seconds 
• AM/PM  
• month  
• date 
• year 
• AD/BC  

 
To set a specific month, click the month text to highlight it, then press the key for the first 
letter in the month. For example, press “D” for December.  Pressing the “J” key 
repeatedly toggles the months January, June and July.  If your mouse has a scroll wheel, 
use it to move up and down through the months.  Or, use the up/down arrow keys on the 
keyboard. 
 
To toggle between AM/PM, or AD/BC, click the mouse on the text, then press “A” or 
scroll the mouse wheel or up/down arrow keys. 
 
The current month can also be selected using the calendar on the Date and Time window. 
 
The Daylight Saving Time (DST) or Standard Time (STD) text next to the local time is 
updated automatically based on the date and your location.  

Formatting the Date and Time 

The format of the date and time can be changed to suit your preferences.  Double-click on 
the Date & Time control to show the date and time formatting options.  See “Have it 
Your Way with Preferences” on page 130. 

Calendar Control  

TheSkyX’s Calendar control on the Date and Time window  provides two mouse click 
access to any date for the current year.  If necessary, click the Date and Time command 
from the Display menu to turn this window on; click the Date & Time tab on the stacked 
windows to bring it to the front. 
 

 
Figure 47: The Calendar control on the Date and Time window (Display > Date and Time command). 
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The top of the calendar control shows the year. Click the forward/backward arrows to 
advance/retreat one year at a time. 
 
The edges of the calendar show the months of the year. Click any tab to bring it forward. 
 
Black numbers for dates indicate the days in the current month, light gray numbers are 
shown for the prior or next month.  The current day is highlighted light red. Click on any 
day to highlight it; the Sky Chart is adjusted accordingly.  Clicking a gray colored 
number advances or retreats to that month. 

Time Controls  

Buttons for controlling the flow of time are available by clicking the Date and Time 
command on the Display menu and on the Date and Time Toolbar. 
 

 
Figure 48: Time Controls on the Date and Time window (Display menu) and the Date and Time 

Toolbar (from left to right: Computer Clock, Go Backward, Step Backward, Stop, Step Forward, Go 
Forward). 

Use the Computer’s Clock (Computer clock) 

When the Computer Clock button is clicked, TheSkyX gets the date and time from the 
computer’s clock.  It also resets the time skip increment to 1× (real time) and sets the Go 
Forward time skip option. 

Verifying TheSkyX’s Time 

Accuracy is of the utmost importance in your observations.  Select T ools > Verify 
T heSkyX’ s T ime to check TheSkyX’ s time against the U.S. Naval Observatory’s Master 
Clock.  You can also click the corresponding toolbar button if you have the Orientation 
Toolbar activated (check T heSkyX  > Preferences > T oolbars). 
 
Note:   T his tool requires an internet connection. 

Move Backward in Time (Go backward) 

Even though time marches on, TheSkyX can make time go backward by clicking the Go 
Backward button.  This can be handy to replay an astronomical event and is sort of like 
having your own DVD player on history. 

Step Backward in Time (Step backward) 

Unlike the Go Backward button, the Step Backward button can be used to incrementally 
retreat time by the Time Skip Increment amount.   Use this to find the first contact of an 
eclipse, or determine the precise time when a minor planet occults a star, for example. 
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Stop Time (Stop) 

Use the Stop time button to halt the motion of stars and other objects from your earth-
based perspective. 

Step Forward in Time (Step forward) 

Use the Step Forward button to incrementally advance time by the Time Skip Increment 
amount. 

Go Forward in Time (Go forward)  

Use the Go Forward button to advance time. When the Time Skip Increment is set to 1× 
(real time), TheSkyX is showing you how the real sky looks at any instant. 

Advancing or Retreating Time (Increment Time By) 

 

 
Figure 49: Increment Time control. 

Use the Increment Time By control to specify the rate or interval to advance or retreat 
time.   
 
The default time interval options include: 
 

• 1× (real time): Time advances or retreats based on the computer’s clock. 
• 10×, 100×, 1000×: Time changes by a factor of 10, 100 or 1000 times the 

normal rate. 
• 1 second  
• 1 minute 
• 1 hour 
• 1 day 
• 1 lunar month 
• 1 year 
• Sunrise: The time skip interval is the length of time between sunrises for each 

day. 
• Sunset: The time skip interval is the length of time between sunrises for each 

day. 
• Start Twilight: The time skip interval is the length of time between morning 

astronomical twilight for successive days. 
• End Twilight: The time skip interval is the length of time between evening 

astronomical twilight for successive days. 
• Custom: Click the Custom command to show the Custom Time Flow 

Increments and Rates dialog. 
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Figure 50: Define custom rates and time skip increments using the Custom Time Flow Increments 

and Rates dialog. 

User-Defined Rates and Time Skip Increments (My rates and increments) 

This list shows the rates and increments that you’ve defined by clicking the Add button to 
the right. 

Define a Numerical Increment or Rate (Number) 

Enter any decimal number for the rate or increment you wish to define.  For example, 
2.56 days, or 500x. 

Define the Flow Rate or Time Skip Increment Unit (Unit) 

Specify the unit for the rate or time skip increment. The lower case “×” unit means “a 
rate that is N times greater than actual time. Only whole numbers (integer) values are 
permitted for time skip rates. 

Add Rates and Increments (Add) 

Once you’ve entered a number and a rate, click Add to add it to the list My Rates and 
Increments list. 
 
Custom rates are saved automatically, and restored when TheSkyX is opened. 

Remove Rates and Increments (Remove) 

Select one or all of the rates and increments, then click the Remove button to remove 
them from the list. 

Quickly Change Time (Change Time) 

The Change Time slider on the Date and Time dialog allows you to quickly advance or 
retreat time at the current rate. 
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This control is useful for reviewing lunar eclipses, occultations and Iridium flares. 
 
Now that you’re familiar with the time controls, below the calendar there is an item 
called Set Specific Time.  Click it. 
 
You’ll see a list of different “times” – not in hour and minute format, but in terms of 
astronomical events. The list of common events includes:  
 
• Now: TheSkyX uses the computer’s clock to show time 
• Sunrise:  The time of day when the rising Sun reaches the “refracted horizon” – the 

line on the refracted sky that corresponds to the observer’s horizontal.  
 

Hint: Refraction in the earth’s atmosphere bends light, so, at sea level, the Sun’s 
upper limb is visible about 3 minutes before it is actually above the local horizon.   
 

• Noon: The time of day when the Sun is centered on the meridian. This is 
not necessarily 12:00 p.m. 

• Sunset:  The time when the Sun appears just below the “refracted 
horizon”.  

• Midnight:  12:00:00 a.m. local time. 
• Morning (Begin Astronomical Twilight):  The time when astronomical 

twilight begins. 
• Evening (End Astronomical Twilight):  The time when astronomical 

twilight ends. 
• New Moon:  The date and time in the current month when the Moon’s 

phase is zero percent. 
• First Quarter: The date and time in the current month when the waxing 

Moon’s phase is approximately 50 percent. 
• Last Quarter: The date and time in the current month when the waning 

Moon’s phase is approximately 50 percent. 
• Full Moon: The date and time in the current month when the Moon’s 

phase is approximately 100 percent. 
• Moonrise: The time of day when the rising Moon intersects the refracted 

horizon. 
• Moonset: The time of day when the setting Moon is below the refracted 

horizon. 
• Vernal Equinox:  The date and time for the current year when spring 

begins in the northern hemisphere. 
• Summer Solstice:  The date and time for the current year when summer 

begins in the northern hemisphere. 
• Autumnal Equinox:  The date and time for the current year when autumn 

begins in the northern hemisphere. 
• Winter Solstice:  The date and time for the current year when winter 

begins in the northern hemisphere. 
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The last item in the list allows you to enter the Julian Date of an event. 
 
The Moon’s phase events search the current month. For example, if TheSkyX’s month is 
set to any date in July, 1592, the New Moon is July 24, even if the date is later than July 
24. 
   
When you select any of these options, the Sky Chart shows you what the sky will look at 
that time for the current date.  Try several of the options and watch how the chart 
changes. 
 
You can make time speed up and even go backwards.  In the Tools menu, choose the 
item called Time Skip.  Try one of the various options.  The Sky Chart will continue 
moving backward or forward in time until you select Stop, or the Use Computer’s Clock 
option. 
 
Finally, you can also enter a specific date and time by selecting the Input item from the 
Main Menu and choosing Date and Time (note there is also a shortcut key for this 
displayed,  within the menu – TheSkyX will always display shortcut keys in the menu 
whenever they are available). 

Reports 

TheSkyX makes generating calendar reports of Sun and Moon activity, equinoxes and 
solstices, planet ephemerides and meteor showers an absolute snap.  Set the Sky Chart to 
any year you choose, and select T ools > R eports to see a wealth of astronomical data 
specific to the given year. 

Equinox/Solstice Report 

This report displays the date and exact time of each equinox and solstice for the Sky 
Chart’s current year.  To see a different year’s values, simply change the Sky Chart’s 
year in the Date and Time tab or toolbar. 

Meteor Radiant Report 

Keep on top of meteor shower activity with this handy report.  With the Meteor R adiant 
R eport, you can instantly see the Month/Day, R A, Dec, and H ourly R ate of each meteor 
shower for the Sky Chart’s current year.  Just as with the other reports, you can obtain 
values for a different year by changing the date in the Date and Time tab or toolbar. 

Planet Report 

This is a “catch all” report that lists a variety of solar, planetary and lunar ephemerides 
and other useful information such as Earth distance, longitude of each visible planet’s 
central meridian, Moon-specific information and more.  You can obtain values by 
changing the date in the Date and Time tab or toolbar. 
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Sun & Moon Report 

This report lists times for moonrise, moonset, sunrise, sunset, and the beginning and 
ending of (astronomical) twilight for each day of the Sky Chart’s current month and year.  
To see values for a different month or year, simply change the date in the Date and Time 
tab or toolbar. 

Sky Database Reports (All SDBs) 

This report shows the name, search prefix, object count, object type and the associated 
text file for every Sky Database. 

Copying Reports 

Any of these reports can be copied to the clipboard for pasting into another application by 
simply clicking the Copy button at the lower left side of the Reports dialog. 

The Look Commands 

Our eyes can see only a small portion of the sky at a time.  TheSkyX can show you the 
entire sky at once, but it’s often more useful to focus the display on one part of the sky at 
a time, to match what you can see in the real night sky with your unaided eyes. 
 
Changing the direction of your view is accomplished with the Look commands.  These 
can be found in the Orientation menu, but they are also available to you as buttons in the 
Orientation tool bar.   
 
By default, the Sky Chart is displayed looking south.  Click the East button in the 
Orientation tool bar.  Note that the star field has changed; the compass direction 
displayed at the bottom of the screen indicates E, for east.  Experiment with the other 
compass direction buttons. 
 
In addition to the compass direction buttons, a set of arrow buttons can be used to shift 
your viewing direction incrementally.  Click the right arrow button.  Notice how the view 
shifts slightly to the left (how far the Sky Chart shifts depends on your field of view, 
discussed below), just as if you were outside, looking at the real sky, and turning your 
head to the right.  The left, right, up and down buttons function similarly (if your 
computer’s monitor is small, or the screen resolution is low, the entire toolbar may not fit 
on the screen, so you may need to click the “>>” symbol to display the up and down 
buttons), mimicking the movement of your head in the indicated directions. 
 
You can also press and hold the CONTROL key then drag the mouse to adjust the position 
of the Sky Chart. 

Orientation Options 

A variety of options exist for orienting the Sky Chart.  You may choose from a terrestrial 
sphere or celestial sphere setup, or a free rotation mode. 
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Terrestrial Sphere 

Select Or ientation > T errestrial Sphere to orient the Sky Chart as if from a vantage 
point on Earth’s surface and according to terrestrial coordinates. 

Celestial Sphere 

To view the Sky Chart from the origin (center) of the celestial sphere, select the Celestial 
Sphere command from the Orientation menu. 

Free Rotation 

Choosing the F ree R otation command from the Orientation menu allows you to freely 
rotate the Sky Chart in any direction without being constrained to any coordinate system 
or convention. 
 
Note:  Each of these options is also available as a button on the Orientation Toolbar. 

Rotating the Sky Chart 

While in Free Rotation mode, you can rotate the Sky Chart freely, in any direction, with 
commands from the Or ientation menu, or by using the R otate T ool found in the T ools 
menu. 

Rotating Clockwise and Counterclockwise 

First, select F ree R otation from either the Or ientation menu or from the Orientation 
Toolbar.  Then, select either R otate Clockwise or R otate Counterclockwise from the 
Orientation menu.  You can also use the keyboard shortcut alt+ (Windows) or ⌥+ (Mac) 
to rotate clockwise.  Similarly, alt- (Windows) or ⌥- (Mac) rotates the Sky Chart 
counterclockwise. 

Rotate Tool 

You can also rotate the Sky Chart to any position angle you choose by using the Rotate 
Tool.  Select T ools > R otate T ool to activate it.  A brownish-red position angle indicator 
will then appears in the Sky Chart with a label indicating its current position angle. 
 
To use the Rotate Tool, first set a central rotation point by clicking and dragging in the 
Sky Chart to move the desired central point to the center of the view.  To change the 
position angle freely, click and drag the square at the end of the position angle indicator.  
Notice that the position angle readout changes as you drag the indicator. 
 
You can also set a position angle using the Rotation settings under the Or ientation > 
Navigate command.  See the Navigate Command section for more details. 

Angular Separation & Position Angle 

Determining the angular separation and position angle of two objects is a snap with 
TheSkyX. 
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Angular Separation & Position Angle Tool 

Select T ools > Angular Separation &  Position Angle to bring up the tool.  You will 
notice that a pale green indicator with two square endpoints and a square center point 
appears in the Sky Chart.  To determine the angular separation and relative position angle 
between two objects, simply click and drag the endpoints so that they overlap the objects 
for which you wish to determine angular separation and position angle values.  You can 
hold down the Control key (Windows) or Command key (Mac) to snap the endpoints to 
the nearest object for greater accuracy.  It’s that simple!  The desired values will appear 
in the label below the indicator.  Determining angular separation and position angles has 
never been so simple or so elegant as it is in TheSkyX. 
 
Once you are finished with this tool, deselect it by returning the T ools > Angular 
Separation &  Position Angle command. 
 
Note:   T he Angular Separation &  Position Angle tool works in terrestrial or celestial 
sphere mode and in free rotation mode.  You can also click and drag the Sky Chart to 
adjust the view at any time. 

Field of View 

You probably know that a circle can be divided into 360 degrees.  Imagine a pie cut into 
six equal slices.  The angle between the edges of a given slice is 360/6 = 60 degrees.  
Astronomers measure angles in degrees, and fractions of a degree: each degree is divided 
into sixty minutes, and each minute is divided into sixty seconds. 
 
When you look up, you can see only a portion of the entire sky.  Imagine for a moment 
that the sky is an immense spherical bowl above your head.  You’re seeing an area of the 
sky that spans a particular angle. 
 
Assuming you have normal peripheral vision, that angle is about sixty degrees – one slice 
of our imaginary pie in the sky.  Another way of saying this is your field of view is sixty 
degrees wide.  Some people can see a little more, and some a little less, but sixty degrees 
is about average for adults. 
 
When you look at the sky with binoculars or a telescope, what you see is magnified – in 
effect, you bring the sky closer, making it easier to see detail and faint objects.  The 
downside of magnification is that it always reduces your field of view, sometimes to just 
a fraction of a degree.  Generally speaking, the greater the magnification, the smaller the 
field of view. 
 
TheSkyX allows you to set the field of view to any angle, from 235 degrees to a fraction 
of a degree.  This is very useful when you’re trying to understand how much of a 
particular constellation or star field might be visible in a pair of binoculars or a small 
telescope. 
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Setting the Field of View 

A simple way to change the field of view is to use the Zoom In and Zoom Out buttons.  
The current field of view is displayed next to these buttons.  Click on that pop-up menu.  
A list of preset fields of view is displayed.  Some of these correspond to the field of view 
of a typical pair of binoculars or amateur telescope.   
 
The Wide Field option shows you the sky from horizon to horizon, 180 degrees.  The 
Naked Eye option gives you a 100-degree field of view – a bit wider field than what you 
can actually see with your eyes, but we wouldn’t want you to miss anything. 
 
You can also define a zoom box to zoom in on a particular area of the Sky Chart.  Place 
your cursor on one corner of the area you want to zoom in on.  While pressing the shift 
key, click and hold while you move your cursor to the opposite corner, then click 
anywhere inside the zoom box to enlarge it (you can click outside the zoom box to cancel 
this operation). 

Stellar Cartography 

Just as you would use a map to find your way around a city, state, or country, celestial 
maps or star charts are designed to help you find your way around the sky. 
 
Use your mouse or track pad to move the arrow around the Sky Chart.  You’ll notice that 
when the tip of the arrow touches an object, an information box describing that object is 
automatically displayed.  The kind of information displayed depends in part on the nature 
of the object, but one thing that is always displayed is the location of the object.  This is 
indicated by two different sets of coordinates. 

Cosmic Coordinates 

Maps of the Earth identify the location of landmarks with two numbers: latitude and 
longitude.  Latitude is measured in degrees north or south of the equator, and longitude is 
measured in degrees east or west of the Prime Meridian. 
 
A similar system is used for objects in the sky.  The celestial equator divides the sky into 
two hemispheres, north and south.  The celestial equivalent of longitude is called right 
ascension (TheSkyX uses the abbreviation RA)  and the equivalent of latitude is called 
declination (dec) .  Right ascension is measured in hours, minutes, and seconds, from 0 to 
24.  This may seem odd at first, but there’s a very good reason for this peculiar 
convention: the Earth is rotating.  It turns around once on its axis in 24 hours, but from 
our terrestrial perspective, it looks like the sky is rotating around the Earth every 24 
hours.  Right ascension is measured eastward from the constellation Aries, the Ram.  
Specifically, 0 hours RA, the First Point of Aries, is the position in the sky where the Sun 
crosses the celestial equator on the first day of spring. 
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Declination is measured in degrees north or south of the celestial equator.  The celestial 
equator is 0 degrees declination.  The north celestial pole is located at 90 degrees 
declination (Polaris, the North Star, has a declination very close to 90 degrees).  The 
south celestial pole is at minus 90 degrees declination.  You can also translate right 
ascension into degrees: a complete circle has 360 degrees; dividing 360 by 24 gives 15, 
so every hour of right ascension is equal to 15 degrees.   
 
Imagine a line running across the sky from due north to due south, splitting the sky in 
two.  This line is called the meridian.  Better yet, turn on the Meridian check box under 
the Reference Lines & Photos group on the Chart Elements window (page 149) to view 
it on the Sky Chart.  When a celestial object crosses the meridian, it is also at its highest 
altitude in the sky.  This is called the transit time.  Generally speaking, the best time to 
observe a celestial object with a telescope is when it’s crossing the meridian. 
 
This brings us to another way of identifying the location of an object in the sky: altitude 
and azimuth.  Altitude is simply the number of degrees the object is above the horizon, 
from 0 (on the horizon) to 90 (directly overhead).  Be careful not to confuse altitude with 
declination – they are not the same thing.   
 
Azimuth indicates the compass direction of an object.  Specifically, it is the number of 
degrees east of north that you need to turn to see the object.  Due east, for example, is 90 
degrees azimuth.   
 
The problem with using altitude and azimuth for astronomical objects of course is that 
these numbers are constantly changing as the Earth rotates.  TheSkyX, however, can 
calculate these numbers instantaneously, making it easier to know what direction to look 
when you’re outside in the dark, trying to find a particular object at a specific time. 

Understanding Projections 

Ever since we discovered that the Earth isn’t flat, but spherical, cartographers have been 
looking for ways to represent a curved surface on a flat surface.  
 
A sphere cannot be projected onto a plane without introducing distortion. In the most 
commonly used projection – called the Mercator projection – objects get larger the 
farther they are from the equator. This causes Greenland to look nearly as large as the rest 
of the United States on world maps. Navigators adopted the Mercator projection because 
a straight line on a Mercator projection, called a rhumb line, represents a constant 
compass bearing from true north.  
 
Other projections have their own combinations of strengths and weaknesses. All 
projections are compromises – the “best” projection is the one whose advantages 
outweigh its disadvantages for a particular application.  
 
By default, TheSkyX uses the stereographic projection for fields of view greater than 60°.  
A stereographic projection is said to be “conformal.” Although (as with all flat maps) the 
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overall projection is distorted, all lines of declination and right ascension intersect at right 
angles, as they do on the celestial sphere.  
 
The advantage of stereographic projection is that, over small areas of the display, object 
shapes are only slightly distorted. Constellations remain easy to identify. Compare this 
with the polar projection of a planisphere. There is almost no distortion near the poles, 
but constellations near the horizon are badly stretched out of shape. (A planisphere is one 
of those rotating star charts that approximate what’s visible in the sky at a given date and 
time.)  
 
When the Sky Chart is set to a field of view of 60° or less, the projection automatically 
switches to an orthographic projection, which displays the sky more as it would appear 
on the surface of a sphere. (This is the only projection used at 60° fields of view and 
smaller.)  

Projections  

By default, TheSkyX uses a stereographic projection for 60° fields of view and greater. 
The Projections command from the Display menu changes the projection. In the 
Projections dialog, click the radio button of the projection you want.  
 

 
Figure 51: The Projections dialog. 

The selected projection is applied to the Sky Chart immediately.  It takes effect only 
when the field of view is greater than 60°– no change occurs if the current field of view is 
60° or less. 
 

• Stereographic – The default for fields of view equal to and greater than 60°. It 
keeps lines of right ascension and declination at right angles and minimizes 
local distortion. Conformal. 235° maximum field of view. 

• Orthographic – Displays the sky more as it would appear on the surface of a 
sphere. It’s the default (indeed, it’s the only available projection) for angles of 
view 60° and less. Conformal. 180° maximum field of view.  
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• Mercator – Shows the celestial sphere like a conventional map. It allows wider 
fields of view, including a 360° view that shows the entire celestial sphere. 
Conformal. 360° maximum field of view.  

• Gnomonic – This is the “pinhole camera projection.”  It displays meteor paths 
as straight lines, as seen when viewing a meteor shower. Non-conformal. 150° 
maximum field of view.  

• Azimuthal Equal-Distance – The distance between objects having a particular 
angular separation on the celestial sphere is the same at any part of the Sky 
Chart. Non-conformal. 300° maximum field of view.  

• Azimuthal Equal-Area – The areas of any sections of the celestial sphere 
subtending a particular solid angle are the same at any part of the Sky Chart. 
Non-conformal. 235° maximum field of view. 

Stars and Constellations 

There are some 6,000 stars visible to the naked eye.  Most of these stars can only be seen 
from locations far from the bright lights of a city or town.  If you really want to see the 
stars, you either have to go to Hollywood or get out of Dodge. 

Star Names 

Some of the brighter stars have proper names, but most don’t – there are just too many to 
give each one a name.  Instead, astronomers have devised a system that assigns names to 
naked-eye stars based on their brightness and the name of the constellation they belong 
to.  Following a centuries-long tradition, the brightest star in a constellation is designated 
by the first letter of the Greek alphabet, Alpha, followed by the genitive form of the Latin 
name of its constellation.  For example, the brightest star in the constellation Orion is 
called Alpha Orionis.  It also has a proper name: Rigel.  (We’ll talk more about 
constellations later.  Right now we’re going to focus on individual stars.)  When the 
letters run out, stars are identified by various alphanumeric designations. 
 
A funny thing about Rigel: even though it’s the brightest star in Orion, its designation is 
Beta Orionis.  Astronomers originally thought that Betelgeuse, another star in Orion, was 
a little bit brighter, but improvements in photometers in the 20th century revealed that 
Rigel is actually the brighter star (it’s possible that Betelgeuse might have been brighter 
in the past, when astronomers first began to designate stars with Greek letters). 

Bright Stars and Dim Stars 

Long before the invention of the telescope, astronomers also came up with a numerical 
system for classifying stars by their brightness.  They decided that the brightest stars 
would be called First Magnitude.  Those half as bright as First would be called Second 
Magnitude, then Third Magnitude, and so on down to Sixth Magnitude, which denotes 
the dimmest stars visible to the naked eye. 
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We use a modified form of this system today.  The brightest star in the nighttime sky is 
called Sirius.  It’s in the constellation Canis Major, the Big Dog, and it’s sometimes 
called the Dog Star.  Its magnitude is minus 1.4, which we write as –1.4.  This may seem 
a little confusing, but it isn’t that hard to understand.  A couple of centuries ago, 
astronomers decided to make the magnitude scale more precise.  They knew the Sun and 
Moon and some of the planets are brighter than the brightest stars, so these were given 
negative magnitudes.  They also realized that a First Magnitude star is actually a bit more 
than twice as bright as a Second.  In order to keep Sixth Magnitude as the faintest star 
visible to the naked eye, astronomers recalibrated the magnitude system to follow a 
logarithmic scale.  Each stellar magnitude is about 2.5 times brighter than the next lower 
magnitude so that the difference of five magnitudes is a brightness factor of (exactly) 
100. 
 
With a telescope, you can see stars much dimmer than Sixth Magnitude.  TheSkyX 
database includes stars down to about 14th Magnitude. 
 
On a clear, moonless night, people who live in cities or suburbs can rarely see stars 
dimmer than Third Magnitude.  If you’re just starting to learn the names of the brighter 
stars and constellations, you should set the magnitude filter in TheSkyX to Second or 
Third magnitude.  That way, when you go out at night to compare what you see on your 
computer to what you can see in the real sky, you won’t be confused by a screen display 
that shows more stars than you can actually see from your location. 

Setting the Magnitude Limit 

This command tells TheSkyX to only display stars, galaxies, clusters, or any other object 
type, or combination of object types, that has magnitude information, that are brighter or 
fainter than a selected magnitude.  Controls for editing the magnitude limits  are found on 
the Chart Elements window on the Display menu.   
 
The following example demonstrates how to change the magnitude limits for all celestial 
objects. 
 

1. Make sure the Chart Elements window is visible. If it’s not, select the Chart 
Elements command from the Display menu to show it.   

2. Highlight the Celestial Objects text by clicking on it.  This selects the 40 chart 
elements in the Chart Elements node. 

3. Click the Edit Attributes button. 
4. Near the bottom of the Chart Elements window you’ll see a tab labeled 

Magnitude Limits.  You can enter a value between 30.0 and –6.0, or change 
the magnitude using the sliders. 
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Figure 52: Magnitude Limits tab on the Chart Elements window. 

The attributes of chart elements (including lower and upper magnitude, angular size, font 
properties and colors) can be changed individually or as a group based on the items that 
are selected in the Chart Elements list. 

Number of Selected Chart Elements (Selected) 

This text shows the name of the selected chart element or the number of selected chart 
elements in the Chart Element list. 

Show Only Brighter Stars (Hide fainter than) 

Specify the magnitude of the faintest objects to be displayed on the Sky Chart.  For 
example, if you live in a light polluted city and want to approximate the stars you can see 
on typical night’s sky, enter magnitude 1 or 2.  

Show Only Fainter Stars (Hide brighter than) 

The Hide Brighter Than controls provide additional filtering, displaying objects only 
within a specified brightness range.  Larger magnitude values represent dimmer objects. 
The brightest objects have negative magnitudes. 
 
As you move the slider the number of stars on the Sky Chart changes to reflect the 
changing magnitude limits. 

Other Chart Elements 

Like land maps, star charts can be overlaid with a variety of lines and markings intended 
to highlight specific celestial features and help you find objects at specific coordinates. 
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The Chart Elements menu lets you display or hide various reference lines and symbols, 
but you should be aware that even though the cosmos mostly consists of empty space, a 
star chart can get very crowded very quickly.  The celestial equator and lines of right 
ascension and declination can be added to the Sky Chart, for example.  Experiment with 
this feature by clicking on the box next to a listed chart element to see how it affects the 
display. 

A Star to Guide You 

For people living in the northern hemisphere, probably the most noteworthy star is 
Polaris, the North Star.  It always stays in the same part of the sky, every night, 365 days 
a year.  The reason for this is fairly simple: Polaris happens to be located almost directly 
above our North Pole.  As the Earth rotates on its axis, other stars rise and set, but 
because Polaris is right above the pole, it always seems to stay in the same place.   
 
How high Polaris is above your horizon is a direct way to find your latitude.  If Polaris is 
40 degrees above the local horizon, for example, you must be somewhere on the 40th 
latitude line.  Philadelphia and Denver are both very close this latitude, as are Naples, 
Italy and Beijing, China.  The stars you can see on any given date and (local) time are 
essentially the same for all of these cities, and any other place along this line of latitude.   
 
More than anything else, latitude determines what you can see in the sky.  The North Star 
is not visible from the Southern Hemisphere, as are most of the stars and constellations 
near it.  And there are all sorts of stars and constellations visible from the Southern 
Hemisphere that we never get to see in the North (the Moon and planets are visible from 
both hemispheres).  TheSkyX can show you what the sky would look like from any place 
in either hemisphere. 

Double Stars 

A little more than half of all stars actually travel in pairs, orbiting each other in space.  
The American astronomer Henrietta Leavitt once quipped that three stars out of every 
two are double.  Most of them appear as single stars to the naked eye.  You need good 
binoculars or a small telescope to resolve them as double stars (there are also triple stars 
and groups consisting of four or even more stars). 
 
Some double stars are true binaries, meaning they are gravitationally bound to each other 
and orbit a common point in space.  Others only appear to be double because they happen 
to lie along the same line of sight from Earth, but are in fact many light years apart and 
not tied to each other by gravity. 
 
One of the best-known double stars in the sky is called Mizar.  It’s located in the handle 
of the Big Dipper. 
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Finding Mizar 

Mizar is visible only from the Northern Hemisphere, and is easiest to find in the evening 
sky in Spring. 
 
Select the Find tab from the vertical tabs on the left side of TheSkyX’s window. 
 
Type Mizar into the Search For text input, then click the Find button.  A double red 
“bull’s eye” will encircle the star in the Sky Chart.  
 
The Big Dipper is one of the northern sky’s most recognizable asterisms (this term is 
described below).  Being able to find it will help you find other nearby constellations, 
such as Cassiopeia.  Once you’ve mastered these constellations, others will be easier to 
learn. 
 
Another good thing about being able to find the Big Dipper: it will make it easy for you 
to find Polaris, and therefore true north.  The two stars at the end of the cup of the dipper 
point to Polaris.  Imagine a line connecting these two stars.  Extend it in the direction the 
cup is pouring, about five times the distance between the two stars.  The star you see at 
the end of that line is Polaris. 

Variable Stars 

Fortunately for us, and everything else that lives on Earth, the Sun radiates energy at a 
very nearly constant rate.  But there are some stars that change in brightness dramatically 
over the course of a few months, and in some cases, just a few days or even hours.  These 
are called variable stars, and TheSkyX distinguishes them with a small red “v” to the 
lower left of the star.   
 
The most notorious variable star is called Algol, a name derived from an Arabic word 
that means demon.  Located in the constellation Perseus, its rhythmic dips in magnitude 
can easily be observed with the naked eye.  Every 2.867 days, over the course of just a 
few hours, Algol falls from second magnitude (2.1) to third (3.4) and back.  During these 
periodic dimmings, you can gauge its changing brightness by comparing it to other 
nearby stars.  The evening sky in Autumn is the easiest time to find this fascinating object 
(it is only visible from the Northern Hemisphere).  It may have been considered demonic 
in ancient times, but today we know this innocent star has a companion that orbits it 
every 2.867 days.  Algol dims when that companion passes in front of it from our 
perspective.  Such stars make up a special class called eclipsing binaries. 

Classifying Stars 

Stars differ not only in their brightness, but also in their size, surface temperature, and 
chemical composition.  The one thing they have in common is that they are all spherical – 
although some spin so fast they tend to bulge in the middle! 
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All stars are basically immense balls of intensely hot gas that generate heat and light 
through a process called nuclear fusion.  The temperature and density in the core of a star 
are so great that lighter atoms smash into each with enough force to fuse into heavier 
atoms.  In our own Sun, for example, atoms of hydrogen fuse to produce atoms of helium 
(this process involves several intermediate steps).  The fusion process releases energy in 
the form of electromagnetic radiation – light. 
 
By spreading starlight into a spectrum, astronomers can learn the temperature and 
chemical makeup of stars.  After studying thousands of stars, it became clear that stars 
fall into various categories, or classes.  Some are massive and bright, and have relatively 
short, tumultuous lives.  Others are small and dim, and can shine steadily for tens of 
billions of years. 
 
A letter and number system is used to define stars in terms of their most important 
physical characteristics, and these designations are displayed when you point to a star in 
the Sky Chart.  A more complete discussion of spectral classes and the physics of stars 
can be found in any introductory astronomy text. 

Giants and Dwarfs 

When you see a bright star in the sky, there are two possibilities: the star is close by and 
relatively average in size, or it is far away and gigantic. 
 
Rigel is the brightest star in the constellation Orion.  It is nearly 800 light years away, but 
is the seventh brightest star in the sky.  It is a whopper, with a diameter of about 100 
million kilometers.  The Sun, by comparison, is about 1.4 million kilometers across. 
 
Astronomers distinguish between apparent magnitude and absolute magnitude.  Apparent 
magnitude is how bright a star looks in the sky.  Absolute magnitude refers to how bright 
a star would appear if it were located exactly 10 parsecs (32.6 light years) away.  The 
apparent magnitude of Rigel is about 0.2, but its absolute magnitude is nearly –7.0. 

More About Constellations 

The desire to find order in nature, even where none exists, seems to be built into the 
human brain.  When you look up at the sky on a dark, clear night, the sheer number of 
stars can be overwhelming.  Our distant ancestors must have been in awe of those 
countless lights randomly scattered across the sky like diamonds. 
 
Because of our instinctive need to find order, cultures all across the globe have organized 
stars into distinctive patterns called constellations.  These patterns are purely a product of 
the human imagination.  Nature had nothing to do with creating them. 
 
The constellations we recognize today have mostly come down to us from the ancient 
Greeks.  Many of them represent mythological figures.  Orion, for example, one of the 
most prominent constellations visible in northern wintertime, represents a heroic hunter 
who first appeared in one of the great epics of classical Greek literature, The Odyssey.  
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Orion is accompanied by two hunting dogs that are also immortalized in constellations: 
Canis Major and Canis Minor, the big and little dogs, respectively. 
 
When you look at Orion, it isn’t hard to imagine the figure of a hunter with a raised arm 
wielding a club.  You can see one classic representation of this figure by going to the 
Display menu and selecting Constellations & Asterisms Options.  You can display line 
drawings, mythical figures, and constellation boundaries by checking the appropriate 
boxes.  You can also use the slider labeled Transparency to adjust how bright these 
renderings appear. 
 
For many other constellations, the connection between its array of stars and what it is 
supposed to represent is difficult to see, to say the least.  They’re a little more like 
abstract art, intended to represent the idea of a thing rather than the thing itself. 
 
Drawing lines between the stars of a given constellation provides a simple “stick figure” 
view of that constellation.  When astronomers think about constellations at all, this is how 
they usually think of them.  The more fanciful mythological drawings of constellations 
became popular in the early 17th century, especially in the gorgeous star charts engraved 
by the great German celestial cartographer Johann Bayer (Bayer is also credited with 
creating the system that designates stars with Greek letters and the genitive name of their 
constellations, as described previously). 
 
When the constellations we recognize today were originally created, a number of stars 
were left over – that is, not all stars fit into the established patterns.  To avoid confusion, 
astronomers designated boundary lines between the constellations.  Not unlike borders 
between countries, any star that falls within the borders of a given constellation is said to 
belong to it, whether it was included in the original depiction of that constellation or not. 

Asterisms 

There are familiar patterns of stars that don’t quite qualify as constellations.  Astronomers 
call these patterns asterisms.  The Big Dipper and the Pleiades (the Seven Sisters) are 
probably the two most familiar examples.  In Japan, the Pleiades are called Subaru.  
You’ve probably seen them driving around your neighborhood. 

Some Tips on Using Star Charts 

Learning how to connect what you see on a star chart to what you see in the real sky 
takes some time.  We’re going to show you a step-by-step process that will make it easier 
for you to find common stars and constellations.  With a little patience and practice, 
you’ll soon become an expert. 
 
First of all, when you go outside and look at the sky, you need to know what direction 
you’re facing.  In particular, you need to know how to find true north.  City streets often 
lie along north/south and east/west lines, but this isn’t always the case.  If you aren’t sure 
which way is north at your viewing location, use a magnetic compass to find it. 
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When hundreds of stars are displayed on your chart, finding individual stars and 
constellations can be very challenging.  But if you limit the number of stars in the chart to 
just a few dozen of the brightest stars, you’ll have a much easier time learning the sky. 

Printing a Sky Chart 

Printing a sky chart to take with you when you go outside is also very helpful.  TheSkyX 
can print any chart it displays.  You can print an “all sky” chart, or select a particular part 
of the sky you’re interested in learning.   
 
Choose the File command from the main menu.  Near the bottom of the menu, you’ll see 
two items: Print and Print Setup (if you have more than one printer connected to your 
computer, Print Setup can be used to select the printer you’d like to use).  Select the 
Print command. 
 
The Print Chart tab of the Export Chart window is displayed on the screen.  In addition 
to printing charts, TheSkyX allows you export charts as Portable Document  Format 
(PDF), Scalable Vector Graphic (SVG) and Postscript files.   

To Export a Sky Chart in PDF, SVG or Postscript Format 

1. Select the desired option from the Format list. 
2. Click the Export button.  
3. On the Export Chart dialog, enter the file name to save the chart in this format. 
4. Click Save. 

 
 
Click the Create Bitmap tab (or, from the main menu, click the Export command from 
the File menu) to view the options for saving Sky Charts as bitmaps or pixmaps.  Click 
the Copy Sky Chart button to copy the current chart to the Clipboard.  Click the Save As 
button to save the chart as a Portable Networks Graphics (PNG) file. 
 
Turn on the Create Custom Size checkbox to specify the Resolution, in dots per inch 
(DPI), Width and Height, in inches, of the bitmap.   
 
If you want to create high-resolution star charts for publication,  individual “layers” of 
the chart can be exported by turning on the desired checkboxes in the Chart Layers tab. 
 
Clicking the Print button on the Print Chart tab sends the chart to the currently selected 
printer.  TheSkyX uses the current Map Like display settings (page 146) and prints stars in 
black, leaving the sky white.  The size of the star is proportional to its magnitude.  Non-
stellar objects are also printed using the symbols that appear in the Map Like Sky Charts. 
 
You can choose the orientation of the printout and other printing parameters by clicking 
the Page Setup button.  When you’re ready to print, simply click the Print button. 
 
The best time to start learning the sky is a clear, cloudless night, when there is no Moon 
or at most a crescent Moon.  Moonlight can interfere as much as city lights when it comes 
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to seeing the stars, and if the Moon is close to Full, you probably won’t be able to find 
any but the very brightest stars and planets.  You also want to be in an open space, a 
place where there are no tall buildings, trees, or annoying artificial lights to interfere with 
your viewing.  Make sure in particular that you have a clear view to the north. 
 
When you get to your observing site, give your eyes at least a few minutes to adapt to the 
darkness.  You’ll need a flashlight to read the chart of course, but you should use one that 
has a red filter.  These can be bought at most stores that sell telescopes, or you can simply 
tape a piece of transparent red film over a standard flashlight.  Using only red light will 
help preserve your night vision.  If you take your computer outside with you, the Display 
> Show Night Vision Mode command will help preserve it, too. 

An Interstellar Perspective 

Our Sun is but one of billions of stars in the Milky Way galaxy.  For centuries, 
astronomers have been charting the positions of other stars in our galaxy, and have 
accurately determined the distances to many thousands of them.  This information allows 
us to step outside our solar system, in effect, and see what the Sun and other stars in our 
part of the galaxy would look like from dozens of light years away. 
 
The constellations are only figments of our imagination.  A constellation’s stars may 
seem to be close together, but are usually very far apart and often have no mutual 
relationship at all.  (Except for being part of the same galaxy, the Milky Way.)  The sky 
looks flat because there are no reference points to help us perceive the distance to the 
stars with just our eyes.  Since the human mind is pretty good at creating order from 
random patterns, seeing pictures in the sky is no surprise.  TheSkyX has a 3D stars tool 
that can help you to understand the spatial relationship between stars that we see at night.   

Viewing the 3D Star Map 

Selecting 3D Stars command from the Tools menu will bring up the 3D Stars window.  
Immediately upon opening the window, the viewer will pan across a 3D rendering of the 
heavens, with the position of our Sun marked in the center.  Click and drag on the star 
field to get a feel for the nature of the 3D space. 
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Figure 53: The 3D Stars window. 

3D Star Map Controls 

On the left, you will see the controls that operate the 3D Stars tool.  On the top, you will 
see a slider that allows you to view visible stars from those relatively nearby to those 
quite distant.   
 
The bottom slider, labeled Viewing Distance from the Sun, ranges from 1 to 2,000 light 
years.  A light year is a fundamental “cosmic yardstick” used to describe the distance to 
the stars.  One light year is equal to the distance that light travels in one year.  Since light 
travels at approximately 300,000 kilometers per second in a vacuum, then a little math 
tells us that a light year is equal to about 9.5 trillion kilometers: that’s pretty far!  Another 
interesting fact about light years is that the number of light years distant an object is tells 
us how long it takes light to arrive here from that object.  So, if an object is 2,000 light 
years away, that means it took the light we see from that object 2,000 years to reach us.  
Also, it means that we see that object, not as it exists today, but as it existed 2,000 years 
ago.  The further we look out into space, the further we see back in time. 
 
Using the Filter Stars by Distance from the Sun slider will allow you to see the general 
stellar structure of our galaxy by displaying stars up to 2,000 light years away from our 
home solar system.  Using this can help you to get a feel for the relative distance of many 
stars, including well-known favorites, such as Betelgeuse and Rigel in the constellation 
Orion.  Notice that the number of stars that disappear grows as you move the slider to the 
left, meaning that most of the stars we see at night are quite close to us, relatively 
speaking. 

Viewing a Single Constellation 

If you would like to focus on a single constellation, you can do that, as well.  Using the 
Show constellation pop-up menu, select a constellation; you can choose from any of the 
88 official astronomical constellations.  Let’s use the functions of the 3D Stars tool to 
explore the region around a famous constellation, Orion, the Hunter. 
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1. Choose Tools > 3D Stars. 
2. Select Orion from the Show constellation drop-down menu.  You will now 

see the constellation of Orion, the Hunter in the viewer, surrounded by the 
constellation boundary box.  These boxes are used by astronomers to describe 
regions of the sky found near the 88 constellations. 

3. Check Show common star names to show the names of the more “famous” 
stars, the A-listers, if you will.  In Orion, the stars of his shoulders, knees, and 
belt are labeled, as well as the brightest star of his head. 

4. Use the Filter Stars by Distance from the Sun slider to hide or reveal stars 
based upon their distance from the Sun.  Move the slider to the left, and take 
note of when each star in Orion disappears. 

5. Now, using the Viewing Distance from the Sun slider, adjust the distance 
back and forth and observe the effect on the constellation’s appearance. 

6. Try sliding the same slider about one-quarter of the way to the right.  Then, 
click and drag on the constellation.  You will see an exploded view of Orion’s 
stars through 3D space.  This gives you a great view of the relative distance of 
each of Orion’s stars.  Experiment with various viewing distances to get a feel 
for how it works. 

7. Use the Filter Stars by Distance from the Sun slider to see an excellent 
demonstration of each star’s distance, as they appear and disappear, based 
upon their distance. 

 
Experimenting with the sliders and with different constellations will serve to give you a 
good grasp on relative stellar distances.  The next time you look up at Orion, think about 
space in 3D and the vast distances over which that light travelled to get to your eyes. 

Closer to Home: Atmospheric Phenomena 

As we mentioned earlier, some of the most interesting things we can see in the sky are 
happening right above our heads, in the upper atmosphere.   

Meteors and Fireballs 
You’ve probably seen a so-called shooting star (maybe you’ve even wished on one).  A 
shooting star isn’t really a star at all, but a grain of space dust.  When one of these 
particles hits our atmosphere, it’s traveling at tens of thousands of kilometers an hour.  
Friction makes it glow white hot, turning it into a meteor.  It may seem surprising that a 
speck of dust at the edge of space could create a streak of light visible from the ground, 
but even the brightest meteor is rarely bigger than a pea. 
 
The flying dust grains that cause meteors mostly come from the tails of comets.  Several 
tons of this material falls to Earth every single day.  If you get away from the lights of the 
city and watch the sky on a moonless night for an hour or two, you’ll see at least a few 
meteors – maybe quite a few.  They’re falling everywhere, all the time. 
 
Once in a while something much larger than a speck of dust falls to Earth and creates a 
spectacular fireball.  Fireballs can blaze across the sky with such intensity that they 



TheSkyX Professional and Serious Astronomer Edition User Guide 
 

104 

literally light up the landscape.  They can range in size from a few centimeters to several 
meters.  Bits and pieces of them sometimes survive the fiery descent through our 
atmosphere and crash into the ground.  These fragments are called meteorites.   
 
Meteorites are chunks of asteroids and they fall into three main categories, based on 
chemical composition.  Iron meteorites are the most commonly found because they are 
very distinctive, consisting of ninety percent iron with a bit of nickel mixed in.  They are 
extremely dense, and have magnetic properties.  
  
Stony meteorites look more like common rocks.  They are the most common form of 
meteorite but aren’t found as often as iron meteorites for two reasons: they look like 
ordinary, everyday Earth rocks, and they can’t be located using a metal detector. 
 
The third class is the stony irons, which, as the name suggests, are a mixture of the iron 
and stony types. 
 
A few people around the world make a good living hunting and selling meteorites.  A 
decent-sized specimen can be worth thousands of dollars to a museum or a private 
collector.  A really big meteorite with an unusual composition can be worth millions.  
Something to think about next time you see a fireball… 

Meteor Showers 
The dust trails left by comets that have visited the inner solar system follow predictable 
orbits around the Sun.  Several times a year Earth passes near one of these cosmic debris 
trains, resulting in a meteor shower.  Halley’s comet, which has a 76-year orbit, is 
responsible for two annual meteor showers, the Eta Aquarids in early May, and the 
Orionid shower in mid-October. 
 
Have you ever looked at a set of railroad tracks and noticed, as they stretch into the 
distance, how they seem to converge to a single point?  A similar effect can be seen 
during a meteor shower.  The debris “train” of the shower’s parent comet follows the 
tracks of an imaginary railroad.  If you pay attention to the direction most of the meteors 
in a particular shower seem to be coming from, they all converge back to the same point 
in the sky – the “vanishing point” of the tracks of the debris train.  This is called the 
radiant.  TheSkyX plots the radiant for all annual meteor showers and estimates the date 
and time they are expected to peak. 
 
To display meteor shower radiants, select the Chart Elements tab from Display menu.  
Within the list of elements, there is an item called Reference Objects.  Click it, and a new 
list of items is displayed.  Check the box next to Meteor Shower Radiants. 
 
The radiants for all meteor showers will now be displayed on the Sky Chart.  If you move 
the cursor to the center of any radiant, details on that shower, including when it is 
expected to peak, will be displayed.  
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The Northern (and Southern) Lights 
The Northern Lights, or aurora borealis, can be as stunning as any fireworks display.  
They appear as curtains of colorful, shifting light, suspended high up in the night sky.  
Unfortunately, they are generally only visible from high latitudes, and when they might 
occur is notoriously hard to predict.   
 
Auroral displays are caused by charged particles from the solar wind striking the Earth’s 
upper atmosphere.  Our planet’s magnetic field guides these particles toward the poles, 
which is why auroras are only visible from high northern and southern latitudes (the 
auroral light show is called the aurora australis in the southern hemisphere). 

Our Celestial Backyard: The Solar System 

Our Sun is one of countless stars in the universe.  The planets that circle the Sun are its 
family, figuratively speaking, and it would be hard to deny that Earth is its favorite child.  
The planet we call home is located at just the right distance to be neither too cold nor too 
hot for liquid water and life to flourish on its surface.  But the rest of the Sun’s family – 
the solar system – is full of diverse and fascinating characters.  Some of them may once 
have harbored some form of primitive life.  These bodies are much, much closer than 
even the next nearest star, and so astronomers like to say they inhabit our celestial 
backyard. 
 
Finding a planet in TheSkyX is simple.  Simply go to the Edit menu and choose Find.  
Type the name of the planet in the Search For box.  Information about the planet will be 
displayed.  You can center the planet in the Sky Chart by clicking the Center button near 
the bottom of the screen.  Note that this same procedure applies to every object in 
TheSkyX’s database.  If you’re unsure of an object’s name or catalog number, click the 
Advanced button to view a comprehensive list of searchable objects. 

The Moon 

The most familiar object in the night sky is undoubtedly the Moon.  It’s been Earth’s 
constant companion for more than four billion years.  Scientists believe that the Moon 
was formed shortly after the birth of the solar system, when a molten planet about the 
size of Mars smashed into the Earth.  That planet is no longer around, but much of the 
fallout from its impact settled into orbit around us and aggregated into the Moon. 
 
The Moon is tidally locked to the Earth.  Our gravitational pull, over millions of years, 
slowly put the brakes on the rotation of our satellite.  Today the Moon makes one 
complete rotation for every single orbit it makes around the Earth.  Because of this, the 
same side of the Moon always faces the Earth.  We had no way of seeing the far side of 
the Moon until spacecraft were sent there in the late 1950’s.  Some people mistakenly call 
the far side of the Moon the dark side of the Moon.  With all due respect to Pink Floyd, 
the Moon has no “dark” side.  Over the course of a lunar day (about 29.5 Earth days) the 
far side of the Moon gets just as much sunlight as the side facing us. 
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As the Moon orbits the Earth, it goes through its familiar phases, from New to Full and 
back again.  TheSkyX can tell you the phase of the Moon on any date, at any time.  It is 
automatically displayed on the star chart in its current phase and proper location 
whenever it is above the horizon.  The orbit of the Moon is not a perfect circle, but an 
ellipse, meaning it has an oval shape (in fact, all orbits, from artificial satellites to planets 
to stars circling the centers of galaxies, are ellipses).  TheSkyX will tell you the current 
distance between the Earth and Moon. 
 
The Moon is one of the most interesting things to look at in binoculars or a telescope.  
Even a little magnification will reveal the larger lunar craters, and help you see the mare, 
the so-called lunar “seas,” which are really cooled lava basins.  The Moon has no 
atmosphere, so liquid water cannot exist there.  Our single natural satellite is dry as a 
bone, but there is some evidence that small amounts of water ice might reside in the 
permanently shadowed craters near the Moon’s poles. 

Moon Photo Viewer 

TheSkyX includes a detailed map of the Moon based on photographs taken by a spacecraft 
called Clementine.  Clementine was launched into space on a converted intercontinental 
ballistic missile – a Cold War sword was turned into a lunar plowshare that yielded a rich 
scientific harvest, giving scientists important new information on the morphology (shape) 
and mineralogy of the Moon. 
 
To access the Clementine Moon map, go to the Tools menu and choose Moon Photo 
Viewer.  Your lunar journey begins with a photo showing the region near the feature 
Tranquillitatis, better known as the Sea of Tranquility.  As you move the mouse cursor 
over the photo, different features are highlighted in red, and the Moon’s longitude and 
latitude are shown to the left.  (To highlight larger features, place the cursor near its 
center.) 
 

 
Figure 54: Moon Photo Viewer window. 
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You can use the Sky Chart’s Moon with the Moon Photo Viewer to locate a particular 
feature in a photo on the Earth-based view of the Moon.  Or, you can click on the Sky 
Chart’s Moon to show the photo of that region. 
 
Do to so, first position the Moon Photo Viewer window so that the Sky Chart is also 
visible on your screen.   
 
Lock On and Frame the Sky Chart’s Moon 

1. Clicking the Find command from the Edit menu. 
2. On the Find window, type Moon and then click the Lock On button. 
3. On the Find window, click the Frame button. 

 
Figure 55: The Sky Chart Moon showing the position of the current Clementine photo (red 

rectangle) and the Moon grid lines. 

The Moon is now fixed to the center of the Sky Chart.  Make sure that the Highlight 
Region on Sky Chart’s Moon checkbox is turned on (page 108).  You can now click on 
the Sky Chart Moon to show the photo of that region on the Moon Viewer window.  Or, 
you can change the Moon Viewer Photo by clicking the Left/Right/Above/Below buttons 
and the Sky Chart’s Moon will highlight this region in red. 

Label Moon Features 

A number of interesting lunar features can be labeled on the Clementine photos, 
including: 
 

• Craters 
• Sub-craters 
• Mare (lunar “seas”)   
• Landing Sites 
• Catena (crater chains)   
• Rima (rilles)   
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• Lacus (lakes)   
• Mons (mountains)   
• Dorsum (wrinkle ridges)   
• Promontor (promontories)   
• Vallis (valleys)   

 
Turn on the Show Moon Features checkbox to display the selected features.  The Turn 
All On and Turn All Off buttons can be used to show or hide all features. 

Feature Information & Mouse Coordinates 

Placing the mouse cursor over the photo reveals additional information, including the 
precise lunar latitude and longitude and details about the feature.  When the Show Crater 
Outlines checkbox is turned on, the crater beneath the mouse cursor is also highlighted in 
red. 

Show Adjacent Photo 

Press the Left/Right/Above/Below buttons to navigate the Moon’s surface. 
 
As you scroll around, you might notice black rectangular regions on some photos.  These 
show areas where no photographic data was acquired during the survey. 

Options 

The Moon Viewer window offers the following display options.  

Show Crater Outlines 

Turn on the Show Crater Outlines to display yellow circles around the craters on the 
photos.   

Show Grid on the Sky Chart’s Moon 

Turn on Show Grid on the Sky Chart’s Moon to show lines of latitude and longitude on 
the Sky Chart’s Moon.  

Highlight Region on Sky Chart’s Moon 

Turn on this checkbox to show the location of the current photo on the Sky Chart’s 
Moon.  You can also click anywhere on the Sky Chart Moon to show the Clementine 
photo for that area. 

Show High-Resolution Photos 

Turn on this checkbox to show 100-meter resolution Clementine photos in TheSkyX 
Professional Edition.   
 
Setting the Moon’s Font  
The font used to label Moon features on the Clementine photos is the same font used to 
label the Sky Chart’s Moon.  If you wish to change this font, edit the Moon’s font 
attributes from the Chart Elements window (page 136) . 
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The Classical Planets 

Not counting Earth, five planets are visible to the naked eye.  It has been known since 
ancient times that the planets slowly change position relative to the stars, which appear to 
be fixed, never moving with respect to each other from year to year.  In fact, the word 
planet derives from an ancient Greek term that means “wanderer.” 
 
All planets in our solar system orbit the Sun (you probably know that the Sun is a star, 
not a planet).  Their orbits lie more or less in the same plane, so as they circle the Sun, 
their paths are restricted to a narrow band in our sky, which is called the ecliptic.  The 
constellations that lie in this plane received special attention from ancient astronomers.  
Collectively they are known as the Zodiac constellations. 
 
The farther a planet is from the Sun, the longer it takes to complete a single orbit.  Planets 
farther from the Sun therefore move more slowly through the Zodiac.   
 
TheSkyX can locate any planet wherever it happens to be on a given night.  Below we 
describe some general features of the planets, starting from the closest in, then moving 
out to the edge of the solar system. 

Mercury 

Mercury is the closest planet to the Sun.  It takes only 88 days to travel around the Sun 
once.  This is another way of saying that a year on Mercury is 88 days long. 
 
Because Mercury is so close to the Sun, it can be spotted only shortly after sunset and 
shortly before sunrise, when it is near the “edge” of its orbit from our perspective.  It is 
hard to see much surface detail on Mercury in even the most powerful telescope, but the 
Mariner 10 spacecraft made three “fly-bys” of Mercury in 1974 and 1975.  Pictures from 
that spacecraft revealed Mercury strongly resembles our Moon, with a heavily cratered 
surface.  It is comparable to our Moon in size, but much denser.  Being so close to the 
Sun, the surface of Mercury is very hot, as you would expect.  The average daytime 
temperature there is above 400º C. 

Venus 

Commonly known as both the morning and the evening “star,” Venus is the brightest 
natural object in the sky after the Sun and Moon.  Its beautiful radiance has dazzled 
mankind throughout history.  Venus is so bright that, from a very dark location, it can 
cast shadows. 
 
When astronomers first eyed Venus through telescopes, they discovered that the planet is 
perpetually enveloped in clouds.  They never part, keeping the surface of the planet 
forever shielded from direct view.  This fact led to a great deal of fevered speculation 
about what might be hidden beneath those relentless clouds.  Could Venus harbor steamy, 
tropical rainforests, inhabited by alien dinosaurs or even more exotic forms of life?   
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Much to the disappointment of science fiction writers, astronomers discovered in the 
early 1960’s that the surface temperature of this deceptively serene-looking planet is hot 
enough to melt lead.  Venus is a hellish, uninhabitable desert.  The reason for this is a 
runaway greenhouse effect.  The Venusian atmosphere is almost entirely carbon dioxide 
(CO2), a gas notorious for its effectiveness at trapping heat.  The fact that high 
concentrations of CO2 have raised the surface temperature of Venus so far above what we 
would otherwise expect is one reason some worry about rising CO2 levels on our planet.  
If Venus had the same mix of nitrogen and oxygen in its atmosphere as we have in ours, 
it would almost certainly be a lovely place to spend your vacation. 
 
When Galileo began to systematically observe Venus with his telescopes, he discovered 
it goes through phases like the Moon.  This helped convince him that the Sun, not the 
Earth, is the center of motion in the solar system.  Venus, like Mercury, is an “inner” 
planet, meaning that they lie closer to the Sun than we do.  This is why these planets are 
visible only in the early evening or pre-dawn skies – from our location in the solar 
system, they never appear to travel very far from the Sun. 

Earth 

Earth is the third planet from the Sun.  Scientists sometimes refer to Earth as the Water 
Planet because more than 70 percent of our surface is covered by liquid water, and water 
is essential for life.  Our world is the only planet in the solar system that can support life 
as we know it. 
 
A day is defined as the amount of time it takes for Earth to make one complete rotation 
on its axis.  A year is defined as the time it takes Earth to make one complete orbit of the 
Sun.  The length of a day and year are different on other planets because they rotate at 
different rates and have different orbits. 
 
The axis about which our planet turns is tilted relative to the plane of our orbit.  This is 
why we have seasons.  In the summer, our northern hemisphere is tilted toward the Sun, 
so the days are longer, and sunlight strikes the Earth more directly, making the northern 
hemisphere warmer (the opposite is true in the southern hemisphere) than it is in winter.  
In the wintertime, our northern hemisphere is tilted away from the Sun.  The days are thus 
shorter and colder (again, the opposite is true in the southern hemisphere).   
 
A solstice occurs when our axis is tilted directly toward or away from the Sun.  The 
winter solstice is the shortest day of the year, and the summer solstice is the longest 
(depending on your latitude, this may or may not correspond to the times of earliest 
sunrise and latest sunset – the explanation is a little more complicated than what we’re 
prepared to discuss here).   
 
An equinox occurs when the center of the Sun is directly above the Earth’s equator.  
There are two of these each year, one in spring (the vernal equinox) and one in fall (the 
autumnal equinox).  Equinox is derived from Latin and means “equal night.”  During an 
equinox, night and day are both just about 12 hours long. 
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Like all planets, the orbit of the Earth is not perfectly circular, but slightly elliptical.  The 
Earth is about a million kilometers closer to the Sun in December than June. 

Mars 

The next planet out from the Sun is Mars.  It is about half the size of our planet and takes 
a little more than two years to go around the Sun once.  Mars is very similar to Earth in 
two important ways.  Its day is just over 24 hours long, and its axis of spin is tilted about 
23 degrees, almost exactly the same tilt as Earth.  This means that Mars has seasons, just 
like we do.  But they last twice as long, since a Mars’ year is about twice as long as one 
of ours (687 Earth days, to be more precise). 
 
Like Venus, the atmosphere of Mars is almost entirely CO2.  Unfortunately it is an 
extremely thin atmosphere, about 1/100th the pressure of our atmosphere at the equivalent 
of Martian sea level.  During the day, the surface temperature of Mars near the equator 
can rise above freezing, but that same night it will drop well below –100º C.  A little 
more greenhouse effect on Mars would be a welcome thing.  As it is, the air on Mars is 
too thin to support liquid water on its surface, another blow to all those science fiction 
writers who imagined alien beings and ancient civilizations on Mars. 
 
Still, Mars is the only other planet in our solar system whose surface is directly accessible 
to astronauts.  Even though liquid water can’t exist on Mars today, there is lots of 
geological evidence to suggest that in the distant past, the atmosphere of Mars was much 
thicker, and water flowed there freely.  This gives scientists hope that Mars may have 
once harbored simple forms of life.  If life did thrive there in the distant past, it may still 
survive today, perhaps in small “oases” deep underground, where organisms would be 
protected from the harsh conditions on the surface. 
 
The best time to look at Mars in a telescope is during an opposition.  About every 26 
months, Mars and Earth line up on the same side of the Sun.  This is when Mars is at its 
brightest and closest, and therefore appears at its best in a telescope.  TheSkyX can 
calculate the dates of future oppositions and even tell you how large, in arcseconds, the 
disk of Mars will appear in an Earth-bound telescope. 
 
As Mars approaches opposition, it briefly exhibits retrograde motion.  This is a fancy 
way of saying that Mars looks like it turns around and moves backward in the sky for 
several days.  This is simply a trick of perspective.  As our two planets orbit the Sun, 
Earth catches up to and passes Mars.  When we pass, Mars appears to move backward 
with respect to the far more distant stars. 
 
Looking at Mars through a telescope, the first thing an observer usually notices on the 
disk of the planet are the albedo features.  These are bright and dark markings that mostly 
correspond to variations in the coarseness of Martian surface dust.  They were first 
systematically charted and named by the Italian astronomer Giovanni Schiaparelli in the 
19th century.  He mistakenly believed that the dark features were seas and lakes, and he 
used the Latin terms mare and lacus accordingly.  Today we know there is no surface 
water on Mars, but like Earth, the Red Planet does have polar caps.  Unlike our polar ice, 
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they are made not just of frozen water but carbon dioxide or “dry ice” as well.  During an 
opposition, you can usually glimpse either the northern or southern cap in a small 
telescope.   
 
There is a huge difference between seeing Mars in a telescope and looking at images of 
Mars taken by orbiting spacecraft.  Beginning with the Mariner 4 fly-by in 1965, 
American, Russian, and European spacecraft have revealed Mars to be a world of 
geological wonders.  Huge craters, towering volcanoes, and immense systems of canyons 
mark and etch its surface. 
 
Mars is orbited by two small moons, named Phobos and Deimos (ancient Greek words 
for fear and terror, respectively).  They are much smaller than our Moon, irregularly 
shaped, and difficult to see in most amateur telescopes.  Some scientists believe these 
moons are actually wayward asteroids. 

The Asteroid Belt 

A ring of interplanetary debris circles the Sun between the orbits of Mars and Jupiter.  
These rocky fragments are thought to be remnants from the original disk of material that 
formed the planets.  The gravity of Jupiter prevented these bodies from aggregating into a 
planet in their own right.  There are literally millions of asteroids, but collectively their 
mass is only about 1/10 the mass of our Moon. 
 
Ceres is the largest asteroid, and the first to be discovered back on New Year’s Day in 
1801.  TheSkyX does not include asteroids in its main database, but you can add 
information on asteroids through the Input  > Small Solar System Bodies menu. 

Jupiter 

Jupiter is the king of the planets.  Ten times wider than Earth, it has more mass than all of 
the other planets in our solar system combined.  Nearly a billion kilometers from the Sun, 
it takes twelve years to complete a single orbit.   
 
Jupiter has a family of dozens of moons of various sizes and shapes, forming, in effect, a 
“mini” solar system.  At last count, astronomers have charted over 60 moons orbiting this 
giant world.  Many of these bodies are small as a typical asteroid (some of them might 
even be asteroids that were captured by Jupiter, caught like flies in its gravitational web). 
 
Jupiter is attended by four large moons comparable in size to our own Moon.  Because 
they were discovered by Galileo when he first turned his telescope on Jupiter in 1609, we 
call them the Galilean satellites. 
 
TheSkyX includes telescope and spacecraft images of Jupiter, and can plot the orbits of its 
Galilean satellites.  This is a particularly useful feature if you have a telescope.  The 
moons shift position night to night as they orbit Jupiter, and you can track these motions 
with a modest telescope, or even a good pair of binoculars.  Also, when a Galilean moon 
passes in front of Jupiter, it casts a shadow on the disk of the planet that can be observed 
in small telescopes.  These shadow transits are fascinating to observe, and TheSkyX can 
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tell you when they will occur.  It also provides timings for another interesting 
phenomenon involving Jupiter’s moons, an occultation.  These occur when one of the 
moons enters the giant planet’s shadow and passes behind it.  Interesting Historical Note: 
by timing the occultations of the Jovian moon Io, the astronomer Ole Romer was able to 
make a rough estimate of the speed of light way back in 1676. 

Saturn 

Author’s comment: I’ll never forget the first time I saw Saturn through a telescope.  I 
was 11 years old.  The telescope was small enough to fit in a lunchbox, but it was made 
by an extraordinary man named Max Bray, and was more than a match for Saturn.  In 
the eyepiece, I saw a small white disk nestled inside a perfect set of white rings.  It took 
my breath away.  Everyone I know who has ever seen Saturn in a telescope remembers it.  
The most fun I’ve ever had in over three decades of being involved in astronomy is 
showing someone Saturn in a telescope for the first time.  The planet is best known of 
course for its extraordinary rings.   
 
Saturn takes nearly 30 years to complete one orbit around the Sun.  During this period, 
our view of the rings is slowly changing.  Sometimes they are spread relatively wide and 
are easy to see, but about every 15 years they line up edge-on to our view.  These “ring 
plane crossings” last a few days or so, and during this time all that can be seen of the 
rings is a dark, thin line crossing the disk of the planet. 
 
Like Jupiter, Saturn is attended by numerous moons of various shapes and sizes.  Titan, 
the largest, has a mostly–nitrogen atmosphere about one-and-a-half times thicker than the 
Earth’s. 

Going Farther 

Saturn is the farthest planet that was known to man in ancient times.  The invention of the 
telescope revealed innumerable new worlds never before seen by human eyes, including 
previously unknown planets in our own solar system. 

Uranus 

The seventh planet out from the Sun, Uranus is the first planet discovered by telescope.  
The astronomer William Herschel is credited with recognizing it as a planet over two 
hundred years ago, in 1781 (other astronomers had seen it, but mistook it for a star – 
Herschel initially thought it was a comet).  Like Jupiter and Saturn, it is a giant, much 
larger than Earth, and its atmosphere is mostly made of hydrogen and helium.  But there 
are also significant amounts of water, ammonia, and methane ice in this frigid world, and 
so astronomers refer to it as an Ice Giant. 
 
At a distance of almost 3 billion kilometers, Uranus takes 84 years to make a complete 
trip around the Sun.  Its axis of rotation is tilted 98 degrees to the plane of its orbit, as if 
the planet had been flipped on its side.  Like all of the giant planets, Uranus has an 
extensive family of moons, at least 27.  They are named after characters taken from the 
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works of Shakespeare and Alexander Pope.  The largest, Titania, is about half the size of 
Earth’s Moon. 
 
On a dark, moonless night, Uranus is just barely visible to the naked eye – if you have 
very sharp vision and know exactly where to look.  TheSkyX, of course, can tell you 
where to find it.  Uranus is relatively easy to find in a good pair of binoculars. 

Neptune 

The next planet out, Neptune, is similar in size and composition to Uranus.  It is also 
considered an Ice Giant.  The existence of Neptune was predicted by mathematical 
analysis of the orbit of Uranus.  Deviations in the predicted orbit of Uranus led 
astronomers to believe that some other large body farther out in the solar system 
periodically tugs at Uranus.  This theory was confirmed when Neptune was discovered 
close to its predicted position.   
 
In a telescope, Neptune appears cool blue in color.  It was first spotted by none other than 
Galileo, when it happened to be near Jupiter in the sky, but Galileo assumed that this faint 
blue object was a star, not a planet, and so he is not credited with its discovery. 
 
It takes Neptune over 184 years to make a single orbit of the Sun.  Discovered in 1846, it 
has yet to make a single orbit since it was first recognized as a planet.  It lies some 4.5 
billion kilometers from the Sun, and is attended by 13 diverse moons.  The largest, 
Triton, is 2700 kilometers in diameter, just a little smaller than our own Moon.  Triton 
orbits Neptune in a retrograde orbit, which means that it travels backwards relative to the 
direction of rotation of Neptune itself.  This suggests that Triton did not form with 
Neptune, but came into being somewhere farther out in the solar system and was later 
captured by Neptune’s gravity. 

Pluto and the Ice Dwarfs 

We all used to be taught that there are nine planets in the solar system.  That is no longer 
the case.  Pluto has been demoted.  Today it is not considered a full-fledged planet, but an 
ice dwarf, one of perhaps hundreds of such objects that inhabit the outer reaches of the 
solar system. 
 
Many people, including a lot of astronomers, are unhappy that Pluto has lost its status as 
a planet.  Controversy is still raging over the decision to reclassify it.  If you’re 
wondering who gets to decide whether or not Pluto is a planet, the authority rests on a 
group called the International Astronomical Union  (IAU).  Founded in 1919, the IAU 
has some 10,000 members, all professional astronomers.  Its main purpose is to promote 
and protect the science of astronomy internationally, but it also has sole authority for 
classifying and naming astronomical objects.  Despite some groups that claim otherwise, 
you cannot have a star named after yourself or a loved one without going through the 
IAU. 
 
During their August, 2006 meeting, the IAU membership voted on a new, more rigorous 
definition of a planet that had been developed by one of its working groups.  This new 
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and improved classification scheme included the category “dwarf planets”  to cover 
objects in our solar system that had recently been discovered beyond the orbit of Pluto.  
Unfortunately for Pluto fans, it perfectly fits the new category, hence the demotion. 

Land of the Comets: The Kuiper Belt and the Oort Cloud 

One of the most beautiful things you’ll ever see in the sky is a bright comet.  Comets are 
refugees from the outer fringes of the solar system.  Mixtures of ice and dust, the 
astronomer Fred Whipple famously described comets as “dirty snowballs.” 
 
Astronomers believe that most comets spend their lives in either the Kuiper Belt or the 
Oort Cloud.  Named for the astronomers who first theorized their existence, these regions 
of space, far beyond the orbit of Pluto, are thought to be repositories of matter left over 
from the formation of the solar system. 
 
A gravitational nudge from a nearby star or a passing cloud of interstellar dust can send 
an object from this region careening into the inner solar system.  When a comet gets close 
to the Sun, its ice begins to sublimate.  The escaping gas and dust form the coma and tail 
that give comets their distinctive appearance. 
 
Most comets are unexpected strangers to our part of the solar system, but some have 
settled into predictable, short-term orbits.  Halley’s Comet is probably the most famous 
example.  TheSkyX charts the orbits of several periodic comets.  Most of them can only 
be seen on rare occasions with a telescope, but you never know when a new comet will 
be discovered and grace our sky in spectacular fashion, as comets Hyakutake and Hale-
Bopp did in the late 1990’s. 
 
You can also enter the orbital elements of newly discovered comets into TheSkyX 
database using the Input > Small Solar System Bodies command.  The position of the 
comet from night to night can then be displayed in the Sky Chart.  Orbital elements can 
be downloaded from Harvard University’s Center for Astrophysics website. 

A 3D View of the Solar System 

Planetary motion is complex.  It took humans thousands of years to figure it all out.  
Fortunately for us, computers make the tough math a breeze, and they allow us to create 
useful simulations of the motions of solar system objects. 

Modeling Planetary Motion 

The planets move in predictable orbits about the Sun, and with the easy-to-use Solar 
System Tool, you can model their positions and motions with ease. 

The Planets 

For a 3D solar system simulation including the eight classical planets, plus Pluto, select 
Solar System from the Tools menu.  A window then opens showing the solar system 
simulator.  On the right, you see the simulation.  You can click and drag on the simulated 

http://www.minorplanetcenter.org/�
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solar system to change the orientation and view it from varying angles.  Time can also be 
moved forward or backward using the Time Skip item in the Tools menu, or the 
corresponding toolbar buttons.  Alternately, you can adjust the time using the Date and 
Time item in the Input menu. 
 
On the left are the menus and controls that affect what you see in the simulator.  There is 
a slider that lets you control the viewing distance from 1 to 50 A.U., or astronomical 
units.  An astronomical unit is a basic unit of distance used to describe the distance 
between objects within the solar system.  One A.U. equals the average distance from the 
Earth to the Sun, about 150 million kilometers.  Try out the distance slider to get a feel 
for how it works. 
 
There are also checkboxes used to toggle on or off the ecliptic grid, orbit depths, and the 
background stars. 

Small Solar System Bodies: Comets 

Small solar system bodies include comets and asteroids.  TheSkyX can display the orbits 
of these objects in the solar system simulator.  By default, there are none available to 
show, so you will have to download some from the internet.  Let’s start by downloading 
some comet data  
 

1. With the Solar System window open, select Input > Small Solar System 
Bodies.  A new window appears with three tabs at the top, Comets, Asteroids 
(Small Database), and Asteroids (Large Database).  Select the Comets tab. 

2. A window opens labeled Comets Available for Display.  Here, you will see 
the total number of comets available for display, as well as a list of their 
names with checkboxes.  It is with these checkboxes that you can toggle 
comets on or off in the Sky Chart or in the solar system simulator. 

3. You have three options for importing comet data into TheSkyX.  You can 
import them from an existing file, or you may download comet data directly in 
TheSkyX using internet databases.  You may download individual comet data 
by name, or you can download all the data for all observable comets at once.  
For our example, let’s download all observable comets at once.  To do this, 
simply click Observable. 

4. The data will then download, and the observable comets will now appear in 
the list above, on the Sky Chart, and in the solar system simulator. 

 
Note: Be sure that your computer is connected to an active internet connection before 
attempting to download comet data. 

Small Solar System Bodies: Asteroids 

The process is very similar when downloading asteroid data from the Asteroids (Small 
Database) tab.  There, you can choose to import asteroid data from an existing file, by 
orbital characteristic, such as distant, critical, or unusual, or you may import by asteroid 
name. 
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Should you decide to import asteroids from the Asteroids (Large Database) tab, you will 
have to visit one of the websites provided and download a file with the desired data.  You 
can then select the file with the Choose button to reveal the asteroids in the Sky Chart 
and solar system simulator.  Additionally, the checkboxes you see under the Asteroids 
(Large Database) tab toggle important display options such as computing asteroid 
positions at startup and 24-hour object paths for imported asteroids. 

Eclipses 

One of the most spectacular phenomena in nature is a total eclipse of the Sun.  If you’ve 
seen one, you’ll never forget it, and chances are you’ll want to see as many as you can in 
your life.  TheSkyX can predict eclipses literally thousands of years in the future.  It can 
tell you where the eclipse will be visible and how long it will last, so naturally it’s a great 
tool for planning a trip to see one of these extraordinary events. 
 
There are three kinds of solar eclipses: total, annular and partial.  In a total eclipse, the 
Moon passes in front of and completely covers the disk of the Sun, making it possible to 
see the Sun’s corona, its extended atmosphere, and eruptions of surface plasma called 
prominences.  This is truly a unique coincidence: the Sun is 400 times bigger than the 
Moon, but the Moon is 400 times closer to the Earth, so in our sky, they have almost 
exactly the same angular diameter, about half a degree.  No other moon in our solar 
system can treat its home planet to a total eclipse. 
 
Similar to a total eclipse, an annular eclipse occurs when the Moon goes right in front of 
the Sun.  Due to differences in orbital positions, the angular size of the Moon is a bit 
smaller than the Sun.  At the peak of an annular eclipse, a ring or “annulus” of light 
appears around the Moon.   
 
In a partial eclipse, the Moon covers a portion of the Sun, so the corona and prominences 
aren’t visible.  Still, a partial eclipse can be fascinating to observe – as long as you use an 
appropriate filter to protect your eyes.   
 
The Solar and Lunar Eclipse Finder lists hybrid eclipses that include both total and partial 
eclipses during the event.  For example, the eclipse in April 2023 near Australia begins as 
an annular eclipse, becomes a total eclipse, then reverts to an annular eclipse. This type of 
eclipse is designated as Hybrid A-T-A. 
 
NEVER LOOK DIRECTLY AT THE SUN WITHOUT A SAFE FILTER!  You can 
instantly and permanently damage your eyesight by looking at the Sun without proper 
protection. 
 
Lunar eclipses occur when the Moon passes into the shadow of the Earth.  If the Moon 
orbited the Earth in the same plane as the Earth orbits the Sun, a lunar eclipse would 
happen every month, when the Moon is in its Full phase.  But because the orbit of the 
Moon is tipped about five degrees relative to the orbit of the Earth around the Sun, lunar 
eclipses only happen about once every eighteen months when the orbits are aligned. 
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You might imagine that when the Moon passes into our shadow it completely disappears, 
but it doesn’t.  Dust in our atmosphere scatters a little bit of sunlight into our planet’s 
shadow.  Because dust mostly scatters red light, the Moon typically takes on a dim red or 
copper glow during the total phase of a lunar eclipse.  How dark the Moon becomes 
depends mostly on how much dust happens to be in the air at the time of the eclipse.  One 
of the fun things about viewing a lunar eclipse is that you never know exactly what shade 
of red or how dark the Moon will appear. 

Viewing Eclipses 

Selecting Tools > Solar & Lunar Eclipse Viewer from the menu bar will bring up the 
Solar & Lunar Eclipse Viewer Window.   
 

 
Figure 56: The Solar and Lunar Eclipse Viewer window. 

In it, you will see a list of upcoming eclipses, a box displaying local circumstances for a 
selected eclipse, the eclipse viewer, and several checkboxes and sliders used to control 
the viewer. 

Solar Eclipse Viewing 

While using protective eyewear is certainly not necessary when viewing a solar eclipse in 
TheSkyX, the importance of using proper protection when observing the actual Sun at any 
time can never be overstated.  Experienced observers should consider the following 
guidelines when observing a total eclipse: 
 

i. get a proper eclipse viewing filter – do NOT improvise – and use it right up until 
the sky darkens rapidly, 

ii. enjoy the total phase naked eye as nature intended,  
iii. use the filter again as soon as the corona has been outshone by the diamond ring. 

 
In the eclipse viewer, solar eclipse paths are viewed on a three-dimensional Earth globe, 
showing the eclipse shadow’s path, rise and set curves, and umbral and penumbral limits. 
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To view a solar eclipse, scroll down the list near the top of the window and select a solar 
eclipse.  Immediately, you will notice that the eclipse viewer will update to show the 
pertinent data on the Earth globe.  A small green circle indicates your home position, as 
entered in the location section of TheSkyX.  Additionally, you will notice a black circle 
along with colored lines representing important data about the selected eclipse.  The 
following is a brief description of these markings. 
 
The Black Circle marks the umbral (darker) eclipse shadow as projected onto Earth.  
This is the region where eclipse totality is possible. 
 
The Yellow Line represents the line of central eclipse.  It shows the eclipse’s center line 
path over the globe.  Yellow Ovals at the beginning and end points of the yellow line 
represent the umbral rise and set curves 
 
The Grey Line represents the limits of the umbral shadow. 
 
The Red Lines show both the rise and set curves and the shadow limits of the penumbra 
(lighter shadow). 
 
The White Line marks the penumbral shadow on the Earth globe. 
 
All of these markers can be toggled on or off by using the checkboxes under Solar 
Eclipse Display Options on the lower left of the window. 
 
Once you have selected an eclipse from the list, you will notice that the Local 
Circumstances box now displays the local information regarding the eclipse, such as its 
local visibility, magnitude, start and end times, and moment of greatest eclipse.  Once an 
eclipse is selected, the Sky Chart automatically updates to display the eclipse from your 
selected location. 
 
Using the slider immediately below the Solar Eclipse Display Options, you can view the 
path of the eclipse in progress, ranging between its start and end points.  Simply slide it to 
the left to move toward the start point, and sliding it to the right will move toward the 
eclipse’s end point. 
 
Note:  Another way to move time is to click Go Forward in the toolbar.  Selecting an 
eclipse automatically stops time in TheSkyX, but by restarting it, you can watch the 
eclipse progress in the viewer in real time, or at any speed you choose. 
 
Below the eclipse start/end slider is the slider marked  Solar Eclipse Viewing Distance.  
With the slider all the way to the left, the eclipse viewer is set to view the globe from a 
perspective of one Earth radius away.  Slide the slider to the right, and you will gradually 
increase the viewing distance up to 50 Earth radii.  If you have a scroll-wheel mouse, you 
can adjust the viewing distance by moving the cursor over the viewer and rolling the 
scroll wheel up (for closer distance) or down (for farther distance).  Clicking and 
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dragging the mouse will rotate the globe, adjusting the angle at which the eclipse path is 
viewed. 
 
Note:  In case your view of the globe is cut off, this window is resizable by clicking and 
dragging on the lower right corner. 

Lunar Eclipse Viewing 

Also included in the eclipse list are lunar eclipses.  These are shown from the perspective 
of Earth’s surface in the Sky Chart.   
 

 
Figure 57: Lunar eclipse showing the umbra and penumbra (the light gray background above). 

 
By selecting a lunar eclipse from the list, the Sky Chart will automatically update to show 
the chosen eclipse.  Note that the Moon and penumbra and umbra of Earth’s shadow 
appear with labels.   
 
Looking at the Local Circumstances box will show the start date and time for the 
selected eclipse, as well as the maximum shadow coverage in lunar diameters.  As with 
solar eclipses, time is stopped when an eclipse is selected, but can be started again 
whenever you wish to view the eclipse in motion.  Using this tool, you can take note of 
shadow contact times when preparing for the exciting spectacle that is a lunar eclipse. 
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Artificial Satellites 

Before 1957, nothing made by human hands existed above our atmosphere.  But in that 
year, the Soviet Union launched the world’s first artificial satellite, Sputnik.  Since then, 
thousands of satellites have been launched into Earth orbit. 
 
TheSkyX downloads orbital elements or two line elements (TLEs) from the web to keep 
track of thousands of satellites and other orbital debris.  Using these numbers, TheSkyX 
can calculate where satellites will appear in the sky for any location on Earth.   
 
To manage which satellites are shown, click the Satellites command in the Input menu.   
 

 
Figure 58: The Satellites dialog (Satellites command from the Input menu). 

Satellite TLE data can be imported from the web or from a text file that contains the 
properly formatted data.  TheSkyX uses orbital element information from Space 
Command Center’s TLEs to predict and display satellites’ positions.  Two-line element 
data must be updated frequently and are available for most satellites on the web.   
  
Gravitational forces, among other things, constantly perturb the orbit of a satellite around 
earth, so its position is not precisely predictable over long periods of time.  TheSkyX 
automatically updates selected TLEs for your each time it is launched. 

Download Satellite TLEs from the Web (Import From Web button) 

Current satellite TLE data are retrieved from Dr. T.S. Kelso’s Celestrak web site. 
 
Clicking the Import from Web button shows the Import Satellites from Celestrak dialog. 
 

http://www.celestrak.com/�
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Figure 59: The Import Satellites from Celestrak dialog. 

Turn on the desired categories, then click the Download button to retrieve them from the 
web.  Importing all the satellites will most likely sap your computer’s processor, so 
choose wisely. 

Import from File 

TLE data residing in a text file, rather on the web, can be imported and displayed by 
clicking the Import From File button.  The text file must contain TLE data only.  For 
example, the TLE data for the GOES 2 satellite looks like this:  

   
GOES 2  
10061U 77048A 98127.50441330 .00000045 00000-0 10000-3 0 97472 10061 
13.1659 29.4732 0005723 183.8196 16.8163 1.00281760 21356  

Status  

The Status section shows the total number of satellites that were successfully loaded, the 
average age of the TLE data (the “newer” the better) and the number of TLEs that have 
been rejected because they are older than 45 days.   
 
Use the Advanced tab on the Find window to locate a particular satellite. 

Show Satellites  

When this option is turned on, satellite positions are computed and displayed on the Sky 
Chart.   

Show Satellites’ Paths 

Turn on this checkbox to draw a line on the Sky Chart that represents the upcoming path 
that the satellite will follow.   
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Length of Satellite’s Path (Length input) 

Enter the length of time, in minutes, of the satellites’ paths. 

Fun Example: Observing the International Space Station (ISS) 

Watching the International Space Station fly overhead is a truly exciting event.  TheSkyX 
can be used to predict when the ISS will travel overhead, and show you its path. 
 
To find the best passes for the ISS, do the following. 
 

1. Click the Satellites command on the Input menu.  
2. Click the Import From The Web button. 
3. Turn on the International Space Station radio button. 
4. Click the Download button. 
5. Click the Satellites From Above Earth button on the Satellites dialog (lower left 

corner of the window). 
6. Select ISS (ZARYA) from the list of satellites, then click the Find Best Passes 

button. 
 
A list of the times when this satellite is visible above the horizon is displayed.  Double-
click the items in the list to show the pass from an above-Earth perspective.  Turn on the 
Update Chart radio button to show the path on the Sky Chart. 

Iridium Flares 

Beginning in 1998, a network of sixty-six communication satellites called Iridium was 
launched into orbit.  At any given time, at least one of them is above the horizon for any 
location on Earth (not counting the territory around the north and south poles).  
Sometimes, as an Iridium satellite moves across the sky, sunlight bounces off its antennas 
and solar panels, creating a brief but brilliant Iridium flare.  TheSkyX can calculate when 
the next flare will be visible from your location (they only happen in early evening or 
shortly before dawn).  Click the Tools > Iridium Flares command to find the next flare 
that you can observe from your backyard. 
 
Choose the Iridium Flares command from the Tools menu. 
 

 
Figure 60: The Iridium Flares tab on the Satellites dialog (Tools > Satellites command). 
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Specifying the Type of Flare to Find (Search For pop-up menu) 

Flares can be located based on what time of day they occur.   
 

• Daytime Flares occur between sunrise and sunset 
• Nighttime Flares occur between sunset and sunrise 
• Dawn/Dusk Flares occur during the morning and evening hours 

 
Choose the All Flares item to search for flares that occur any time, day or night.   

Length of Time to Search (During the next) 

Enter the number of days from now to search for flare events.  Flare prediction involves 
some heavy duty computing, so you may want to limit the length of the search to less 
than a week so on slower computers. 

Minimum Height Above the Horizon (Above altitude)  

Mountains, trees or nearby buildings can hide flares that occur at lower altitudes.  Enter 
the lowest altitude that a flare can be seen from where you will be observing. 

Limiting Magnitude of Flare (Brighter than) 

Enter the magnitude of the faintest flare you want to find.  Faint nighttime flares are easy 
to spot; but if you’re looking for a daytime or evening flare, make sure to enter 
magnitude minus 2 or brighter (the lower the magnitude, the brighter the flare). 

Show Iridium Flare Paths 

Turn on this option to show a line on the Sky Chart that shows where the flare occurs and 
how long the flare lasts. 

Set Time to Now (Computer clock) 

This button resets TheSkyX’s date and time to the computer’s clock.   

Begin Searching for Flares (Find flares) 

Click this button to begin the search for flares.  Even a very fast computer requires a 
minute or more to locate all the flares for the next month. 

Iridium Flare Report 

The right side of the window shows a report containing the following information for 
each flare. 

• Local time when the flare begins. 
• Coordinated Universal Time when the flare begins. 
• Maximum magnitude of the flare. 
• The altitude and azimuth position at maximum magnitude. 
• The angle, in radians, between observer's line of sight and Sun, subtended 

at the satellite. 
• The name of the Iridium satellite. 
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• The mirror number on the satellite that is causing the flare and its angle. 
• The Julian date of the flare. 

 
Click a column header to sort the column’s contents from smallest to biggest (that is, an 
ascending sort).  Clicking a particular header more than once will invert the sort.  For 
example, clicking the Magnitude header once sorts the flares from brightest to faintest.  
Clicking it twice sorts from faintest to brightest (a descending sort). 

Simulating the Flare (Watch flare) 

Now the fun begins.  Clicking the Watch Flare button orients the Sky Chart so that the 
selected flare is visible near the center of the window.  If no flare is selected, the first 
flare in the report will be simulated.  A green laser pointer momentarily appears, showing 
you exactly where to look to view the start of flare.  They’re really easy to miss in the 
actual sky. 
 
The excitement builds as the satellite’s mirror begins to reflect the Sun’s light and grow 
brighter for the next few seconds.   
 
Now that you’ve seen a simulated flare, your goal is to go outside and actually observe 
the real thing.  Take your friends or family along; after viewing the flare, they’ll think 
you are an astronomy wizard. 

Satellites from Above Earth 

Often people who have not studied or practiced astronomy are amazed that many 
satellites are visible to the naked eye.  Most times, satellites are observed by chance when 
someone looks up and catches a glimpse of something moving among the stars.  TheSkyX 
has a useful tool that aids with satellite observation and can tell you not only when and 
where to look, but also the name and purpose of many satellites in the sky. 
 

 
Figure 61: The Satellites Above Earth tab (Tools > Satellites From Above Earth). 
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Review: Viewing Satellites and their Orbits 

To observe satellites, select the Satellites from Above Earth command from the Input 
menu.  If this is your first time using the satellites tool, there will not be any satellites 
listed, and you will have to download some satellite Two-Line Elements (TLE’s) before 
any satellite data can be shown.  You can think of a TLE as a big set of numbers that 
describes a satellite’s orbit. 
 
To obtain TLE data, click the Satellites button, or select Satellites from the Input menu.  
The Satellites window appears.  From here, you can choose to import satellite data from 
the web or an existing file.  Later, you can also choose to clear all satellite data by 
clicking Remove All. 
 
Note:  Ensure that TheSkyX’s date is set to within 45 days of the current date to avoid 
date rejection when downloading satellite for import. 
 
Let’s start by downloading some satellite TLEs from the web.  To do this, simply click 
Import From Web... on the Satellites window.  You can then choose the satellite category 
or categories you wish to download from the internet database, Celestrak.  After you have 
selected the desired satellite categories, click Download. 
 
Return to the Satellites From Above Earth window, and you will see the satellites plotted 
as points around the Earth globe.  Also, note that the satellites are also viewable in the 
Sky Chart. 
 
On the Satellites From Above Earth window, a list featuring your newly downloaded 
satellites appears on the left.  By selecting a satellite(s) from this list and by clicking 
Show Selected Orbits.  The satellite orbits will appear in the viewer.  Sliding the Viewing 
Distance slider will change the view from a distance of 1 Earth radius up to 50 Earth 
radii.  If your mouse is equipped with a scroll wheel, you can use it to adjust the viewing 
distance, too.  If need be, the lower right corner of the window can be dragged to resize it. 
 
By clicking Update Chart, the Sky Chart is updated to show the recent satellite data from 
a ground-based perspective.  Now you will be able to amaze your friends and neighbors 
with your uncanny ability to “predict” satellite appearances in the heavens! 

Astronomical Conjunctions 

When two or more planets appear near one another – within a few degrees or less –the 
objects are said to be in conjunction.  But don’t be fooled.  Although the objects appear 
close by from our earth-bound perspective, the two objects are still hundreds or thousands 
of astronomical units apart.  There’s no need to worry about a collision. 
 
Finding out when two or three planets will be in conjunction is easy with TheSkyX’s 
Conjunction Finder.  It can locate conjunctions between any two or three planets and/or 
the Sun and Moon, as viewed from Earth.  
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Select the Conjunction Finder command from the Tools menu and then mark two or 
three objects in the Objects list.  Earth is listed for reference only; it cannot be selected as 
part of the search. 
 
Click the Start button to begin the search.  TheSkyX uses the value entered in the Within 
(degrees) number input to determine how close the objects must fall before a conjunction 
is reported.  Once a conjunction is found, the Sky Chart is updated to show it. 

Beyond the Backyard: Our Home Galaxy 

Our Sun is but one member of a huge assemblage of hundreds of billions of stars that 
comprise our home galaxy, the Milky Way.  Our galaxy is also peppered with vast, 
colorful clouds of gas and dust, called nebulae, and other exotic objects. 
 
The invention of the telescope revealed that there is much more in the night sky than stars 
and planets.  In the 18th century, the French astronomer Charles Messier began to catalog 
some of these mysterious objects to make sure he didn’t mistake them for new comets.  
The Messier Catalog is still in use today.  It includes star clusters, and various kinds of 
nebulas and galaxies.  These so-called “deep sky” objects are favorite viewing targets of 
amateur astronomers. 
  
There are literally millions of objects in the sky that astronomers want to keep track of.  
Various catalogs have been developed for this purpose.  TheSkyX includes several of 
them in order to chart these objects on the Sky Chart. 

The Milky Way 

The ancient Greeks believed that the Milky Way was exactly that: spilled milk.  History 
failed to record whether anyone cried over it.  It wasn’t until Galileo invented the 
astronomical telescope that the true nature of the Milky Way was revealed: millions of 
stars too distant to be resolved by the naked eye.  We now know that the stars of our 
particular galaxy form an immense pinwheel shape, with several spiral arms extending 
out from its center.  When you look at the Milky Way, you’re looking at a section of one 
of these spiral arms (galaxies come in a variety of shapes and sizes, from spherical to 
irregular – more on this later). 
 
An unfortunate fact of modern life is that the Milky Way is too faint to be seen from 
within cities and most of their suburbs.  You need to be far from city lights and any other 
source of light pollution to appreciate how extraordinarily beautiful it is.  TheSkyX can 
display the Milky Way at various levels of brightness, simulating what you might see 
from the outskirts of a small town or an isolated mountain peak.  Astronomers have come 
up with the very cool-sounding term isophote to describe regions of equal brightness in 
the Milky Way. 
 
In the Display menu, the item Milky Way Options allows you to choose to display the 
Milky Way graphically, with isophotes corresponding to two levels of brightness, or as a 
wide-angle photograph of the Milky Way superimposed in the proper position on the Sky 
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Chart.  As with constellation figures, you can adjust the transparency of the Milky Way 
to simulate how much (if any) of it you can see from your location. 
 

 
Figure 62: The Milky Way Options window (Click the Milky Way Options command from the 

Display menu). 

Turn Milky Way On/Off (Show Milky Way) 

Show or hide the Milky Way photograph or isophote drawings by turning this checkbox 
on or off. 

Displaying the Milky Way (Milky Way Type) 

Choose how to show the Milky Way on the Sky Chart.   

Milky Way Photograph  

Options in this group allow you to configure how the Milky Way Photograph appears on 
the Sky Chart. 

Name of Milky Way Photograph (Name) 

A color and black and white Milky Way photos are supplied with TheSkyX.  Double-click 
on the name, or highlight it and click the Apply button to show in on the Sky Chart. 
 
Note that the Milky Way photo shown in the Photo-Like display mode only.   

Position on Galactic Equator 

The position of the Milky Way photograph with respect to the galactic equator can be 
configured.  Changes to these settings are applied to the Sky Chart immediately. 

Degrees Above Galactic Equator (Above) 

Use this slider to adjust how far above the galactic equator (in degrees) the top of the 
photo will appear. 
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Degrees Below Galactic Equator (Below) 

Use this slider to adjust how far below the galactic equator (in degrees) the bottom of the 
photo will appear. 

Longitudinal Position (Longitude) 

Use this slider to adjust where the left edge of the  photograph appears on the galactic 
equator.   

Transparency of the Photograph (Transparency) 

Use the slider to change the transparency of the Milky Way photograph.   

Beyond Our Galaxy 

About a hundred years ago astronomers believed that our galaxy, the Milky Way, 
contained pretty much everything in the universe.  But as telescopes became larger and 
more powerful, it became clear that there are other galaxies beyond the Milky Way – lots 
of them, in fact.  According to the latest estimates, there are some fifty to one hundred 
billion galaxies in our universe comparable in size to the Milky Way. 
 
Our galaxy is also surrounded by a halo of some hundred and fifty star clusters.  These 
clusters contain hundreds of thousands to millions of stars arranged in relatively compact, 
spherical shapes.  These globular clusters are made up mostly of ancient stars, some of 
them over ten billion years old. 
 
Just as some planets have moons, the Milky Way and many other galaxies are orbited by 
smaller “satellite” galaxies.  The Milky Way has at least two.  They were originally 
described by Persian astronomers, but today we call them the Magellanic Clouds in honor 
of Ferdinand Magellan, a 16th century European explorer who observed and charted them 
on one of his epic voyages into the Southern Hemisphere.  Our galactic companions are 
most easily seen from that hemisphere, although at certain times of year they can be 
glimpsed from very low Northern latitudes.  They are beautiful objects, and to the naked 
eye look like small shreds of the Milky Way.  Even though they lie only 20 degrees apart 
in the sky, they are separated by 75,000 light years in space.  With a telescope you can 
resolve some of their stars, and also see nebulae and star clusters that reside within them. 
 
The Milky Way is just one of billions of galaxies that populate the Universe.  Besides the 
Magellanic Clouds, only one of these other galaxies is visible to the naked eye.  It’s 
called the Andromeda Galaxy because it lies within the boundaries of that constellation.  
Every other galaxy requires a good pair of binoculars or a telescope to see. 
 
TheSkyX’s database includes thousands of galaxies within reach of amateur telescopes.  
They can be displayed in the Non-stellar Objects section of the Chart Elements window. 
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Galaxies of various shapes and sizes exist right out to the edge of observable space.  We 
live in a truly extraordinary universe.  We hope the TheSkyX will enrich and expand your 
appreciation of it. 

Have it Your Way with Preferences 
Select the Preferences command from TheSkyX menu (or click Tools > Preferences 
under Windows) to reveal a host of options that allow you to configure the appearance 
and contents of the toolbars, what information appears on the status and report windows, 
as well as advanced options. 
 
The Preferences window shows four buttons along the top.  Click one to view the options 
associated with it. 

Toolbars 

The standard set of toolbars and the toolbars you create are listed on the left side of the 
window.  When the check mark next to the toolbar name is on, the toolbar is visible on 
the main window.  Toolbars can also be turned on and off by right-clicking (+click on 
the Mac) the mouse over the toolbar, and then selecting the desired command from the 
pop-up menu. 
 
Click the Customize button to configure the commands or actions that appear on each 
toolbar, or add new toolbars with the commands you want.   
 
Use the Toolbar Button Options to configure the size and appearance of the buttons on 
the toolbars. 

Customizing Toolbars 

The standard set of toolbars contain the most commonly used commands.  You can edit 
the buttons or commands that appear on these toolbars to add additional items, or remove 
unwanted items or create additional toolbars with any set of commands. 
 
To edit the actions on a toolbar: 

1. Highlight the toolbar you wish to edit from the Toolbars list, or click the New 
button and enter the name of a new toolbar. 

2. Highlight the desired action in the Actions list then click the green right-pointing 
arrow to add this action to the Current Toolbar Actions list. 

 
Once selected in the Current Toolbar Actions list, the action can be positioned on the 
toolbar by pressing the up/down arrows or removed by clicking the left arrow. 
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Figure 63: Customize Toolbars window (TheSkyX > Preferences command on the Mac, Tools > 

Preferences command Windows, Customize button). 

List of All Actions in TheSkyX (Actions List) 

Menu commands, dialogs and button actions are listed in the Actions list on the left side 
of the window.  Each action can be added to (or removed from) a standard or custom 
toolbar.  The <SEPARATOR> action places a vertical line between actions on the toolbar. 

List of Defined Toolbars (Toolbars) 

The currently available toolbars are listed on the top right of the window.  The names of 
the standard toolbars are shown in green text and cannot be removed or renamed.  
Custom toolbar names appear in black text. 

Actions in the Toolbar (Current Toolbar Actions List) 

The list of actions that will appear on the toolbar are shown on the bottom right of the 
window.  Selecting an action allows it to be moved up or down by clicking the up/down 
arrow, or removed by clicking the left arrow. 
 
The right arrow adds the selected action to the toolbar. 

Resetting Standard Toolbars (Restore All Button) 

The standard toolbar set with the standard “factory” actions will be restored.  
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Status Windows 

TheSkyX offers three different status windows that can be configured to show information 
about the current time, telescope position, and other report attributes.   

Chart Status 
The Chart Status window (Display > Chart Status) provides helpful information about 
the sky chart.  By default, the current location, date and time are shown, but up to 21 
chart status attributes be added.   
 

 
Figure 64: Chart Status window (Display > Chart Status). 

To change the contents of the Chart Status report, select the Preferences command from 
TheSkyX menu on the Mac (Tools > Preferences under Windows) then click the Status 
Windows icon.  In the Status Window list, select Sky Chart Status.   
 
Highlight the items in the Attribute List that interest you, then click the right-arrow 
button. 
 
Note that double-clicking the left side of the Sky Chart Status report shows the Sky Chart 
Status report options on the Preferences dialog.  Double-clicking the right side of the 
report shows the attribute-specific dialog.  For example, double-clicking on the Location 
text reveals the Location dialog. 

Digital Setting Circles and Status Bar 
The contents of the report that appears on the Digital Settings Circles window (page 217) 
and the Status Bar window can be configured identically as the Chart Status window.  
Just make sure to select the appropriate option on the Status Window list. 
 

 
Figure 65: A Status Bar can be shown at the bottom of Sky Chart. 
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Report Setup 

The object-specific properties (for example, an object’s magnitude, or the spectral class 
of stars or the Moon’s ecliptic longitude) , that appear in the Object Information Report 
and Tool Tips Report is configurable to your needs.  
 

• The Object Information Report appears on the Edit > Find dialog.  
• The Tool Tips Report is the small window that appears when you place the 

mouse over an object on the Sky Chart. 
 

 
Figure 66: Tool tip on the Sky Chart. 

Date & Time Control 

The format of the date and time displayed in the Date & Time control (page 80) can be 
configured to meet your requirements.   
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Figure 67: Date & Time Control options on the Preferences window. 

To open the Date & Time Control window select the Preferences command from 
TheSkyX menu (or Tools > Preferences in Windows) then click the Date & Time Control 
icon.   
 
In concept, formatting the date and time is simple.  On the Date & Time Format text box, 
just type the format of the date and time that you want, or select one of the predefined 
formats from the drop down list.  However, please take a moment to carefully read the 
text on this window.  It should be self-explanatory, but this seemingly simple option is 
extremely flexible and it might take you a few tries to get the format just the way you 
want it. 

Date & Time Format Configuration  

The allowable date and time format abbreviations in the Date and Time format text are 
shown in the table below. 
 
Abbreviation Explanation 
AP Shows AM or PM in capital letters.  Omitting the AP from the format 

will the time using a 24-hour time or military time format instead of 
the standard time format. 

ap Shows am or pm in lower case letters.  Omitting the ap abbreviation 
from the format will the time using a 24-hour time or military time 
format instead of the standard time format. 
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d A single lower case d shows the day as a number between 1-31. 
dd Two lower case d’s in succession indicate the abbreviated name of the 

day should be displayed.  For example, dd shows the text Fri. 
dddd Four successive lower case d’s indicate the complete name of the 

current day should be displayed.  For example, dddd shows the text 
Friday. 

h A single lower case h shows the hour without a leading zero.  For 
example, 1 a.m. is shown as 1. 

hh Two successive lower case h’s show the hour with a leading zero when 
appropriate.  For example, 1 a.m. is shown as 01. 

M A single upper case M shows the month as a number between 1 and 
12.   

m A single lower case m shows the minutes without a leading zero when 
appropriate.  For example, 5 minutes after the hour is shown as 5. 

MM Two successive upper case M’s indicate the abbreviated name of the 
current month should be displayed.  For example, MM would show 
Jan. 

mm Two successive lower case m’s show the minutes with a leading zero.  
For example, 5 minutes after the hour is shown as 05. 

MMMM Four successive upper case M’s indicate the complete name of the 
current month should be displayed.  For example, MMMM would 
show January. 

S A single lower case s shows the seconds without a leading zero when 
appropriate.  For example, 5 seconds after the minute is shown as 5. 

ss Two successive lower case s’s show the seconds with a leading zero.  
For example, 5 seconds after the minute is shown as 05. 

yy Two successive lower case y’s indicate the year should omit the 
century, and show as just the decade and year.  For example, yy shows 
15. 

yyyy Four successive lower case y’s indicate the year should be shown using 
four digits.  For example, yyyy shows 2015. 

Advanced Settings 

The Advanced button shows application-wide options that normally do not need to be 
changed.  We recommend leaving the options alone unless you’ve contacted technical 
support and have been instructed to alter one or more settings. 
 
The exceptions are: 
 

• Turning on/off the chart scroll bars 
• Showing the frame rate 
• Turning on/off the status bar 
• Setting the Target Frame Rate (to conserve power on battery operated 

computers) 
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• Turning on/off the zoom tool 
• Playing the startup sound 
• Showing the splash screen at startup 

Customizing Chart Elements 
There are over ninety different chart elements that can be displayed in the TheSkyX.  The 
universe is made up of vast emptiness, punctuated by an infinite variety of objects with 
an infinite variety of form.  From stars, nebulae, and galaxies, to ecliptic lines, coordinate 
grids, and reference lines, they are all here.  What follows is an introduction to each chart 
element.  To toggle any chart element on or off in the Sky Chart, simply check the box 
next to its name in the window. 

Editing Chart Element Attributes 

Before we continue to discuss chart elements, it would be prudent to say a word their 
customizability.  Many of the chart elements have editable attributes, giving you the 
ultimate flexibility in customizing the Sky Chart.  Things such as object color, point style 
(graphic representation), and label font are all editable.  Simply double-click on any 
object in the Chart Elements tab, and the Edit Chart Element Attributes window opens.  
Here, you can change fonts, line attributes, object fill color, and symbol options.  Also, 
for objects that have them, you can adjust the magnitude limits, and angular size limits 
by selecting the appropriate tab in the same window.  Experimentation is perhaps the best 
teacher when exploring the customizable item attributes for chart elements. 
 
Note:  Not all attributes of all chart elements are editable, as many are not applicable 
or do not make sense.  These attributes will appear grayed out and are not selectable. 
 

 
Figure 68: Properties tab on the Edit Chart Element Attributes for the Galactic Equator. 
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In Figure 67, the Properties tab for the Galactic Equator chart element is shown.  Notice 
that the Fill Color and Symbol buttons are grayed because the galactic equator is a line so 
it does not have an associated fill color or symbol. 
 

 
Figure 69: Properties tab on the Edit Chart Element Attributes when more than one element is 

highlighted. 

The Edit Chart Elements window can be used to set the magnitude limits, angular size 
limits and properties of multiple object types, too.  For example, on the Chart Elements 
window, highlight the Galaxies text under the Non-stellar Objects node of the Celestial 
Objects group and then click the Edit Attributes button. 
 
The Selected Chart Element text shows that seven different chart elements (that is, all 
the different classifications of galaxies) have been selected.  Any attribute changes will 
now be applied to each object type.   
 
As another example, you could limit magnitude of every object on the Sky Chart to only 
those between magnitude 8 and 10 by selecting the Celestial Objects group, then setting 
the Hide Fainter Than number input to 10 and the Hide Brighter Than to 8.  
 

Editing Attributes By Right Clicking 

The attributes of a chart element can also be edited by right-clicking the mouse (+click 
on the Mac) over the element on the Sky Chart, and then clicking the Edit <Chart 
Element> Attributes where <Chart Element> is the element beneath the cursor. 
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Figure 70: Right-clicking (+click on the Mac) on a constellation line shows a context pop-up menu. 

Celestial Objects 

Here, you will find all of the real objects of the universe that are included in TheSkyX’s 
database. 

Non-stellar Objects 

Celestial objects other than individual stars and the objects of our solar system, such as 
galaxies, nebulae, and star clusters, can be found under the heading Non-stellar Objects. 

Galaxies 

Galaxies, sometimes called “island universes,” are the largest building blocks of the 
observable universe.  Galaxies are classified according to their shape.  You can choose 
among galaxy types that you wish to display in the Sky Chart.  You can choose to show 
Type C, elliptical, lenticular, spiral, and irregular galaxies, as well as galaxy clusters.  
Under Non-stellar Objects > Galaxies, the list of checkboxes will allow you to toggle on 
or off galaxies based upon their type.  Notice that there are several different graphical 
points indicating galaxy type; these allow for quick identification in the Sky Chart. 

Nebulas 

There are many kinds of clouds of gas and dust in the sky, such a cloud is known as a 
nebula.  Each of the different kinds of nebulae can be selected for display in the Sky 
Chart. 
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Bright Nebula 

Bright nebulae are nebulae that emit or reflect light visible to the naked eye and appear as 
glowing clouds in the night sky.  In some bright nebulae, called emission nebulae, the 
radiation from nearby stars ionizes the gas in these nebulae, and causes it to glow.  A 
well-known emission nebula is the Orion Nebula in the sword of Orion, the Hunter.  In 
still others, the light from stars bounces off of dust particles in the nebula, thereby 
illuminating it; these nebulae as known as reflection nebulae.  A famous reflection nebula 
is that around the Pleiades. 

Dark Nebula 

Not all nebulae emit light.  Sometimes they are dark and are only visible by being 
amongst or in front of regions of ionized gas (bright nebulae).  A famous dark nebula is 
the Horsehead Nebula, also known as Barnard 33, in the constellation of Orion, the 
Hunter.  A dark nebula is a region of cold, dense dust and gas.  They are so dense as to 
block the light from background stars or from a nearby emission nebula.  Star formation 
occurs within the dark nebulae, but such formation has not yet reached a level great 
enough for nebular ionization to occur.  The Great Rift of the Milky Way is a dark nebula 
that is visible to the naked eye from a dark sky site. 

Planetary Nebula 

Planetary nebulae are special kinds of nebulae occurring near a dying star or white dwarf.  
When stars about the eight times the mass of our Sun or smaller begin to decline, they 
swell and contract, throwing off the outer layers in the process, and eventually leaving a 
white dwarf at the center.  The white dwarf’s radiation causes the cloud of gas to glow.  
These objects are called planetary nebulae because they looked like planets in the 
telescopes of astronomers during the 18th and 19th centuries.  They do not have anything 
to do with the planets of our solar system, though.  They are all quite far away.  An 
interesting fact is that our Sun will end up as a planetary nebula in some 5 billion years 
from now. 

Star Clusters 

Visible in the sky are several clusters of stars.  These are stars which formed together in 
the same region of space at about the same time.  Star Clusters come in two varieties, 
open and globular. 

Open Clusters 

An open star cluster is a group of a few hundred stars up to a few thousand stars.  These 
stars all formed from the same nebula, or cloud of gas and dust.  These stars still interact 
with each other gravitationally, albeit loosely.  Some open clusters, such as the Pleiades, 
in Taurus, the Bull, are still surrounded by remnants of the cloud from which the 
component stars formed.  Others, such as the Hyades, also in Taurus, do not reveal 
distinct nebulosity. 
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Globular Clusters 

Globular clusters are ancient, high density clusters of stars existing beyond the plane of 
the Milky Way or other galaxies.  They are so-called because they look like globes in the 
sky.  Some people have described them as looking, in telescopes, very much like salt 
spilled onto a black table cloth.  These clusters orbit the galactic core in the region 
beyond the disk, known as the halo.  Globulars are composed of old stars, and are 
remarkably free of gas and dust, presumably because that material was long ago turned 
into stars.  Some globulars are visible to the naked eye, such as Omega Centauri and M13 
in Hercules, though M13 requires very dark skies and good vision. 

Cluster + Nebulosity 

Some clusters contain nebulosity, either reflection nebulae caused by light from the 
component stars bouncing off of dust and gas surrounding them, or emission nebulae, 
which glow due to ionization of the cloud by the component stars’ radiation.  Use this 
item to toggle such clusters on or off. 

Other Sources 

Quasar 

Quasars, quasi stellar radio sources, are among the oldest known objects in the universe.  
They are all very far away, lying hundreds of millions or even billions of light years away 
from Earth.  The first quasars were discovered in the late 1950’s by radio astronomers.  
For years, the debate raged as to their nature.  Today, it is believed that they are 
supermassive black holes.  Tremendous energy emits from such a black hole region rising 
from the tremendous turmoil of the material orbiting and flowing into the black hole, in 
what is known as the accretion disk.  It is possible that such objects are the precursors to 
modern galaxies, and would therefore account for the presence of the supermassive black 
holes found at many galactic cores. 

X-ray Source 

Many high-energy objects in the universe emit x-rays, such as stars, nebulae, and 
galaxies.  Unusually strong x-ray emissions indicate a very high energy situation, such as 
a black hole’s accretion disk.  In fact, it was by observing strong x-ray sources, such as 
Cygnus X-1, that black holes were eventually brought from the realm of the theoretical to 
that of the real.  Other powerful x-ray sources include quasars, certain double stars, such 
as those with a neutron star or white dwarf component, and some galaxy clusters. 

Radio Source 

Some objects emit large quantities of radio waves, these are known as radio sources.  
Pulsars (short for pulsating star) are perhaps the most well-known examples of 
astronomical radio sources.  Pulsars are rapidly rotating neutron stars with a beam of 
radio radiation that sweeps by Earth like the beam from a lighthouse.  The result is a 
pulsing radio signal detectable in radio telescopes.  The first pulsar was discovered by 
Jocelyn Bell and Antony Hewish in 1967. 
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Radio astronomy is a complete subfield of astronomy that has its roots in the 1930s, when 
the radio emissions of the Milky Way were first discovered.  Radio astronomy really took 
off after World War II.  In the 1950s, Cambridge’s Ryle and Hewish created important 
radio maps of the sky.  Other milestones occurred in the 1960s with the research of Frank 
Drake at Green Bank, West Virginia, and the ground-breaking discovery of the cosmic 
microwave background by Penzias and Wilson in New Jersey. 

NGC Probable Star 

These are objects that are listed in the New General Catalogue (NGC) as being probable 
stellar objects.  Probable objects are those predicted mathematically or through a 
combination of mathematics and observations. 

Other NGC 

NGC  stands for New General Catalogue, a catalog of astronomical objects most notable 
for its size and the fact that it includes all types of deep-sky objects.  It was first compiled 
in the 1880s on commission of the Royal Astronomical Society by J.L.E. Dreyer, using 
William and John Herschel’s observations.  Since then, it has continued to grow in size 
and has been thoroughly revised twice. 
 
Turn the Other NGC checkbox on or off to toggle those objects belonging to the NGC 
and not specifically to any other object group. 

Mixed Deep Sky 

To toggle those objects that do not fall into any other category of non-stellar object, 
choose the Mixed Deep Sky checkbox. TheSkyX classifies objects in the famous Messier 
catalog as a mixed-deep sky. 

Solar System Objects 

The many objects of our solar system are discreetly displayable in TheSkyX.  Choosing 
which to show in the Sky Chart is as simple as clicking a checkbox. 

Moon, Sun, Planets 

Here, you will be able to toggle the Moon and the eight classical planets, (including 
Earth), a host of small solar system bodies (comets, asteroids), satellites, and the Sun.  
You will notice that each of the naked eye planets, plus the Moon and Sun, each has a 
unique graphic point style to instantly distinguish them in the sky chart. 
 
Here, you can select from any of the solar system objects.  By clicking the tree arrow 
next to Solar System Objects, you will see that you can choose among the Moon, the 
eight classical planets, small solar system objects (you’ll find Pluto here), satellites, and 
the Sun. 
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Small Solar System Bodies 

Under Small Solar System Bodies, you will find a button with the same label.  Clicking 
this button (or, clicking the Small Solar System Bodies command from the Input menu) 
will open a window allowing you to import small solar system bodies, such as comets 
and asteroids, into TheSkyX by using either an existing file, or by downloading orbital 
data from the internet.  

Comets 

Getting comet data imported into TheSkyX, follow these four, simple steps. 
 

1. With the Solar System window open, select Input > Small Solar System 
Bodies.  A new window appears with three tabs at the top, Comets, Asteroids 
(Small Database), and Asteroids (Large Database).  Select the Comets tab. 

2. A window opens labeled Comets Available for Display.  Here, you will see 
the total number of comets available for display, as well as a list of their 
names with check-boxes.  It is with these check-boxes that you can toggle 
comets on or off in the Sky Chart or in the solar system simulator. 

3. You have three options for importing comet data into TheSkyX.  You can 
import them from an existing file, or you may download comet data directly in 
TheSkyX using internet databases.  You may download individual comet data 
by name, or you can download all the data for all observable comets at once.  
For our example, let’s download all observable comets at once.  To do this, 
simply click Observable. 

4. The data will then download, and the observable comets will now appear in 
the list above, on the Sky Chart, and in the solar system simulator. 

 
Note: Be sure that your computer is connected to an active internet connection when 
attempting to download comet data. 

Asteroids 

The process is very similar as comet data when downloading asteroid data from the 
Asteroids (Small Database) tab.  There, you can choose to import asteroid data from an 
existing file, by orbital characteristic, such as distant, critical, or unusual, or you may 
import by asteroid name. 
 
Should you decide to import asteroids from the Asteroids (Large Database) tab, you will 
have to visit one of the websites provided and download a file with the desired data.  You 
can then select the file with the Choose button to reveal the asteroids in the Sky Chart 
and solar system simulator.  Additionally, the check-boxes you see under the Asteroids 
(Large Database) tab toggle important display options such as computing asteroid 
positions at start-up and 24-hour object paths for imported asteroids. 

Small Database Versus Large Database Asteroids 
There are lots of asteroids out there; over 430 thousand have been cataloged to date.   
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The sheer number of them presents problems for charting programs.  If you want to show 
them all, there’s no easy way to continually update their positions without really slowing 
down the computer.  And, if you want to show the  path of one particular asteroid, 
“wading through” them all to find the one you want can be frustrating. 
 
For optimal functionality, TheSkyX breaks asteroids into separate databases, Small and 
Large. 

Small Database Asteroids  
• Limited to 1000 total on Sky Chart. 
• Can be imported by name, orbital characteristic, a text file or by entering the 

individual orbital elements. 
• Can create Object Paths (page 73) for any or all of them. 
• Sky Chart coordinates are updated continually. 

Large Database Asteroids 
• An unlimited number can be shown on the Sky Chart. 
• Can be imported from a standard IAU text file. 
• Cannot create Object Paths (page 73). 
• Can show the 24-hour path vector. 
• Sky Chart coordinates are updated only after the text file is imported, or by 

clicking the Compute Asteroid Positions button on the Asteroids (Large 
Database). 

 
When you click on an asteroid to identify it, its elements are numerically integrated to 
update them to the current equinox. The coordinates in the Object Information report are 
computed to an accuracy of ±1 arcsecond.  

Asteroid Paths 

The position and 24-hour path of any asteroid, over any time period, and for any number 
of selected small database asteroids, or for all asteroids. 

To View a 24-hour path for all Large Database Asteroids: 
1. Click the Small Solar System Bodies command on the Input menu. 
2. Click the Asteroids (Large Database) tab. 
3. Turn on the Draw a line for each asteroid showing its path for the next 24 hours 

checkbox. 

To Create the 24-hour path for any of the Small Database Asteroids: 
1. Click Input > Small Solar System Bodies. 
2. Click the Asteroids (Small Database) tab. 
3. Load the desired asteroids and click Close. 
4. Click Tools > Object Paths. 
5. Select the asteroids in the Asteroids list. 
6. On the Create Paths tab, enter 1 hour (or any other increment). 
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7. On the Count text input, enter 24 hours or any other number of increments. 
8. Click the Create Path button. 

 
A path for the selected asteroids for the select time increment is drawn. 

Satellites 

Artificial satellites can be viewed on the Sky Chart as they appear from your backyard, or 
from a position above Earth. 
 
From the Chart Elements window, click the Satellites button, or select the Satellites 
command from the Input menu,  to open the Satellites window.  In this window, you can 
import satellite or Iridium flare data from an existing file or from the internet.  
Checkboxes allow you to toggle the satellites and orbital paths in the Sky Chart.  The 
Brightness slider allows you to control the brightness of satellites, making them easier to 
spot against a starry background. 

Viewing Satellites and their Orbits 

To observe satellite orbits, select Tools > Satellites from Above Earth.  If this is your 
first time using the satellites tool, there will not be any satellites listed, and you will have 
to download some satellite two-line elements (TLEs) before any satellite data can be 
shown.  You can think of a TLE as a set of numbers that describes a satellite’s orbit. 
 
To obtain TLE data, click the Satellites button, or select Satellites from the Input menu.  
The Satellites window appears.  From here, you can choose to import satellite data from 
the web or an existing file.  Later, you can also choose to clear all satellite data by 
clicking Remove All. 
 
Note:  Ensure that TheSkyX’s date is set to within 45 days of the current date to avoid 
date rejection when downloading satellite for import. 
 
Let’s start by downloading some satellite TLEs from the web.  To do this, click the 
Import From Web... button.  You can then choose the satellite category or categories you 
wish to download from the internet database, Celestrak.  After you have selected the 
desired satellite categories, click Download. 
 
Return to the Satellites From Above Earth window, and you will see the satellites plotted 
as points around the Earth globe.  Also, note that the satellites are also viewable in the 
Sky Chart. 
 
On the Satellites From Above Earth window, a list featuring your newly downloaded 
satellites appears on the left.  By selecting a satellite(s) from this list and by clicking 
Show Selected Orbits.  The satellite orbits will appear in the viewer.  Sliding the Viewing 
Distance slider will change the view from a distance of 1 Earth radius up to 50 Earth 
radii.  If your mouse is equipped with a scroll wheel, you can use it to adjust the viewing 
distance, too.  If need be, the lower right corner of the window can be dragged to resize it. 
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By clicking Update Chart, the Sky Chart is updated to show the recent satellite data from 
a ground-based perspective.  Now you will be able to amaze your friends and neighbors 
with your uncanny ability to “predict” satellite appearances in the heavens! 

Viewing Iridium Flares 

Some satellites become incredibly bright for short periods of time.  This phenomenon is 
due to the fact that their orbit brings them into precise alignment as to reflect a large 
quantity of sunlight down to Earth in a precise location.  This is most commonly 
observed with the Iridium communication satellites, and is therefore referred to as an 
Iridium Flare. 
 
TheSkyX can predict and display Iridium Flares using the satellite function.   
 

1. Select Input > Satellites, or, if the Satellites from Above Earth window is 
open, click the Satellites button. 

2. Choose the Iridium Flares tab. 
3. You can search for all flares, or limit your search to just daytime, nighttime, 

or dawn/dusk flares.  For this example, choose All flares. 
4. Leave the next few menus at their default settings. 
5. Click Find Flares, and TheSkyX will connect to an internet database to 

retrieve Iridium Flare data.  Be sure that your computer is connected to the 
internet for this. 

6. Once the upcoming flares appear in the list, click the Watch Flare button, and 
the flare will appear in the Sky Chart, along with a pointer directing you to the 
flare’s position. 

 
Now you know just where to look when it’s time for the next Iridium Flare. 
 
The Satellites window also features a button labeled Satellites From Above Earth, 
clicking this button opens the tool of the same name.  For more on using viewing 
satellites, please see the section Satellites From Above Earth. 

Stellar Objects 

From the Chart Elements window, under the Stellar Objects heading, you will see the 
stellar objects displayable by TheSkyX; stars, double stars, suspected variables, 
supernovae, and variable stars.  Any of these are selectable via the checkboxes.   

Stars 

Immense luminous spheres occurring in the night sky, stars make up the better part of the 
mass of the  universe observable to the naked eye.  They generate their light from nuclear 
reactions in their cores.  These nuclear reactions fuse hydrogen and helium to form 
elements up to atomic number 26: iron.  Stars occur in a variety of sizes and colors.  The 
color of a star is due to its temperature; red stars are relatively much cooler blue stars.  
Our Sun is a middle-sized star.  The sizes of star points in the Sky Chart does not reflect 
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actual size, but is an expression of relative apparent brightness, with larger points 
representing stars of greater apparent brightness. 

Star Options 

You will also see a button labeled Star Options.  Clicking this button opens a useful 
window that contains controls allowing you to adjust the Appearance of stars as well as 
options for their Proper Motion.  Tabs at the top of this window allow you to select 
between the two. 
 
Clicking the Appearance Tab brings up several sliders.  The Fainter/Brighter slider 
adjusts the apparent brightness of the stars in the Sky Chart. The Contrast slider adjusts 
the contrast of the Sky Chart image.  Less contrast can be useful those learning to identify 
constellations.  The More Fuzzy/More Solid slider lets you change the star points from 
fuzzy, nebulous orbs, to solid balls, and many points in between.  You can adjust the 
number of stars appearing in the Sky Chart by using the Less/More Stars slider.  
Additionally, the halos seen around the star points can be controlled by the No/Bright 
Halos slider. 

Star Color 

Star color can be adjusted here in terms of the saturation of the spectral color of stars.  
Also, the stars may be colored according to the selected ‘Star’ attribute color via a 
checkbox. 
 
If you would like the stars to appear red in Night Vision Mode, check the checkbox 
labeled Red in Night Vision Mode. 

Map Like vs. Photo Like Display 

You may also choose between a Map Like chart, where the Sky Chart appears similar to 
a traditional printed chart, or a Photo Like chart, where the Sky Chart appears as photo-
realistic view of the sky, by choosing the radio button at the bottom of the window. 

Proper Motion 

TheSkyX continually calculates stars’ proper motion, that is their actual motion in the 
heavens, not just the rising and setting, called apparent motion.  To access the proper 
motion options from the Star Options window, click the Proper Motion tab.  From here, 
you can turn off proper motion at any time by un-checking Compute Proper Motion.  
You can also choose to Show Proper Motion Vectors by checking the box labeled as 
such.  Using the field labeled Proper motion vector length, you can enter a value 
between 0.00 and 99.00 years. 

Suspected Variable 

Many stars in the heavens are not steady in their energy output.  Such stars are known as 
variable stars.  There are many different types of variable star.  (Please see Variable 
Stars for more information.)  Choose Suspected Variable to toggle on or off those stars 
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which appear, based upon best observations, to exhibit variable star tendencies, but are 
not yet confirmed. 

Supernova 

Perhaps the most energetic single event in the cosmos, the supernova is a relentless stellar 
explosion, whose effects are felt across vast expanses of space and time.  There are a few 
different types of supernovae, all with the same effect: an exploded star.  These events 
release incredible amounts of energy, much more than the Sun will release over its entire 
lifetime!  In addition to an enormous emission of light, there is also a shock wave 
emanating from the star.  Material in this shock wave reaches incredible speed, and 
matter is slammed together hard enough for it to fuse into heavier elements and to emit 
light.  It is this fusion that is thought by some scientists to produce all elements heavier 
than iron in the Universe. 

Variable Star 

A variable star is a star whose energy output is not constant, but varies in a regular 
pattern.  Some variable stars are useful in determining cosmic distances.  There are many 
different types of variables, but two main types of variable star, eclipsing binaries and 
Cepheids, make up the majority of variables in the night sky. 
 
An eclipsing binary is a binary star with two component stars of unequal brightness.  
When the brighter one is in “front” as viewed from Earth, the star appears to be brighter, 
and it appears dimmer when the dimmer one is in “front.”  A notable eclipsing binary is 
Algol in the constellation of Perseus.   
 
A Cepheid variable is a star whose energy output varies because the star swells and 
shrinks at regular intervals.  It is believed that these stars do this because of their internal 
structure and rotation causing a harmonic resonance.  The prototype Cepheid variable is δ 
(delta) Cephei.  Cepheids are useful because they can be used to determine distances.  
Their variation periods are directly related to their brightness.  Using this information, an 
observed Cepheid’s apparent brightness can be compared with its brightness as 
determined by observing its period to calculate its distance.  An historic use of this 
principle was when Edwin Hubble proved that the spiral nebulae were distant, separate 
galaxies in 1922 by observing Cepheid variables within them. 

Non-Stellar Objects 

Just as with stars, TheSkyX offers a number of options for displaying non-stellar objects.  
Select Display > Non-stellar object options to bring up the Non-stellar Object Options 
dialog.  You can also access this dialog from the Chart E lements tab, under Non-stellar 
Objects. 
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Non-Stellar Object Options 

Many of these options are designed to reduce computer resources while rendering the 
Sky Chart.  Others are designed to reduce the number of non-stellar objects rendered to 
help you to hone in on just the objects you wish to observe. 

Non-Stellar Object Density 

The top two sliders are used to adjust the non-stellar object density in fields of view 
greater than 60° (top slider) and less than 60° (bottom slider).  Simply click and drag the 
slider to the left or right for less or greater object density. 
 
You can also choose to plot objects whose entries overlap in various catalogs, such as 
NGC, IC, and PGC.  Simply select the Plot overlapping catalog entries checkbox to 
activate this option. 
 
TheSkyX plots small galaxies as either filled ellipses or as a galaxy symbol.  If you prefer 
a symbol, select the Plot small galaxies as a “ galaxy symbol...”  checkbox.  For more on 
galaxy symbols, see the Galaxies section in the Chart E lements tab. 

Non-Stellar Object Drawings 

The style and appearance of non-stellar object drawings can be set with the drop-down 
and slider here.  Choose either F illed or H ollow from the drop-down menu to set the non-
stellar object drawing style.  The slider below the drop-down menu morphs the drawings 
between More fuzzy and More solid appearance. 

In Place Photos 

TheSkyX can show NGC, IC, and PGC non-stellar objects as in place photos from the 
Digitized Sky Survey.  It can also clip the photos to the catalogued shape of the object, if 
you so choose.  Select the appropriate checkboxes in this section to activate these options. 
 
You can also set the Default frame size when object size is unknown with this section’s 
value field.  The default setting is 10.00 arc-minutes, but you can change that value to 
suit your needs by using the up/down arrows or by directly entering a value in the field. 

Solar System Options 

If you want the Sun and Moon to appear as transparent ellipses, select the first checkbox 
in this section. 
 
You can also choose to Show E arth’ s shadow by selecting this checkbox. 
 
To exaggerate the angular size of the Sun and Moon in fields of view 90° and wider, set 
the desired value in the bottom-most field in the Non-Stellar Object Options dialog.  You 
can choose values between 1.0 and 10.0 times. 
 
When you are satisfied with the non-stellar object options settings, click Close to return 
to the Sky Chart. 
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Reference Lines and Photos 

The Sky Chart can show reference lines that display coordinates, help you visualize your 
orientation, or indicate what part of the sky you’re looking.  It can also show in place 
photographs for many deep space objects.    

Constellation & Asterism Options 

Here, you will find items such as asterisms, constellation drawings, constellation 
boundaries, constellation figures, constellation labels, the ecliptic, and the equatorial grid. 
 
Each of the above items is able to be toggled, and there are a number of options available 
to you by clicking Constellation & Asterism Options.  Doing so opens a window of the 
same name.  Two tabs, labeled Constellations and Asterisms appear at the top.  Under the 
Constellations tab, note that there are sections each for constellation figures, boundaries, 
and drawings, with a number of customizable options for each. 

Constellation Figures 

Click the Show Constellation Figures checkbox: dot-to-dot figures appear in the Sky 
Chart.  Today, there are a number of conventions for drawing the constellation figures, 
such as those from Astronomy and Sky & Telescope magazines, as well as those from 
H.A. Rey, and TheSkyX’s own.  Choosing between the many styles is as easy as using the 
pop-up menu. 
 
You can also choose to affix a label to the constellations, and you can customize that 
label among many options.  This is especially useful, as there is much confusion about 
constellation pronunciation, especially the genitive forms, such as Cephei or Aurigae.  
Checking the box labeled Label with: brings up the labels, and the pop-up menu lets you 
pick from a number of label options, including pronunciation for the constellation name 
and the genitive forms (used for describing objects that “belong” to a constellation, such 
as the star Epsilon Eridani). 

Constellation Boundaries 

Astronomers use the constellations to map out the sky.  But, instead of using just the 
drawings themselves, astronomers have laid out the entire sky in 88 sections, each 
attributed to a constellation found within that section.  To view these sections, or 
constellation boundaries, check Show Constellation Boundaries.  If you would like to 
highlight the central constellation region in the Sky Chart, simply click Highlight the 
constellation boundary near the center of the screen. 

Constellation Drawings 

To display beautiful constellation drawings from Johannes Bayer’s Uranometria, check 
the box labeled Show Constellation Drawings.  Additionally, if you would like see only 
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the drawings for constellations currently at the center of the screen, click the Only show 
constellations that are near the center of the screen.   
 
Below that is a list of the 88 constellations with checkboxes, along with buttons for 
selecting All, None, the Zodiac constellations, and those constellations at the Center of 
the screen.  You can select exactly which constellations appear by utilizing the 
corresponding checkbox (check Andromeda to display the Andromeda drawing).   
 
Click the button with the color above the Transparency slider to change the color of the 
constellation drawing overlay.  You can pick from a list of colors, or you can choose your 
own color from the color wheel by clicking the color square in the lower right (the one 
with the three black dots).  The transparency of the constellation drawing overlay is 
controlled by the Transparency slider: move it to the right for increased transparency, 
and left for increased opacity. 

Asterisms 

Click the Asterisms tab, and you will see a list of available asterisms, along with a 
checkbox enabling asterism labels to be shown in the Sky Chart.  To show an asterism, 
locate it in the list and ensure that it is checked.  The chosen asterism will then appear in 
the Sky Chart. 
 
Also you can choose all asterisms at once by clicking the Show All button, or no 
asterisms by clicking the Show None button. 
 
Highlighting an asterism from the list and clicking the Center button is a handy way to 
locate and learn asterisms; they will be centered in the Sky Chart once the button is 
clicked.  TheSkyX probably contains more asterisms than you have come across before, 
so spend some time and have some fun discovering new ones. 

Ecliptic 

The ecliptic  is the apparent path of the Sun through the sky throughout the year.  This 
path also represents the general plane of the solar system, and it is because of this that the 
Moon and the planets can be found on or very near this line in the sky.  That is a handy 
fact, as it greatly limits the possible areas for planets to appear, therefore making them 
more easily found. 
 
To turn the ecliptic line on in TheSkyX, click the Ecliptic checkbox in the Chart Elements 
window.  Likewise the ecliptic can be turned off by clicking the Ecliptic checkbox again.  
The ecliptic, like most chart elements, is customizable by double-clicking on Ecliptic in 
the chart elements window, or by right-clicking on the ecliptic in the Sky Chart. 

Equatorial Grid 

An equatorial grid can be plotted onto the Sky Chart by turning on the Equatorial Grid 
checkbox.  This spherical grid is based upon Earth’s equator projected into space, or the 
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celestial equator.  The grid also displays coordinates of right ascension and declination 
overlaid onto the Sky Chart. 
 
The grid’s attributes are fully customizable (see “Customizing Chart Elements” on page 
136). 

Horizon Grid 

A grid that is based on the local theoretical horizon can be shown by turning on Horizon 
Grid checkbox.  This grid displays coordinates of azimuth and altitude overlaid onto the 
Sky Chart. 
 
The grid’s attributes are fully customizable (see “Customizing Chart Elements” on page 
136). 

Horizon  

Turning on the Horizon checkbox displays a line that represents the local horizon.  The 
default local horizon is drawn as a featureless line at 0° altitude.  You can redefine the 
line so it represents the horizon at your viewing site (see “Horizon and Atmosphere” on 
page 151). Adding natural objects and obstructions to the horizon gives a better idea of 
what is and isn’t visible, and the approximate times at which objects rise or set.   

Horizon and Atmosphere Options 

To best approximate your observing site, TheSkyX allows you to show custom horizons 
and simulate atmospheric conditions including showing clouds, the Sun and Moon’s glow 
and displaying simulated meteor showers. 
 

 
Figure 71: The Horizon and Atmosphere Options dialog. 



TheSkyX Professional and Serious Astronomer Edition User Guide 
 

152 

Horizon and Atmosphere Options 

Under this section, you can choose to display the horizon as a panoramic photograph or 
custom drawn region, as well as show clouds, meteor radiants and other options.  
 
In the Horizon & Atmosphere Options window, you will notice four tabs at the top: 
Horizon, Sky Gradient, Clouds, and Miscellaneous.   
 
Under the Horizon tab, you can toggle the horizon and change it to one of several 
available virtual observing spots by choosing from the list at the left. 
 
Using the sliders on the right, under Horizon Photo Position, you can fine-tune the 
positioning and dimensions of the horizon image to best simulate your actual observing 
location. 
 
You can also adjust the transparency of the horizon image using the slider. 
 
If you would like to be able to scroll the sky chart below the horizon, click the Allow Sky 
Chart to be scrolled below the local horizon checkbox. 

Custom Horizon 

Near the center of the Horizon & Atmosphere window is a drop-down menu labeled 
Horizon Type.  This is set to Photograph by default, but by changing it to Custom 
Drawn, you can use the mouse to draw out a horizon outline based upon the 
measurements of your observing location.  Simply click and drag in the blue shaded 
region along the correct coordinates to draw out a custom horizon mask.   
 
Turning on the Show Refracted Horizon checkbox will draw a line on the refracted sky 
that corresponds to the observer’s horizontal.  Near the horizon, the atmosphere refracts 
(bends) the light so much that objects below the “physical” horizon are visible. 
 
Clicking From Photo Horizon generates a horizon mask based upon the photo selected 
when the Photograph Horizon Type is selected.  Once you are satisfied with your custom 
drawn horizon mask, click Apply. 

Creating Your Own Panoramic Horizon 

If you own a digital camera and popular image processing software, you can create your 
own horizon panorama by stitching together a sequence of photos that spans 360 degrees.   

Collecting the Photos 
If you wish to create a panoramic horizon, the following hardware and software is 
recommended: 
  

• A digital camera 
• A tripod  
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• Panorama or “stitching” software that supports the PNG file format (PhotoShop 
Elements™, PhotoShop CS4™ or The Panorama Factory™, for example). 

• Image processing software to make the “sky” portion of the photo transparent 
(PhotoShop Elements™ or PhotoShop CS4™, for example). 

Photo Taking Tips 
• Early morning, late evening, or an overcast day works best for even light 

distribution. 
• Use the widest field settings for your camera or telephoto lens. Don’t zoom or 

magnify the photo. 
• If you use a tripod, make sure it is level so that the “ends” of the panorama match.  

Modern stitching software can account for errors here. 
• For best results, expert photographers recommend using up to a fifty to eighty 

percent overlap for adjacent photos. 
 

 
Figure 72: Panorama before transparency is added. 

 
Figure 73: Panorama after transparency is added. 

Tips for Creating Panorama Photos 
• Use your favorite stitching software to combine the individual images. Search the 

web for a list of software that can perform this operation.  The Panorama Factory 
software works well. 

• After stitching the adjacent photos together, the panorama must have an 
transparent region that identifies the “sky”.  Use your favorite image processing 
software to create an “alpha channel” or “transparency” layer to define a mask of 
the transparent regions, and then save this as a PNG photo. Your image 
processing software should have detailed information about how to accomplish 
this. 

• For best performance, the width and the height of the panorama should be 
multiples of 512 pixels.  The supplied panoramic photos are 4096 x 512 pixels or 
8192 x 512 pixels, for example. 

• Larger images consume more computer and video RAM.  Generally, the smaller 
the panorama, the better. 

• Consider opening one of the horizon photos that come with TheSkyX in your 
image processing software to use a “template” for  creating your own panorama.  
In Windows, they’re located in the Program Files\Software Bisque\Resources 

http://www.panoramafactory.com/�
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There are many web sites dedicated to creating photographic panoramas.  Search the web 
for “panorama” and “panorama tools” or “image stitching”. 
 
When you have the final panorama, save it to the Horizon Photos folder. 

Mac 
Custom horizon photos on the Mac should be saved in the appropriate Application 
Support folder: 
 
<Home Folder>/Library/Application Support/Software Bisque/TheSkyX <Edition Name>/Horizons 

Windows 
Custom horizon photos on Windows should be saved in the appropriate My Documents 
folder: 
 
<My Documents>\Software Bisque\TheSkyX <Edition Name>\Horizons 
 
The Horizon Photos list on the Horizon tab of the Horizon & Atmosphere Options 
dialog will now show your photo.  Select its name, then click the Apply button to update 
the Sky Chart.  You’ll need to fiddle with the Horizon Photo Position settings to get 
things “just right” for your panorama. 

Sky Gradient 

TheSkyX even lets you adjust the color of the sky.  While this is best used to match sky 
conditions at your real-life observing location, you can always use it for fun, too.  Click 
the Sky Gradient tab to see how.  
 
Hint: Sky Gradients only apply when the Show Daylight command is checked on the 
Display menu. 
 
On the left, you will see a list of different sky color gradients corresponding to different 
times of day and sky conditions. 
 
On the right, you will see the controls for editing the sky color gradient.  Under Edit Sky 
Gradient, you will see the name of the selected sky gradient, the selected cloud tint (if 
any), a color preview of the selected sky gradient, as well as various buttons used to 
adjust the sky gradient. 
 
Let’s make a change to the default daytime sky gradient to represent a paler day. 
 

1. Click the Show Daylight command from the Display menu to turn on daylight 
simulation. 

2. Click the Horizon & Atmosphere Options command on the Display menu. 
3. After the new window opens, click on the Sky Gradient tab. 
4. In the drop-down menu, Sky Gradient Type, choose Selected Sky Gradient. 
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5. Select a sky gradient form the list to edit, this time let’s choose Daytime.  This 
gradient simulates the color of the sky during sunlight hours.  If you would 
like, you may change the Description by editing the text in the field to the 
right. 

6. Now, on the right you will see the daytime sky color gradient in a sample box.  
On the far right, you will also see little gray triangles that correspond to start 
points for the gradient colors.  Double-click the top-most triangle. 

7. The color wheel opens, allowing you to select a new color.  Choose any color 
you like from the wheel and click OK.  Do this for the remaining triangles 
until you are satisfied with the sky color gradient in the sample box.  If you 
would like to remove a gradient point, click Remove Point.  You can also 
click Paste Photo to import a sky photograph. 

8. Once you have the sky gradient set to your liking, you can fine-tune it with the 
Darker/Lighter slider, located below the sample box. 

9. To save your new gradient, click Save Gradients.  This action will save all 
changes made to gradients during the current session.  To return to default 
settings, you can always click Defaults, even after saving changes. 

10. Once you have saved and selected your new sky color gradient, it appears in 
the Sky Chart. 

Clouds 

Select the Clouds tab in the Horizon & Atmosphere dialog to bring up options for cloud 
images, position, and transparency.  Handily, these options will update live in the Sky 
Chart as you choose them. 

Cloud images 

On the top left, notice the checkbox marked Show Clouds.  Selecting this option will turn 
the clouds on or off completely. 
 
Choose a cloud image from those listed in the box to the left labeled Cloud Photo Name.  
Click the Apply button or double-click on the cloud photo you want to use to apply it to 
the Sky Chart.  You can also see a preview of your cloud choice to the right of the dialog 
box. 

Cloud Transparency 

Maybe you have hazy, thin clouds at your observing site and you would like TheSkyX to 
model similar clouds in the Sky Chart.  Simply click and drag the T ransparency slider to 
achieve the level of transparency you desire.  The exact transparency percentage appears 
to the right of the slider. 

Cloud Photo Position 

You have complete control over the position and orientation of cloud images in TheSkyX.  
Choose a top and bottom limit for your cloud image by using the sliders to the right.  You 
can also spin the cloud image around your point of view by using the R ight/L eft slider.  
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Note that your selections for each slider are marked in degrees or either altitude 
(Top/Bottom) or azimuth (Right/Left). 

Miscellaneous 

Options for the Sun’s halo, the Moon’s halo, and meteors appear under the 
Miscellaneous T ab in the Horizon & Atmosphere dialog. 

Sun’s Halo 

Check this box to show the Sun’s halo in the Sky Chart.  You can also stipulate an 
angular size (in degrees) for the solar halo.  The default size is 10.00°. 

Moon’s Halo 

This box controls the lunar halo.  Check it to have the moon’s halo appear in the Sky 
Chart.  The default size is 50.00°, but you can change it to whatever you wish (0.00°-
99.99°). 

Meteors 

Several options exist for displaying sporadic meteors and meteor showers. 
 
Checking the Show Meteor Shower R adiants checkbox will show the radiant points for 
upcoming meteor showers in the Sky Chart.  You can select how far into the future you 
want TheSkyX to look in plotting upcoming meteor shower radiants by entering a value in 
the Show only those during the next:  field.  The default value is one week (7 days), but 
you can change it to whatever you wish.  This feature is particularly useful when 
planning to observe a meteor shower. 
 
You can also choose to show random, or sporadic, meteors in the Sky Chart by selecting 
the Show meteors (randomly) checkbox, and then choosing an hourly rate.  These 
sporadic meteors will not be based on actual forecasts, but are a great way to add extra 
realism to the Sky Chart.  In the real sky, you can expect to see anywhere from five to 15 
sporadic meteors per hour. 

Milky Way Options 

The Milky Way may be toggled by clicking the Milky Way checkbox in the Chart 
Elements window.  There are a number of options for Milky Way display available by 
clicking the Milky Way Options button. 
 
Once you have clicked the Milky Way Options button, the corresponding window will 
open.  With the central drop-down menu, you may choose either Photograph or 
Isophotes as your Milky Way type.  Choosing Photograph will display a photo-realistic 
depiction of the Milky Way in the Sky Chart.  Alternately, choosing Isophotes will give 
you a view reflecting areas of equal brightness. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

157 

Celestial North Arrow 

If you would like to have a handy guide orienting you to true north, as a compass does, 
turn on the Celestial North Arrow checkbox in the Chart Elements window.  A red 
indicator will appear in the upper left-hand corner of the Sky Chart, pointing North and 
East to help you stay oriented. 

Reference Objects 

There are a number of markers for various reference objects available in TheSkyX.  Many 
are self-explanatory, but here is a short description of those with a more technical aspect.  
Remember that each chart element is editable by double-clicking on its name in the list. 

Area of Interest, Arrow, Chart Scale 

See the “My Chart Elements” on page 169 for an explanation of these object types. 

Dome Slit 

The graphic that is displayed when TheSkyX is coupled to, and positioning an 
astronomical dome. 

Meteor Shower Radiants 

This marks the radiant point (or point of apparent origin) of a meteor shower. 

Mosaic Grid 

This is the grid produced when setting up to take a photo mosaic of a region in the sky.  
This grid represents each component frame of the mosaic.  

Reference Line 

A user-drawn line of reference. 

Reference Point 

A user-generated reference point. 

Telescope Limit 

This is a reference line that marks the slewing limit of the telescope currently set up in 
TheSkyX. 

Target Object 

This object marks the set target of your telescope or the object otherwise currently 
selected in the Sky Chart. 

Telrad 

If you have a telescope setup entered into TheSkyX, the field of view of your Telrad™ 
viewfinder will appear on the Sky Chart with this option turned on. 
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Telescope Cross Hairs 

With a telescope set up, these crosshairs show where it points in the Sky Chart. 

Pointing Sample 

A position on the celestial sphere that has been used by TPoint to calibrate the telescope 
and improve the telescope’s pointing. 

Tour Title 

When viewing a tour, this object toggles the title of the tour on or off in the Sky Chart. 

Zoom Box 

This option is a place holder so that the zoom box attributes  can be edited (see “Editing 
Chart Element Attributes” on page 136).  To show or hide a zoom box, press and hold 
down the SHIFT key while dragging the mouse (see “Zoom Box” on page 25). 

Managing Databases 
TheSkyX includes a host of standard astronomical databases (see “Appendix A: Databases 
and Cross References”).  TheSkyX can also be used to create custom databases from text-
based data (see “Custom Databases”).  The Database Manager on the Input menu 
provides a means to turn on and off these databases, depending on your needs. 

Using the Database Manager 

To access the database manager, choose the Database Manager command from the 
Input menu.  In the window that opens, you will see an expandable tree list of databases 
to the left, and a large field to the right with tabs for General information, database 
Items, Advanced options, and Replaced Objects. 
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Figure 74: The Database Manager window. 

To make a database viewable, turn on the checkbox next to its name in the list. 

General Tab 

Selecting this tab will let you view the general information about the selected database.  
Information such as the text file, object types contained within the database, and the file 
path is found here. 

Items Tab 

Clicking here will show you a list of the objects contained within the selected database.  
Clicking the Center Item button will center the highlighted object in the Sky Chart.  
Alternately, you can automatically center a selected item by checking the Auto center 
highlighted item box. 

Advanced Tab 

Here, you can remove, then Reload all the Sky Databases (SDBs).  You can also convert 
your TheSky6 SDBs to TheSkyX-compatible SDBX format.   
 

1. Copy your TheSky6 Sky Database (.sdb) and text (.txt) files into TheSkyX’s SDBs 
folder (see “Application Support Files” on page 19 for details). 

2. Click the Convert button, select the folder that holds your existing SDBs and 
associated text data (only). 

3. Click the Open button to begin the conversion process. 
 
The converted databases will appear on the Database Manager window’s list of 
Databases under My Sky Databases.  
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Replaced Objects 

To view replaced objects, click this tab.  Clicking Refresh will update the list. 

Optional Star Databases 

TheSkyX can show stars from the native NOMAD (80 GB) and UCAC 3.0 (8 GB) star 
catalogs.  As you can see, these star catalogs are unusually large, so you’ll not want 
 

Mac 

By default, TheSkyX looks to the following folder for the native NOMAD star catalog on 
the Mac: 
 
<Application Bundle>/Resources/Professional/Core Databases/NOMAD 
 
If the appropriate files are copied to this folder, then turning on the NOMAD checkbox 
will show stars from this catalog at fields of view of 1 degree and smaller. 
 
The default location for the native UCAC 3 star catalog on the Mac is: 
 
<Application Bundle>/Resources/Professional/Core Databases/UCAC3 
 
Where <Application Bundle> is the Mac “application bundle” folder that holds all 
TheSkyX-related files. 
 
If the appropriate files are copied to this folder, then turning on the UCAC3 checkbox 
will show stars from this catalog at fields of view of 1 degree and smaller. 

Windows 
By default, TheSkyX looks to the following folder for the native NOMAD star catalog: 
 
<Application Bundle>/Resources/Professional/Core Databases/NOMAD 
 
If the appropriate files are located here, then turning on the NOMAD checkbox will show 
stars from this catalog at fields of view of 1 degree and smaller. 
 
The default location for the native UCAC 3 star catalog is: 
 
<Application Bundle>/Resources/Professional/Core Databases/UCAC3 
 
If the appropriate files are located here, then turning on the UCAC3 checkbox will show 
stars from this catalog at fields of view of 1 degree and smaller. 
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Custom Databases 
Creating your own database of celestial objects can be a useful thing to do if you choose 
to carefully document your observations.  TheSkyX lets you do this with a great amount 
of freedom.  Let’s take an overview look at the Create Sky Database command. 

Creating a Sky Database 

To see the Create Sky Database window, select Input > Create Sky Database.  A tabbed 
window then opens, with sections each for defining fields, behaviors, advanced 
operations, and compilation operation. 

Define Fields Tab 

From the Define Fields tab, you can select values for a number of items.  If you wish to 
open a file containing field data, simply click Choose Source Text File.  If you would 
like to open it in Unicode, be sure to select the Open text file in Unicode checkbox. 
 
To enter value ranges for field items, highlight a field in the window to the left.  You will 
see its current column start and end points, if any.  To enter values, you may either enter 
them in the Starting column and Ending column fields below, or you can click on the 
starting point on the graph and drag to the desired ending point.  When dragging, the 
selected values appear to the right of the Set Columns button.  You can always change 
the values by clicking and dragging again.  Once you have entered the desired values, 
click the Set Columns button.  The column will then be set on the graph, and a label 
featuring its description appears in blue. 
 
Clicking Clear All will clear any and all data from the graph. 

Behavior Tab 

This tab includes options that define control the how the database interacts with the Sky 
Chart.   
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Figure 75: Behavior tab on the Create Sky Database window (Data > Create Sky Database). 

Sky Database Identifier (Identifier) 

Enter text that uniquely defines the database you are creating.  

Search Prefix 

Enter the text prefix that can be used to locate objects in the SDB when finding objects 
(page 35).   
 

Default Object Type 

Select the type of object (star, open cluster, etc.) that is in the source text file from this 
list.   

Minimum Field of View 

Enter a number for the smallest (most narrow) field of view on the Sky Chart to show the 
objects in this database.   

Maximum Field of View 

Enter a number for the largest (widest) field of view on the Sky Chart to show the objects 
in this database. 

Coordinate Frame 

Select the coordinate system, equatorial (RA/Dec) or horizon (Azm/Alt) for the objects in 
the source text file. 

Equinox 

Enter the equinox of the coordinates in the source text file. 
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Plot Order 

When displaying databases, you may want a specific object to should appear “on top of” 
other objects.  The Plot Order allows you to select when, relative to objects in the core 
database, this database will be drawn on the sky chart. 
 

• Early – Show objects in the Sky Database before stars.  Stars will overlay objects 
in the database. 

• Middle – Show objects in the Sky Database after stars.  Objects in the database 
will overlay stars. 

• Late – Show objects in the Sky Database on top of all other objects. 

Cross Reference Type 

Select how objects in the source text file are cross referenced with objects in the core 
databases. 

• None – Objects in the text file do not contain cross references to objects other 
databases. 

• Database – Objects in the text file contain cross references to objects in 
TheSkyX’s core databases, or other SDBs. 

• Pure – Objects in the text file reference existing object names or catalog numbers. 
• Common Name – Objects in the text file reference existing common object 

names. 

SDB Description  

Enter a text description for the Sky Database.  The SDB Description text editor accepts 
text that is formatted with hypertext markup language (HTML) , so that, for example, 
links to external web sites can be included with the header.   
 
Please note that the SDB Description text input is a simple text editor, not a web browser.  
This means, for example, when HTML is pasted into the SDB Description text box, a 
link to an external web page may be formatted as a hyperlink (that is, underlined in blue), 
but clicking on the underlined text will not show the external link in a web browser.  
 
Once the SDB is compiled (see “Compile Tab” on page 164), the web links in the 
description can be accessed from the Description on General tab of the Sky Database 
Manager (see “Managing Databases” on page 158). 
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Figure 76: The General tab of the Database Manager window (page 158) showing web accessible 

hyperlinks in the Sky Database Description field. 

Additionally, there are options that control plotting, searching, and how object 
information is shown in the database and/or Sky Chart. 

Advanced Tab 

Under Advanced, you will find operators to translate text to object type, multipliers for 
various measurements and coordinates, folder options, and Unicode control. 
 
To the left is the Translate Text to Object Type section.  Simply type text into the fields, 
and select the desired object type from the drop-down menu. 
 
Multipliers for right ascension, declination, magnitude, major and minor axes, and 
position angle may be entered into the fields to the upper right. 
 
Under Folder Operations, you can choose to compile a new folder from existing text 
files, or you may choose to convert a folder of TheSky6 database files for use in 
TheSkyX. 
 
Additionally, you can convert a text file to Unicode and select from a list of codecs to use 
in the To Unicode section to the lower right. 

Compile Tab 

This is where you can finally compile your database, once all the criteria are set.  
Clicking the Compile button compiles the database, revealing the corresponding text file 
in the field with a star chart above.  You can add a header by checking the Add header to 
text file box. 
 
Once you are finished, click the Close button. 
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Defining Search Fields in Sky Databases 

Most text-based celestial object databases include catalog numbers or other identifiers to 
uniquely identify each object.   
 
TheSkyX can use these identifiers to generate a “searchable” Sky Database (SDB) .  
Objects in these databases can be located by typing the SDB Search Identifier, followed 
by the object’s unique identifier in the Search For text box on the Find window. 
 
Searchable Sky Databases and the objects they contain, are also listed in the Advanced 
tab of the Find dialog.   
 
The following procedure describes how to configure the Sky Database parameters so that 
once the SDB is created, the objects in the database can be located using the Find 
command on the Edit menu. 
 

1. Select the Create Sky Database command from the Input menu. 
2. On the Define Fields tab, click the Choose button near the top to the window. 
3. Select the file that contains the space separated text-based celestial object 

database and click Open.  The contents of the text file appear on the right side of 
the Define Fields tab. 

4. Specify the beginning and ending columns that hold the RA Hours, RA Minutes, 
RA Seconds, Dec Sign, Dec Degrees, Dec Minutes and Magnitude.  These are 
the minimum required fields for an SDB.   
 
For example, suppose in columns 66-74 contain right ascension in decimal 
format.  To define RA Hours, select this text on the left side  of the window, then 
enter 66 in the Starting Column text input and 74 in the Ending Column text 
input and then click the Set Columns button.  The text file shows RA Hours in 
blue above these columns. (You can also drag the mouse to highlight the desired 
columns in the text file on the right.)   
 
Repeat this process for each required field. 
 

5. On the Behavior tab, click  
6. Turn on the Allow Searching for Objects in Database checkbox on the Behavior 

tab of the Create Sky Database window. 

Search Prefix  

Some astronomical databases do not require a prefix to search for objects that are present 
in a database.  For example, if the database contains common names of objects like 
“Polaris” or “Andromeda Galaxy”, a catalog prefix is not required. 
 
Other catalogs identify each item by a single, unique number.   For example, the NGC 
catalog has 7,840 items and they are numbered from 1 to 7,840.  For this catalog, a prefix 
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and a number are required to uniquely identify and locate each object in the catalog (for 
example, NGC 555).  
 
In the example below, the ARP catalog of galaxies requires a Search Prefix because the 
search field contains only numbers from 1 to 338.  Entering just the number “338” would 
not provide enough information to uniquely identify ARP 338.  

Search Prefix Hints 

• For convenience when searching, limit prefixes to about 3-5 characters.  
• Do not use existing prefixes such as NGC, IC, PGC or SAO.  
• If a Search Prefix is defined in an SDB, then the prefix is required when 

searching for objects in that SDB.  For example, if the Search Prefix is defined as 
ARP-PG then the only way to locate objects in the Arp Peculiar Galaxies SDB is 
to enter ARP-PG 338.  

 

 
Figure 77: The Behavior tab on the Sky Database window (Sky Database command from the Input 

menu). 

Just like other fields on the Define Fields dialog, the Label/Search field is specified by 
dragging over the columns (in this example, columns 1 through 3) then clicking the Set 
columns button. Alternatively, you can drag the columns then double-click on the 
Label/Search field.  
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Figure 78: The Define Fields tab on the Sky Database window (Sky Database command from the 

Input menu). 

In the Advanced tab of the Find dialog, when the database is expanded the Search Prefix 
will be added to the search field.  
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Figure 79: The Advanced tab on the Find dialog (choose the Find command on the Edit menu). 
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My Chart Elements 
TheSkyX allows you to add your own chart elements to the Sky Chart.  In so doing, 
TheSkyX gives you the best of convenience from both electronic and paper star charts. 

Adding Chart Elements 

 
Figure 80: The My Chart Elements window (Input menu). 

 
The easiest method to add a chart element to the Sky Chart: 
 

1. Select the My Chart Elements command from the Input menu. The My 
Chart Elements window opens.  At the top left is a checkbox, Show My 
Chart Elements.  Once you have added your own elements, turning this 
option on will reveal them on the Sky Chart.  Notice that there are two 
tabs in this window, Manage and Import/Export. 

2. On the Manage tab, select which element to add by clicking one of the 
buttons on the left side of the window: 

• Add Object – Adds an object to the Sky Chart.  The object can be 
of any type (star, cluster, galaxy, etc.) or one of your own object 
types (My Object Type). 
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• Add Label – Adds a text label to the Sky Chart.  The Enter Label 
window will appear so that you can specify the label’s text. 

• Add Object Label – Adds a custom label to an existing object.   
• Add Arrow – Add a reference arrow to the Sky Chart to highlight a 

particular object or region. 
• Add Ellipse – Adds an ellipse to the Sky Chart. 
• Add Area of Interest – Adds a shaded rectangular region to the 

Sky Chart for emphasis. 
• Add Chart Scale – Adds a small graphic that shows the angular 

scale for the chart. 
• Add Telrad – Adds a Telrad™ Finder to the Sky Chart. 
• Add Graphic – Adds a photograph or Scalable Vector Graphic to 

the Sky Chart. 
3. Position the mouse cursor over the Sky Chart, then CTRL+left-click 

(Windows) or +left-click (Mac) to add the Chart Element at that 
position. 

 
Or, click the Add and Edit button on the My Chart Elements window.  This opens a new 
window where you can input the necessary information about the element. 
 

 
Figure 81: Add/Edit Chart Element window. 

 
Near the top of the Add/Edit Chart Element window, you will see the coordinates 
section.  You can choose between Equatorial or Horizon (azimuth-altitude) coordinates.  
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Also, you can choose to precess the coordinates you put in from one equinox to the 
current one to update old data.  To do this, simply input equinox dates in the fields To 
and From, and then click Precess.  The new coordinates will then appear in the 
coordinate fields above. 
 
Note:  This function works forward or backward.  If you would like to precess current 
coordinates to a past time, you can do that, as well. 
 
Once you have your coordinates entered, it is time to choose the object type.  Using the 
pop-up menu, choose the object type for your new chart element.  Remember that each of 
these objects is able to be toggled from various places in the Chart Elements window. 
 
You can then enter Label text, and a Snap to/cross reference point in the appropriate 
fields. 
 
The next four fields control the actual appearance of your object in the Sky Chart.  
Magnitude, just like the magnitude of a star, controls the apparent brightness of the 
object in the Sky Chart (remember that the bigger the number, the dimmer the object).  
Position Angle controls the angular offset in degrees of your new object and the 
reference object, relative to the north celestial pole.  Imagining your object as an ellipse, 
input the major and minor axis measurements in arc minutes.  Remember that circles are 
special types of ellipses whose major and minor axes are equal. 
 
Near the bottom of the window are the DRAW commands.  You can choose the type of 
draw command you wish to use from the drop-down menu.  You can then enter a 
command argument into the field below, or use the arrows to choose an appropriate 
argument value. 
 
Once you click OK, you will be brought back to the My Chart Elements window, and 
your new custom chart element appears in the object list to the right. 
 
You can always edit the element data by clicking Edit. 
 
To center the object in the Sky Chart, click Center. 
 
Clicking Remove All will remove all My Chart Elements. 
 
To change the CTRL+left click (Windows) or +left-click (Mac) behavior, use the drop-
down menu to the lower left.  You can choose to snap to the Cursor Position, Nearest 
Star, or the Nearest Non-stellar Object. 
 
When you are finished managing My Chart Elements, click Close. 
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Export/Import My Chart Elements 

Choose the Export/Import tab at the top of the My Chart Elements window.  Here, you 
will be able to export your created chart elements, or you can import other chart elements 
from a text file. 

Exporting Chart Elements 

Follow these easy steps to export your chart elements in Sky Database (SDB) format. 
 

1. To export a chart element, choose Export/Import tab at the top of the My 
Chart Elements window.  The top portion of the window now shows export 
options. 

2. Choose an appropriate identifier and enter it into the first field. 
3. Then, from the Default Object Type drop-down menu, choose the desired 

object type.  You can choose from any of the object types used in TheSkyX. 
4. Choose the desired maximum and minimum values for the FOV (Field of 

View). 
5. Coordinate Frame lets you choose between equatorial or horizon (alt.-

azimuth) coordinate systems. 
6. Choose the appropriate equinox, plot order, and cross reference type. 
7. Before exporting, be sure to take note of the checkboxes to the top right of the 

export section.  These boxes let you toggle options for plotting objects and 
their labels, make these objects searchable, and to enable click identify for 
them. 

8. Once you are ready, click the Export to File... button to export your data to a 
Sky Database file.  Simply choose the file’s destination, and click Save. 

 
Note:  You can also save these data to the clipboard for later pasting. 

Importing My Chart Elements 

You can import  any chart element(s) from a text file by using the bottom portion of the 
My Chart Elements window, Export/Import tab.  Simply click the From File button to 
import an existing file.  If you have chart element data copied to the clipboard, you can 
paste those data into TheSkyX by clicking the button labeled From Clipboard.  
Additionally, you can change the working directory by clicking the Choose button. 

Observing Lists  
The Manage Observing List command in the Tools menu can be used to perform 
advanced searches or database queries to generate observing lists.  The Advanced Query 
tab offers much more detail regarding your query of celestial objects than the simplified 
options on the What’s Up Setup tab. 
 
The normal procedure for creating an observing list is to define the type of objects you’re 
after, and specify the astronomical databases to search (in the Object Types & Databases 
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tab).  Next, you can create custom filters based the attributes of the object types in the 
Filters tab.  The Constellations tab allows you to refine the location further. 
 
Once you’ve defined the parameters for your query, clicking the Run Advanced Query 
button generates an observing list on the Observing List window (Display menu). 

Advanced Query Setup 

Defining an advanced query is as simple as turning on the Advanced Query tab to the left 
of the What’s Up Setup tab.  You will notice that the query setup area changes to a multi-
tabbed window that lets you Open/Save Query, choose Object Types & Databases, set 
Filters, and select Constellations and Other criteria for your query.  The following is a 
brief discussion of each tab and the information contained there. 
 

 
Figure 82: Advanced Query tab on the Manage Observing List window (Tools > Manage Observing 

List command). 

Open/Save Query Tab 

Here, you will see advanced (or Saved) queries available to you.  You can open queries 
by double-clicking on the query name in the Saved Queries list (the Current Query 
shows the name of the currently loaded query settings file), save current query settings by 
clicking the Save As button, or create new ones by clicking one of the options in the 
Create New Query For pop-up menu.   
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Figure 83: Create New Query For pop-up menu. 

To Create a New Query 

1. Click the Create New Query pop-up menu. 
2. Select from one of the pre-defined queries to setup a query for that object type.  

Or click the Let Me Define Query Parameters command to clear any existing 
query settings and start from scratch. 

 
The Query Attributes list shows the selected object types and databases and the various 
filters used in the selected query. 

Object Types & Databases Tab 

Here is where you select which types of objects you wish to include in your query, along 
with from which databases you would like to search. 
 
It’s best not to mix object types in your query.  For example, it’s not a good idea to create 
a single query for asteroids and spiral galaxies.  These object types are distinct and need 
separate queries. 

Filters Tab 

Under this tab, you can select from a thoroughly customizable list of filter options to 
narrow your query parameters.  All current filters can be edited or removed at any time 
by using the corresponding buttons found in the Current Filters section. 

Constellations Tab 

This tab allows you to specify a specific constellation, or group of constellations, to 
search. 

Other Tab 

This tab includes options that allow you to name your query, choose among search 
criteria related to the Sky Chart, set queries to run automatically at given times, and to 
determine imaging availability of objects sorted by the query. 
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Observing List Example 

Let’s go through the steps involved in running an advanced query.  Suppose you want to 
create an observing list that contains all the double stars from the Washington Catalog of 
Double Stars that have a spectral type of G5 in Orion.   
 
TheSkyX makes generating an observing list from this complex query relative simple. 
 

1. Select the Manage Observing List command in the Tools menu. 
2. Click the Advanced Query tab.   
3. On the Advanced Query tab, click the Create New Query For pop-up menu. 
4. Select the Double Stars command.  Double stars from the WDS (Washington 

Catalog of Double Stars) database are automatically selected for you in the Object 
Types & Databases tab. 

5. Click the Filters tab to define a filter that limits our search to just the G5 double 
stars.  In the Attributes list, expand Double Stars, then select Spectral Type and 
click the Create Attribute Filter button. 

 

 
Figure 84: The Create Attribute Filter dialog. 

6. On the Create Attribute Filter dialog, select the Equal To command from the 
Match Objects That pop-up menu. 

7. Type the text G5 into the This Value text input and click OK. 
8. On the Constellations tab, click the None button, then turn on the check mark 

next to Orion. 
9. On the Open/Save Query tab, click the Save As button, and specify the name of 

this query as G5 Double Stars in Orion.  It’s always a good idea to save your 
work. 

10. Click the Run Advanced Query button to run the query and create the observing 
list on the Observing List window (Display menu). 

 
The Observing List window now shows forty-three G5 double stars in Orion.   
 
When you highlight any object on Observing List, the green laser pointer will direct you 
to it in the Sky Chart.   
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The Show on Sky Chart pop-up menu affects how the object is shown in the Sky Chart.  
You can choose among Wide-field view, Constellation view, Small-field view, or Do not 
show at all. 
 
Clicking the Center button centers the object in the Sky Chart’s field of view. 
 
Clicking Copy Text copies the object text to the clipboard. 
 
Print Information lets you print out the data from the list about the object. 
 
If you would like to slew a connected telescope to the object, simply click Slew to make 
it so. 

Observing List Window 

The Observing List window lets you create, edit, and manage objects your observing 
lists. 
 

 
Figure 85: The Observing List window (Observing List command from the Display menu). 

Observing lists can be created from TheSkyX in several different ways: 
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• Manually add items.  For each object in the list, double-click <Add> on the 
spreadsheet control, enter the name of the object and the press the Return key 
(Enter key on Windows). 

• What’s Up?  Click the What’s Up? button located on the top left of the window 
to generate a list of objects (page 60). 

• Manually type or paste a list of object names from the Clipboard.  Click the 
Manage Observing List button on the top of the Observing List window, then 
click the Add Objects tab.  From here, you can type the list of object names, or 
paste a list of names that have been copied to the Clipboard by clicking the Paste 
Object Names button.  When the list is complete, click the Add Objects to 
Observing List button to update the Observing List spreadsheet. 

• Create an advanced query.  Click the Manage Observing List button on the top 
center of the window to define simple or extremely complex database queries that 
produce exactly the observing list you need.  See “Observing Lists” on page 172 
for details. 

Labeling Observing List Objects (Label objects in observing list) 

Turn this option on to display a text label next to each object in the observing list. 

Draw a Line Between Observing List Objects (Draw a line connecting list objects) 

Drawing a line that connects each object in the list helps visualize the path the telescope 
must take to view each object in the list. 

Centering Objects in the List (Center) 

Highlight an object in the list, then click the Center button to center this object in the Sky 
Chart.  The chart’s field of view stays the same. 

Copying Object Information to the Clipboard (Copy Text) 

Highlight an object in the list, then click the Copy Text button copy the object’s 
information to the Clipboard.  This text report can be pasted into any text editor. 

Print Information  

Click this button to print the Object Information Report for selected observing list object 
on the default printer. 

Slew the Telescope (Slew) 

Slew the telescope to the selected object. 

Add Observing Notes (Add to Observer Log) 

Use  the Observing Log dialog to keep a track of the objects you have observed.  You can 
even rate the object and seeing conditions, as well as add personalized notes.   
 
Select the observed object in the list, then click the Add Observer Log button to show the 
Edit Observation tab of the Observer Log window. 
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Figure 86: The Edit Observation tab on the Observing Log window (click the Add Observer Log 

button on the Observing List window to view this window). 

Name of the Observer (Observer) 

Type your name, or the list of observers’ names, here.   

Rate the Current Seeing Conditions (Seeing)  

Atmospheric turbulence, moisture, light pollution, and many other factors influent local 
astronomical seeing conditions.  Seeing conditions are typically rated on a scale from 1-
5, the higher the rating, the better the seeing. 

Rate the Current Object (Rating)  

Similar to rating seeing, the subjective quality or appearance of the object that you’re 
observing can also be rated.  Again, a higher the number indicates a better rating. 

Enter Personal Comments (My notes) 

Critique the observed object by typing your notes here. 
 

Updating the Observations Table (Update My Observations) 

Click this button to add notes, ratings, and object information to the My Observations 
table on the My Observations tab. 
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Figure 87: The My Observations tab on the Observer Log window (click the Add Observer Log button 

on the Observing List window to view this window). 

The My Observations table shows the list of objects that you have observed.  The 
Observing List table shows an icon next to objects to indicate they have been observed.  
 

 
Figure 88: Objects that have been observed include a checkmark next to them in the Observing List. 

To remove an observation, select it and press the DELETE key. 

Manage Observing List Window Orientation 

The orientation and position of the controls in the Observing List stacked window 
changes based on the window’s aspect ratio (that is, the ratio of the height to the width of 
the window).   
 
This allows the Observing List window to float in a vertical orientation or be docked to 
the left or right side of the main window.  The window can also float in a horizontal 
orientation or be docked to the bottom of the main window.   
 
You can choose which orientation works best for your workflow and hardware (screen 
size, aspect ratio, resolution, number of screens, etc.). 
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By default, the Observing List window is docked to the left side of TheSkyX’s main 
window in the vertical orientation.  To undock it, first make sure it’s the topmost stacked 
window by clicking on the Observing List tab on the left side of the window.  (Click the 
Observing List command from the Display menu to turn it on if necessary.)   
 
Once visible, click and drag the topmost portion (the caption) of the Observing List 
window and move it off the stacked windows. 
 

 
Figure 89: Click and drag the mouse to undock or “tear off” the Observing List window. 

The window can now be positioned where you want, even on a second monitor (if you’re 
lucky enough to have two!). 

Horizontal Orientation 

The controls on the Observing List window automatically switch between the vertical and 
horizontal orientation as the window is sized.  
 
When the window is taller than it is wide, the controls appear in a vertical orientation.  
When the window is wider than it is tall and the window is wide enough to fit the 
controls in a horizontal orientation, the controls are automatically repositioned.  
 
To make the Observing List controls appear a horizontal orientation, click the lower right 
corner of the Observing List window (or the size control in the lower right corner on the 
Mac) and drag the window wider (while not making it taller).  Once the window is wide 
enough to fit the controls horizontally, they’re repositioned automatically. 
 
When the Observing List window is in the horizontal orientation, it can also be “docked” 
to the bottom of the main window (see Figure 89).  To dock it to the bottom of the main 
window, click and drag the caption to the center of the bottom of the main window.  
When the top of the caption is near the bottom of the main window, positions of the Sky 
Chart and stacked windows are adjusted to make room for the Observing List window.  
At this point, release the mouse to dock the window. 

Observing List Orientation Notes 

• The Observing List window cannot be docked to the bottom of the window when 
the Observing List controls are in the vertical orientation. 

• The main window will not allow the Observing List window to be docked at the 
bottom if there’s not enough room for it to fit.  So, maximize the main window 
before attempting to dock the horizontal Observing List window.   

• The Chart Status Window can be closed or undocked to make room, if necessary. 
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• If all attempts at “bottom docking” fail, then close all other stacked windows.  If 
the window refuses to be docked it means there is not enough room for it to fit. 

 

 
Figure 90: The Observing List controls in a horizontal orientation and docked to the bottom of the 

main window. 

This configuration allows you to access items in the observing list while viewing the Sky 
Chart and still have access to the controls in the other stacked windows. 

Creating Sky Chart Mosaics 

 
The Mosaic Grid command on the Tools menu can be used to divide a rectangular area of 
the sky into smaller rectangular regions (called tiles), each of which has the dimensions 
of a selected field-of-view indicator (FOVI) or any other custom size.  Once the mosaic is 
created, you can slew the telescope to the center of any rectangle simply by clicking on it. 
 
This provides an easy way to photograph an area of the sky that is larger than a single 
CCD or film photograph can cover, or to systematically survey sections of the sky (as 
when searching for comets or asteroids).  
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Figure 91: Sample mosaic grid on the Sky Chart. 

1. Select the Mosaic Grid command from the Tools menu to show the Mosaic Grid 
dialog. 

 

 
Figure 92: Mosaic Grid dialog. 
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Mosaic Tile Geometry 
Use the options on the Geometry tab to define the Width and Height, in 
arcminutes, of each mosaic tile and each tile’s rotation, or Position Angle, in 
degrees, measured counterclockwise from North.  You can optionally select a 
field of view indicator in the My FOVIs list. 
 
Next, enter the number of Rows and Columns, the Overlap of the primary 
mosaic grid and the grid’s position on the celestial sphere, equatorial 
coordinates.  
 
Turn on the Follow Moon checkbox so that TheSkyX will slew to the current 
position of the Moon, instead of a fixed equatorial coordinate.  
 
Turn on the Show Mosaic Grid checkbox to show the mosaic grid then click 
the Create and Show Mosaic Grid button to center and frame the mosaic on 
the Sky Chart. 
 

2. Click the Advanced tab.  The Advanced tab can be used to duplicate the primary 
mosaic grid.     

 

 
Figure 93: Advanced tab on the Mosaic Grid dialog. 

Enter the horizontal (x-axis) and vertical (y-axis) offset for the new mosaic. 
The offset unit is defined as the “width of the primary mosaic.” A value of 1 
in the “X offset” will place the replicated mosaic’s upper left corner next to 
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the primary mosaic’s upper right corner. (The offset is always relative to the 
upper left corner of the primary mosaic.)  
 
An offset of 0,0 is allowed and will place another mosaic on top of the 
primary mosaic. The mosaics centers are numbered starting at one through the 
total number of mosaic regions. Mosaics are ordered alphabetically.  
 
Click the “Add” button to create the new mosaic and add the offset to the 
mosaic replication list. 
 

3. Specify the numbering convention for the mosaic centers.  
• -X,+Y – Mosaic center numbers are incremented right to left by row, 

starting in the upper right corner of the mosaic.  
• +Y,+X – Mosaic center numbers are incremented top to bottom by 

column, starting in the upper right corner of the mosaic. 
• +X,+Y – Mosaic center numbers are incremented left to right by row,  

starting in the upper right corner of the mosaic. 
• -Y, -X – Mosaic center numbers are incremented bottom to top by column, 

starting in the lower left corner of the mosaic. 

To Clipboard Button 

Click the button to copy the equatorial coordinates of the centers of selected mosaic to 
the Clipboard. These coordinates can be used to generate a script that slews your 
telescope to each position. 

 

Sample mosaic grid data: 
 
  1  A   0   9.32121655 -29.04969590 
  2  A   1   9.32119169 -28.89969638 
  3  A   2   9.32116702 -28.74969737 
  4  A   3   9.32114254 -28.59969785 
  5  A   4   9.30977751 -29.04991248 
  6  A   5   9.30976922 -28.89991265 
  7  A   6   9.30976100 -28.74991333 
  8  A   7   9.30975284 -28.59991349 
  9  A   8   9.29833849 -29.04991248 
 10  A   9   9.29834678 -28.89991265 
 11  A  10   9.29835500 -28.74991333 
 12  A  11   9.29836316 -28.59991349 
 13  A  12   9.28689945 -29.04969590 
 14  A  13   9.28692431 -28.89969638 
 15  A  14   9.28694898 -28.74969737 
 16  A  15   9.28697346 -28.59969785 

Reset Slewed 

Once you have slewed your telescope to a given frame, parentheses are placed around the 
number in the center of the block, indicating that this frame has been imaged. If you wish 
to start the mosaic process over, click this button to clear all the parentheses. 
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Using the Mosaic Grid 

Once a link with the telescope is established , click anywhere within one of the mosaic 
tiles, and the telescope will automatically slew to its equatorial center. 
 
If you are viewing or photographing the Moon, turning on the Follow Moon checkbox. 
The telescope’s drive will automatically be reset to the lunar rate. (The previous rate is 
restored when you remove the mosaic.) 
 
Although each tile is numbered sequentially, you can slew to them in any order. (If 
TheSkyX’s window is not maximized, or the field of view is too small, the numbers might 
not be displayed.) A selected frame’s border changes color from magenta to red, to 
remind you it’s been “visited.”  To reset each tile to its original color, click the Reset 
Slewed button.  
 
If you’re using the Mosaic Grid feature to take pictures, the CCD or film camera has to 
be aligned with the mosaic frames. You must therefore either position the camera to align 
it with the Sky Chart, or orient the Sky Chart to the camera. TheSkyX can help you. Use 
Image Link to align one of your CCD images with the Sky Chart, the “Image Link 
Information” gives the orientation of the image as an angular offset from North. You can 
then adjust the camera mount or the Sky Chart’s orientation accordingly.  
 
The Mosaic feature works best with equatorial telescopes. Alt-az telescopes suffer from 
field rotation, which causes the field of view to gradually rotate. The severity of this 
effect varies with the altitude coordinates of the area being photographed, and the length 
of time needed to complete the photography. A field-rotation corrector might be needed.  

Image Link and Automated Astrometry 
 
TheSkyX Professional Edition’s Image Link™ and automated astrometry feature make it 
possible to overlay Flexible Image Transport System (FITS) photos on the Sky Chart.   
 
Star patterns in the photo are compared with known star catalogs to determine the photo’s 
astrometric solution (sometimes referred to as a “plate solve”).  This means the photo can 
exactly overlay the Sky Chart – stars and galaxies in the photo match the corresponding 
objects on the Sky Chart.  
 
Image Link can be used with photos from the Digitized Sky Survey for area of the sky of 
up to about 3° square.  
 
Your photos become interactive star charts.  Objects in the photo can be viewed, labeled 
and identified, just as if they were part of the Sky Chart. 
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The astrometric solution can be used to precisely locate the position of variable stars, 
optical components of gamma ray bursts, supernovae, comets and asteroids.  It can also 
be used to automate calibration runs using the TPoint Add On. 

Photo Requirements 

An astrometric solution can be determined for photos that have the following attributes. 
 

• A FITS photo that adheres to the Flexible Image Transport System standard.   
• A minimum of 6 well-defined stars in the photo.  
• A field of view of 10 degrees or smaller.  For photos that have small fields of 

view (5-20 arcminutes), Software Bisque recommends using one of the larger star 
catalogs from TheSky6 Professional Edition Database Add On (page 266). 

• The approximate equatorial coordinates of the photo must be known.  When you 
use TheSkyX or CCDSoft for Windows to acquire photos, the FITS header 
includes this information.  

• The approximate scale of the photo, in arcseconds per pixel, must be known.  If 
you know the details of the optical system and detector, the scale can be obtained 
from the Field of View Indicator Report (page 65). 

  
Let’s use a FITS photo from the Digitized Sky Survey to demonstrate how Image Link 
and automated astrometry work together.   
 

1. On the Find tab, enter M81 and then click the Frame button.  This sets the field 
of view to about 40 arcminutes and frames M81 on the Sky Chart. 

2. Select the Digitized Sky Survey command from the Tools menu. 
3. On the Setup tab, turn on the Web option to retrieve Digitized Sky Survey photos 

from the web. 
4. On the Create Photo tab, click the Create button in the Show in FITS Viewer 

section.  The photo is downloaded from the web and displayed in the FITS 
Viewer window. 

5. On the FITS Viewer window, click the To Image Link command in the Photo 
pop-up menu.  The photo is now displayed in the Image Link window. You’ll 
normally open your FITS photos that are acquired from a CCD or digital camera 
by clicking the Open FITS button on the Image Link window. 

6. Click the Find Astrometric Solution button.   
 
The Astrometric Solution tab on the Image Link window shows the equatorial 
coordinates of the photo, the scale, position angle and the list of stars used in the solution.  
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Figure 94: The Astrometric Solution tab of the Image Link window. 

The photo of M81 also appears on the Sky Chart at the appropriate location.  Turn on the 
Show Photo In Front of Chart Elements option to show the photo “on top of” the other 
chart elements. 
 

 
Figure 95: M81 “linked” to the Sky Chart. 
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The default Image Link settings can be used to perform astrometric solutions on photos 
acquired from a wide range of optical systems.  If an Image Link fails, check the 
following settings on the Setup tab of the Image Link window. 

Unknown Scale 

When the Unknown Scale option is turned on, TheSkyX still needs to know the 
approximate image scale of the photo.  For example, if the image scale is 10 arcseconds 
per pixel but you use 1 arcsecond per pixel, then the Image Link will fail.  Make sure that 
the Approximate Scale value is “close to” the actual scale (plus or minus 2 arcseconds 
per pixel). 

Known Scale 

When the Known Scale option is turned on, make sure to use the correct scale of the 
photo (to plus or minus 0.5 arcseconds per pixel). 
 
If you’re sure the scale is correct, the next step is to review and configure the Source 
Extraction Setup parameters.  Source Extractor is a powerful photo analysis tool used by 
TheSkyX to catalog the sources of light (that is, stars, extended objects like nebulas, 
asteroids, etc.) in photos.   
 
If your wide-field photo contains too many light sources (photos in the Milky Way, for 
example), or has a poor signal to noise ratio (too short of an exposure), you’ll want to try 
altering two Source Extractor parameters accordingly to achieve a successful astrometric 
solution.  In other words, if there are too many light sources, increase the Detection 
Threshold so that fewer stars are used on the astrometric solution.  If there is an 
insufficient number light sources, decrease the Detection Threshold until a sufficient 
number is found. 
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Figure 96: The Source Extraction Setup dialog. 

Typically, the Detection Threshold is the only setting that needs to be adjusted to allow a 
successful astrometric solution.   
 
The Detection Threshold can range from 1.0 up to 50.0.  The lower the number, the more 
light sources that will be found in the photo.  When the Detection Threshold too low, 
then potentially too many light sources, or light sources from noise in the photo can be 
found.  Too many light sources and or light sources from noise will cause the astrometric 
solution to fail. 
 
If an astrometric solution fails for a particular photo, or for all the photos obtained your 
imaging system, then altering the Detection Threshold is usually the solution. 
 
If changing the Detection Threshold over a range of values fails to find a solution, the 
next, not normally necessary, step is to change is the Minimum Number of Pixels Above 
Threshold. 
 
The Minimum Number of Pixels Above Threshold is the number of “pixel counts” 
above the background (or black point) that a light source must be to be detected.  Increase 
this value by increments of 5 or so until the astrometric solution is found. 
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Advanced users can read Source Extractor for Dummies by Dr. Benne W. Holwerda of 
the Space Telescope Science Institute for a technical explanation of each source 
extraction parameter (and more). 
 
Here are a few examples of how modifying the Detection Threshold parameter can affect 
the astrometric solution. 

Example 1 

 
Figure 97: Photo with satellite trail. 

The above photo has a satellite passing through it.  Setting the Detection Threshold to 1, 
and then clicking the Light Sources button on the Image Link Setup tab shows the light 
sources in the photo. 
 
 

 
Figure 98: A “poor” inventory of light sources. 

http://astroa.physics.metu.edu.tr/MANUALS/sextractor/�
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What’s wrong here? When the Detection Threshold at set to 1, the streak is misidentified 
as a series of non-existent light sources.  These “stars” are then used in the astrometric 
solution, and, Image Link fails because these light sources do not actually exist. 
 

 
Figure 99: "Correct" inventory. 

 
Changing the Detection Threshold parameter from 5 to 10, shows no stars detected in the 
“streak” and only true “stars” are identified. 
 
Note: Even though an astrometric solution can be found using this photo, it is a very poor 
photo for many reasons. It has very bad signal to noise ratio (the dynamic range is 65 
counts out of a possible 65535), and it is also “deficient” in stars (about 6 are 
“inventoried”). A longer exposure is highly recommended for photos like this.  
 

Example 2 

This photo also reveals the importance of the Detection Threshold setting. 
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Figure 100: Sample image. 

The above photo contains relatively good signal and has many “well-defined” stars. 
However, notice how the nebulosity in the upper left affects the inventory using different 
Detection Threshold values. 
 

 
Figure 101: Note the incorrectly identified "stars" in the upper left corner. 

 
A Detection Threshold setting of 6 identifies stars in the nebula that do not exist, and 
causes the astrometric solution to fail. 
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Figure 102: Changing the detection threshold correctly identifies stars in the nebula. 

 
A Detection Threshold setting of 30 correctly identifies the stars in the nebula; The 
solution will now succeed. 

Example 3 

 

 
Figure 103: Poor signal-to-noise ratio and poor focus make this a very poor candidate for an 

astrometric solution. 

At first glance, image in Figure 102 may appear to be a good candidate. Upon closer 
inspection, the image “falls apart”… 
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Figure 104: Histogram 

The histogram (from CCDSoft for Windows) shows that there is very little actual signal. 
The default background and range settings differ by a mere 65 counts for a 16-bit 
(65,353) camera. The exposure time should be increased to ensure better a signal-to-noise 
ratio. 
 

 
Figure 105: Same image after adjusting the range or "white point" 

After increasing the range (that is, increasing the “white point” in the image), another 
very important deficiency is revealed, specifically that the image is way out of focus. 
Notice the donut-looking stars.  
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Figure 106: Multiple light sources (indicated by two red dots) are detected for individual “out of 

focus” stars. 

The Show Inventory command, using a detection threshold of 10, reveals that several of 
the out of focus stars are identified as two separate light sources!  If multiple light sources 
are detected for a single star, then the astrometric solution will almost certainly fail. 
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Telescope Control 
TheSkyX Serious Astronomer Edition can control many go to and computer guidable (or 
“push to”) telescope mounts.   
 
SUN OBSERVING WARNING! 
NEVER attempt to observe the Sun through your telescope! Without a specially designed 
solar filter, looking the Sun through a telescope or with the naked eye – for even a 
fraction of a second – will cause instantaneous, irreversible eye damage. 
 
When observing during the day, do not point the telescope near the Sun. Do not use 
TheSkyX’s automatic-slew feature to find astronomical objects during the day. 
 
Children should never use a telescope during the daytime without strict adult supervision. 

Telescopes with Optical Encoders (Push To) 

If your telescope is equipped with optical encoders, TheSkyX can show and track its 
position with the aid of a “serial interface box”.  The encoders read the rotation of the 
telescope’s axes, and return numbers that represent how much they moved. The following 
serial interface boxes are compatible with TheSkyX. 
 

• AB Engineering 
• BBox (Software Bisque) 
• NGC-MAX (JMI)   
• NGC Sky Commander (Lumicon)  
• Sky Commander (SkyComm Engineering)  
• Sky Wizard 3 (Lumicon)  
• Sky Tour (Tele Vue)  
• SkyQuest IntelliScope Computerized Object Locator (Orion Telescopes & 

Binoculars) 
 
Jim’s Mobile, Inc. (www.jimsmobile.com) is a good source to purchase software-guided 
telescope (SGT) hardware.  

Telescopes with Go To Control 

TheSkyX can send positioning and other commands to the following “go to” telescope 
systems. 
 

• Astro-Physics GTO mounts (all models)  
• Celestron™ Advanced Series (all models)  
• Celestron™ NexStar (all models)  
• Celestron™ CG Series (all models)  

http://www.jimsmobile.com/�
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• Celestron™ CGE Series (all models)  
• Celestron™ CPS Series (all models)  
• Celestron™ GT Series  
• Celestron™ SLT Series (all models)  
• Celestron™ NexStar i Series (all models)  
• Celestron™ Ultima 2000™ telescopes 
• Gemini Telescope Positioning System (Losmandy and MI-250)  
• iOptron™ SmartStar™ Series 
• Meade™ LX200™ (Classic) Telescopes 
• Meade™ LX200™ 16-inch (Classic) Telescopes 
• Meade™ Autostar (classic) telescopes 
• Meade™ Autostar II (LX200 GPS) Telescopes and Mounts 
• Meade™ Autostar III Telescopes and Mounts  
• Orion® Telescopes & Binoculars Atlas™ EQ-G Equatorial Mounts and 

Sirius™ EQ-G Equatorial Mounts  
• SkyWatcher mounts using the SynScan Controller 
• StellarCAT™ Computer Assisted Telescope Innovations 
• Takahashi™ Temma mounts (all go to models)  
• Vixen™ Sphinx™ and Sphinx Deluxe mounts 

 
In addition, TheSkyX can simulate a telescope link. You can experiment without actually 
having a telescope connected.  
 
Whether your telescope has optical encoders, or computer control, the Sky Chart tracks 
the telescope’s position. In addition, TheSkyX can command “go to” telescope systems.  
Select an object from TheSkyX’s database, and it will point the telescope at it. 
 
All systems using optical encoders are set up the same way and are explained below in a 
single section.  Computer-controlled telescopes are each set up slightly differently.  

Setting the Correct Time 

Computer-controlled drive systems typically have an internal clock that must be set with 
high accuracy.  (Encoder-based systems do not need as high degree of accuracy.)  The 
best method for keeping accurate time on your computer is to use an Internet time server.  
Most modern operating systems include time synchronization as part of their Date & 
Time settings. 

Night Vision Mode 

Selecting Night Vision Mode command from the Display menu (or clicking the Night 
Vision button) redraws the display in red to minimize loss of dark adaptation.   
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On the Mac, turning on Night Vision Mode will show the entire desktop, and all other 
applications that are running, red.  Turning off Night Vision Mode, or exiting TheSkyX 
restores the screen colors. 
 
Under Windows, by default, turning on Night Vision Mode reddens only TheSkyX’s main 
window.  In order to change the desktop colors, you must configure TheSkyX to use a 
Windows Theme.  See the “Night Vision Setup (Display Menu)” below for details. 

Night Vision Setup (Display Menu) 

TheSkyX on Windows allows you to change screen elements or both screen elements and 
the Windows theme to red.  (You can learn more about Windows Themes by searching 
Windows help.)  Each method has advantages and disadvantages.  Together they can 
provide an effective way to minimize screen brightness that should satisfy even the most 
discriminating astronomer. 
 
The Night Vision Setup dialog (Figure 106) lets you configure how colors are changed 
when entering and exiting Night Vision Mode. 
 

 
Figure 107: Night Vision Setup dialog (Display menu, Windows OS only). 

When the Change Windows Desktop Theme checkbox is off and the Night Vision Mode 
button clicked on,  the colors of the TheSkyX’s screen elements change to red.     
 
Note that when the Change Windows Desktop Theme checkbox is turned off, the options 
to set theme names are disabled.  
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Figure 108: Sample Night Vision Mode Screen that does not use the Windows Desktop Theme. 

When the Change Windows Desktop Theme checkbox is on and the Night Vision Mode 
button is clicked on, the selected Night Vision Mode Theme File Name is loaded.   
 
Themes are changed automatically under Windows 7.  Under Windows XP and Windows 
Vista, the Control Panel’s Display Properties application  appears, and you must select 
OK or the Apply button to actually apply the new theme.  

Night Vision Mode Theme File Name 

Click the Choose button to select the theme file name to load when Night Vision Mode is 
turned on. 

Standard Windows Theme File Name 

Click the Choose button to select the theme file name to load when Night Vision Mode is 
turned off.   
 
Before you can choose a theme file name, you save one to your hard drive.   

Saving a Theme File Under Windows 7 
1. Click Start > Control Panel. 
2. Click the Change the Theme link under Appearance and Personalization. 
3. Under the Change the Visuals and Sounds on your Computer window, select the 

desired theme.  The easiest way to save a theme file under Windows 7 is to 
modify an existing theme, then save it.  (There’s no other obvious way just save a 
“supplied” theme.)  For example, after selecting a theme to use, click the Window 
Color icon at the bottom of this window and then modify the color’s intensity 
before clicking the Save Changes button.  The now “modified” theme appears in 
My Themes. 

4. Right-click the modified theme, then click the Save Theme for Sharing 
command. 
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5. Enter a name for the “theme pack file” (.themepack), such as My Theme, and then 
click OK.  The Windows 7 default location to save themes is the Libraries > 
Documents folder.  Remember this folder name. 

Windows 7 Starter Edition and Themes 
If you are using a Netbook computer, chances are it runs Window 7 Starter Edition.  
Windows themes on this “streamlined” operating system are very limited and cannot be 
saved to a file, or restored from a file.  These limitations make TheSkyX’s Night Vision 
Mode less than ideal.  To best preserve dark adaptation when using the Starter Edition, 
we recommend covering the computer screen with a sheet of red velum, which is 
available at most hobby stores. 

Saving a Theme File Under Windows Vista 
1. Click Start > Control Panel. 
2. Click the Appearance and Personalization link. 
3. Under Personalization, click Change the Theme. 
4. Enter a name for the “theme file” (.theme), such as My Theme, and then click 

OK.  The Windows XP/Vista default location to save themes is the Libraries > 
Documents folder.  Remember this folder name. 

Saving a Theme File Under Windows XP 
1. Click Start > Control Panel > Display. 
2. On the Themes tab of the Display Properties window, click the Save As button.  
3. Enter a name for the “theme file” (.theme), such as My Theme, and then click 

OK.  The Windows XP/Vista default location to save themes is the Libraries > 
Documents folder.  Remember this folder name. 

 
Once you’ve saved the theme file, to select it in Night Vision Setup dialog, click the 
Choose button  next to the Standard Windows Theme File Name, then navigate to the 
folder where the file resides, and double-click the theme pack name.  TheSkyX will now 
load this theme when exiting Night Vision Mode. 

Setting Up and Using Push To Telescope Systems 

Other than the encoders and their interface box, the extra hardware required includes a 
standard serial (RS232) cable to connect the interface to your computer and a USB to 
serial adaptor. The serial cable is usually supplied with the encoder system; USB to serial 
adaptors can be purchased at almost any computer store.  Make the appropriate 
connections from the encoders to the interface box, and the box to your computer.  

Configuring the Hardware 

You are now ready to configure the hardware. 
 
Select the Telescope Setup command from the Telescope menu.  The Telescope Setup 
dialog is displayed.  
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Figure 109: The Telescope Setup dialog. 

1. From the Mount pop-up, click the Select Mount button. On the Select 
Mount window, select SGT.  Or select the name of your serial interface box, 
if it’s listed then click OK. 

2. Click Settings.  The Telescope Settings dialog appears. 
 

 
Figure 110: The SGT Settings dialog. 
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Click the Serial Port button to select the serial port to which the interface 
is connected.  All telescope serial interface boxes use RS232 serial 
communication. Since most modern computers are not equipped with a 
serial port, you’ll most likely need to purchase a USB to serial adaptor to 
convert a USB port into a serial port.  Follow the manufacturer’s 
instructions for installing the software drivers for this hardware.  On the 
Mac, choose the port that contains the manufacturer of your USB to serial 
adaptor’s name.  On Windows, use the Device Manager to determine the 
communications port number (COM number) for the adaptor, and enter 
“COMN”, when “N” is the number of the port reported by the Device 
Manager. 

3. Select your telescope model from the Telescope pop-up menu.  If it isn’t 
listed, choose the CUSTOM option.  The number of encoder tics per 
revolution for the selected telescope is displayed in the Encoders edit boxes to 
the right. If your telescope isn’t listed, don’t worry.  Just manually enter the 
correct values in the Encoders edit boxes.  If you don’t know these values, 
contact the manufacturer. 

4. Enter the same values in the Tics/Rev edit boxes.  The RA and Dec values are 
sometimes different. Don’t switch them. If you own version 1.7 through 1.99 
of the BBox, or version 2.93 through 3.49 of NGC-MAX, enter 32768 for 
both axes. 

5. Set the Clockwise/Counterclockwise options for Azimuth and Altitude 
Direction.  If you aren’t sure which way the encoders are supposed to be 
mounted, contact the manufacturer.  Or continue with the setup, and see which 
way the cross hairs move when you link the telescope and computer.   If the 
cross hairs move in the wrong direction, you’ve selected the wrong direction. 

6. Click the Configure Device button.  This step applies only if you own a BBox, 
version 1.7 (or later).  If not, skip to the next step. The BBox is automatically 
configured for the selected number of encoder tics. If you get the message 
“Cannot configure BBox,” try again. If you still cannot configure the box, 
please refer to the “Troubleshooting” section on page 218.  This step need be 
done only once, as the interface box stores the configuration in non-volatile 
memory.   

7. Click Close to save the configuration. 

Aligning the Encoders 

TheSkyX is now configured to communicate with the encoders.  The next step is to align 
the encoders by aiming the telescope at specific stars.  This gives TheSkyX the 
information it needs to calculate where the telescope is pointing. 
 
Any two stars that are visible from your location can be used during the alignment 
procedure.  
 

1. After your telescope is setup, select the Connect command from the 
Telescope menu to show the SGT Alignment dialog. 
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Figure 111: The SGT Alignment dialog. 

2. Click the Start Alignment button.  If your telescope is mounted equatorially 
(that is, the RA axis is pointing to the celestial pole), point it at 90° declination 
by default.  Choose a different declination (or azimuth) from the Point Scope 
At pop-up menu if your telescope cannot be pointed at 90°. 

3. If your telescope has an az-alt mounting, point it at 90° altitude.  
Specifically, you’re looking for the telescope position where rotation in right 
ascension (or azimuth) causes no rotation in declination (or altitude). The 
default angle is 90°.   

4. Point the telescope at the first alignment star.  The default first-alignment 
star is Polaris. To use a different star, use the Find command to locate the star 
(or just click on it in the Sky Chart).  Then click Align On in the Telescope 
sheet of Object Information dialog. 

5. Point the telescope at the second alignment star.  The default second-
alignment star is Capella. To use a different star, use the Find command to 
locate the star (or just click on it in the Sky Chart). Then click Align On in the 
Object Information dialog.  The difference between the actual angular 
separation of the alignment stars and the angle measured by the encoders is 
displayed. A difference of zero indicates a “perfect” alignment.  Experience 
shows that a difference of 1 degree or less is acceptable. If the difference is 
substantially greater, please refer to “Troubleshooting” below. 

6. Click Accept Alignment.  The alignment is complete. You should see cross 
hairs in the Sky Chart, marking the approximate center of the field of view of 
the telescope. 
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As you move the telescope, the cross hairs move to show where the telescope is pointing. 
As the cross hairs reach the edge of the screen, the Sky Chart automatically scrolls to 
keep the cross hairs visible.  
 
The Connect button on the toolbar is “down” to show the telescope link is active.  

Selecting Alignment Stars 

If you choose different alignment stars, don’t pick closely spaced ones.  Generally 
speaking, the greater the angular separation of the alignment stars (in both right ascension 
and declination), the more errors inherent to the system are “averaged out” across the sky. 

Realignment with Each Use 

TheSkyX has no provision for saving alignment settings because you must align the 
telescope each time you use it, even when observing from the same location.  

Software Options 

The Software Options section of the Telescope Setup dialog provides the following 
additional controls over encoder/go to interface. Mark or clear the checkboxes to select or 
deselect them. 

Always Confirm Slews  

A window appears that requires you to confirm any slewing command. 

Always Confirm Syncs  

A window appears that requires you to confirm any synchronization command. 

Always Ensure Telescope Cross Hairs are Visible on Chart 

• No allows the Sky Chart to be positioned in a different part of the sky as 
the telescope’s cross hairs 

• Yes allows the telescope’s cross hairs to move across the Sky Chart; the 
Sky Chart’s position is updated when the telescope’s position is outside 
the chart’s field of view. 

• Yes, Centered pins the telescope’s cross hairs to the center of the window.  
The Sky Chart’s center coordinates are updated to match the telescope.  

Using the Software-Guided Link 

The cross hairs in the Sky Chart will now “follow” the telescope.  This is true whether 
you move the telescope by hand, or let its motor drive turn it. Be sure you’ve clicked the 
Computer Clock button. The Sky Chart will then update automatically. If you select a 
specific date and time, the Sky Chart does not update; however, the Sky Chart may not 
match what you see through the telescope. 
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Terminating the Link 

On the Telescope menu, click the Connect command.   Or, select Disconnect Telescope 
in the Shut Down pop-up menu on the Telescope window.  

Finding a Particular Object 

TheSkyX can help you position the telescope on a particular object.   
 

1. Use the Find command on the Edit menu to locate the object.  
2. Click the Guide To Current Object button.  It is located on the Utilities tab of 

the SGT Alignment window.  This will show the Guide To controls on the Sky 
Chart.  When the telescope is pointing relatively near the target object, its position 
is represented by cross hairs on the RA/Azimuth and Dec/Altitude axis circles.  
When an axis is far from the object, a red and green line are shown instead.  The 
red line rotates as the telescope is moved. The green line remains stationary.  
Your goal is to move the telescope until the red line is drawn on top of the green 
line.  At this point, the lines fade away.  Slowing move the telescope axis until the 
cross hair is over the center green circle. 

 

 
Figure 112: The SGT Guide To controls.  

3. Starting with the RA/Az axis, move the telescope until the cross hairs are 
centered in the circle.  Lock the RA/Az axis.  

 
Repeat the last step for the Dec/Alt axis.  
 
The Sky Chart’s cross hairs are now over the desired object. When you look through the 
telescope, the object should be near the center of the field. If Impose Slew Limits are 
enabled, TheSkyX warns you if you try to move the telescope into a limit-line region. 

Setting Up and Using your Go To Telescope 

TheSkyX can drive many popular commercial telescopes.  Most telescopes that TheSkyX 
controls are serial devices (one exception is Vixen SX mounts; it uses an Ethernet 
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connection).   In order for a telescope that uses serial communications to “communicate” 
with the computer (and TheSkyX), the computer must have a serial port. 
 
Unfortunately, serial ports have been replaced by USB ports on virtually every newer 
model computer.  This means the physical USB hardware, as well as the USB protocol, is 
not compatible with older serial devices.  Fortunately, there is a solution… 

USB to Serial Adaptors 

The most common method to connect a personal computer that has a USB port to a 
telescope that uses serial (RS232) communication, is to use purchase a USB to serial 
adaptor.   
This hardware device “converts” one of the computer’s USB ports into a virtual serial 
port that understands serial communication used by the telescope.   
 
The most common way to do this is to use a USB to Serial Adaptor so that one of the 
computer's USB ports can accept RS232 commands.  (Bluetooth or serial to Ethernet 
hardware devices are other, less common, and typically more expensive alternatives.) 
 
USB to serial adaptors are relatively inexpensive and can be purchased at almost any 
computer store.   
 
• Before purchasing the USB to serial adaptor, make sure the adaptor is compatible 

with your computer’s operating system.  For example, some USB to serial adaptors 
are not compatible with Mac OS X Snow Leopard. 

• Carefully follow the manufacturer’s setup instructions for your operating system.  
Remember, the USB to serial adaptor hardware requires that you install a separate 
software driver before it can be used to communicate with a telescope. 

Mac OS X Snow Leopard and USB to Serial Adaptors 

When you plug a USB to Serial Adaptor into a computer that is running Mac OS Snow 
Leopard, a message appears that a new network device has been connected, and prompts 
you to set it up (via the Network options in System Preferences).   
 
Configuring the USB to Serial Adaptor as a network device will not allow TheSkyX to 
control a telescope that uses RS232 serial communication.  
 
In order for TheSkyX to control a telescope that uses serial communications on Mac OS 
X, an OS X compatible USB to serial adaptor driver must be installed first.   
 
Contact the manufacturer of your USB to Serial Adaptor hardware device, or visit the 
manufacturer’s Downloads page to obtain this driver.  
 
After installing the Mac OS X-compatible USB to Serial Adaptor driver, you need to 
select it from TheSkyX’s Telescope > Telescope Setup > Settings window.  
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You’ll also need a telescope cable that connects your computer to USB to serial adaptor.  
Cables for Meade and Celestron products can be purchased from the Software Bisque 
Store.  
 
We strongly recommend that you read the telescope’s owner manual carefully, and 
become thoroughly familiar with the telescope’s operation, before using TheSkyX to 
control it.  

Configuring the Telescope Interface 

TheSkyX must be configured so your computer can communicate with the telescope.  The 
following general procedure applies to most “go to” telescopes.  
 

1. Turn off the telescope.  
2. Using the appropriate telescope cable, connect the serial port on the 

telescope to an unused serial port.  If your computer does not have a serial 
port, you’ll need to use a USB to serial adaptor. 

3. Turn on the telescope. 
 
Select the Setup command from the Telescope menu.  In the Mount list box, select the 
name of your telescope.  If the exact model of your telescope is not listed, use the 
manufacturer’s name instead. 
 

 
Figure 113: The default Telescope Setup dialog. 

4. Click Settings.  On the Mac, the Serial Device Settings dialog allows you to 
specify the USB to serial adaptor that your telescope cable is connected to. 

 
Under Windows, in the COM Port text input, type the letters “COM” 
followed by the number of the port that the Device Manager reports for 
the device.  
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Windows Serial Port Notes 

• Only standard serial ports or USB to serial adaptors that are not being 
used by any other device should be used. 

• Use Windows Device Manager to determine the COM port number for 
your serial ports, or USB to serial adaptor. 

Linking To and Synchronizing the Telescope 

Most “go to” drive systems must be properly configured before TheSkyX can control 
them. You can do this “by hand,” using the telescope’s hand paddle. Or, you can do it 
from within TheSkyX by performing a process called synchronization. 
 
(Note that Celestron telescopes using firmware version 4.1 and earlier cannot be 
synchronized from TheSkyX and must be aligned using the hand paddle before TheSkyX 
can control it.) 

Important Notes: 

• The local date, time, time zone, Daylight Saving Time and terrestrial 
coordinates must be entered into the telescope’s hand paddle.  If the 
telescope is connected to your computer, you might find it easier to use 
TheSkyX to initialize the telescope’s hand paddle with these values.  

• The telescope must be aligned with the celestial sphere.  Follow the 
manufacturer’s instructions for aligning the telescope with the night sky. 

Telescope Limits 

Controlling the slewing limits of your telescope is a snap with TheSkyX’ s telescope limits 
command.  There, you can set lower altitude and upper altitude and declination limits.  
To open the Telescope Limits dialog, select T elescope > T elescope L imits. 

Upper Limits 

When you first open the Telescope Limits dialog, you will first be given an opportunity 
to set the Upper L imits of your telescope’s slewing control.  Use the data fields to enter 
maximum values for declination and altitude slewing and to choose whether the telescope 
limits are plotted on the Sky Chart. 

Lower Altitude Limit 

Choose the L ower Altitude L imit tab to set minimum altitude limits for your telescope 
setup.  In the top portion of the dialog window, you will see a graph upon which you can 
click and drag the mouse pointer to draw a set of altitude limit data for given azimuth 
values. 
 
You can also choose to Open a pre-existing horizon file, and, once you have set altitude 
limits, you can save a horizon file for later use by clicking Save As. 
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Clicking Set T o allows you to set altitude limits according to a number of values, such as 
a given set altitude, or to match the current horizon image.  For more on horizon images, 
see H orizon &  Atmosphere Options. 
 
You can also import the telescope’s current Az/Alt position into the dialog by clicking 
Get T elescope Az/Alt. 
 
Here, too, you choose to have TheSkyX plot the set limits onto the Sky Chart by clicking 
Show limits on Sky Chart. 
 
Once you are satisfied with the input limit data, click OK  to commit.  If you decide not to 
use these data, click Cancel. 

TPoint Add On 

The TPoint Add On is optional telescope pointing analysis software that allows 
you to analyze the errors inherent in your particular telescope system to 
drastically improve its pointing performance.  Both TheSkyX Serious Astronomer 
E dition and TheSkyX Professional E dition supply a 90 day trial version of TPoint.  
The TPoint Add On can be accessed from the T ools menu. 
 
Like many aspects of your imaging system, there is a learning curve to master 
calibrating telescope pointing.  Fortunately, TheSkyX makes using TPoint Add On 
easier and you should be able to complete a calibration run on the first night to 
start analyzing and improving your telescope’s pointing right away.  There is a 
comprehensive user guide for TPoint available by selecting H elp > T Point Add 
On User Guide. 

Telescope Controls 

The Telescope window holds the most commonly used telescope controls.  Select the 
Telescope command from the Display menu to show it.   
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Figure 114: The Telescope window. 

Not all telescope mounts have the same feature set; the Telescope window holds 
commands that are common to most every go to mount. 
 
Manufacturer-specific telescope control features are accessed in the <Telescope Name>-
Specific window from the Display menu.  For example, Gemini specific commands are 
located in the Gemini-Specific window from the Display menu. 

Telescope Initialization (Start Up pop-up menu) 

This pop-up menu contains that commands that are used to connect to and initialize the 
mount with TheSkyX. 
 

• Telescope Setup 
Shows the Telescope Setup dialog.  See “Configuring the Telescope 
Interface” for more information. 
 

• Connect Telescope  
Same selecting the Connect command from the Telescope menu.  See 
“Linking To and Synchronizing the Telescope” for more information 
about this command. 
 

• Find Home  
Sends the mount to its home position.  (Gemini-specific command.) 
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• Synchronize  
Use this command to tell TheSkyX where the telescope is currently 
pointing.  See “Software Synchronization” for more information about this 
command. 

Telescope Tools 

Once communication with the telescope is established, the Telescope Tools can be used 
to help find objects, tracking communications between the mount and the computer and 
initialize the mount’s hand paddle or controller with TheSkyX’s location, date, time, and 
time zone values.  

Star Search 

The Star Search feature slews the telescope in a spiral pattern of increasing size to help 
locate an object in the eyepiece.  
 

 
Figure 115: The Star Search dialog. 

Spiral Search (Star Search button) 

Begins slewing the telescope in a spiral pattern, based on the size of the selected Field of 
View Indicator. 

Defining the Size of the Spiral (Telescope’s Field of View group) 

The “tightness” of the telescope’s outward spiral can be configured to match the 
telescope’s field of view.  Click the Select From Field of View Indicators button to tell 
TheSkyX the specifics of your optical system. 

Communications Log 

Use this window to track the serial or network communications between TheSkyX and the 
telescope.   

Location, Date, Time 

Astro-Physics, Gemini, Celestron and Meade mounts allow TheSkyX to set their location, 
date, time and time zone information, rather than having to do it from the hand paddle.   
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Figure 116: The Telescope Location, Date, Time dialog. 

Click the right arrow to send TheSkyX’s time, date, latitude, longitude and time zone to 
the telescope.   
 
To ensure accurate slews, TheSkyX’s values should match the telescope’s values for these 
parameters.   
 

 
Figure 117: Move and Jog Controls. 

Move and Jog Controls 

Use the controls on the Move and Jog tabs to manually slew or move, by discrete 
increments, the telescope. 

Move Tab 
Click and hold the Move arrow buttons on the Telescope window to direct the telescope 
in a specific direction.   The Rate pop-up menu controls the speed of the slew.  The Rate 
options in this list change depending on the currently selected mount. 
 
The Move controls offer eight directions: North, East, South, West, and the “diagonal” 
directions in between.  Diagonal direction buttons are hidden for mounts that do not 
support dual-axis moves. 
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Jog Tab 
Use these arrow buttons to slew the telescope by the angular distance shown in the 
Distance list, and using and equatorial (RA/Dec) or horizon (Azm/Alt) coordinates. 

Orientation Options 
The direction a particular button moves the mount is configurable.  This is useful, for 
example, when the optical tube on a German equatorial mount changes sides from East to 
West, the relative motion of the telescope in the right ascension axis is reversed.  
Changing the orientation for the right ascension axis makes the buttons work “as 
expected” for the opposite side of the mount. 
 

• Normal sends the standard commands to the mount for moving in this 
direction. 

• Swap Axes changes the left/right direction buttons to up/down, and 
up/down to left/right. 

• Flip Left/Right swaps the left and right buttons.  Left moves right, and 
right moves left. 

• Flip Up/Down swaps the up and down buttons.  Up moves down and 
down moves up. 

 
Alice, welcome to Wonderland. 

Shut Down Procedure (Shut Down pop-up menu) 

At the end of the night, you’ll want to make sure to park the telescope so it will be in the 
correct orientation to close the observatory roof.  Note that some telescope control 
systems do not have the ability to park the telescope.  For these telescopes, TheSkyX uses 
a “built-in” park feature that slews the mount to the park position (a fixed 
altitude/azimuth coordinate) that you define and turns off the mount’s sidereal tracking.  
When communication with the mount is established again, TheSkyX can unpark the 
mount and initialize the mount’s control system. 

Set Park Position 

Use this command to specify the altitude and azimuth coordinates to slew the mount 
before parking.  The current position of the telescope cross hairs is used as the park 
position. 

Clear Park Position 

Use this command to delete the previously defined park position.  After clearing the park 
position, a new one must be defined with the Set Park Position command before the 
telescope can be parked. 

Park  

The Park command slews the telescope to the park position, and then turns the mount’s 
sidereal tracking off (where possible). 
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Unpark 

For mounts that do not support parking (see above), once parked, the Unpark command 
must be issued to end the “periodically rewind the mount’s position because it is still 
tracking” loop.  

Disconnect Telescope 

Terminates communication with the mount, same selecting the Connect command from 
the Telescope menu when there is a connection.  See “Linking To and Synchronizing the 
Telescope” for more information about this command. 

Focuser 

Controls the focus and focus speed of a pulse focuser that is connected to the telescope’s 
focuser port.  This feature is especially useful when viewing CCD images on a monitor 
while focusing.  

Software Synchronization 

The following procedure applies if your telescope can be synchronized through software.  
If your telescope must be aligned first, do so following the manufacturer’s initialization 
instructions now. 
 

 
Figure 118: The Telescope Synchronization window (Synchronize command in the Start Up pop-up 

menu on the Telescope window). 

1. Select the Connect command from the Telescope menu.  Cross hairs 
appear on the Sky Chart, showing the position the telescope “thinks” it is 
pointing.  If you receive a “Can’t establish link” message, be sure the 
connections are correct, the telescope is turned on, and the correct port is 
selected.  

2. If you haven’t set the telescope’s time and coordinates, do so now.  Use 
the Telescope window’s Synchronize command in the Start Up pop-up 
menu to do so.  
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3. Position the center of the telescope’s field on a known star.  Don’t use a 
planet, nebula, or galaxy. Star coordinates are more accurate, and a star is 
a true “point source.”  

4. Click on that star in the Sky Chart or use the Find command to locate it.   
5. Select Synchronize command in the Start Up pop-up menu on the 

Telescope window.   
 
The telescope is now aligned and can be used with TheSkyX.  The Sky Chart’s cross hairs 
should jump to the object used for synchronization, or be centered on the star used during 
the hand paddle initialization. 

Slewing to a Specific Object 

1. Click on the object in the Sky Chart.  If the desired object is not visible on the 
current chart, select the Find command from the Edit menu, enter the object’s 
name (Crab Nebula, for example) or its catalog number (M1) into the Search 
For text input and click the Find button.   

2. Click the Slew button.  One is located on the Telescope, Find and the 
Observing List windows and on the Telescope toolbar.   

 
The Search For text input and Find button are also available on the Telescope window.  
 
There’s another way slew the telescope… 
 

1. Right-click an object in the Sky Chart. 
2. Select the Slew command from the Sky Chart’s pop-up menu. 

Slewing to a Specific Coordinate 

Use the Slew To Coordinates command from the Tools menu on the Telescope window 
to display the Enter Coordinates tab of the Navigate window.  From here, enter any right 
ascension and declination or azimuth and altitude coordinate, then click either the Slew 
To RA/Dec or Slew To Az/Alt button.  

Using the Telescope Simulator 

The telescope simulator allows you to simulate the process of connecting to, 
synchronizing and slewing a go to telescope without actually connecting to any hardware.  
This can be useful to become familiar with how to operate a telescope from TheSkyX or 
practice an observing session during daylight. 
 

1. Select the Telescope Setup command from the Telescope menu.  
2. In the Telescope Setup dialog, click the Select Mount button.  
3. Choose Telescope Mount Simulator option from the Simulator list.  
4. Click OK.   
5. Click the Connect button on the Telescope Setup dialog to establish a virtual 

connection to the simulated telescope mount. 
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Terminating the Telescope Link 

Select the Connect command Telescope menu to end the session.   

Using the Telescope Simulator 

The telescope simulator allows you to simulate the process of connecting to, 
synchronizing and slewing a go to telescope without actually connecting to any hardware.  
This can be useful to become familiar with how to operate a telescope from TheSkyX or 
practice an observing session during daylight. 
 

1. Select the Telescope Setup command from the Telescope menu.  
2. In the Telescope Setup dialog, click the Select Mount button.  
3. Choose Telescope Mount Simulator option from the Simulator list.  
4. Click OK.   
5. Click the Connect button on the Telescope Setup dialog to establish a virtual 

connection to the simulated telescope mount. 

Digital Setting Circles 

TheSkyX’s Digital Settings Circles window displays a status report that contains, for 
example, the telescope’s RA/Dec coordinates.  The text size is also configurable so that it 
can be more easily read at a distance.  
 
This feature is available with both encoder-based systems and telescopes having full 
computer control.  
 
To use it, select the Digital Setting Circles command from the Telescope menu.  

 
Figure 119: Digital Setting Circles window. 

Configuring the Digital Settings Circles Report (Report Setup button) 

By default, the report shows universal time (UT) and local sidereal time (LST).  Click the 
Report Setup button to show the Digital Setting Circles report in the Preference dialog. 
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Select the attributes you wish to display in the report, and then click Close. 

Troubleshooting the Telescope Setup 

Physically connecting a hardware device to computer software is not always a simple 
task. Things can, and often do, go wrong.  Below is a checklist of items to consider 
before contacting the Software Bisque support desk. 
 

• Both the software and the hardware must be correctly configured.  
Communication ports, cables, connectors and telescope control systems all 
must be plugged in, turned on, connected properly using the correct 
telescope interface cable and initialized before attempting to be “linked” to 
the computer. 

• Connection cables must be wired correctly. TheSkyX uses “bi-directional” 
serial communication with most devices.  This means that the connecting 
cable must be wired properly to send and receive commands.  You can 
verify that a serial cable is functioning by measuring resistance of pins 2, 3 
and 5 on each end of the telescope cable. 

• The communication port must be operational.  If you are using a USB to 
serial adaptor, make sure that you have the latest software drivers installed 
for the device. 

• The proper telescope firmware (that is, the software that is run by the 
telescope’s control system) must be correct before TheSkyX can control 
the telescope.   Contact the manufacturer to obtain firmware updates. 
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Astro-Physics GTO German Equatorial Mounts 

 
Figure 120: Astro-Physics GEM (photo copyright Astro-Physics) 

AP GTO Minimum System Requirements 

TheSkyX can control any mount that employs the Astro-Physics GTO control system 
running firmware version G or later (including the GTOCP1, GTOCP2 and GTOCP3).  If 
you have and older version of the firmware, contact Astro-Physics for details about 
upgrading.  TheSkyX will successfully connect to and control earlier firmware versions 
(for example, Software Bisque has successfully tested TheSkyX using the GTO model 
controller with firmware version D from May 2001 with the GTO model controller).  
However, we strongly recommend using the latest firmware version. 

Hardware Requirements 

• Astro-Physics GTO German Equatorial control system with firmware G or 
later.  

• A standard RS232 serial cable.  Serial cables can be purchased from most 
any computer store. 

• A USB to serial adaptor.   

Step-by-Step AP GTO Setup Procedure 

1. Using a standard DB9 M/F RS232 serial cable, connect the male end of 
the cable to the port labeled COM1 on the GTO Control Panel and the 
female end to the USB to serial adaptor. 

2. Click the Telescope Setup command from the Telescope menu.  
3. Select Mount in the Imaging System list on the left side of the Imaging 

System Setup window.  
4. On the Choose Mount window, select your model telescope and click OK.   

If the exact model of your telescope is not listed, don’t worry; just select a 
similar model telescope.  The underlying serial communication protocol is 
the same for similar models. 
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5. Click the Settings command on the Mount Setup pop-up menu and then 
select the correct COM port (Windows) or the correct Serial Device 
(Mac). 

6. On the Imaging System Setup window, turn on the desired preferences 
and then click Close. 

7. Select the Connect command from the Telescope menu.   
 
The telescope cross hair will now display the current coordinates of the telescope.  If the 
mount has not been parked, or has not been initialized with the location, date and time 
from another application, the coordinates of the telescope will be RA: 0h 0' 0" Dec: 90º 0' 
0".  Use the Synchronize command (page 215) to initialize the telescope from TheSkyX if 
necessary. 
 
AP mounts are automatically initialized using TheSkyX’s time, date, location and 
Daylight Saving Time adjusted time zone, the mount's tracking is started, and the 
telescope is put into the long format mode. 

Astro-Physics GTO Control System Notes 

• TheSkyX always places the Astro-Physics control system into the “long 
format” mode upon establishing a link. 

• Click Tools > Location, Date, Time on the Telescope Setup window 
(Display menu) to compare TheSkyX’s date, time, latitude, longitude and 
time zone settings to the mount.  Click the >> button to reset the AP 
GTO’s values to match TheSkyX’s. 

Astro-Physics Specific Commands 

Select the Astro-Physics Specific command from the Display menu to show commands 
that are specific to this control system.  This command is only available when an Astro-
Physics model mount is selected Telescope > Telescope Setup window. 
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Figure 121: The Astro-Physics Specific window (Display menu). 

Most of the AP-specific commands are self-explanatory.  Details about each command 
can be found in AP Protocol documentation; this document is available from Astro-
Physics web site. 
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Celestron and NexStar-Compatible Mounts 

 
Figure 122: The Celestron C11-SGT (XLT) Computerized Telescope (NexStar-compatible).  

Copyright Celestron International. 

TheSkyX controls most NexStar-compatible telescopes manufactured by Celestron 
International, including:   

• Celestron™ Advanced Series (all models) 
• Celestron™ NexStar (all models) 
• Celestron™ CG Series (all models) 
• Celestron™ CGE Series (all models) 
• Celestron™ CPS Series (all models) 
• Celestron™ GT Series (all models) 
• Celestron™ SLT Series (all models) 
• Celestron™ NexStar i Series (all models) 

 
The NexStar control system is also used on telescopes from other manufacturers, 
including: 

• Orion Telescopes and Binoculars go to telescopes 
• Sky-Watcher SkyScan go to telescopes 
• Tasco go to telescopes 

Celestron Minimum System Requirements 

TheSkyX can control telescopes that employ the NexStar control system using firmware 
version 1.6 and later and motor controller version 4.2 or later.  If you have and older 
version of the firmware, contact the manufacturer for details about upgrading. 
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NexStar-Compatible Telescope Hardware Requirements 

• A NexStar-compatible telescope. 
• A NexStar Telescope Interface Cable.  This cable can be purchased from 

Software Bisque, or the manufacturer. 
• A USB to serial adaptor.  

 
Important Notes 
 

• The NexStar firmware version 1.6 and later, and motor controller version 
4.2 and later are required to support high precision (24-bit) slewing and 
variable tracking rates.    

 
To determine the NexStar firmware version for your mount, when the 
hand paddle LED reads NexStar GPS, press the Menu button, then press 
the button labeled UP or DOWN (6 key or 9 key) until the Utilities menu 
appears. Press the UP or DOWN arrows on the keypad until the Version 
option appears, then press the Enter button. The versions for different 
firmware components are listed in the following order: hand controller, 
motor controller version for each axis, GPS version and then the bus 
control version. 

  
Contact Celestron International for details about obtaining updated 
firmware for your NexStar. 

• NexStar GT Series telescopes using firmware version 1.6 and earlier and 
motor controller version 4.2 and earlier must use the Ultima 2000 model 
mount.   

• The NexStar command protocol version 4.1 or later supports software 
synchronization (that is, the telescope's position can be defined by external 
software like TheSkyX).  See page 215 for details about synchronizing 
your mount with TheSkyX. 

Step-by-Step NexStar Setup Procedure 

1. Turn off both the computer and the telescope (always a good idea when 
connecting devices). 

2. Connect the telescope interface cable to the serial port of the computer and the 
hand paddle of the NexStar (RJ22 end connector).  

3. After the telescope interface cable is plugged into the NexStar’s hand paddle and 
into the USB to serial adaptor, turn both the computer and the telescope on (the 
order does not matter). 

4. Click the Telescope Setup command from the Telescope menu.  
5. Select Mount in the Imaging System list on the left side of the Imaging System 

Setup window.  
6. On the Choose Mount window, select your model telescope and click OK.   If the 

exact model of your telescope is not listed, don’t worry; just select a similar 

http://www.celestron.com/�
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model telescope.  The underlying serial communication protocol is the same for 
similar models. 

7. Click the Settings command on the Mount Setup pop-up menu and then select the 
correct COM port (Windows) or the correct Serial Device (Mac). 

8. On the Imaging System Setup window, turn on the desired preferences and then 
click Close. 

9. Select the Connect command from the Telescope menu. 
10. Click the Synchronize command on the Start Up pop-up menu (page 215), then 

follow the on-screen instructions to complete the initialization. 
 
The telescope cross hairs show the current position of the telescope should appear on the 
Sky Chart. 

For NexStar models 4, 5, 8 (non GPS), 60, 80 and 114  

Before connecting TheSkyX to the NexStar models 4, 5, 8 (non GPS), 60, 80 and 114, 
make sure that the hand paddle is in the RS 232 mode. That is, the NexStar hand paddle 
must display the text RS-232 on the top line, and Undo to Exit on the bottom line, at all 
times so that the hardware's serial port is operational; otherwise a connection cannot be 
established to the device through software. If the hand paddle does not remain in RS232 
mode at all times, TheSkyX will not be able to communicate with the telescope.  

NexStar/TheSkyX Communication Notes 

• Make sure so set the correct Daylight Saving Time setting on the NexStar 
hand paddle, otherwise TheSkyX’s positions for solar system object, and 
object rise/set times, will differ from the NexStar hand paddle’s values by 
one hour.    

• The NexStar models 4, 5, 8 (non GPS), 60, 80 and 114 hand paddle must 
be in RS232 mode in order to communicate with TheSkyX.   

• The NexStar models 4, 5, 8 (non GPS), 60, 80 and 114 must be initialized 
and aligned in order to communicate with TheSkyX.   

• The NexStar models 8 GPS and 11 GPS hand paddle does not need to be 
in any particular menu in order to communicate with TheSkyX.   

• The NexStar firmware version 1.6 and later supports Motion Control 
buttons.   

• The NexStar firmware version 1.6 and later has built-in slew limits. If a 
slew from TheSkyX fails, check the LED readout from the hand paddle to 
make sure these limits have not been exceeded.  
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Gemini Astronomical Positioning System 

 
Figure 123: The Losmandy Gemini astronomical positioning system.  Copyright Losmandy 

Instruments. 

Gemini Minimum System Requirements 

TheSkyX can control any mount that employs the Gemini Astronomical Positioning 
System firmware version 1.05 or later.  If you have and older version of the firmware, 
contact the manufacturer for details about upgrading. 

Hardware Requirements 

• Gemini Astronomical Positioning System with firmware version 1.05 or 
later.  

• A Gemini telescope cable.  (Contact Losmandy Instruments to purchase 
this cable.)  

• A USB to serial adaptor.  

Step-by-Step Gemini Setup Procedure 

1. Using the Gemini telescope serial cable, plug the male RJ22 end of the cable into 
the port labeled RS-232 on the Gemini controller and the female end to the USB 
to serial adaptor. 

2. Click the Telescope Setup command from the Telescope menu.  
3. Select Mount in the Imaging System list on the left side of the Imaging System 

Setup window. 
4. On the Choose Mount window, select your model telescope and click OK.   If the 

exact model of your telescope is not listed, don’t worry; just select a similar 
model telescope.  The underlying serial communication protocol is the same for 
similar models. 

5. Click the Settings command on the Mount Setup pop-up menu and then select the 
correct COM port (Windows) or the correct Serial Device (Mac). 
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6. On the Telescope Setup window, turn on the desired preferences and then click 
Close. 

7. Select the Connect command from the Telescope menu.  
8. If the telescope has not been initialized, click Tools > Locate, Date, Time 

command on the Telescope window (Display menu).  This window shows 
TheSkyX’s settings, and the Gemini’s.  Click the >> button to set the Gemini’s 
values to TheSkyX’s. 

9. Click the Synchronize command on the Start Up pop-up menu (page 215), then 
follow the on-screen instructions to complete the initialization. 

 
The Gemini should now be initialized and ready to use. 

Gemini Specific Commands 

Select the Gemini Specific command from the Display menu to show commands that are 
specific to this control system.   
 
Note that this command is only available when the Gemini is selected in the Mount pop-
up menu on the Telescope > Setup window. 
 

 
Figure 124: The Gemini Specific window (Display menu). 

Details about the Gemini-specific commands can be found in Gemini User Manual; this 
document is available on the Losmandy web site (http://www.losmandy.com) . 
 

http://www.losmandy.com/�
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iOptron Mounts 

 
Figure 125: The iOptron SmartStar™-E Go To Alt/Az mount (“The Cube”). 

iOptron Minimum System Requirements 

TheSkyX can control iOptron SmartStar model altitude/azimuth and equatorial mounts. 

Hardware Requirements 

• Any iOptron model go to mount.  
• A standard USB cable (supplied with the mount). 
• A Windows computer running TheSkyX.   

Notes 

• TheSkyX does not currently support iOptron mounts on the Mac.   
• The iOptron firmware used to develop TheSkyX’s driver contained 

significant limitations that prevent the mount from being initialized by 
TheSkyX; slews cancelled by TheSkyX also report errors.  (Representatives 
from iOptron indicate that these issues will be addressed in future 
firmware updates.)  Make sure to setup the iOptron to run standalone 
before attempting to control it using TheSkyX.  

Step-by-Step iOptron Setup Procedure 

1. After installing the Windows communication drivers for the iOptron, use 
Windows Hardware Manager to determine the port number used for this 
device. 

2. Click the Telescope Setup command from the Telescope menu.  
3. Select Mount in the Imaging System list on the left side of the Imaging 

System Setup window. 
4. On the Choose Mount window, select your model telescope and click OK.   

If the exact model of your telescope is not listed, don’t worry; just select a 
similar model telescope.  The underlying serial communication protocol is 
the same for similar models. 

5. Click the Settings command on the Mount Setup pop-up menu and then 
select the correct COM port (Windows) or the correct Serial Device 
(Mac). 
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6. On the Telescope Setup window, turn on the desired preferences and then 
click Close. 

7. Select the Connect command from the Telescope menu.  
8. Click the Synchronize command (page 215) on the Start Up pop-up menu, 

then follow the on-screen instructions to complete the initialization. 
 
The iOptron should now be initialized and ready to use. 
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Meade Instruments Mounts 

 
Figure 126: The Meade Autostar ETX-90PE telescope.  Copyright Meade Instruments. 

Meade Minimum System Requirements 

TheSkyX can control LX200 Classic, Autostar, Autostar II and Autostar-compatible 
mounts, including the RCX400 series and telescopes that use the LX200 protocol, such as 
the Vixen SkySensor 2000.   

LX200 Classic Hardware Requirements 

• LX200 by Meade Instruments Corporation telescope (or a control system 
that uses the LX200 protocol). 

• An LX200 telescope cable.  This cable can be purchased from Software 
Bisque or the manufacturer. 

• A USB to serial adaptor. 

Autostar/Autostar II/Autostar III Hardware Requirements 

• Autostar, Autostar II or Autostar III compatible telescope by Meade 
Instruments Corporation telescope (or a control system that uses the 
LX200/Autostar serial communications protocol). 

• An Autostar telescope cable.  This cable can be purchased from Software 
Bisque or the manufacturer.  

• A USB to serial adaptor. 

Meade RCX400 (Autostar II) Hardware Requirements 

• Meade RCX400 by Meade Instruments Corporation telescope. 
• An LX200 telescope cable.  This cable can be purchased from Software 

Bisque or the manufacturer. 

Step-by-Step LX200/Autostar Setup Procedure 

TheSkyX must be configured correctly before it can communicate with the LX200. 
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1. Turn off the telescope.  
2. Using the appropriate cable, connect the serial port on the telescope to the 

USB to serial adaptor.  
3. Turn on the telescope.  
4. Click the Telescope Setup command from the Telescope menu.  
5. Select Mount in the Imaging System list on the left side of the Imaging 

System Setup window.  
6. On the Choose Mount window, select your model telescope and click OK.   

If the exact model of your telescope is not listed, don’t worry; just select a 
similar model telescope.  The underlying serial communication protocol is 
the same for similar models. 

7. Click the Settings command on the Mount Setup pop-up menu and then 
select the correct COM port (Windows) or the correct Serial Device 
(Mac). 

8. Click Close. 
9. Click Telescope > Connect. 
10. Click the Synchronize command (page 215) on the Start Up pop-up menu, 

then follow the on-screen instructions to complete the initialization. 

Troubleshooting the LX200 (Classic) Telescope 

  
TheSkyX will successfully establish communications with the Autostar/LX200 device, 
provided all of the following are true: 
 

• The device is turned on and functioning. 
• The hand paddle is plugged into the telescope’s base panel. 
• The hand paddle is in Polar or Alt/Az mode and not in Land Mode. See 

the documentation for setting this mode. 
• The telescope cable is wired correctly for bi-directional communications.  
• The telescope interface cable is plugged into the correct serial 

communications port or USB to serial adaptor. 
• The telescope cable is plugged into the RS232 port on the LX200 base 

panel.   
• The telescope cable is not plugged into a modem port (Windows). 
• The COM port  or USB to serial adaptor is functional and the software 

drivers are installed.  
• The telescope interface cable (the one sold by Software Bisque) is using 

the DB9 end connector labeled “LX200” and not “BBox and Compatible”. 
• The Autostar/LX200 mount is selected in the Control System list on the 

Telescope Setup window.   
• The selected serial device (Mac) or COM port (Windows) is correct.  

Click Telescope > Telescope Setup > Settings to check this setting.  
 
Verify that all of the above is true, and TheSkyX will successfully communicate and 
control the telescope. 
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Software Bisque Paramount Robotic Telescope Systems 

 

 
Figure 127: The Software Bisque Paramount MX Robotic Telescope Mount. 

Please refer to the Paramount User Guide for instructions on setting up and using the 
Paramount (models GT-1100S, ME and MX) with TheSkyX Professional Edition. 
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StellarCAT  

The StellarCAT hardware permits “go to” functionality for Dobsonian-class telescopes. 

Computer Assisted Telescope Innovations 

  
Figure 128: ServoCAT and ServoCAT Jr. Track/GOTO.  Copyright 

StellarCAT. 

StellarCAT Minimum System Requirements 

TheSkyX can show the position of your telescope that uses the StellarCAT and 
StellarCAT Jr. control system, as well as issue slew commands to point the telescope to 
any object.   

StellarCAT Hardware Requirements 

• StellarCAT or StellarCAT Jr. Track/GOTO system 
• Sky Commander or Argo Navis DSC.  (See the “ServoCAT Quick Start 

and Troubleshooting Guide” for details about setting up the Digital Setting 
Circle or DSC.) 

• A USB to serial adaptor. 

Step-by-Step StellarCAT Setup Procedure 

TheSkyX must be configured correctly before it can communicate with the StellarCAT.  
Please consult the StellarCAT User’s Manual for details about setting up and configuring 
the system before attempting to connect it to TheSkyX. 
 

1. Turn off the control system.  
2. Using the appropriate cable, connect the serial port from the serial 

interface box to the computer’s USB to serial adaptor (or serial port).   
3. Turn on the control system.  
4. Select the Telescope Setup command from the Telescope menu.  
5. Select Mount in the Imaging System list on the left side of the Imaging 

System Setup window.  
6. Select the Choose command from the Mount Setup pop-up menu. 
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7. On the Choose Mount window, select your model telescope and click OK.   
If the exact model of your telescope is not listed, don’t worry; just select a 
similar model telescope.  The underlying serial communication protocol is 
the same for similar models. 

8. Click the Settings command on the Mount Setup pop-up menu and then 
select the correct COM port (Windows) or the correct Serial Device 
(Mac). 

9. Click Close 
10. Click Telescope > Connect. 

Troubleshooting the StellarCAT Connection 

  
TheSkyX will successfully establish communications with the StellarCAT, provided all of 
the following are true: 
 

• The device is turned on and functioning. 
• The DSC serial cable is wired correctly for bi-directional communications.   

See the ServoCAT User’s Manual for details about this cable.   
• The ServoCAT serial cable is plugged into the correct serial 

communications port or USB to serial adaptor (PC side). 
• The ServoCAT telescope cable is plugged into the RS232 port on back of 

the .   
• The telescope cable is not plugged into a modem port (Windows). 
• The COM port  or USB to serial adaptor is functional and the software 

drivers are installed.  
• The telescope interface cable (the one sold by Software Bisque) is using 

the DB9 end connector labeled “LX200” and not “BBox and Compatible”. 
• Autostar/LX200 is selected as the Mount.   
• The selected serial device (Mac) or COM port (Windows) is correct.  

Click Telescope > Telescope Setup > Mount Setup > Settings to check it.  
 
Verify that all of the above is true, and TheSkyX will successfully communicate and 
control the telescope. 
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Takahashi Temma Mounts 

 
Figure 129: Takahashi Temma mounts.  Photo copyright Takahashi. 

Temma Minimum System Requirements 

TheSkyX can control Takahashi Temma model altitude/azimuth and equatorial mounts, 
including: 
 

• EM-10 Temma PC Jr. (USD2)  
• EM-200 Temma PC Jr. (USD2)  
• EM-200 Temma PC   
• NJP Temma PC   
• EM-500 Temma PC 
• EM-10 Temma2 Jr. (USD3) 
• EM-200 Temma2 Jr. (USD3) 
• EM-11 Temma2 Jr. (USD3) 
• EM-200 Temma2   
• EM-400 Temma2 
• EM-500 Temma2 

Hardware Requirements 

• Any Takahashi Temma or Temma2 mount.  
• A Takahashi telescope cable (supplied with the mount). 
• A USB to serial adaptor.  

 

Step-by-Step Temma Setup Procedure 

TheSkyX must be configured correctly before it can communicate with the Temma 
mount. Make sure to set TheSkyX’s location, date, time, time zone and Daylight Saving 
Time correctly before proceeding. 
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Figure 130: Temma PC Jr. Control Panel 

 
1. Turn off the Temma telescope mount.   
2. Using the gray Temma telescope cable (supplied with your mount), connect the round 

end to the port labeled RS-232C on the Temma mount, and the DB9 end to the USB 
to serial adaptor. 

3. Turn the MOTOR and COMPUTER STAND BY switches to the ON position.  When 
the Temma control system is powered on, it is initialized with the following default 
parameters. 

 
• The control system “thinks” the optical tube assembly end of the declination axis 

is on the West side of the mount.   
• The control system “thinks” telescope is pointing right ascension 0.0 and 

declination 0.0. 
• The right ascension and declination correction speeds are set to 90.   
• The control system’s tracking is direction is for the Northern Hemisphere. 

 
These default parameters will not match the actual position of the optical tube 
assembly. TheSkyX allows you to correctly initialize the Temma’s control system to 
match the position of the OTA. See the step below to do so. 
 

1. Select the Telescope Setup command from the Telescope menu. 
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2. Select Mount in the Imaging System list on the left side of the Imaging System 
Setup window. 

3. Select the Choose command from the Mount Setup pop-up menu.   
4. On the Choose Mount window, select your model telescope and click OK.   If the 

exact model of your telescope is not listed, don’t worry; just select a similar model 
telescope.  The underlying serial communication protocol is the same for similar 
models. 

5. Click the Settings command from the Mount Setup pop-up menu and then select the 
correct COM port (Windows) or the correct Serial Device (Mac). 

6. Click Close. 
7. Click Telescope > Connect. The Temma’s local sidereal time and latitude are set 

according to TheSkyX's values.  The telescope cross hairs appear on the Sky Chart at 
0,0 right ascension/declination. The Temma’s tracking direction is automatically set 
according to TheSkyX’s North or South latitude setting.   

8. Click the Synchronize command (page 215) on the Start Up pop-up menu, then 
follow the on-screen instructions to complete the initialization.  See “Temma 
Synchronization” below for more information. 

Temma Synchronization 

When the Temma mount is powered off, then on, the Temma control system’s right 
ascension/declination coordinates are always 0.0,0.0.  
 
At this point, you must point the telescope to a known position, and then synchronize 
TheSkyX at that position. 
  
Synchronization Method Procedure 
To synchronize when the optical tube assembly 
end of the declination axis is on the West side 
of the mount. 

1. Loosen the clutches on the mount and orient the telescope 
so that the optical end of the declination axis is on the West 
side of the mount. 

2. Keeping the OTA end of the declination axis on the West 
side of the mount, center a known star that is on the 
opposite side of the meridian. 

3. Identify this star in TheSkyX (either by clicking on it or using 
TheSkyX’s Find command from the Edit menu.) 

4. On the Telescope window, select the Synchronize 
command in the Start Up pop-up menu and follow the on-
screen instructions. 
 

To synchronize when the optical tube assembly 
end of the declination axis is on the East side 
of the mount. 
 

1. Loosen the clutches on the mount and orient the telescope 
so that the optical end of the declination axis is on the East 
side of the mount. 

2. Keeping the OTA end of the declination axis on the East 
side of the mount, center a known star that is on the 
opposite side of the meridian. 

3. Identify this star in TheSkyX (either by clicking on it or using 
TheSkyX’s Find command from the Edit menu.) 

4. On the Telescope window, select the Synchronize 
command in the Start Up pop-up menu and follow the on-
screen instructions. 
 

To synchronize by pointing the telescope at the 
zenith. 

1. Loosen the clutches on the mount and orient the telescope 
so that the optical tube assembly is pointing straight up (that 
is, the OTA is vertical). 

2. Select the Temma Specific command from the Display 
menu to show the Temma Specific window if necessary. 

3. Click the Settings tab on the Temma Specific window. 
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4. Click the Sync At Zenith button. 
 

No synchronization. If the Temma has been initialized using other software, or is still 
initialized from a previous observing session (that is, you did not 
turn off the Computer Stand By switch on the mount). 
 
1. Click Telescope > Connect Telescope. 

 

Built-in Backlash Compensation 

The Temma control system has a built-in “backlash compensation” feature that attempts 
to minimize the effects of gear slop.  When the mount is commanded to slew from 
TheSkyX, it actually slews past the object a small amount, then slews back to it in the 
direction of sidereal tracking.   

Temma Specific Commands 

Select the Temma Specific command from the Display menu to show commands that are 
specific to this control system.   
 
Note that this command is only available when the Temma is selected in the Mount pop-
up menu on the Telescope > Setup window. 
 

 
Figure 131: The Temma Specific commands window (Display menu). 
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Settings Tab 

The following Temma-specific settings are available. 

Set Solar Rate 

Click this button to set the mount’s tracking rate to approximate the Sun’s rate of motion 
across the sky. 

RA Adjustment (sidereal seconds/day) 

Enter the adjusted tracking rate for the right ascension axis in sidereal seconds per day. 
There are 86,164 seconds in one sidereal day. (1 "earth day" = 1.002738 “sidereal day”). 
See the tracking rate example below. 

Dec Adjustment (min/day) 

Enter the adjusted tracking rate for the declination axis in minutes per day. See the 
tracking rate example below. 

Tracking Rate Example 

The following example shows how to set the Temma’s tracking rates to match 
(approximately) the Moon’s reported rate.  This same procedure can be used for any solar 
system object. 
 
1. From TheSkyX, click the Find command from the Edit menu. 
2. Type Moon in the Find text box, and then click the Find button.   
3. On the Object Information dialog report, note the RA Rate (arcseconds/sec) and the 

Dec Rate (arcseconds/sec). For this example, suppose RA = 0.4334 and Dec = 
0.2567.   

4. Compute the RA adjustment using the following equation: (TheSkyX’s RA Rate × 
5760) × –1. The value is –2496.  

5. Compute the Dec adjustment using the following equation: (TheSkyX’s Dec Rate × 
1440) × –1. The value is 370.  

6. Enter both values and click the Set Tracking Rates button. 

Stop RA Motor (Standby Mode) 

Click this button to turn tracking off.  Note that this command is not supported by all 
Temma models.  You may wish to verify that the mount’s motor actually stops tracking 
before relying on this command to enter standby mode.  

Guide Rates 

RA  

Enter the right ascension correction speed (as a percentage of the sidereal rate).  This 
setting is used for the slow speed when using the Motion Controls. 

Dec 

Enter the declination correction speed (as a percentage of the sidereal rate).  
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Set RA/Dec Guide Rates 

Click this button to set the current tracking rate using the number entered in the New text 
box. 

Sync At Zenith 

Click this button to synchronize the Temma mount when the OTA is pointing at the 
zenith. 

Use 12V Power Source Button 

Click this button to configure the Temma control system to use 12-volt power supply. 

Use 24V Power Source Button 

Click this button to configure the Temma control system to use 24-volt power supply.   
• Issuing these commands when the Temma is slewing will cause the mount’s 

motors to stop.  
• Even when a 12-volt power supply is used, clicking the 24V Power Source Button 

results in higher slew rates. 

Status Tab 

Temma’s Local Sidereal Time 

Displays the local sidereal time reported by the Temma control system, in hours, minutes 
and seconds.  

OTA is on this Side of Mount (East/West) 

For German equatorial mounts, the optical tube assembly (OTA) end of the declination 
axis can be located on the East or West side of the mount. The Temma reports which side 
of the mount it “thinks” the optical tube assembly is on.  Select the appropriate side from 
the pop-up menu. 

Voltage From Power Supply 

The Temma mount can use either 12V or 24V power.  The actual voltage that is being 
supplied to the control system is shown here. 

Hemisphere Tracking Direction 

TheSkyX’s North/South latitude setting in the Input > Location window is used to 
configure the Temma’s direction of tracking. 

Standby Mode 

Reports whether or not the Temma mount is in “standby mode,” which means the 
mount’s MOTOR switch (Figure 129 on page 235) is turned off.  When this switch is in 
the off position, the mount’s right ascension axis will not track at the current tracking 
rate. 
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Parking the Temma PC Jr.  

Temma PC Jr. mounts do not allow the mount’s tracking rate to be turned off through 
software (the Motor Power switch must be turned off to stop the motors from tracking at 
the current rate).  Therefore, when the Park command is issued for this mount, TheSkyX 
still slews the mount to the park position, but it must then periodically slew back to the 
park position every few minutes (to undo the rotation or the right ascension axis that is 
the result of the mount tracking at the sidereal rate).   
 
Note that “software-based parking and continuous rewinding” is a poor workaround to a 
fundamental shortcoming in the mount’s control system.  Loss of communication 
between the mount and TheSkyX will prevent TheSkyX from correcting the mount’s park 
position, and will most likely result in the mount tracking into itself.  This unfortunate 
event will most likely cause damage to the mount, equipment, cabling or all three.  The 
Temma control system has no built-in software or hardware tracking limits and it will try 
to rotate the right ascension axis even after the mount has tracked into a fixed object like, 
such as the pier. 
 
At a minimum, this telescope control system should allow tracking to be turned off 
through software.  Ideally, the telescope’s firmware should support a park/unpark 
mechanism that allows the mount to be shut down and restarted to restore the last session. 
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Vixen HTTP Equatorial Mounts 

 
Figure 132: The Vixen™ Sphinx HTTP mount.  Photo copyright Vixen Optics. 

Vixen Minimum System Requirements 

TheSkyX can control Vixen Sphinx HTTP mounts using firmware version 1.2 build 35 
and later.  If you have an older version of the firmware, contact the manufacturer for 
details about upgrading. 

Hardware Requirements 

• Any Vixen Sphinx model German equatorial mount that uses the STAR 
BOOK™ Star-Chart Go To System.  

• An Ethernet crossover cable for direct connection from the computer to 
the STAR BOOK or an Ethernet straight cable for network connection to 
the telescope through a router. 

Cabling Notes 

The Vixen HTTP mount uses standard network protocol rather than serial 
communications.  In the Settings dialog, enter the URL of the mount on your network.  
The default URL is http://169.254.1.1.  Use this address if the Vixen is connected directly 
to the computer’s network port using with an Ethernet crossover cable.    
 
If your mount is plugged into a network router, use a standard network cable instead.   

Step-by-Step Vixen HTTP Setup Procedure 

4. Plug the network cable into the base of the Star Book and into the computer’s 
network port (a network crossover cable is required) or into a network router or hub 
(using a standard Ethernet cable). 

5. Select the Telescope Setup command from the Telescope menu. 
6. Select Mount from the Imaging System list on the left side of the Imaging System 

Setup window. 
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7. Select the Choose command from the Mount Setup pop-up menu.   
8. On the Choose Mount window, select your model telescope and click OK.   If the 

exact model of your telescope is not listed, don’t worry; just select a similar model 
telescope.  The underlying serial communication protocol is the same for similar 
models. 

9. On the Imaging System Setup window, click the Settings button from the Mount 
Setup pop-up menu and enter the URL of the Vixen Star Book.  When the mount is 
turned on and the network cable is plugged into both the Star Book hand paddle and 
the network router, the Star Book’s About box shows the URL of this device on the 
network.  Enter this address into the URL text input on the HTTP Port Settings 
dialog. 

10. On the Imaging System Setup dialog, turn on the desired preferences and then click 
Close. 

11. Select the Connect command from the Telescope menu.  The telescope cross hair 
displays the current coordinates of the telescope. 

12. Click the Synchronize command (page 215) on the Start Up pop-up menu, then 
follow the on-screen instructions to complete the initialization. 

 
The Vixen mount should now be initialized and ready to use. 
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Camera Control 
 
TheSkyX Professional Edition for Mac and Windows, stand alone, can acquire photos 
from SBIG-model cameras using the Basic Camera Add On.  (Software Bisque plans to 
add and expand support for additional model cameras and hardware in future updates.) 
 
Additionally, TheSkyX Professional Edition for Windows can acquire photos from any 
camera that is supported by CCDSoft for Windows Version 5.0.0.196 or later. 

Configuring the Basic Camera Add On  

Follow the steps below to configure TheSkyX Pro to directly control an SBIG camera. 
 

1. Install the SBIG camera drivers for your operating system.  If necessary use 
SBIG’s free CCOPS software for your OS to make sure the driver is functioning 
and you can take photos. 

2. Make sure your camera is plugged in and turned on.  Before attempting to connect 
to the camera, allow 30 seconds or so for the SBIG camera to initialize. 

3. From TheSkyX, select the Telescope Setup command from the Telescope menu. 
4. Select Camera from the Imaging System list. 
5. Click the Choose command on the Camera Setup pop-up menu.  If you have not 

purchased the Basic Camera Add On, click the Run Trial button to use begin the 
90 day trial period. 

6. Expand SBIG, then select your camera model and click OK. 
7. Select the Connect command from the Camera Setup pop-up menu.  If the SBIG 

drivers are installed properly, after about 15 seconds, the green Ready status text 
appears on the Imaging System Setup window and on the Camera window.   

 

http://www.sbig.com/sbwhtmls/softpage.htm�
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Figure 133: The Camera window. 

Take a photo by clicking the Take Photo button on the Camera window.   

Select Exposure Length (Exposure Length) 

The maximum exposure length is determined by how good your polar alignment is, and 
by how accurately your mount tracks. If you see stars trailing into lines, shorten your 
exposure until this goes away (or take some time to improve your polar alignment or the 
accuracy of your mount’s tracking). If you see wiggly lines on long exposures, then your 
mount's tracking error is too large for the current focal length. Use a focal reducer, or 
switch to a scope with a shorter focal length that better fits the capabilities of your mount. 
 
The following table includes some recommended exposure times for various objects. The 
table assumes a focal ratio in the range of about f/7.  Use longer exposures for longer 
focal ratios, and shorter exposures for shorter focal ratios.  If you get blooming on a 
particular object, then go to a shorter exposure. If you don't get much detail in the image, 
or it seems washed out, go to a longer exposure.  Generally speaking, unless you run into 
blooming, saturation, or other problems, longer exposures are generally better. 
Experiment to find the best exposures for your setup. You might want to keep a written 
record of successful exposures, which you can use as a guide for future imaging sessions. 
 
Object Suggested Exposure range 
Sun Use a visual solar filter, plus any additional filters needed to cut the 

light. Polarizing filters, moon filters, or other specialized filters 
such as h-alpha filters can reduce the light so that your camera's 
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shortest exposure will be sufficient for solar images. Do not use so-
called photographic solar filters. These are intended for film, which 
is much less sensitive than your CCD detector.  
 
Never attempt to photograph or view the sun without a proper 
solar filter! 
 

Bright 
planets 

Planets such as Venus, Jupiter, Saturn and Mars require 
surprisingly short exposures with most setups, as little as 5 to 10 
thousandths of a second.  However, if you use a Barlow or eyepiece 
projection to increase the focal ratio to f/20 or even f/30, longer 
exposures (up to a full second) may be required. 
 

Moon The moon is also very bright, especially around full moon, and may 
require some effort on your part to attenuate the light sufficiently 
for imaging.  Polarizing filters and moon filters, or both, will get 
the job done.  As with solar images, the shortest possible exposure 
of your camera should be tried first.  Then add additional filtering if 
that isn't short enough, or increase the exposure if it's not long 
enough. 
 

Open 
clusters, 
bright 
globular 
clusters 

These objects require relatively short exposures, and exposure 
length is usually limited by blooming if you don’t have an anti-
blooming camera.  If you do have an anti-blooming camera, you 
can even image open clusters long enough to image background 
galaxies.  For clusters with very bright members, or globular 
clusters with very bright cores such as M13, exposures under a 
minute should be enough.  Dimmer clusters may require exposures 
longer than a minute.  Very bright clusters, such as the Pleiades, 
may only work well with anti-blooming cameras. For color 
imaging, be careful not to saturate bright stars so you can get truer 
star colors. 
 

Galaxies Galaxies come in a enormous range of brightness levels.  M31 will 
show up in an exposure of a few seconds; M101 may require 5 to 
10 minutes or more. Generally speaking, edge-on spirals and 
elliptical galaxies are brighter and require shorter exposures.  Face-
on spirals are usually the dimmest galaxies and require longer 
exposures.  When using a scope with a very long focal length, large 
pixels or binning may be required to get reasonable exposure times. 
 

Nebulas Nebulas come in an even wider range of brightness than galaxies 
do. Some, like M42, will yield excellent results in less than 20 
seconds.  Others, like the Rosette Nebula, may require 20-minute 
exposures to get good detail.  A few trial exposures will help you 
determine the best exposure for any given nebula. 



TheSkyX Professional and Serious Astronomer Edition User Guide 
 

246 

Generally speaking, longer exposures are better in most cases because they provide 
better-quality data. However, blooming, the risk of passing satellites or airplanes, and 
other factors usually limit the longest exposure time you can use. You can take multiple 
exposures and combine them in various ways to increase the quality of your photos. 

Set Frame Type to Light 

If you are just getting started, make sure that the Frame is set to Light. The Frame pop-
up also includes settings for taking photo reduction frames.  A CCD detector generates a 
certain amount of noise, and photo reduction removes a great deal of that noise. When 
you are taking a photo, always set the frame type to Light. 
 
The frame types are: 
Light A normal photo, taken with the shutter open. 

 
Bias A frame of the shortest possible exposure, 

taken with the shutter closed. It represents the 
minimum noise in the CCD detector and 
camera circuitry. This is subtracted from Dark 
frames so that the dark frames can be scaled 
for time and temperature differences. 
 

Dark A photo taken with the shutter closed.  It is in 
effect a picture of the electronic noise in the 
camera. This noise can be subtracted from a 
Light image to create a cleaner image. 
 

Flat Field A flat-field is an image taken of an evenly 
illuminated field, with the shutter open. Think 
of the flat-field as an image of the optical 
noise in the system, such as dust motes on 
glass surfaces or reflections off of the inside 
of the telescope. The Flat Field is applied to 
the Light frame to remove this source of 
noise. 
 

Set an Appropriate Reduction Setting (Reduction pop-up) 

When you select Light as the frame type, you can also choose the type of reduction to 
apply to the photo.  Reduction is the process of applying bias, dark, and flat-field frames 
to your image to reduce system noise. 
 
For your first images, choose the AutoDark reduction setting. After your exposure is 
finished, the software will automatically take a dark frame with the same exposure 
settings, and subtract it from the photo. This will give you a cleaner image with less 
thermal noise. When you gain more experience, you can explore the other reduction 
options: 
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None The software performs no photo reduction. Use this 

setting when you wish to manually apply your own 
bias, dark, and flat-field images; or when you simply 
want a quick image without any reduction. 
 

AutoDark This will follow the first exposure with a single dark 
frame. The dark frame is saved in memory and will 
be applied to all subsequent exposures with the same 
duration.  If you change the exposure duration, a new 
AutoDark frame will be taken. 
 

Using CCDSoft for Windows 

In addition to the TheSkyX’s stand alone support for SBIG cameras, any camera that can 
be controlled by CCDSoft for Windows version 5.00.200 or later can also be used.  
Please double-check that you have installed the latest release of CCDSoft for Windows 
before continuing. 

Configuring TheSkyX to use CCDSoft  

1. Install the SBIG camera drivers. 
2. Make sure that CCDSoft, standalone, can connect to and acquire photos from the 

camera.  If CCDSoft does not work to control the camera, TheSkyX can’t use it to 
acquire photos either. 

3. Make sure your camera is plugged in and turned on.  Before attempting to connect 
to the camera, allow 30 seconds or so for the SBIG camera to initialize. 

4. From TheSkyX, select the Telescope Setup command from the Telescope menu. 
5. Select Camera from the Imaging System list. 
6. Click the Choose command on the Camera Setup pop-up menu.  If you have not 

purchased the Basic Camera Add On, click the Run Trial button to use begin the 
90 day trial period. 

7. Expand Software Bisque, then select CCDSoft’s Camera and click OK. 
8. Select the Connect command from the Camera Setup pop-up menu.  If the SBIG 

drivers are installed properly, and CCDSoft is configured correctly, then after 
about 15 seconds, the green Ready status text appears on the Imaging System 
Setup window and on the Camera window. 

Temperature Control 

CCD detectors have a small but significant amount of noise.  Cooling the detector 
reduces this noise dramatically, so nearly all CCD cameras used in astronomy have some 
form of cooling.  The Temperature Setup button in the Camera window allows you to set 
the level of cooling for your camera. 
 

http://www.sbig.com/sbwhtmls/softpage.htm�
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Clicking on the Temperature button displays the Temperature Setup dialog. Click the 
On option to turn temperature regulation on.  Then set an appropriate temperature for 
your camera, taking into account the ambient temperature and your camera’s cooling 
capabilities.   
 

 
Figure 134: The setpoint you enter in the Temperature dialog will vary with the ambient 

temperature. 

The Temperature dialog recommends a setpoint on cameras that provide ambient 
temperature data, but you can also calculate it for yourself.  
 
Generally speaking, you want to set the cooling setpoint so that approximately 75-85% of 
the camera’s cooling capacity is used to maintain that temperature. This leaves a 
sufficient reserve cooling capacity to quickly respond to changes in ambient temperature. 
 
By keeping some cooling capacity in reserve, the camera can maintain the setpoint more 
accurately.  Your camera documentation will contain information about the maximum 
cooling capacity of your camera, typically expressed in degrees below ambient 
temperature.  For example, the ST-7E camera has a cooling capacity of 30 degrees below 
ambient. To calculate an optimal setpoint, take 75% of 30, and subtract it from the 
ambient temperature.  For example, if the ambient temperature is 15 degrees Celsius, and 
75% of 30 is 22.5, then your target temperature is 15-22.5, or –7.5 degrees. If you were 
working with the ST-237 camera, cooling capacity is 25 degrees below ambient, so your 
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target temperature is -2.5ºC.  In the real world, cooling capacity will vary somewhat.  As 
long as your values stay in the 75%-85% range, you are going to get good results. 

Taking a Photo 

To take a photo, click the Camera tab, enter the Exposure Length, Binning and click 
Take Photo button. 
 
When the photo is ready, it is displayed in the FITS Image Viewer window (page 62). 
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Focuser Control 
TheSkyX can control focusers that are part of the telescope’s control system.  Simply plug 
the focuser into the telescope’s focuser port, then use the Focuser controls on the 
Telescope window to adjust focus. 
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Dome Control 
 
TheSkyX can control astronomical domes that support the Astronomy Command 
Language (ACL) and any dome that can be controlled by AutomaDome for Windows. 
 
As you slew the telescope using TheSkyX, the Dome Add On algorithms automatically 
rotate the dome’s aperture to the correct azimuth taking into account the telescope-dome 
geometry. 
 
The position of the dome’s opening is displayed on the Sky Chart for reference. 
 

 
Figure 135: Sky Chart showing dome slit and telescope cross hair. 

Minimum Requirements 

• Any ACL-compatible dome hardware. 
• Any dome controller supported by AutomaDome for Windows version 1.00.012 or 

later. 
 
TheSkyX Professional Edition for Mac and Windows, stand alone, can control 
astronomical domes with the Dome Control Add On.  (Software Bisque plans to add and 
expand support for additional domes controllers in future updates.) 
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Additionally, TheSkyX Professional Edition for Windows can control domes supported 
by AutomaDome for Windows version 1.00.012 or later. 

Configuring the Dome Control Add On  

Follow the steps below to configure TheSkyX Pro to directly control a dome. 
 

1. Make sure your dome controller is ready.   
2. From TheSkyX, select the Telescope Setup command from the Telescope menu. 
3. Select Dome from the Imaging System list. 
4. Click the Choose command on the Dome Setup pop-up menu.  If you have not 

purchased the Dome Control Add On, you can click the Run Trial button to use 
begin the 90 day trial period. 

5. Select your dome controller and click OK. 
6. Select the Connect command from the Dome Setup pop-up menu.  If the dome 

drivers are installed properly, after about 15 seconds, the green Connected status 
text appears on the Imaging System Setup window and on the Dome window.   

Using AutomaDome for Windows 

In addition to the TheSkyX’s stand alone support for domes, any dome that can be 
controlled by AutomaDome for Windows can also be used.  Please double-check that you 
have installed the latest release of AutomaDome for Windows before continuing. 

Configuring TheSkyX to Use AutomaDome  

• Make sure AutomaDome, standalone, can connect to control the dome.  If AutomaDome 
does not work to control the dome, TheSkyX can’t use it to control the dome either. 

• From TheSkyX, select the Telescope Setup command from the Telescope menu. 
• Select Dome from the Imaging System list. 
• Click the Choose command on the Dome Setup pop-up menu.  If you have not purchased 

the Dome Control Add On, click the Run Trial button to use begin the 90 day trial 
period. 

• Expand Software Bisque, then select AutomaDome Dome and click OK. 
• Select the Connect command from the Dome Setup pop-up menu.  The green Connected 

status text appears on the Imaging System Setup window and on the Dome window. 

Dome Geometry 

The next step is to define the dome geometry so that the dome opening can be coupled to, 
and follow the telescope. 
 

http://www.bisque.com/sc/shops/store/automadome-box.aspx�
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Figure 136: The positions of the dome geometry parameters in an actual dome. 
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Figure 137: Overhead view of the dome. 

 

 
Figure 138: Dome geometry setting on the Imaging System Setup window. 
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The above dialog allows you to specify the dome geometry for your dome, telescope 
and optical system.  
 
Use the above figures and the definitions below to determine the geometry for your 
dome, telescope and optical system.  

Dome Radius  

Enter the radius of the dome. All measurements should be the same units. See above 
diagram for details. See Technical Description of Required Parameters below for more 
information. 

Offset of Mount from Dome  

The arguments xm, ym, zm specify the offset of "the mount" from "the dome." See 
Technical Description of Required Parameters below for more information. 
 

Xm  

Enter the distance from the N-S centerline of "the dome" to "the mount." See above 
diagram for details. Also, see Technical Description of Required Parameters below for 
more information. 

Ym  

Enter the distance from the E-W centerline of “the dome” to “the mount”. See above 
diagram for details. Also, see Technical Description of Required Parameters below for 
more information. 

Zm 

Enter the distance from “the dome” to “the mount”.  This parameter is not defined in the 
above diagram. See Technical Description of Required Parameters below for more 
information. 

Offset of Telescope from Mount  

The arguments xt, yt specify the offset of the telescope from the mount. See Technical 
Description of Required Parameters below for more information. 

Xt  

Enter the distance from the N-S centerline of “the mount” to the “optical center”. See 
Technical Description of Required Parameters below for more information. 

Yt  

Enter the distance from the E-W centerline of “the mount” to the “optical center”. This 
parameter is not defined in the above diagram, and is normally zero. See Technical 
Description of Required Parameters below for more information. 
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Offset of Optical Axis from Telescope (yo)  

Enter the offset of the optical axis within the telescope. This value is typically zero for 
most amateur telescopes.  

 
Use these dome and telescope mount geometry options to define the position of your 
telescope mount with respect to the center of the dome. These parameters are required to 
predict the azimuth and elevation of the dome aperture for any asymmetrically mounted 
telescope. See Technical Description of Required Parameters below for more 
information. 

Technical Description of Required Parameters  

Parameter Description (See notes below) 
Rdome   Radius of dome  
xm, ym, zm Offset of mount  
xt, yt   Offset of telescope 
Yo   Offset of optical center  
ta, tb   Telescope roll/pitch in radians.   
 

Notes:   

• The dome is presumed to be hemispherical (or some other portion of a sphere). 
The radius of the sphere is specified through the Rdome argument. Any desired 
units can be used as long as the other “length” arguments are in the same units.  

• The arguments xm, ym, zm specify the offset of the mount from the dome. "The 
dome" is the center of the sphere. "The mount" is that point along the roll axis 
(and hence fixed in space) that lies nearest to the telescope (Note 5). The x, y, z 
coordinate system is oriented east, north, up.  

• The arguments xt, yt specify the offset of the telescope from the mount. “The 
mount” is the fixed point defined in Note 4. “The telescope” is that point along 
the pitch axis (and hence fixed within the moving part of the mount) that lies 
nearest to the optical axis (Note 6).  

• The argument yo specifies the offset of the optical axis within the telescope. "The 
telescope" is the point defined in Note 5. “The optical center” is the point along 
the optical axis that lies nearest to the pitch axis. It is the intersection of the 
optical axis with the dome that defines the point the azimuth and elevation of 
which are to be calculated.  

• The telescope roll/pitch coordinate system matches hour angle and declination in 
the equatorial case. This means that it is left-handed, longitude increasing 
clockwise as seen from the positive pole. It means also that zero roll occurs when 
a northern-hemisphere telescope is pointing south. Thus the telescope roll/pitch 
system matches azimuth/elevation in handedness but there is an azimuth zero-
point offset of 180 degrees. Note that the roll/pitch are mechanical rather than 
celestial, so that above/below pole and east/west of the pier cases are 
distinguished.  
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• The coordinate systems for the offsets are as follows.  
 They are all right-handed.  
 The xm, ym, zm axes point east, north, up.  
 The orientation of the xt, yt axes is such that they coincide with xm, ym 

for the case of an alt-azimuth mount pointing south. Other types of 
mounting follow suit. For an equatorial mount in the Northern 
Hemisphere, when the telescope is pointing at the meridian north of the 
zenith, xt points east (i.e. aligned with xm), and the horizontal component 
of yt points north (i.e. aligned with ym).  

 The yo axis is coincident with yt when the telescope is pointing at the 
positive pole.  

 The units of rdome, xm, ym, zm, xt, yt, xo and yo must all be the same.  
• The dome azimuth/elevation coordinate system follows the normal convention. 

Azimuth increases clockwise from zero in the north, through 90 degrees (pi/2 
radians) in the east. The value returned is in the range zero to 2pi. At the zenith, 
zero is returned.  

• Small "pointing corrections", minor non-perpendicularities and misalignments, 
are ignored.  

Dome Commands 

Select the Dome command from the Display menu to show the Dome window.  This 
window is normally “docked” to the left side of the Sky Chart, but can be positioned 
elsewhere by dragging the caption. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 
 

258 

 
Figure 139: Dome commands. 

Status 

Shows the current status of the dome connection. 

Azimuth  

Shows the current azimuth of the dome opening. 

Connect 

Click this button to establish communication with the dome controller. 

Disconnect 

Click this button to terminate communication with the dome controller. 
 

Go To  

Click this button to enter the azimuth to position the dome opening. 

Find Home 

Click this button to locate the dome’s home position. 
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Open Dome  

Click this button to open the dome. 

Close Dome  

Click this button to close the dome. 

Park Dome  

Click this button to send the dome to its park position. 

UnPark Dome  

Click this button to perform any necessary initialization when starting up the dome for 
the night.  

Sync Dome 

Click this button to synchronize the dome opening to a specific azimuth. 

Abort 

Click this button to terminate in any dome command that is currently in progress. 

Result  

Shows the result of the dome command that is reported by the dome controller hardware.  
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Appendix A: Databases and Cross References 
TheSkyX Professional Edition and Serious Astronomer Edition include databases of 
celestial objects from the standard astronomical catalogs listed in the tables below.  
 
If you want to use a specific set of databases, select the Database Manager command 
from the Input menu to turn any catalog on or off. 

Star Catalogs 

The Hipparcos-Tycho Catalogs are the primary stellar databases used to display 
information by TheSkyX for stars to about 12th magnitude and brighter. 

  
TheSkyX also cross-references stars from the following catalogs.  

• Bayer/Flamsteed Designations 
• Smithsonian Astrophysical Observatory Catalog (SAO)  
• Positions and Proper Motion Catalog (PPM)  
• Henry Draper Catalog (HD)  

 
Star Catalog Name Details/Object Count 
Hipparcos/Tycho Stellar Catalog 

 
1.2 million stars, complete to 12th magnitude 

 
Hubble Guide Star  Catalog (GSC) Version 1.2  

 
19 million stars, complete to about 14th magnitude 

General Catalog of Variable Stars (GCVS) 
 

40,214 variable stars 
 

New Suspected Variable Star Catalog (NSV) 
 

13,490 suspected variable stars 
 

Struve Double Star Catalog 
 

4,307 double stars 
 

Washington Catalog of Double Stars (WDS) 
 

102,139 double stars 

Non-Stellar Catalogs 
Non-stellar Catalog Name Details/Object Count 
Historically Corrected New General Catalogue 
(HCNGC) from the NGC/IC Project* 

 

7,840 non-stellar objects 
 

Index Catalog (IC) from the NGC/IC Project* 
 

5,382 non-stellar objects 

Catalog of Principal Galaxies (PGC) 
  

98,087 galaxies 
 

PK Planetary Nebula Catalog (PLN) 
 

 

1,455 planetary nebulae 

Tomm Lorenzin 2000+ Catalog 
 

 

2,088 non-stellar objects 

Herschel Catalog 
 

400 

Caldwell Catalog 
 

109 

http://astro.estec.esa.nl/Hipparcos/hipparcos.html�
http://tdc-www.harvard.edu/software/catalogs/hstgsc.html�
http://ad.usno.navy.mil/wds/�
http://www.ngcic.org/�
http://www.ngcic.org/�
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Messier Catalog (M) 
 

110 

Saguaro Astronomy Club (SAC) Database 
 

10,580 

 
*The HCNGC and IC catalog is used with permission of The NGC/IC Project LLC - http://www.ngcic.org 
– please contact Bob Erdmann at hcngc at ngcic dot org for any questions or clarifications regarding this 
astronomical catalog. 

Additional Sky Databases (SDBs) 

TheSkyX includes the following additional astronomical catalogs that can be displayed on 
the Sky Chart.   From the Input > Database Manager dialog, navigate to the Sky 
Databases (SDBs) > Optional Databases node in the Databases list to turn them on or 
off.  
 

Catalog Name Search Prefix Object Count Object Type 
1.4-GHz Northern Sky  1-4ghz                31524 Reference Point        
6C Survey of Radio Sources I  6CSRSI                 1761 Radio Source           
6C Survey of Radio Sources II  6CSRSII                8278 Radio Source           
6C Survey of Radio Sources III 6CSRSIII               8749 Radio Source           
6C Survey of Radio Sources IV  6CSRS-IV               5421 Radio Source           
6C Survey of Radio Sources V - A  6CSRS-VA               2229 Radio Source           
6C Survey of Radio Sources V - B  6CSRS-VB               1229 Radio Source           
6C Survey of Radio Sources VI  6CSRS-VI               6752 Radio Source           
Abell - Zwicky Clusters of Galaxies  AGC                    2712 Cluster of Galaxies    
Abell Planetary Nebulae APN                      86 Nebula                 
Ackerman Red Stars ARS                     267 Reference Point        
APM Bright Galaxy Catalogue APM                   14681 Galaxy                 
Arp Globular Clusters  Arp-GC                   43 Globular Cluster       
Arp Peculiar Galaxies  ARP-PG                  338 Galaxy                 
Barnard's Dark Nebulae  Barnard                 349 Dark Nebula            
Bright Nebulae Drawings (TMB)   TMB-BN                25743 Bright Nebula          
Catalog of Bright Galaxies  CBG                    4364 Galaxy                 
Celestron NexStar Doubles  CND                      55 Double Star            
Cepheids in the Large Magellanic 
Cloud  

LMC-CV                   97 Variable Star          

Cluster System of the Large 
Magellanic Cloud  

LMC-CL                 1762 Mixed Deep Sky         

Cool Galactic Carbon Stars CCS                    5987 Reference Point        
Cousins Photometric Standards CPS                     670 Reference Point        
Culled Henden CI Labels                       HC-L                      0 Reference Point        
Dark Nebulae Isophotes TMB DND                     650 Dark Nebula            
Declination Zero l                           51 Reference Line         
Declination Zero Label                           13 Reference Point        
DeepMap 600 l                          470 Reference Point        
Don Macholtz Messier Marathon l Macholtz                110 Target Object          
Double Stars with common names l                          169 Double Star            
Einstein Obs Ex M-S Survey  EMSS                    835 X-Ray Source           
Feitzinger Dark Nebula FZ-DN                   489 Dark Nebula            
Feitzinger Globules  FG                      331 Reference Point        
Florsch - Small Magellanic Cloud Stars        SMC-Florsch             584 Reference Point        
G2 V Stars from SIMBAD Query  G2V                     688 Reference Point        
Galactic Globular Clusters - Monella  GC-Monella              160 Globular Cluster       
Galactiglob Galaxies  TJ-GG                  2495 Galaxy                 
Galaxy Isophote M51 Example BSR-GI                  902 Galaxy                 
Heinz Nebula Small Magellanic CLoud           HN                      117 Nebula                 
Henden 3C                                     H3C                     504 Reference Point        
Herbig-Haro Objects   HH                      454 Reference Point        
HW Clusters Large Magellanic Cloud  HW-SMC                   87 Globular Cluster       
IRAS 1.2 Jy Redshift                          IRAS-1.2               9899 Galaxy                 
IRAS Small Scale Structure                    IRASS                 16740 Reference Point        

http://www.ngcic.org/�
http://www.ngcic.org/�
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Kron Clusters Small Magellanic Cloud          SMC-KRON                 69 Globular Cluster       
Landolt Faint Photometric Standards           LFPS                    526 Reference Point        
Landolt Photometric Standards                 LPS                    1154 Reference Point        
Landolt Photometric Standards South           LPS-S                   109 Reference Point        
Lindsay Clusters Small Magellanic 
Cloud       

SMC-L                   118 Globular Cluster       

Lynds' Bright Nebulae  LBN                    1053 Bright Nebula          
Lynds' Dark Nebulae  LDN                    1791 Dark Nebula            
Meade Alignment Star Labels  MAS                      78 Reference Point        
Michael Covington Deep Sky Objects COV                     200 Mixed Deep Sky         
Milky Way Globular Clusters  MW-GC                   150 Globular Cluster       
Molonglo Reference - Radio Sources            Molongo Radio         12141 Radio Source           
Molonglo Reference - Radio Sources            Molongo Radio         12141 Radio Source           
Navigational Stars  NavStar                  58 Reference Point        
NB Carbon Stars - Skiff  NBC                     211 Reference Point        
Nebulae in the Magellanic Clouds- HII         LMC-HII                 358 Nebula                 
NGC and -IC objects UNKNOWN 
magnitudes  

                        982 Mixed Deep Sky         

NGC Max Alignment Stars - JMI  JMI                      30 Star                   
Objects in the Direction of the SMC           SMC-B                   965 Reference Point        
Open Cluster Data 5th Edition  (Lynga 
1987)   

OC-L                   1151 Open Cluster           

Palomar Globular Clusters PAL                      15 Globular Cluster       
Palomar Sky Survey - 102 CD labels.  DSS-102                   0 Reference Point        
Palomar Sky Survey Plates Additional 
Data     

POSS                   1037 Reference Point        

Parkes Radio Sources  PKS90                  8264 Radio Source           
Planetary Nebulae in LMC                      LMC-PLN                 169 Planetary Nebula       
Pulsars  (Taylor+ 1993   PULSARS                 558 Radio Source           
Query Common Non-Stellar                          329 Mixed Deep Sky         
RealSky CD's North Labels                     RealSky-N               765 Reference Point        
RealSky CD's South Labels                     RealSky-S               800 Reference Point        
RealSky North & South Labels                  RealSky-NS              658 Reference Point        
Redshift Galaxies                             RG                    12844 Galaxy                 
Rich Clusters of Galaxies (North)             RC-GN                  2712 Cluster of Galaxies    
Rich Clusters of Galaxies (South)             RC-GS                  1364 Cluster of Galaxies    
Roslund Red Stars in Scorpious                RR                       69 Reference Point        
Seyfert Galaxies Seyfert                 121 Galaxy                 
Shapley-Ames Bright Galaxies                  SA-BG                  1246 Galaxy                 
Shapley-Ames Bright Galaxies                  SA-BG                  1246 Galaxy                 
Sharpless H II Regions                          313 Nebula                 
Skiff North Bright Standards                  BK-NBS                  119 Reference Point        
Star Clusters and Associations                SCA                    1039 Open Cluster           
Stars in the Double-Double l  DDS                       2 Star                   
Supernova Remnants - Green                    SNR-G                   231 Supernova              
Terzan Globular Clusters                      Ter                      11 Globular Cluster       
Third Catalogue of Nearby Stars               CNS3                   3802 Reference Point        
Trapezium Circumstellar disks                 TCD                     149 Reference Point        
Trapezium ROSAT PSPC                          Trap-XRay               171 X-Ray Source           
Trapezium Stars - TMB                           14 Star                   
Trapezium Stars VizieR  Trap-Vzr                292 Reference Point        
Trumpler Clusters  Tr                       34 Open Cluster           
Trumpler Stars  Tr-S                     39 Reference Point        
UV-Excess Galaxies                            UVG                    8162 Galaxy                 
Van Den Berg Reflection Nebulae  Vdb                     158 Nebula                 
Video Calibration Stars  VCS                     958 Target Object          
W-G Clusters Small Magellanic Cloud  WG                       18 Globular Cluster       
Yale Bright Star Catalog 1st half  YBSC-1                 4991 Star                   
Yale Bright Star Catalog 2nd half   YBSC-2                 4105 Star                   
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Solar System Objects 
Group Objects in Group Number of Objects 
Sun, Planets, Moons  Sun 

Mercury 
Venus 
Earth 
Earth’s Moon 
Mars 
Jupiter 
Io 
Ganymede 
Europa 
Callisto 
Saturn 
Enceladus 
Mimas 
Tethys 
Dione 
Rhea 
Titan 
Hyperion 
Iapetus 
Uranus 
Neptune 

22 

Small Solar System Bodies 
 

Pluto 1 
Comets Up to 1000 at once.  

 
Asteroids (Minor Planets) Every known asteroid (Orbital 

elements are updated from the 
web.) 

Artificial Satellites Updated from the web via the 
Input > Satellites command. 

Up to 10,000 two-line elements 
(TLEs) can be imported and 
updated from the web when 

TheSkyX is launched. 

Photographs 
Photos Database Details 
Anglo-Australian Observatory  Photos 172 color photos from the David Malin collection of AAO images. 
Deep-sky Overlays 127 photos that appear on the Sky Chart. 
Hubble Photos 314 color photographs from the Hubble Space Telescope. 
Messier Overlays 104 color photographs. 

 
Non-stellar objects 
 

53 color photographs of  non-stellar objects. 
 

Solar System Photos 255 color photographs of the solar system objects. 
 

Digitized Sky Survey thumbnails 100,000 grayscale photos from the Digitized Sky Survey. 
 

Catalog Cross References 

TheSkyX also cross-references the following catalogs. Use TheSkyX Find command on 
the Edit menu to locate any object from any of these catalogs. 

  
Cross-Referenced Catalogs Prefix Object Count 
Arakelian Catalog of Galaxies 

 
ARAK 595 

Bayer/Flamsteed Designations n/a n/a 
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Bonner Durchmusterung Number B+nn nnnnn - 
Caldwell Catalog Caldwell + Cn 109 
Cape Durchmusterung Number P-nn nnnn - 
Catalog of Galaxies and Clusters of Galaxies CGCG 29,809 
Common Non-Stellar Object Names name of object   
Common Star Names name of object   
Constellations name of constellation 88 
Cordoba Durchmusterung C-nn nnnnn - 
David Dunlap Observatory Catalog of Galaxies DDO 242 
Fairall Catalog of Galaxies FAIR 1,185 
Henry Draper number HD 359,083 
Infrared Astronomical Survey IRAS 9,347 
Karachentseva Catalog of Galaxies 
 

KARA 183 

Kazaryan UV Galaxies KAZ 581 
Kiso UV Galaxies 
 

KUG 5,455 

Messier Catalog M 110 
Positions and Proper Motions Number PPM - 
Second Byurakay Survey SBS 259 
Smithsonian Astrophysical Catalog (SAO)  SAO 258,997 
Struve Catalog STRUVE 3,100 
Tololo Galaxies TOL 111 
University of Michigan Catalog of Galaxies UM 652 
unnamed 1SZ 26 
unnamed 2SZ 32 
unnamed ARP 560 
unnamed ESO 16,239 
unnamed LGS 5 
unnamed VV 1,161 
Uppsala General Catalog of Galaxies UGC 13,073 
Virgo Cluster Catalog of Galaxies VCC 2097 
Weinberger Catalog of Galaxies WEIN 207 
Zwicky1 1ZW 238 
Zwicky2 2ZW 199 
Zwicky3 3ZW 159 
Zwicky4 4ZW 203 
Zwicky5 5ZW 531 
Zwicky6 6ZW 238 
Zwicky7 7ZW 1,145 
Zwicky8 8ZW 645 

 Ephemeral Data 

TheSkyX can display the positions of comets and minor planets and man-made satellites. 
  
The orbital element data required to accurately display these objects changes frequently 
and can be updated from TheSkyX using different sources on the worldwide web.  
 
The table below lists the sites the TheSkyX uses to update this information. 
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Object Type Object Count Web Site Address to Obtain Updated Orbital 
Element Data 

Comets Up to 1000 http://www.minorplanetcenter.org/cfa/ps/Ephemerides   
  
 

Satellites Up to 10,000 
 

http://celestrak.com 
  

Asteroids 
(Large 
Database) 
 

All known asteroids http://asteroid.lowell.edu 
 
 

 

TheSkyX Professional Edition-Specific Databases 

 
In addition to the databases listed above, TheSkyX Professional Edition includes an 
optimized version of the UCAC3 star catalog with approximately 30 million stars.   

TheSkyX Pro Database Add On 

If you need more star data, consider purchasing TheSkyX Professional Edition Database 
Add On from Software Bisque.  TheSkyX Pro Database Add On includes 210 GB of 
native star catalogs , Software Bisque-optimized star catalogs and the complete Digitized 
Sky Survey (the 10x compression version, distributed with permission).   
 
Catalog Name Number of Stars Approximate Size (GB) 
Native NOMAD Catalog and related 
files. 

1.1 billion  100 

Native UCAC3 Catalog and related 
files. 

100,766,420  8 

Software Bisque NOMAD plot files. 800 million  40 
Small TheSkyX Pro-specific UCAC3 
plot file. 

30 million .8 

Large TheSkyX Pro-specific UCAC3 
plot file. 

90 million 2 

Digitized Sky Survey (10x 
compression). 

Photographic data for the entire 
celestial sphere. 

60 

 
The databases and files in TheSkyX Pro Add On product are distributed on a USB hard 
drive that can be purchased from the Software Bisque Store. 

Database Add On Copyright Information 

The large and small TheSkyX Professional Edition-specific plot files included on the 
Database Add On hard drive are copyright Software Bisque and cannot be redistributed.  
The Digitized Sky Survey is copyright AURA and cannot be redistributed without written 
permission.  Please contact the USNO for details about distributing the native NOMAD 
and UCAC3 catalogs. 
 

http://www.nofs.navy.mil/nomad/�
http://www.usno.navy.mil/USNO/astrometry/optical-IR-prod/ucac�
http://www.usno.navy.mil/USNO�
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Using the Database Add On 

Configuring TheSkyX Professional Edition to use the Database Add On star catalogs and 
photos from Digitized Sky Survey is simple. 
 

1. Plug the USB hard drive that contains the Database Add On files. 
2. From TheSkyX Professional Edition, select the Database Manager command from 

the Input menu. 
3. In the list of databases, expand the Database Add On node, then highlight the 

Database Add On Root. 
4. Click the Choose Folder button. 
5. Select the volume name (Mac) or drive letter (Windows) for the drive and click 

the Choose button.  The Property table should now show the correct location for 
these files.   

6. Click Close. 
 
The Sky Chart will now show stars from the UCAC3 and NOMAD star catalogs at small 
fields of view. 
 
Additionally, when the Digitized Sky Survey Setup’s Disc Or Other Drive option is 
turned on, photos from the Digitized Sky Survey will be retrieved from the hard drive 
when the Show Digitized Sky Survey Photo command is selected from the Tools menu. 
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Appendix B: Migrating from TheSky6 to TheSkyX 
If you are comfortable using TheSky6, you’ll want to review the table of changes below 
to ease the transition to TheSkyX. 

Terminology Changes 

This phrase or command in 
TheSky6… 

Is now this in TheSkyX… 

Chart Mode Map Like option, Display menu, page 146. 
 

Comets/Minor Planets/Extended 
Minor Planets 

Small Solar System Bodies command, page 
142. 
 

Data Menu Input Menu. 
 

Data Wizard Advanced Query, page 173. 
 

Data Wizard Results Observing List, page 172. 
 

Daytime Sky Mode Show Daylight, page 33. 
 

Display Explorer Chart Elements, page 136. 
 

Display Properties Chart Attributes, page 136. 
 

Eclipse Finder Solar & Lunar Eclipse Viewer, page 117. 
 

Extended Labels Detailed Labels, page 47. 
 

Extended Minor Planets Asteroids (Large Database), page 142. 
 

Image Groups Place Photos, page 57. 
 

Images Photos, page 54. 
 

Image Manager (Data Menu) Place Photo, page 57. 
 

Import command Create Sky Database command, page 161. 
 

Mapping/Map Points Pointing Calibration/Pointing Samples.  See 
the TPoint Add On User Guide for details 
about pointing calibration. 
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Minor Planets Asteroids, page 143. 
 

Mirror Image Show Mirror Image, page 29. 
 

Moon Phase Calendar Calendar, page 77. 
 

Moon Viewer Moon Photo Viewer, page 105. 
 

Night Vision Mode Show Night Vision Mode. 
 

N/E Indicator Celestial North Arrow (Chart Elements 
window, page 136). 
 

Options  command Preferences (Tools Menu, Windows) page 130. 
 

Pole Up Celestial Sphere, Orientation menu, page 27. 
 

Print Preview  Export Chart, page 100. 
 

Real Mode Options Horizon & Atmosphere Options, page 151, and 
Milky Way Options, page 156. 
 

Sky Database Manager Database Manager, page 158. 
 

Sky Display Sky Chart, page 19. 
 

Sky Document Sky Chart Settings, page 33. 
 

Sky View Preferences Chart Element Attributes, page 136. 
 

Stellar & Solar System Update 
Frequency  

Target Frame Rate, page 135 .   
 
Solar system object updates now occur 30 
times per second by default, rather than once 
every 5 minutes as did TheSky6. 
 

Sync command  Startup pop-up menu on the Telescope window 
(Display menu), page 215. 

Sun & Moon Report Reports, page 86. 
 

Use Computer’s Clock Computer Clock, page 133. 
 

User-Defined Data My Chart Elements, page 169. 
 

User-Defined Object Types My Object Types, page 29. 
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View Menu Display Menu. 
 

Virtual Sky Mode Photo Like, page 146. 
 

Zenith Up Terrestrial Sphere Orientation, page 87. 
 

 
TheSky6 Feature Equivalent TheSkyX Feature 
Changing Font Colors 

 
Edit the Attributes of Chart Elements (page 
136). 

Defining Telescope Limit Lines Click the Telescope Limits command from the 
Telescope menu. 

Edit or Draw the Local Horizon  1. Click the Horizon & Atmosphere 
command on the Display menu. 

2. Click the Horizon tab. 
3. Select the Custom Drawn option in the 

Horizon Type list. 
Object Tips (Tool Tips) 

 
1. Click the Preferences command from the 

Tools menu (Windows) or TheSkyX menu 
(Mac). 

2. Click the Report Setup icon. 
3. Select Tool Tips from the Report list.  
4. Turn on the desired Object Properties to 

appear in the tool tip. 
 

Right-click to drag the screen 
 

Left-click the mouse to drag the Sky Chart. 

Setting the Upper and Lower 
Magnitude Limits 

Setting the magnitude limit, page 94. 

Showing Labels (common labels and 
extended labels) on Sky Chart 

Labels (for common names and detailed labels) 
are located on the Labels window.  Click 
Labels command on the Display menu to show 
this window. 
 

Showing Reference Lines and 
Reference Photos, including: 

• Constellation Figures 
• Constellation Drawings 
• Constellation Boundaries 
• Galactic Equator 
• Milky Way 
• Equatorial lines (equatorial 

grid and North/East Indicator) 
• Horizon 
• Ecliptic 

Reference lines can be turned on or off from 
the Chart Elements window (page 149).  



TheSkyX Professional and Serious Astronomer Edition User Guide 
 

272 

• Telescope Limit Lines 
• Horizon-based lines, 

including the local horizon, 
refracted horizon, meridian 
and horizon grid 

• Local Horizon Fill Color 
 
Zoom Box Press and hold the SHIFT key while dragging 

the mouse on the Sky Chart to create a zoom 
box. 
 

TheSky6 and TPoint for Windows Settings 

TheSky6 can open and save a variety file formats.  The follow section describes each 
format and how to transition your existing data to TheSkyX.  

Sky Documents 

• By default, TheSkyX uses your computer’s IP address to determine your location.  
TheSkyX also has a “To Google Map” option that can be used verify and refine 
your location.  If you have the GPS coordinates of your observing site, then you 
can enter them manually, as well as your time zone,  from the Input > Location > 
Custom tab (page 22).   

• TheSkyX uses the computer’s local time by default.  See “Entering the Date and 
Time (Date & Time Control)” on 80 for details how to set a specific date and 
time. 

Field of View Indicators 

• TheSky6 stores your custom field of view indicators in a text file named Field of 
View Indicators.txt in the folder named <My Documents>\Software 
Bisque\TheSky6\Field of View Indicators. TheSkyX also stores FOVIs in a text file 
of the same name, but in the folder named <My Documents>\Software 
Bisque\TheSkyX Professional Edition\Field of View Indicators.  The format of 
TheSky6's Field of View Indicators.txt text file the same as TheSkyX.  So, you can 
copy TheSky6's Field of View Indicators.txt to TheSkyX’s folder to preserve your 
FOVIs.  

Telescope Configuration 

• Telescope-configuration is a manual process.  You'll need to manually set the 
telescope and the telescope settings (telescope type, COM port, limit settings, 
etc.) from TheSkyX.  

• Use TheSky6 to park the telescope.  Then connect to the telescope from TheSkyX 
and, without slewing the telescope, on the Telescope window, from the Shut 
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Down pop-up menu, configure TheSkyX’s park position by clicking the Set Park 
Position command (page 214).  

TPoint for Windows Settings and Models 

Important Note: TPoint for Windows is not compatible with TheSkyX Professional 
Edition.  TheSkyX Professional Edition instead now offers the integrated TPoint Add On. 
 

• In TheSky6, the TPoint for Windows model is saved as part of the Sky Document 
(.SKY) document.  TPoint for Windows is a separate application.  In TheSkyX, the 
can be purchased as an "Add On" but is an integrated component  and is accessed 
by clicking the Telescope > TPoint Add On command at any time (there's a 90 
day free trial period to use the TPoint Add On).    

To transfer an existing TPoint for Windows model to TheSkyX Pro and the TPoint 
Add On 

1. From TheSky6, open the TPoint document by right-clicking on the TPoint icon, 
and then click Open.  This launches TPoint for Windows and opens the .TPT 
document with the model.  

2. From TPoint for Windows, click the Export command from the File menu, then 
enter a name for the text file that will hold your exported mapping data.  This 
“pointing data” can be imported into the TPoint Add On.  

3. From TheSkyX, click  the TPoint Add On command from the Telescope menu.  
4. From the TPoint Add On Setup tab, select the Import command from the TPoint 

Add On Settings pop-up menu.  
5. Select the text file name that holds the TPoint for Windows pointing data and then 

click Open.  
 
The TPoint Add On now has your pointing data, and you can turn on the desired terms for 
your model.  A recalibration will be required to restore the CH, IH and ID terms (the 
telescope’s “synchronization” information).  See the TPoint Add On User Guide for more 
information about recalibration 

Comets/Asteroids/Satellites 

• The latest orbital elements and two-line elements TLEs for these objects will need 
to be downloaded from TheSkyX.   See pages 116 and 121 for details. 

Sky Databases 

A folder of TheSky6 SDBs can be converted to TheSkyX-compatible Sky Database 
format (.SDBX) from the Advanced tab of TheSkyX’s Database Manager (page 159). 
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Appendix C: Daylight Saving Time  
The following table lists the international Daylight Saving Time (DST) starting and 
ending dates that TheSkyX uses to determine when DST begins and ends.  

  
The  Time Zone options are found in the Daylight Saving Option (DSO) pop-up. 

  
Time 
Zone 

DST 
Starts 

DST Ends Adopting Countries 

Australia-
NSW  

Last 
Sunday of 
October 

Last Sunday 
of March 

Australia (Australian Capital Territory, Lord Howe 
Island, New South Wales)  
  

Australia-
South  

Last 
Sunday of 
October 
  

Last Sunday 
of March 

Australia (Broken Hill NSW, South Australia, Victoria)  
  

Brazil  Third 
Sunday of 
October   

Third 
Sunday of 
February 

Brazil  
  

Chile  Second 
Sunday of 
October  

Second 
Sunday of 
March 

Chile  
  

China  Third 
Sunday of 
April 
  

Second 
Sunday of 
September 

China  
  

Cuba  First 
Sunday of 
April  

Second 
Sunday of 
October  

Cuba  
  

Egypt  First Day 
of May  

First Day of 
October  

Egypt  
  

Europe  Last 
Sunday of 
March 

Last Sunday 
of October  

Albania, Andorra, Austria, Belarus, Belgium, Bosnia 
Herzegovina, Bulgaria, Croatia, Cyprus, Czech 
Republic, Denmark, Estonia, Faroe Islands, Finland, 
France, Georgia, Germany, Gibraltar, Greece, 
Greenland (Scoresbysund), Hungary, Italy, 
Kazakhstan, Latvia, Lebanon, Lithuania, Luxembourg, 
Macedonia, Malta, Monaco, Mongolia (Ulan Bator), 
Netherlands, Norway, Poland, Portugal, Romania, 
Russian Federation, San Marino, Slovakia, Slovenia, 
Spain, Sweden, Switzerland, Turkey, Ukraine, 
Yugoslavia  
  

Falkland 
Islands 

Second 
Sunday of 
September  

Third 
Sunday of 
April  

Falkland Islands  

Greenland  Last 
Sunday of 
March 

Fourth 
Sunday of 
September 

Greenland (except Scoresbysund and Thule)  
  

Iran  21st Day 
of March 

21st Day 
September  

Iran  
  

Israel  Last Friday 
of March 

Last Sunday 
of August 

Israel  
  

Jordan  First 
Friday of 
April  

Third Friday 
of 
September 

Jordan  
  

Kyrgyzstan  Second 
Sunday of 
April 

Last Sunday 
of 
September 

Kyrgyzstan  
  

Moldova  First 
Sunday of 
March 

Last Sunday 
of 
September 

Moldova  
  

Namibia  First First Sunday Namibia  
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Sunday of 
September 

of April    

New 
Zealand  

First 
Sunday of 
October 

Third 
Sunday of 
March  

New Zealand  
  

U.S. and 
Canada 

Second 
Sunday of 
March 

First Sunday 
of 
November  

Begins March 2007 
  
Bahamas, Bermuda, Canada, Greenland (Thule), 
Mexico, St. Pierre and Miquelon, Turks and Caicos 
Islands, United States of America  
  

Paraguay  First 
Sunday of 
October 

Last Sunday 
of February 

Paraguay  
  

Syrian  First Day 
of April 

First Day of 
October 

Iraq, Syria 
  

Tasmania  First 
Sunday of 
October 
  

Last Sunday 
of  March  

Tasmania  

United 
Kingdom  

Last 
Sunday of 
March 

Last Sunday 
of October 

England, Ireland, Isle of Man, Scotland, Wales  
  
  

Mexico First 
Sunday of 
April 
  

Last Sunday 
of October 

Mexico 
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Appendix D: Macro Commands 
The table below lists the macro commands that can run at waypoints in tours. 
 

Command  Name 
Number of 
Arguments Argument 1 Argument 2 Argument 3 Argument  4 Argument 5 

SetVisible 2 Object type Visible    
SetMagFaintest 2 Object type Magnitude    
SetMagBrightest 2 Object type Magnitude    
SetSizeMin 2 Object type Size (arcmins)    
SetSizeMax 2 Object type Size (arcmins)    

SetPenStyleWidth 3 Object type 
Pen style 
(0=none) Pen width   

SetPenColor 5 Object type Red Green Blue Alpha 
SetFillRgb 5 Object type Red Green Blue Alpha 
SetFontRgb 5 Object type Red Green Blue Alpha 
SetFontFamilySize 3 Object type Family name Point size   
SetSymbolSVG 3 Object type SVG filename Size(mm)   
ToggleVisible 1 Object type     
SetExtendLabel 4 Dataset/Type Database Field Value  
AddObject 4 RA Dec Type Magnitude  
AddLabel 3 RA Dec Label   
AddArrow 4 RA Dec Width Height  
AddAreaOfInterest 3 RA Dec Size   
AddChartScale 2 RA Dec    
AddTelrad 2 RA Dec    
AddMoveTo 2 RA Dec    
AddLineTo 2 RA Dec    
AddPolyPoint 2 RA Dec    
AddEllipse 5 RA Dec Major axis Minor axis Position Angle 
AddSVG 4 RA Dec File name Size  
ClearUserData 0      
SetRefFrame 1 Frame     
SetDefaultType 1 Object type     
SetConstlLine 2 Constellation On/Off    
SetConstlBoundary 2 Constellation On/Off    
SetConstlDrawing 2 Constellation On/Off    
SetConstlLabel 2 Constellation On/Off    
ConstlLinesUpdate 0      
LaserPointer 3 RA Dec Duration   
Fade 1 Seconds     
Zoom 1 Degrees     
Center 1 Object name     
Frame 1 Object name     
TourIncrement 1 Days     
TourText 3 Text Height Position   
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Appendix E: Constellation Abbreviations 
(And) Andromeda (Cru) Crux Australis (Ori) Orion 

(Ant) Antlia (Cyg) Cygnus (Pav) Pavo 

(Aps) Apus (Del) Delphinus (Peg) Pegasus 

(Aqr) Aquarius (Dor) Dorado (Per) Perseus 

(Aql)Aquila (Dra) Draco (Phe) Phoenix 

(Ara) Ara (Equ) Equuleus (Pic) Pictor 

(Ari) Aries (Eri) Eridanus (Psc) Pisces 

(Aur) Auriga (For) Fornax (PsA) Pisces Australis 

(Boo) Bootes (Gem) Gemini (Pup) Puppis 

(Cae) Caelum (Gru) Grus (Pyx) Pyxis 

(Cam) Camelopardus (Her) Hercules (Ret) Reticulum 

(Cnc) Cancer (Hor) Horologium (Sge) Sagitta 

(CVn) Canes Venatici (Hya) Hydra (Sgr) Sagittarius 

(CMa) Canis Major (Hyi) Hydrus (Sco) Scorpius 

(CMi) Canis Minor (Ind) Indus (Scl) Sculptor 

(Cap) Capricornus (Lac) Lacerta (Sct) Scutum 

(Car) Carina (Leo) Leo (Ser) Serpens 

(Cas) Cassiopeia (LMi) Leo Minor (Sex) Sextans 

(Cen) Centaurus (Lep) Lepus (Tau) Taurus 

(Cep) Cepheus (Lib) Libra (Tel) Telescopium 

(Cet) Cetus (Lup) Lupus (Tri) Triangulum 

(Cha) Chamaeleon (Lyn) Lynx (TrA) Triangulum Australis 

(Cir) Circinus (Lyr) Lyra (Tuc) Tucana 

(Col) Columba (Men) Mensa Berenices (UMa) Major Ursa 

(Com) Coma Berenices (Mic) Microscopium (UMi) Ursa Minor 

(CrA) Corona Australis (Mon) (Vel) Vela 

(CrB) Corona Borealis (Mus) Musca (Vir) Virgo 

(Crv) Corvus (Nor) Norma (Vol) Volans 

(Crt) Crater (Oct) Octans (Vul) Vulpecula 
 (Oph) Ophiuchus  
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Appendix F: TheSkyX Pro Automation Model 
 
TheSkyX Professional Edition’s automation model is essentially identical to TheSky6 
Professional Edition’s automation model.  Please refer to TheSky6 Professional Edition’s 
Automation Model documentation for details about its objects and their methods and 
properties. 
 
TheSkyX Pro can replace or be exchanged for TheSky6 Pro as far as automation is 
concerned, the only caveat is that controlling programs (clients) need to use TheSkyX 
Pro’s program ids in place of TheSky6 Pro’s program ids.  
 
For example, if your existing script or application source code references TheSky6 Pro’s 
StarChart object: 
 
TheSky6.StartChart  
 
In order to use TheSkyX Pro’s StarChart instead, replace the above syntax with: 
 
TheSkyXAdaptor.StarChart   
 
Your application will now use TheSkyX Professional Edition’s StarChart Object instead 
of TheSky6 Pro’s StarChart object. 
 
The table below includes a complete list of TheSky6 Pro and TheSkyX Pro program ids. 
 
TheSky6 Pro Program ID Equivalent TheSkyX Pro Program ID 
TheSky6.DataWizard  TheSkyXAdaptor.DataWizard 

TheSky6.MyFOVs TheSkyXAdaptor.MyFOVs  

TheSky6.ObjectInformation TheSkyXAdaptor.ObjectInformation 

TheSky6.RASCOMTele TheSkyXAdaptor.RASCOMTele 

TheSky6.RASCOMTheSky TheSkyXAdaptor.RASCOMTheSky 

TheSky6.RASServerApp TheSkyXAdaptor.RASServerApp 

TheSky6.Raven TheSkyX.Raven 

TheSky6.StarChart TheSkyXAdaptor.StarChart 

TheSky6.Utils  TheSkyXAdaptor.Utils  

 
The Visual Basic (VB) code below shows an example how to use the StartChart object in 
either TheSky6 Pro or TheSkyX Pro.  Note that both applications can be installed and run 
on the same computer, and both object models can be accessed on a single computer, 
without issue. 

http://www.bisque.com/help/TheSkyV6/TheSky_Version_6.htm#Introduction_Object_Model.htm�
http://www.bisque.com/help/TheSkyV6/TheSky_Version_6.htm#Introduction_Object_Model.htm�
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Dim StarChart    
‘Remove the tic mark below to use TheSky6 
‘Set StarChart = CreateObject("TheSky6.StarChart")    
 
‘The following line will use TheSkyX Pro’s StarChart object 
Set StarChart = CreateObject("TheSkyXAdaptor.StarChart")  
  
Software Bisque plans extend TheSkyX Professional Edition’s automation model in 
future updates.  For now, the object model version 10.1 of TheSkyX Professional Edition 
it is complete, equivalent to, and backward compatible with TheSky6 Pro’s automation 
model. 
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Appendix G: TheSkyX Change Log 
Changes and improvements to TheSkyX Professional Edition and TheSkyX Serious 
Astronomer Edition since the initial release are listed below. 

Version 10.1.7 

 Fixed a bug that prevented entering FOVIs with multiple elements. 
 Height of Object Information Report now scales to the height of the font. 
 The sky6StartChart is now applying ra dec sets properly. 
 Added camera temperature regulation to the Basic Camera Add On. 

Version 10.1.6 (Initial Release of TheSkyX Professional Edition) 

 Added a Planet Report that includes a variety of Sun, Moon and planet 
ephemerides and other body-specific data. 

 Video driver incompatibility workaround—changed OpenGL calls so that horizon 
and other graphics items do not disappear when using Intel display adaptors. 

 Bug fix—Added Cepheus constellation line for Wil Trion set.  
 Bug fix—For locales where decimal and separators differed from US (“.” and “,” 

respectively), custom locations floating point numeric values were being 
truncated at the decimal level. 

 Bug fix—FOVIs: No longer allow click OK while selecting a root item in the list 
of telescopes, which isn't a valid selection which was confusing. 

 Bug fix—Julian date displayed in Find tab is now shown to a more appropriate 
number of significant figures. 

 Bug fix—mirror photos when the Show Mirror Image command is turned on. 
 Added NexStar-specific telescope commands dialog. 
 Added Sky Commander/ServoCAT support. 
 Bug fix—The Edit Chart Element dialog wasn’t in sync with changes that happen 

outside of it. 
 Added Cross Hair Update Interval option to the Telescope > Telescope Setup 

dialog. 
 Bug fix—horizon/equatorial lines fonts/widths are now correct. 
 Bug fix—changes to time zone and elevation are now immediately applied. 
 Bug Fix—mounts that cannot report which side of the pier they are on will now 

point “better” w/r/t TPoint. 
 Bug fix—“Software imposed slew limits” can be over-ridden. 
 Bug fix—Display > Non-Stellar Options dialog, the Hollow Deep Sky option is 

no longer ignored.   
 Bug fix— Display > Non-Stellar Options dialog, a “fuzzy” value of 0 is now 

applied correctly. 
 Sky Database pens and brushes can now have an alpha channel. 
 Setting the pen color now works in a drawing Sky Database. 
 The Status Bar can now be configured to show Sky Chart Status information.  To 

save screen space, items placed in the Status Bar do not include a text prefix as 
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they do in the Chart Status window.  For example, the date appears as just: 
12/22/2020.  

 Added angular separation and position angle from prior object to Object 
Information Report on the Find dialog. 

 Corrected AP Park Positions (labels were wrong). 
 Moon's Long/Lat are shown separately from the Moon Feature Information text 

box. 
 Fixed a regression bug that prevented showing Moon Viewer photos. 
 Changed name of TheSkyX supplied Sky Databases from “System” to “Core Sky 

Databases” in the Database Manager dialog. 
 All negative values for offsets in FOVIs. 
 Added TeleAPI to list of supported telescopes. 
 Corrected spelling of the star Alnair. 
 Updated/added SBIG detectors and corrected the relative position of the 

autoguider for the SBIG STL-4020M model camera. 
 Corrected misspelling of Sirius in tour description. 
 1) Enabled the app option to turn off Autosave (was forced to on and disabled) 

and added an option to turn off being prompted to save modified settings.  Sky 
Chart settings are “dirtied” better now, but not “perfectly” (on the conservative 
side).  These changes allow customers more flexibility w/r/t multiple charts and is 
more like what TheSky6 Pro offers. 

 The format of the date and time that is displayed in TheSkyX’s custom Date & 
Time control can now be configured.  Right-click on the control to edit the 
format. 

 Bug fix—prevent loading large database asteroids while load in progress. 
 Bug fix—Percent status is now correct while converting large database asteroid 

text file.  
 Cleaned up Asteroid (Large Database) dialog. 
 Night Vision Mode under Windows no longer requires Windows themes.    
 Fixed printing of ellipses (galaxies,  etc.) 
 When FOVI groups are selected (like Telescopes+Eyepieces) the Combine 

message now correctly displays the number of combinations. 
 Bug fix—Positions of the galactic poles are now precessed to the current equinox. 

Version 10.1.3 (Build 2930) July 24, 2009 
 

 Higher accuracy computations for Jupiter’s and Saturn's moons. 
 Shadows of Jupiter’s major moons now appear on the planet. 
 Jupiter and Saturn’s moons can now be locked on.  
 Jupiter’s and Saturn’s major moons can be located using the Find command.  
 Added pulse focuser support for mounts that support pulse focusers through the 

telescope protocol (LX200/Autostar/AP GTO/Gemini). 
 Comet perihelion date now uses full precision from orbital elements. 
 Stereographic spelled correctly in Projections dialog. 
 Double-clicking tree list to add a “My FOVI” now works correctly. 
 Clicking Cancel button when editing a new FOVI no longer creates the FOVI. 
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 Press Insert/Delete keys to add/remove My FOVIs. 
 The type Circle no longer appears in the Shape List when editing FOVIs. 
 Can double-click My FOVI list to edit them. 
 Increased the minimum size of the FOVI edit fields for better readability on the 

Mac. 
 E/W offset option renamed to East/west offset; N/S offset renamed to North/south 

offset on the Edit Detector dialog. 
 Center telescope cross hair now corrects for coordinate offset caused by TPoint 

model. 
 Corrected location for observatory in India. 
 Fixed a bug that caused TheSkyX to crash when connecting to the Temma. 
 Fixed a bug that caused the Temma to hang on connection. 
 The “Always keep telescope crosshairs on screen” option is now saved. 
 On the Mac, after a crash, re-starting TheSkyX and clicking cancel when 

prompted for a serial number would keep incrementing the multi-instance index.  
It is also possible that this fix might lessen the cases when starting again on the 
Mac after a crash goes to a new instance. On Mac (Unix OS) shared memory can 
survive a crash.  Restarting the computer is the only way to free it. 

 Turning on/off FOVI’s from Chart Elements tab now works. 
 The “Slew button always disabled after slew” issue with Vixen HTTP telescopes 

is fixed. 
 Set both date and time in Gemini and LX200 driver (date was not always set 

correctly). 
 Reboot Gemini command now works. 
 Button text “Find Now” changed to “Find” on the Find window and Telescope 

window.   
 “Find” text on Telescope window changed to “Search For” for consistency with 

Find window. 
 Increased default width of SDB manager window.  
 Changed the maximum size for FOVI to 50 degrees. 
 TheSkyX Windows installer no longer allows individual features to be selected 

when there’s insufficient space on a drive. 
 Stellar catalogs are now saved and restored when opening an observing list query. 
 FOVI’s now drawn after Photo SDBs.  
 Constellation label checkbox in Chart Elements now works.  
 Numerous bug fixes related to changing the magnitude limits of single and 

multiple chart elements. 
 Fixed bug where clicking on planet moon reverted to Earth’s Moon. 
 The Tools > Show Satellites > Find Best Passes option now works (regression 

bug).  
 NexStar telescope cross hair position is now always correct. 
 Increased NexStar’s time out time to 3.5 seconds (per protocol specifiction) 
 Changed My Chart Element # heading to Element #. 
 Jupiter’s major moons can now by located from the Display > Find window. 
 Herschel and Caldwell labels are no longer filtered when the corresponding 

NGC/IC has already been plotted.  
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 Renamed “Allow scrolling below the horizon picture” to “Allow Sky Chart to be 
scrolled below the horizon" (Display > Horizon and Atmosphere dialog). 

 The Allow Sky Chart to be scrolled below the horizon option can be accessed 
when either “Photograph” or “Custom Horizon” is selected. 

 FOVIs fill color can now be edited. 
 The default fill for circular FOVIs in Map-Like View is transparent. 
 For object types that cannot be turned on or off, the state of the Visible checkbox 

in the Chart Elements list is set to “indeterminate”. 
 Telescope can be slewed to any ra/dec or az/alt coordinate from the Telescope 

windows Tools > Slew To Coordinates command.  (Or the Enter Coordinates tab 
of the Orientation > Navigate window). 

 Disabled diagonal move buttons for telescopes that do not support this feature. 
 Added the native Set Sidereal Tracking Rate and Turn Tracking Off commands to 

the AP-Specific dialog. 
 Changed the text “Related Find Results” to "Related Search Results" on the 

Display > Find window. 
 Updated telescopes listed in FOVI telescope database (including RCOS 

telescopes). 
 Searching for Asterisms now works (recompiled Asterisms.txt). 
 Changed moonlit side of symbol on date calendar for first and last quarter Moon.  
 Add a provision to (externally) abort serial operations that may timeout. 
 For mounts that can set tracking rates, but not get/read them, provide a convention 

so that an agnostic (non bias) status message may result. 
 Telrad Finder is now the correct size.  
 Added the Telescope Simulator to the list of supported telescopes (under Software 

Bisque).  
 Improved Telescope Simulator’s cross hair motion (slews now simulate 

acceleration and deceleration). 
 The automated location look up via IP is now more robust wrt invalid http 

responses. 
 The LX200 can now automatically synchronize at the home position after a park 

and reconnection to TheSkyX. 
 Added an abortable progress indicator window that appears when loading 

observing lists with large numbers of objects. 

Version 10.1.2 (Build 2845) May 7, 2009 

 
 Initial Release of TheSkyX Serious Astronomer Edition for both Mac and 

Windows. 
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6C Survey of Radio Sources, 262 
6ZW, 265 
7ZW, 265 
8ZW, 265 
AB Engineering, 197 
Abell – Zwicky Clusters of Galaxies, 262 
Abell Planetary Nebulae, 262 
absolute magnitude, 98 
Ackerman Red Stars, 262 
adding objects, 169 
Aitken Double Star Catalog, 44 
albedo, 111 
alignment stars, 205 
altitude, 91 
analemma, 51 
Angle of view 

minimum/maximum, 92 
angular diameter, 117 
Angular separation, 35 
Antalova Open Clusters, 44 
APM Bright Galaxy Catalogue, 262 
apparent magnitude, 98 
Apriamasvili Planetary Nebulae, 44 
Arakelian Catalog of Galaxies, 264 
ARP, 265 
Arp Globular Clusters, 262 
Arp Peculiar Clusters, 262 
Arp-Madore Globular Clusters, 44 
Asteriod Belt, 112 
asteriods, 104 
asterisms, 99, 149, 150 

labeling, 150 
asteroids, 142 
astrometric solution, 185 

Astro-Physics, 219 
Astro-Physics GTO mounts, 197 
attributes of 

chart elements, 136 
aurora australis, 105 
aurora borealis, 105 
AutoAstrometry, 185 
autodark, 246 
Autumn, 85 
Autumnal Equinox, 85 
azimuth, 91 
azimuth/altitude grid lines, 151 
Azimuthal Equal-Area, 93 
Azimuthal Equal-Distance, 93 
background sky color, 154 
Barkhatova Open Clusters, 44 
Barnard Dark Nebulae, 44 
Barnard’s Dark Nebulae, 262 
Basel Open Clusters, 44 
Bayer, Johannes, 149 
Bayer/Flamsteed Designations, 261 
BBox, 197 
begin twilight, 85 
Berkeley Open Clusters, 44 
Bernes Dark Nebulae, 44 
bitmaps, 100 
Biurakan Open Clusters, 44 
Blanco Open Clusters, 44 
Blindness 

solar-induced, 197 
Bochum Open Clusters, 44 
Bonner Durchmusterung Number, 265 
Bonner Durchmusterung Stars, 44 
boundaries 

constellation, 149 
bright nebulae, 139 
Bright Nebulae Drawings, 262 
Caldwell Catalog, 261 
Caldwell Catalog, 265 
calendar, 77 
Calendar 

setting date, 81 
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Cape Durchmusterung Number, 265 
Catalog numbers 

entering, 45 
Catalog of Bright Galaxies, 262 
Catalog of Galaxies and Clusters of 

Galaxies, 265 
Catalog of Galaxies and Clusters of Galaxies 

(CGCG), 44 
Catalog of Principal Galaxies (PGC), 261 
Catalog of Selected Non-UGC Galaxies, 45 
catalogs 

list of searchable, 35 
Catalogs 

list, 45 
Cederblad Bright Nebulae, 44 
celestial equator, 90 
Celestron 

Advanced Series, 197 
CG Series (all models), 197 
CGE Series, 198 
CPS Series, 198 
GT Series, 198 
NexStar i Series, 198 
NexStar Series, 197 
SLT Series, 198 
Ultima 2000, 198 

Celetron NexStar Double Stars, 262 
Cepheids in the Large Magellanic Cloud, 

262 
chart elements 

symbols, 137 
Chart elements, 29 
chart layers, 100 
Clementine mission, 106 
cluster+nebulosity, 140 
Collinder Open Clusters, 44 
Colors 

spectral, 35 
comets, 103, 115, 142 
Common name labels 

displaying, 48 
Common Non-Stellar Object Names, 265 
Common Star Names, 265 
computer clock, 82 
Conjunction Finder, 126, 127 
constellation 

abbreviations, 149 
pronunciation, 149 

constellation 
boundaries, 149 

constellation 
drawings, 149 

constellation lines 
Astronomy Magazine, 149 
H.A. Rey, 149 
Patrick Moore, 149 
Sky & Telescope magazine, 149 

constellations, 98 
Constellations, 265 
Cool Galactic Carbon Stars, 262 
coordinates 

sexagesimal vs. decimal format, 40 
Cordoba Durchmusterung, 265 
corona, 117 
Cousins Photometric Standards, 262 
crater chains, 107 
craters, 107 
cross hairs 

telescope, 158 
customize 

chart elements, 136 
Czernik Open Clusters, 44 
dark nebula, 139 
Dark Nebulae Drawings, 262 
databases 

custom, 161 
SDB, 158 

date & time, 86 
date and time, 79 
David Dunlap Observatory Catalog of 

Galaxies, 265 
David Dunlap Observatory Dwarf Galaxies, 

44 
Daytime slewing, warning, 197 
decimal format, 40 
declination, 90 
Declination Zero Label, 262 
Declination Zero Line, 262 
DeepMap 600, 262 
default settings 

toolbars, 131 
Deimos, 112 
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Disclaimers, 3 
Distance, 35 
Dolidze Open Clusters, 44 
Dolidze-Dzimselejsvili Open Clusters, 44 
DonMacholtz Messier Marathon, 262 
Dorsum (wrinkle ridges), 108 
double star 

binary, 96 
Double Star Common Names, 262 
Dreyer, J.L.E., 141 
Dunlap Southern Objects, 44 
dwarf planets, 115 
Earth, 110 
eclipses 

lunar, 117 
solar, 117 

eclipsing binaries, 97 
ecliptic, 109, 149, 150 
edit 

chart elements, 136 
Einstein Observatory Ex M-S Survey, 262 
encoders 

setting up, 201 
Encoders 

aligning, 203 
models supported, 197 
realignment, 205 

end twilight, 85 
enter 

location, 20 
equinox, 110 
ESO, 265 
European Southern Observatory Objects, 44 
evening, 85 
export 

star charts, 100 
Fairall Catalog of Galaxies, 265 
Fall, 85 
Father Lucian Kemble Asterisms, 44 
Feinstein Open Clusters, 44 
Feitzinger Dark Nebula, 262 
Feitzinger Globules, 262 
field of view, 89 
Field of View Indicators, 65, 69 
field width, 89 
Filter 

by magnitude, 95 
find 

objects, 105 
planets, 105 

finding objects, 35, 41 
Magellanic Clouds, 41 
name, 41 

Finding objects 
by catalog designation, 45 
by type, 42 

fireball, 103 
first quarter, 85 
FITS, 185 
focusers, 250 
FOVI, 69 
Frolov Open Clusters, 44 
full moon, 85 
G2 V Stars from SIMBAD, 262 
Galactiglob Galaxies, 262 
galaxies, 127 
Gemini Astronomical Positioning System, 

225 
General Catalog of Variable Stars (GCVS), 

261 
George Abell planetary nebulae and galaxy 

clusters, 44 
globular clusters, 129, 140 
Gnomonic projection, 93 
Go To telescope 

models supported, 197 
Goto My PC, 14 
grid 

equatorial, 150 
horizon, 151 

grid lines 
ra/dec, 150 

Gum Bright Nebulae, 44 
Haffner Open Clusters, 44 
Halton Arp Interacting Galaxies, 44 
Hamason Planetary Nebulae, 44 
Harvard Open Clusters, 44 
Haute Provence Globular Clusters, 44 
Havermeyer and Moffat Open Clusters, 44 
Henize LMC Objects, 262 
Henize Planetary Nebulae, 44 
Henry Draper Catalog (HD), 261 
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Henry Draper number, 265 
Herbig-Haro Objects, 262 
Herschel Catalog, 261 
Herschel, John, 141 
Herschel, William, 141 
HII Regions 

Sharpless Catalog, 263 
Hipparcos/Tycho Stellar Catalog, 261 
Hogg Open Clusters, 44 
Holmberg Galaxies, 44 
HTML, 163 
Hubble Guide Star Catalog (GSC), 261 
ice dwarfs, 114 
Ice Giant, 113 
identifying objects, 35 
Image Link, 185 
image scale, 68 
images 

celestial objects, 57 
import 

asteroids, 142 
comets, 142 

Index Catalog (IC), 261 
Infrared Astronomical Survey, 265 
International Astronomical Union (IAU), 

114 
iOptron, 227 
iOptron SmartStar Series, 198 
Iridium flare, 77 
Iridium flares, 123 
Iridium flares, 145 
Iskudarian Open Clusters, 44 
isophote, 127 
JMI 

NGC-MAX, 197 
Jonckheer Planetary Nebulae, 44 
Jupiter, 112 
Karachentseva Catalog of Galaxies, 265 
Kazaryan UV Galaxies, 265 
King Open Clusters, 44 
Kiso UV Galaxies, 265 
Kohoutek Planetary Nebulae, 44 
Krasnogorskaja Planetary Nebulae, 44 
label 

asterisms, 49 
asteroids, 49 

Bayer designation, 49 
comets, 49 
common non-stellar names, 49 
common star names, 49 
constellations, 49 
detailed, 50 
Flamsteed designation, 49 
Messier catalog, 49 
meteor showers, 50 
NESW, 49 
planets, 50 
satellites, 50 

label 
common names, 48 

labels 
asterisms, 150 
constellation options, 149 

Lacaille Globular Clusters, 44 
Lacus (lakes), 108 
Landing Sites, 107 
Large Magellanic Cloud, 129 
last quarter, 85 
LGS, 265 
limit 

magnitudes of objects, 137 
Limiting 

magnitude, 95 
lines 

adding to chart, 149 
location, 20 

on Earth, 21 
Loden Open Clusters, 44 
logarithmic scale, 94 
logging observations, 177 
Losmandy Instruments mounts, 198 
lower magnitude limit, 137 
Lynds Bright Nebula, 44 
Lynds Dark Nebula, 44 
Lynds’ Bright Nebulae, 263 
Lynds’ Dark Nebulae, 263 
Lynga Open Clusters, 44 
Magellanic Clouds, 129 
magnification, 68 
magnitude, 94 

absolute, 98 
apparent, 98 
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magnitude limits, 137 
mapped point, 158 
mare, 106 
Mare, 107 
Markarian Open Clusters and Galaxies, 44 
Mars, 111 
Meade Alignment Star Labels, 263 
Meade Instruments 16-inch LX200 Series, 

198 
Meade Instruments Autostar II, 198 
Meade Instruments Autostar III Series, 198 
Meade Instruments Autostar Series, 198 
Meade Instruments LX200 Series, 198 
Meade Instruments mounts and telescopes, 

229 
Melotte Open Clusters, 44 
Mercator projection, 91 
Mercury, 109 
meridian, 91 
Merrill Planetary Nebulae, 44 
Messier catalog, 141 
Messier Catalog, 262 
Messier Catalog, 44 
Messier Catalog, 265 
meteor, 103 

radiant, 104 
showers, 104 

meteor shower radiants, 157 
meteorites, 104 

iron, 104 
stony, 104 

Michael Covington Deep Sky Objects, 263 
midnight, 85 
Milky Way, 41, 42, 127, 156 
Milky Way galaxy, 101, 127, 129 
Minkowski Planetary Nebulae, 44 
minor planets, 104 
minor planets, 142 
mixed deep sky objects 

Messier catalog, 141 
Mons (lunar mountains), 108 
Moon, 105 

Catena (crater chains), 107 
craters, 107 
Dorsum (wrinkle ridges), 108 
Lacus (lakes), 108 

Landing Sites, 107 
Mare (lunar seas), 107 
Mons (mountains), 108 
photos, 106 
Promontor (promontories), 108 
Rima (rilles), 107 
sub-craters, 107 
Vallis (valleys), 108 

moonrise, 85 
moonset, 85 
morning, 85 
Morphological Catalog of Galaxies, 44 
Mosaic command, 181 
mosaic grid, 157 
mouse 

scroll wheel zooming, 25 
my chart elements, 169 

add area of interest, 170 
add arrow, 170 
add chart scale, 170 
add ellipse, 170 
add label, 170 
add object, 169 
add object label, 170 
add photograph, 170 
add Telrad finder, 170 
export, 172 
import, 172 
reference line, 157 
reference point, 157 
telescope limit line, 157 

naked eye, 90 
Naked eye view, 26 
Navigational Stars, 263 
NB Carbon Stars, 263 
nebula 

dark, 139 
nebulae 

bright, 139 
nebulae, 138 
nebulas, 127 
Neptune, 114 
New General Catalogue (NGC), 261 
new moon, 85 
New Suspected Variable Star Catalog 

(NSV), 261 
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NexStar-compatible mounts, 222 
NGC and IC Objects with unknown 

magnitudes, 263 
NGC Catalogue, 141 
NGC Sky Commander, 197 
NGC-MAX, 197 
NGC-Max Alignment Stars, 263 
night vision, 101 
Night Vision Mode, 198 
No OpenGL, 13 
noon, 85 
Northern Proper Motion 1st Part Galaxies, 

44 
nuclear fusion, 98 
object paths, 75 
observer logs, 177 
observing lists 

creating, 172 
example, 175 
window orientation, 179 

Oort Cloud, 115 
open clusters, 139 
Optical Encoders. See Encoders 
orbital elements, 115 
orientation commands, 87 
Orion Telescopes & Binoculars EQ-G 

mounts, 198 
Orion Telescopes & Binoculars Sirius 

mounts, 198 
Palomar Clusters, 263 
Palomar Globular Cluster, 45 
panning, 26 
Parkes Radio Sources, 263 
Peimber and Costero Planetary Nebulae, 45 
Perek & Kohoutek Planetary Nebulae, 45 
PGC Catalog, 261 
Phobos, 112 
Phonetic matches, 41 
Photo Viewer, 57 
photographs, 57, 149 
photos, 57 
pictures, 57 
Pismis Open Clusters, 45 
PK Planetary Nebula Catalog, 261 
planetary nebulae, 139 
planets, 109 

plate solve, 185 
Pleiades, 139 
Pluto, 114 
Position angle, 35 
Position error, 35 
Positions and Proper Motion Catalog 

(PPM), 261 
Positions and Proper Motions Number, 265 
preferences, 130 

advanced, 135 
target frame rate, 135 
toolbars, 130 

Principal Catalog of Galaxies, 43 
printing charts, 100 
probable stars, 141 
Projections 

understanding, 91 
prominences, 117 
Promontor (promontories), 108 
proper motion, 146 
Proper motion, 35 
Pulsars, 263 
quasar, 140 
ra/dec grid lines, 150 
radiants 

meteors showers, 104 
radio source, 140 
radmin, 14 
red screen, 101 
reference lines, 157 
reference lines, 149 

asterisms, 149 
constellation boundaries, 149 
constellation figures, 149 
ecliptic, 149, 150 
equatorial grid, 149 
galactic, 149 
local horizon, 151 
refracted horizon, 152 

reference point, 157 
refraction, 85 
registration, 17 
Remote Desktop, 14 
report setup, 133 
restore 

toolbars, 131 
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retrograde motion, 111 
right ascension, 90 
Rima (rilles), 107 
Rise time, 35 
Rodgers, Campbell & Whiteoak Bright 

Nebulae, 45 
Rosland Open Clusters, 45 
Ruprecht Open Clusters, 45 
Saguaro Astronomy Club (SAC) Database, 

262 
Sandqvist & Lindroos Dark Nebulae, 45 
Sandqvist Dark Nebulae, 45 
satellites, 121, 144 

Iridium flares, 123 
Saturn, 113 
scale, 68 
scrolling, 26 
SDBs, 165 

HTML, 163 
sky databases, 158 

searching for objects, 35 
seasons, 110 
Second Byurakay Survey, 265 
serial number, 16 
set 

AM/PM, 81 
date, 79 
day, 79 
month, 79 
time, 79 
time to now, 85 
year, 79 

Set time, 35 
sexagesimal format, 40 
Seyfert Galaxies, 263 
Shapley & Lindsay Clusters in LMC, 45 
Sharpless Bright Nebulae, 45 
Sharpless catalog, 263 
Sharpley-Ames Revised Catalog of 

Galaxies, 44 
Sher Open Clusters, 45 
sky chart, 19 
Sky Chart 

elements, 136 
Sky Commander, 197 
sky databases, 158 

sky gradient, 154 
Sky Tour, 197 
Sky Wizard 3, 197 
SkyWatcher SynScan mounts, 198 
Small Magellanic Cloud, 129 
small solar system bodies, 142 

asteriods, 112 
comets, 115 
pluto, 114 

Smithsonian Astrophysical Catalog (SAO), 
265 

Smithsonian Astrophysical Observatory 
Catalog (SAO), 261 

Software Bisque Paramount, 231 
solstice, 110 
spectral class, 98 
Spring, 85 
Star 

limiting brightness, 95 
star clusters, 139 
star names, 93 
Star Search command, 212 
stars, 145 

appearance of, 146 
proper motion, 146 

Stars in the Double Double, 263 
StellarCAT, 232 
Stephenson Open Clusters, 45 
Stereographic projection, 91 
Stock Open Clusters, 45 
Struve Catalog, 265 
Struve Double Star Catalog, 261 
sub-craters, 107 
Summer, 85 
Summer Solstice, 85 
sunrise, 85 
sunset, 85 
supernovas, 147 
support, 19 
suspected variable stars, 146 
symbols, 137 
sync, 212, 215 
synchronization, 212 

telescope, 215 
synchronization, 209 
Takahashi Temma, 234 
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Takahashi Temma mounts, 198 
Target Frame Rate, 135 
target object, 157 
technical support, 19 
Telescope 

configuring the interface, 208 
finding objects, 206 
synchronization, 209 
troubleshooting, 218 

telescope cross hairs, 158 
telescope limits, 157 
Telescope Link 

slewing to a specific object, 216 
synchronization, 215 

Telrad™ finder, 157 
Terzan Globular Clusters, 45 
Third Cambridge Catalog of Radio Wave 

Sources, 44 
time 

animation, 75 
time skip, 75 
Tololo Galaxies, 265 
Tombaugh Open Clusters, 45 
Tomm Lorenzin Catalog, 261 
Tonantzintla Globular Clusters, 45 
toolbars 

customize, 130 
default settings, 131 

tours, 51 
title, 158 

transit time, 91 
Transit time, 35 
Trapezium, 263 
Trumpler Clusters, 263 
Trumpler Open Clusters, 45 
Trumpler Stars, 263 
UGC, 265 
UltraVNC, 14 
uninstall, 16 
United Kingdom Schmidt Globular Clusters, 

45 
University of Michigan Catalog of Galaxies, 

265 

Upgren Open Clusters, 45 
upper magnitude limit, 137 
Uppsala General Catalog of Galaxies, 45 
Uranometria, 149 
Uranus, 113 
user-defined objects 

my chart elements, 169 
Vallis (valleys), 108 
van den Bergh Bright Nebulae, 45 
van den Bergh Open Clusters, 45 
van den Bergh-Hagen Open Clusters, 45 
Vandenbergh Reflection Nebulae, 263 
variable stars, 147 
variable stars, 97 
VCC, 265 
Venus, 109 
Vernal Equinox, 85 
Video Calibration Stars, 263 
Vixen Sphinx HTTP, 241 
Vixen Sphinx mounts, 198 
Vorontsov-Velyaminov Interacting 

Galaxies, 45 
VV, 265 
Vyssotsky Planetary Nebulae, 45 
Washington Catalog of Double Stars 

(WDS), 261 
WEIN, 265 
What’s Up Tonight?, 65 
William Herschel Globular Clusters, 44 
Winnecke Double Stars, 45 
Winter, 85 
Winter Solstice, 85 
x-ray source, 140 
Yale Bright Star Catalog, 263 
Zodiac, 109 
zoom 

in, 90 
out, 90 

zoom box, 25, 90, 158 
zoom tool, 25 
Zwicky Galaxies, 45 
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